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Unit-1 Introduction to 3D space

Introduction

Welcome to Blender, the free and Open Source 3D animation suite. Blender can be used to
create 3D visualizations such as still images, video, and real-time interactive video games.
Blender is well suited to individuals and small studios that benefit from its unified pipeline and
responsive development process. It is a cross-platform and runs on Linux, macOS, and MS-
Windows systems with less memory and disk footprint. Its interface uses OpenGL to provide

a consistent experience across all supported hardware and platforms.

Key Features

e Blender is a fully integrated 3D content creation suite, offering a broad range of essential
tools, including Modelling, Rendering, Animation, Video Editing, VFX, Compositing,
Texturing, Rigging, many types of Simulations, and Game Creation.

e Cross platform, with an OpenGL GUI that is uniform on all major platforms (and
customizable with Python scripts).

e High-quality 3D architecture enabling fast and efficient creation work-flow.

e Excellent community support from forums and IRC.

e Small executable size, optionally portable.

Title-Img 1. 1A rendered image being post-processed.

Source- blender.org Link-

https://docs.blender.org/manual/en/dev/getting_started/about/introduction.html

Despite everything Blender can do, it remains a tool. Talented artists do not create masterpieces
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by pressing buttons or manipulating brushes, however, by learning and practicing subjects such

as human anatomy, composition, lighting, animation principles.

3D Content Creation Software such as Blender has the added technical complexity and

jargon associated with the underlying technologies. Terms like UV maps, Materials, Shaders,

Meshes, and “Sub surf” are the mediums of the digital artist, and understanding them, even

broadly, will help you to use Blender to its best. As this is a 3D based software, the navigation

and the working pattern are very different unlike any other 2D based software. In this Unit,

you will learn about the Interface of the software.

Outcomes

Upon completion of this unit you will be able to:

Interface and customize elements as the Info Editor (Top), a large 3D View,

TimeLine(Bottom), Outliner (Top right), properties Editor (Bottom right) etc.

Experience the Navigation within the 3D space using different Transformation tools and

the creation of basic meshes (objects) in Blender

Use Transformation tools in Blender

Manage Navigation in Space

Create Basic Primitives

Work on the Interface

Create Shortcuts and

Identify Buttons and Controls

Terminology

Header

Menu

Mode

Viewport shading
Transform

Manipulator:

Snap

Tool Shelf

Header contains various menus and controls based on the current mode.
Menu offers tools to navigate in 3D space.

3D view has several modes used for editing different kinds of data.
Allows you to change the way objects are displayed in the viewport.
These handy selectors allow you to rotate or move objects by grabbing
(clicking with your mouse) their controls and moving your mouse in
the axis.

Controls the snapping tools that help with transforming and modelling
objects.

Tool shelf is a context-sensitive region containing tools depending on



the current mode.

Properties Region : Properties Region contains properties of the active object and selected
objects.

Grid Floor . The grey squares forming a floor mark the zero height of the world.

Orbit . Rotate the view around the point of interest.

Roll . Rotate the viewport camera around its local Z axis in 15° discrete steps.

Introduction to 3D view

3D View is used to interact with 3D scene for a variety of purposes, such as modeling,
animation, texture painting, etc.

Main Region

One region, which is always visible, is known as the Main Region and is the most prominent
part of the editor.

Each editor has a specific purpose, so the main region and the availability of additional regions
are different between editors.

Header

The header contains various menus and controls based on the current mode.

Draw Mode Proportional editing OpenGL

Orientation (view shading) object mode ':cr:c;‘ijveer

viewport

Active object
Editor | T Pivot TMrgnlslel'gors Lock to
type Modes Point p L scene Sna
Ilmﬂ"l'—l A | Hﬂ? LI_P
°o: %5 3 F nE

k_’f = Global

7D &

il G @ Object Mode ¥

Title-Img 1. 2. 3D View header Attribution
Attribution- Source- blender.org
Link-https://docs.blender.org/manual/en/dev/editors/3dview/introduction.html
Menus
View This menu offers tools to navigate in 3D space.
Select Contains tools for selecting objects.
Add Gives a list of different objects types that can be added to a scene.
Object This menu appears when in Object Mode. It contains tools to edit objects. In edit mode,
it will change to the appropriate menu with editing tools.

Controls Modes The 3D view has several modes used for editing different kinds of data:

Object Mode The default mode, available for all object types, as it is dedicated to object data-
block editing

Edit Mode A mode available for all renderable object types, as it is dedicated to their “shape”
Object



Pose Mode An armature only mode, dedicated to armature posing.

Sculpt Mode A mesh-only mode, that enables Blender’s mesh 3D-sculpting tool.

Particle Edit A mesh-only mode, dedicated to particle systems, useful with editable systems
(hair).

Arranging the Screen

Blender uses a novel screen-splitting approach to arrange areas. The idea is that you split up
the big application window into many number of smaller (but still rectangular) non-
overlapping areas. That way, each area is always fully visible, and it is very easy to work in

one area and hop over to work in another.
Changing the Size
You can resize areas by dragging their borders with LMB. Simply move your mouse cursor

over the border between two areas, until it changes to a double-headed arrow, and then click

and drag.

e Splitting and Joining
e Area Split Widget

Title-Img 1. 3. Changing the size Attribution-
Source- blender.org

Link-https://docs.blender.org/manual/en/dev/interface/window_system/areas.html

In the upper right and lower left corners of an area are the area split widgets, and they look like
a little ridged thumb grip. It bothsplits and combines areas. When you hover over it, your cursor
will change to a cross (+). (Refer Img 1.3) LMB and drag it inward split the area. You define
the direction of that border by either dragging horizontally or vertically. In order to join two
areas LMB click and drag the area splitter outward. They must be the same dimension (width
or height) in the direction you wish to join. This is so that the combined area space results in a

rectangle.



Title-Img 1. 3 Properties Editor is being merged “over” the Outliner. Attribution-
Source- blender.org

Link- https://docs.blender.org/manual/en/dev/interface/window system/areas.html

The area that was closed gets a dark overlaid with an arrow. Now you can select the area to be
closed by moving the mouse over it. Release the LMB to complete the join. If you press Esc

or RMB before releasing the mouse, the operation will be aborted.

Area Options

RMB on the border opens the Area Options. Split Area Shows an indicator line that lets you
select the area and position where to split. Tab switches between vertical/horizontal. Join Areas

Shows the join direction overlay. Confirm or cancel works as described above.

Toggle Maximize Area

e Menu: View » Toggle Maximize Area

e Hotkey: Ctrl-Up, Shift-Spacebar

The maximized area fills the whole application window. It contains the Info Editor and the
select area. You can maximize an area with the View » Toggle Maximize Area menu entry.
To return to normal size use again menu entry, or RMB on the editor’s header and select
Maximize Area and Tiled Area to return. In the Info Editor header, the Back to Previous button

on the right of the menus also returns to tiled areas. A quicker way to achieve this is to use the
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https://docs.blender.org/manual/en/dev/interface/window_system/areas.html

shortcuts: Shift-Spacebar, Ctrl-Down or Ctrl-Up to toggle between maximized and normal

areas.

Tabs & Panels

Tabs

Tabs are overlapping sections in the user-interface. The Tabs header can be vertical (Tool
Shelf) or horizontal (Properties Editor, User Preferences). Vertical tabs can be switched with

the Wheel within the tab header and Ctrl-Wheel changes tabs from anywhere in the region.

Title-Img 1. 4Tools tab (selected), Create, etc
Source- blender.org

Link- https://docs.blender.org/manual/en/dev/interface/window_system/tabs_panels.htmi
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Title-Img 1. 5 Horizontal tab header Attribution- Source- blender.org

Link- https://docs.blender.org/manual/en/dev/interface/window_system/tabs_panels.html

Panels

The smallest organizational Unit in the user interface is a Panel. Panels can be collapsed to

hide its contents. They are used in the Properties Editor, but also for example in the Tool Shelf
7



and the Properties region. In the image on the right there are three panels:

1. Transform
2. Edit

3. History

The Edit panel is expanded and the other two panels are collapsed.

Set Origin

Title-Img 1. 6 Tool Shelf panels. Orange: Panel Headers Attribution-
Source- blender.org

Link- https://docs.blender.org/manual/en/dev/interface/window system/tabs panels.html

Collapsing and expanding

A triangle on the left of the title shows the expanded (V) and collapsed (») state of the panel.

¢ Aclick with the LMB on the panel header expands or collapses it.
e Pressing A expand/collapses the panel under the mouse pointer.

e A Ctrl-LMB click on the header of a specific panel will collapse all other panels and make
this the only expanded one.

e Dragging with LMB over the headers will expand or collapse many at once.

Panel Position


https://docs.blender.org/manual/en/dev/interface/window_system/tabs_panels.html

You can change the position of a panel within its region by clicking and dragging it with the

LMB on the grip widget (::::) in the upper right corner.

Pinned Panel Often it is desirable to view panels from different tabs at the same time. This has
been solved by making panels pinnable. A pinned panel remains visible regardless of which
tab has been selected. You can pin a panel by Shift clicking its header, or by RMB clicking on
the header and choosing Pin in the context menu. In the image shown to the right, is an example

of the Mesh Options pinned in the tools tab.

Zoom

The zoom factor of a whole region with panels can be changed by Ctrl-MMB clicking and
moving the mouse anywhere within that region or use the Numpad Plus and Numpad Minus
to zoom in and out the contents. Pressing Home (Show All) will reset the zooming at the

screen/panel focused by the mouse pointer.

Alignment

The alignment of the panels in the Properties Editor can be changed between vertical and
horizontal. To do this, click with RMB somewhere within the main region of the Properties
Editor and choose either Horizontal or Vertical from the appearing menu. Keep in mind though

that the panels are optimized for vertical alignment.

Viewport Shading

It allows you to change the way objects are displayed in the Viewport.

Header: Viewport Shading

» Rendered

Texture
Solid

s Wireframe

=
|

Bounding Box

U

Title-Img 1. 7The Viewport Shading menu Attribution- Source- blender.org

Link- https://docs.blender.org/manual/en/dev/editors/3dview/properties/shading.htmi



Bounding Box

Only shows rectangular boxes that outline an object’s size and shape.

Wireframe

Obijects appear as a mesh of lines representing the edges of faces and surfaces.

Solid

The default drawing mode using solid coloured surfaces and simple lighting.

Textured
Shows meshes with an image applied using the mesh’s active UV Map. For Cycles materials,
the image is the last one selected in the Node Editor. For other render engine’s, the UV Map’s

applied face texture will be shown.

Material

A fast approximation of the applied material.

Rendered

An accurate representation using the selected Render Engine and lit with the visible scene
lights.

Keyboard Shortcut

e Shortcuts Switches between Wireframe and Solid draw modes. Z

e Switches between the current and Rendered draw modes. Shift-Z

e Switches between Solid and Textured draw modes. Alt-Z

Except for Rendered, these shading modes are not dependent on light sources in the scene.
Instead they use a simple default lighting adjusted by the Solid OpenGL Lights controls on the
System tab of the User Preferences editor.

The viewport shading controls the appearance of all objects in a scene, but this can be
overridden for individual objects using the Display panel in their Object Properties.

3D Space Navigation

Navigating in 3D space is done with the use of both mouse movement and keyboard shortcuts. To
be able to work in the three-dimensional space that Blender uses, you must be able to change your

viewpoint as well as the viewing direction of the scene. While describing 3D View editor, most of
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the other editors have similar functions. For example, it is possible to translate and zoom in the

UV/Image editor.

Orbit
e Mode: All modes

e Menu: View * Navigation » Orbit

e Hotkey: MMB, Numpad2, Numpad4, Numpad6, Numpad8, Ctrl-Alt-Wheel

Rotate the view around the point of interest. Click and drag MMB on the viewport’s area. If
you start in the middle of the area and move up and down or left and right, the view is rotated

around the middle of the area.

To change the viewing angle in discrete steps, use Numpad8 and Numpad2 (which correspond
to vertical MMB dragging, from any viewpoint), or use Numpad4 and Numpad6 (or Ctrl-Alt-
Wheel) to rotate the scene around the global Z axis from your current point of view. Finally,

Numpad9 switches to the opposite side of the view.

Alternatively, if the Emulate 3 button mouse option is select in the User Preferences you can

press and hold Alt while dragging LMB in the viewport’s area.

Roll
e Mode: All modes

e Menu: View » Navigation » Roll

e Hotkey: Shift-Numpad4, Shift-Numpad6, Ctrl-Shift-Wheel

Rotate the viewport camera around its local Z axis in 15° discrete steps.

Panning

e Mode: All modes

e Menu: View » Navigation » Pan

e Hotkey: Shift-MMB, Ctrl-Numpad2, Ctrl-Numpad4, Ctrl-Numpad6, Ctrl-Numpad8
Move the view up, down, left and right. To pan the view, hold down Shift and drag MMB in
the 3D View. For discrete steps, use the hotkeys Ctrl-Numpad8, Ctrl-Numpad2, Ctrl-Numpad4

11



and Ctrl-Numpad6 as with orbiting (note: you can replace Ctrl by Shift). For those without a
middle mouse button, you can hold Shift-Alt while dragging with LMB.

Zooming

e Mode: All modes

e Menu: View » Navigation » Zoom

e Hotkey: Ctrl-MMB, Wheel, Numpad Plus, Numpad Minus

Move the camera forwards and backwards. You can zoom in and out by holding down Ctrl
and dragging MMB. The hotkeys are Numpad Plus and Numpad Minus. The View »
Navigation sub-menu holds these functions too as well. Refer to the 3D View’s View menu
image above for more information. If you have a wheel mouse, you can zoom by rotating the
Wheel.

Zoom Border

e Mode: All modes

e Menu: View » Zoom Border

e Hotkey: Shift-B

The Zoom Border tool allows you to specify a rectangular region and zoom in so that the region
fills the 3D View. You can access this through the View menu, or the shortcut Shift-B, then

LMB click and drag a rectangle to zoom into. Alternatively you can zoom out using the MMB.

12



Dolly Zoom

e Mode: All modes
e Hotkey: Ctrl-Shift-MMB

In most cases its sufficient to zoom the view to get a closer look at something, however, you
may notice that at a certain point you cannot zoom any closer. This is because, Blender stores
a view-point that’s used for orbiting and zooming. It works well in many cases, however
sometimes you want to move the view-point to a different place. This is what Dolly supports,
allowing you to transport the view from one place to another. You can dolly back and forth by
holding down Ctrl-Shift and dragging MMB.

Transform Manipulators

These handy selectors allow you to rotate or move objects by grabbing (clicking with your

mouse) their controls and moving your mouse in the axis.

A7~ Global %

Title-Img 1. 8 Transform Manipulators Attribution-
Source- blender.org

Link-https://docs.blender.org/manual/en/dev/editors/3dview/object/editing/transform/control/manipulators.html

e Mode: Object and Edit Modes

e Menu:

e Hotkey: Ctrl-Spacebar

The Transformation manipulator widgets allow mouse controlled translation, rotation and
scaling in the 3D View. There is a separate manipulator for each operation. Each manipulator

can be used separately or in combination with the others.

13



Translate Rotate

Title-Img 1. 9 The different Manipulators Attribution-
Source- blender.org
Link-

https://docs.blender.org/manual/en/dev/editors/3dview/object/editing/transform/control/manipulators.html

Header Controls

Manipulators can be accessed through the header of the 3D View.

Axis : Enable/disable the manipulators Ctrl-Spacebar.

Manipulators: Toggles each of the manipulators. Clicking with Shift-LMB on multiple
manipulator icons will combine the manipulators.

Arrow: Translation.

Arc: Rotation.

Box: Scale.

Basic Transformations

Grab/Move
e Mode: Object Mode, Edit Mode, and Pose Mode

e Panel: Tool Shelf » Tools » Transform » Translate

e Menu: Object type » Transform » Grab/Move

e Hotkey: G

In Object Mode, the grab/move option lets you translate (move) objects. Translation means

changing location of objects. It also lets you translate any elements that make up the object

14



within the 3D space of the active 3D View. Pressing G activates “Grab/Move” transformation
mode. The selected object or element then moves freely according to the mouse pointer’s

location and camera.

You can also move an object by clicking and holding RMB on the object to move it. To confirm
the action, press LMB.

Rotate

e Mode: Object and Edit Modes

e Panel: Tool Shelf » Tools » Transform » Rotate

e Menu: Object/Mesh/Curve/Surface » Transform » Rotate

e Hotkey: R

Rotation is also known as a spin, twist, orbit, pivot, revolve, or roll and involves changing the
orientation of elements (vertices, edge, face, Object etc.) around one or more axes or the Pivot

Point

Scale

Mode: Object and Edit Modes

Panel: Tool Shelf » Tools » Transform » Scale

Menu: Object/Mesh/Curve/Surface » Transform » Scale

Hotkey: S

Scaling means changing proportions of objects. Pressing S will enter the Scale transformation
mode where the selected element is scaled inward or outward according to the mouse pointer’s
location. The element’s scale will increase as the mouse pointer is moved away from the Pivot
Point and decrease as the pointer is moved towards it. If the mouse pointer crosses from the

original side of the Pivot Point to the opposite side, the scale will continue in the negative
15



direction and flip the element.

Title-Img 1. 10 Basic scale usage
Source- blender.org
Link- https://docs.blender.org/manual/en/dev/editors/3dview/object/editing/transform/basics.html
From left to right, the panels show: the original Object, a scaled down Obiject, a scaled-up

Object and a scale-flipped Object.

Transform Orientations

e Mode: Object and Edit Modes

e Panel: Properties region » Transform Orientations

e Hotkey: Alt-Spacebar

Orientations affect the behaviour of Transformations: Location, Rotation, and Scale. You will
see an effect on 3D Manipulator (the widget in the centre of the selection), as well as on
transformation constraints (like axis locking). This means that, when you press G-X, it will

constrain to the global X-axis, but if you press G-X-X it will constrain to your Transform

Orientations X-axis.

Title-Img 1. 11Transform Orientations selector Attribution-

Source- blender.org
16



Link- https://docs.blender.org/manual/en/dev/editors/3dview/object/editing/transform/control/orientations.html
The Orientations options can be set through the Orientation selector in 3D View header, with
Alt-Spacebar, or in the Transform Orientations panel in the Properties region.

Orientations Global

The manipulator matches the global axis. When using the Global orientation, the orientation’s
XYZ matches world’s XYZ axis. When this mode is selected, the local coordinates of the
object are subjected to the Global coordinates. This is good to place objects in the scene. To
constrain an axis, press G and the desired axis. To constrain to a local axis, press the desired
axis two times. The difference between Global and Local, is more noticeable when you have
an object in which the origin is not located at the exact center of the object, and does not match
the Global coordinates.

Local

The manipulator matches the object axis.

Notice that, here, the Manipulator is at a slight tilt (it is most visible on the object’s Y-axis, the
green arrow). This is due to our 15° rotation of the object. This demonstrates the difference
between local coordinates and global coordinates. If we had rotated the object 90° along its X-
axis, we would see that the object’s “Up” is the world’s “Forward” — or the object’s Z-axis
would now be the world’s Y-axis. This orientation influences many parts of the interface, so it

is important to understand the distinction.

Normal

The Z-axis of the manipulator will match the normal vector of the selection.

In Object Mode, this is equivalent to Local Orientation, in Edit Mode, it becomes more

interesting.

As you see, the light blue lines indicate the faces’ normals, and the darker blue lines indicate
the vertex normals (these were turned on in the N Properties region under Mesh Display »
Normals » Face and Vertex). Selecting any given face will cause our Manipulator’s Z-axis to
align with that normal. The same goes for Vertex Select Mode. Edge Select is different — A
selected Edge has the Z-axis aligned with it (so you will have to look at the Manipulator widget
to determine the direction of X and Y). If you select several elements, it will orient towards

the average of those normals.
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A notable example of how this is useful is in Vertex Select Mode: Pick a vertex and then do
G, Z, Z to tug it away from the mesh and shove it into the mesh. To make this even more
useful, select a nearby vertex and press Shift-R to repeat the same movement — except along

that second vertex’s normal instead.

Gimbal

Uses a Gimbal behaviour that can be changed depending on the current Rotation Mode.

Creating Basic Primitives

Mode: Object Mode and Edit Mode

Panel: Tool Shelf » Create » Add Primitive/Mesh

Menu: Add » Mesh

Hotkey: Shift-A

A common object type used in a 3D scene is a Mesh. Blender comes with several “primitive”
mesh shapes that you can start modelling from. You can also add primitives in Edit Mode at

the 3D cursor. If the created object can be removed by hitting delete key.

Undo Hotkey: Ctrl-Z
Redo Hotkey: Ctrl-Shift-Z

18



Title-Img 1. 12 Blender’s standard primitives Attribution-

Source- blender.org

Link- https://docs.blender.org/manual/en/dev/modeling/meshes/primitives.html

Unit summary

In this Unit, you have learnt what is 3D Interface and how to

e Work effectively and navigate in 3D space within Blender to manage the work flow

e Customize the user interface to limit the tools and option required for the user in
Blender.

e Use Hot keys
e Identify buttons and controls

e Interact with 3D scene using 3D View for a variety of purposes, such as modeling,

animation, texture painting, etc.

e Use the Info Editor at the top, a large 3D View, TimeLine at the bottom, Outliner at the
top right, properties Editor at the bottom right etc.

19



After learning this Unit, you can download the Open Source Software available on the internet

for free of cost to practice the possibilities of creating 3D Interface.

Assignment

Create a Dining Table with a table lamp using the basic primitives.

Assessment

Explain 3D Navigation in Blender

Define Primitives.

Write a brief note on Transform Manipulator.
Describe the types of Viewport Shading.
Write a brief note on Track Panel.

How are the splitting and arranging widgets used?

Fill in the Blanks

1. allows you to change the way objects are displayed in the viewport.
2. tool is used to rotate the view around the point of interest.
3. Pressing expand/collapses the panel under the mouse pointer.
4. In mode, objects appear as a mesh of lines representing the edges of
faces and surfaces.
5. The short cut can be used to grab and move object.
Resources

While studying this Unit, you can browse the internet links for online tutorials and several

books and training DVDs available in theBlender Storeand on theBlender Cloud.

wiki.blender.org
archive.org
www.blender.org

docs.blender.org

20



Unit-2 Introduction to Modeling

Introduction

In this Unit, you will learn about the important Tools, which support the work flow in
Modelling and the many ways of Selecting an Object, Duplicating, Mirroring, etc. Common
use of Mirroring is to model Half an Object, duplicate it and then use the mirror transform to
create a reversed version to complete the model. You will also learn how to organize 3D scenes
by using Layers, as it often becomes exponentially more confusing as they grow more
complex. Sometimes the artist also needs precise control over how individual Objects are lit,

and does not want lights for one Object to affect nearby Objects.

Outcomes

Upon completion of this unit you will be able to:
e Draw with Selection Tools
e Select, duplicate and mirror an Object
e Create Multiple Objects with Mirror and Duplicate
e Edit Pivot Point
e Use Snap Tool

e Organize 3D Scenes using Layers
Terminology

Active Object  In Object Mode, the last (de)selected item is called the “Active Object”

Point selection  Selecting the Object in the viewport with a RMB.

Border select ~ With Border Select, you can draw a rectangle while holding down LMB.

Lasso select Lasso select is used to draw a dotted line around the pivot point of the
Obijects, in Object Mode.

Circle select Circle Select is used to move with dotted circle through Objects with
LMB.

Mirror Mirroring an Object or Mesh selection will create a reversed version of
the selection.

Duplicate This will create a visually-identical copy of the selected Object(s).

Edge Ring In Edge select mode, holding Ctrl-Alt while selecting an edge selects a
sequence of edges that are not connected.

21



Selection
grid
Cursor
Selected
Layers
Cursor

center

to

to

to

Snaps the currently selected Object(s) to the nearest grid point.

Moves the cursor to the centre of the selected Object(s).

Objects can be placed into one or more “layers” using Object layers.

Moves the cursor to the center of the grid.

Work Flow of Modeling

Object Selection Selections and the Active Object Blender distinguishes between

two different states of selection:

Title- Img 2. 1 Unselected Object in black, selected Object in orange, and active Object in yellow.

Source-Blender.org

Link-https://docs.blender.org/manual/en/dev/editors/3dview/object/select ing/introduction.html

e In Object Mode, the last (de)selected item is called the “Active Object” and isoutlined in

yellow (the others are orange). There is exactly one active Object at any time (even when

nothing is selected).

e Many actions in Blender use the active Object as a reference (for example linking

operations). If you already have a selection and need to make a different Object the active

one, simply re-select it with Shift-RMB.

o All other selected Objects are just selected. You can select any number of Objects.

22


https://docs.blender.org/manual/en/dev/editors/3dview/object/selecting/introduction.html
https://docs.blender.org/manual/en/dev/editors/3dview/object/selecting/introduction.html

Point Selection

o The simplest form of Object selection consists of using RMB on it.
o Toadd to the selection, use Shift-RMB on more Objects.

o If the Objects are overlapping in the view, you can use Alt-RMBto cycle through
possible choices.

o If you want to add to a selection this way, then the shortcut becomes Shift-Alt-MB.

o Toactivate an Object that is already selected, click Shift- RMB onit.

o Todeselectan active Object, click Shift-RMB one time and hence, two clicks if the Object
is not active. Note that this only works if there are no other Objects under the mouse.
Otherwise it just adds those to the selection. There appears to be no workaround for this
bug.

Border Selection
e Mode: Object Mode and Edit Mode

e Menu: Select » Border Select

o Hotkey: B

With Border Select you draw a rectangle while holding down LMB. Any Obiject that lies

even partially within this rectangle becomes selected.

o For deselecting Objects, use MMB or Border Select again with holding Shift.

o To cancel the selection use RMB.

Example

Title-Img 2. 2 Border selecting in three steps
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Source-Blender.org

Link-http://blender-manual- i18n.readthedocs.io/ja/latest/modeling/objects/selecting.html

Border Select has been activated in the first image and is indicated by showing a dottedcross-
haircursor. In the second image, the selection region is being chosen by drawing a rectangle
with the LMB. The rectangle is only covering two cubes. Finally, in the third image, the
selection is completed by releasing LMB.

Notice in the third image, the bright color of left-most selected cube. This meansitisthe “Active
Object”, the last selected Object prior to using the Border Selecttool.

Lasso Select

e Mode: Object Mode and Edit Mode
e Menu: no entry in the menu
e Hotkey: Ctrl-LMB

Lasso select is used by drawing a dotted line around the pivot point of the Objects, in
Object Mode.

Circle Select
e Mode: Object Mode and Edit Mode
e Menu: Select » Circle Select

e Hotkey: C

Circle Select is used by moving with dotted circle through Objects with LMB. You can select
any Object by touching of circle area. It is possible to dynamically change the diameter of circle

by scrolling MMB as seen in Img 2.3 and Img 2.4. Deselection is under the same principle -

MMB. To cancel the selection use RMB or key Esc.
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Title- Img 2. 3 Circle selection

Source-Blender.org
Link-https://wiki.blender.org/index.php/Doc%3A2.6/Manual/Modeling/Objects/Selecting

Title-Img 2. 4 with huge circle

Source-Blender.org

Link-https://wiki.blender.org/index.php/Doc%3A2.6/Manual/Modeling/Objects/Selecting

Menu Selection

The selection methods described above are the most common. There are also many

more options accessible through the Select menu of the 3D View.
Select Grouped

e Mode: Object Mode
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e Menu: Select » Grouped

o Hotkey: Shift-G

There are two ways to organize the Objects in relation to one another.

1. Parenting

2. Simple grouping

Select Grouped uses the Active Object as a base to select all others.

Children Shift G
Immediate Children Shift G
Parent Shift G
Siblings Shift G
Type Shift G
Layer Shift G
Group Shift G
Hook Shift G
Pass Shift G
Color Shift G
Properties Shift G
Keying Set Shift G

Lamp Type Shift G

Title-Img 2. 5 Select Grouped menu

Source-wiki.Blender.org

Link-https://wiki.blender.org/index.php/File:25-Manual-Object-Selection-Grouped.png
Mirror Object
e  Mode: Object and Edit Modes

e Menu: Object/Mesh* Mirror

e Hotkey: Ctrl-M



Mirroring an Object or Mesh selection will create a reversed version of the selection. The
position of the mirrored version of the selection is determined by the Pivot Point. A common
use of mirroring is to model halfan Object, duplicate it and then use the mirror transformto

create a reversed version to complete the model.

Title- Img 2. 6 Mirroring a Selection

Source-Blender.org

Link- https://docs.blender.org/manual/en/dev/editors/3dview/object/editing/transform/mirr or.html

Duplicate Object

This will create a visually-identical copy of the selected Object(s). The copy is created at the

same position as the original Object and you are automatically placed in Grab mode.

This copy is a new Object, which shares some data-blocks with the original Object (by default,
all the Materials, Textures, and F-Curves), but which has copied others, like the mesh, for
example. Therefore, this form of duplicationissometimescalled “shallow link”, because notall
data- blocks are shared; some of them are “hard copied™!

. Mode: Edit and Object Modes

. Menu: Object » Duplicate

. Hotkey: Shift-D

This will create a visually-identical copy of the selected Object(s). The copy is created at the
same position as the original Object and you are automatically placed in Grab mode. See the

example below (Img 2.7).
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Examples

Title-Img 2. 7 The MeshCone.006 of Object Cone.002 is being edited.
Source-Blender.org

Link- https://docs.blender.org/manual/en/devieditors/3dview/object/editing/duplica tion.html

The mesh’s unique data-block ID name is highlighted in the Outliner.
The cone in the middle has been

(1)  link duplicated to the left and

(2) duplicated to the right.

The duplicated right cone is being edited; the original cone in the middle remains

unchanged. The Mesh data has been copied not linked.

Likewise, if the right cone is edited in Object mode, the original cone remains unchanged. The
new Objects transform properties or data-block is a copy, not linked.

When the right cone was duplicated, it inherited the material of the middle cone. The material

properties were linked, not copied.

Snapping

e Mode: Object and Edit Mode
o Hotkey: Shift-S

Transform Snapping

Title-Img 2. 8 Magnet icon in the 3D View header (red when enabled)

Source-Blender.org
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Link- https://docs.blender.org/manual/en/dev/editors/3dview/object/editing/transform/cont rol/snap.html

The ability to snap Objects and Mesh element to various types of scene elements during
a transformation is available by toggling the magnet icon (which will turn red) in the 3D

View’s header buttons.

Snap Element

Snap Elerment
® Volume
N Face
" Edge

Vertex

B Increment

Title-Img 2. 9 Snap Element menu

Source-Blender.org

Link- https://docs.blender.org/manual/en/dev/editors/3dview/object/editing/transform/cont rol/snap.html
Volume

Snaps to regions within the volume of the first Object found below the mouse cursor. Unlike
the other options, this one controls the depth (i.e. Z-coordinates in current view space) of the
transformed element. By toggling the button that appears to the right of the snap target menu
(Refer Img 2.10), target Objects will be considered as whole, when determining the volume

center.

Face

Snap to the surfaces of faces in Mesh Obijects. It is useful for retopologizing the surface of the

geometry.

Edge

Snap to edges of Mesh Objects.

Vertex

Snap to vertices of Mesh Objects.
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Increment
Snap togrid points. When in Orthographic view, the snapping increment changes dependingon

zoom level.

lcon Details

@ Align rotation with the snapping target.

Project individual elements on the surface
of other objects.

Snaps elements to its own mesh.

Consider Objects as whole when finding
volume center.

’Llf’_':ﬁ Snap to grid, instead of snapping in
T increments relative to the current location.

Title-Img 2. 10 Various Snap Option

Source-Blender.org

Link- https://docs.blender.org/manual/en/dev/editors/3dview/object/editing/transform/cont rol/snap.html

Pivot Points
Origin of the 3D model, which is therefore not the physical center of gravity of the Object, but
rather the pivot point that will identify the location coordinates of the Object in 3D space, and
in toward which operations (such as rotation and scaling of the entire Object) will be carried
out, in Object Mode.

e Mode: Object Mode and Edit Mode

e Menu: Drop list in the header of the 3D View
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® Active Element

'a Median Point

G@ Individual Origins
< 3D Cursor
Cj Bounding Box Center

»j:i Global v q%%l

Title-Img 2. 11 Pivot Point modes
3D Cursor

e Mode: Object Mode and Edit Mode

e Menu: Select from the icon in the 3D View header.

e Hotkey: .
The 3D cursor is the most intuitive of the pivot points. With the 3D cursor selected as the
active pivot point (from either the Editors Header or via.), simply position the 3D cursor and
then do the required transformation. All rotation and scaling transformations will now be done

relative to the location of the 3D cursor. The image below shows the difference when rotating an
Object around the median point (left) and around the 3D cursor (right).

Title- Img 2. 12 Rotation around the 3D cursor compared to the median point.
Attribution- Source-Blender.org
Linkhttps://docs.blender.org/manual/en/dev/editors/3dview/object/editing/transform/control/
pivot_point/3d_cursor.html
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Individual Origins
e Mode: Object Mode and Edit Mode

e Menu: Select from the pivot-icon icon in the 3D View header.

e Hotkey: Ctrl-.
In Object Mode

Title-Img 2. 13 Rotation around individual origins.

Source-Blender.org

Link-
https://docs.blender.org/manual/en/dev/editors/3dview/object/editing/transform/control/pivot_point/individual_origins.html?highli
ght=rotation%?20around%20individual%20 origins

The OriginofanObjectisshowninthe 3D View by asmallorangecircle. This is highlighted in
the image to the right by the red arrow. The origin tells Blender the relative position of that
Object in 3D space. What you see in the 3D View (vertices, edges etc.) is what makes up the
Object.

While the Origin is equivalent to the center of the Object, it does not have to be located in the
center of the Mesh. This means that an Object can have its center located on one end of the
Mesh or even completely outside the mesh. For example, the orange rectangle in the image has
its Origin located on the far left of the mesh.

Now let us examine: Rotation around the individual origins:

e The blue rectangle has its Origin located in the center of the mesh, while the orange
rectangle has its Origin located on the left-hand side.

« When the Pivot Point is set to Individual Origins, the center of each Object (indicated by
the red arrow) remains in place while the Object rotates around it in the path shown by the

black arrow.
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Title-Img 2. 14 Rotation around individual origins (middle) compared to the median point
(right)

Source-Blender.org
Link-

https://docs.blender.org/manual/en/dev/editors/3dview/object/editing/transform/control/pivot_point/individual_origins.html

Title-Img 2. 15 Scaling around individual origins (middle) compared to the
median point (right).
Source-Blender.org

Link- https://docs.blender.org/manual/en/dev/editors/3dview/object/editing/transform/control/pivot_point/individual origins.html

Working with Layers

3D scenes often become exponentially more confusing as they grow more complex.
Sometimes the artist also needs precise control over how individual Objects are lit, and does
not want lights for one Object to affect nearby Objects. For this and other reasons below,
Obijects can be placed into one or more “layers”. Using Object layers, you can:

Selectively display Objects from certain layers in your 3D View, by selecting those layers in
the 3D View header. This allows you to speed up interface redrawing, reduce virtual-world
clutter, and help improve your workflow.

Mode: Object Mode
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e Panel: Object » Relations
e Menu: Object » Move to Layer...
e Hotkey: M

Viewing layers

Blender provides twenty layers whose visibility can be toggled with the small unlabelled buttons
in the header (Refer Img 2.16, 3D View layer buttons). To select a single layer, click the
appropriate button with LMB; to select more than one, use Shift-LMB - doing this on an already

active layer will deselect it.

- soo ] 5 = = it o
_®% = ®obectiode 1| @4 % N ‘(anuns snnns|®: @) &+ B FE)

Title-Img 2. 16 3D View layer buttons.

Source-Blender.org

Link- https://docs.blender.org/manual/en/dev/editors/3dview/object/properties/rela tions/layers.html

To select layers via the keyboard,

e Step 1: press 1to 0 (on the main area of the keyboard) for layers 1 through 10 (the top row

of buttons), and

o Step 2: Alt-1to Alt-0 for layers 11 through 20 (the bottom row). Use Shift for multiple
(de)selection works for these shortcuts too.

You can select or deselect all Scene Layer buttons at once by pressing \.
Locking to thescene

By default, the lock button directly to the right of the layer buttons is enabled. This means that

changes to the viewed layers affect all other 3D Views locked to the scene
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Multiple Layers

An Object can exist on multiple layers. For example, a lamp that only lights Objects on a
shared layer could “be” on layers 1, 2, and 3. An Object on layers 3and 4 would be lit, whereas
an Object on layers 4 and 5 would not. There are many places where layer-specific effects

come into play, especially lights and particles.

Moving Objects between layers

Title-Img 2. 17 Layer selection. Source-Blender.org

Link- https://docs.blender.org/manual/en/dev/editors/3dview/object/properties/relations/la yers.html

To move selected Objects to a different layer, press M and then select the layer you want from
the pop-up menu. Objects can also be on more than one layer at a time. To have an Object

on multiple layers, hold Shift while clicking.

Title-Img 2. 18 Selection in the Object tab Source-Blender.org

Link- https://docs.blender.org/manual/en/dev/editors/3dview/object/properties/relations/la yers.html

Another way to view or change a selected Object layer isvia the Relations panel, in the Object

tab.

Title-Img 2. 19 Layersin Object tab, Relations panel. Source-Blender.org

Link- https://docs.blender.org/manual/en/dev/editors/3dview/object/properties/relations/la yers.html

You will then see the layer buttons in the Relations panel — as before — the Object can be

displayed on more than one layer by clicking Shift- LMB.
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Objects in Blender

The geometry of a scene is constructed from one or more Objects. These Objects can range
from lamps to light your scene, basic 2D and 3D shapes to fill it with models, armatures to

animate those models, to cameras to take pictures or video of it all.

Object Types

Mesh

Meshes are Objects composed of Polygonal Faces, Edges and/or Vertices, and can be edited

extensively with Blender’s Mesh editing tools.

Curve

Curves are mathematically defined Objects which can be manipulated with control handles or

control points (instead of vertices), to manage their length and curvature.

Surface

Surfaces are patches that are also manipulated with control points. These are useful for simple

rounded forms and organic landscapes.

Metaball

Meta Objects (or Metaballs) are Objects formed by a mathematical function (with no control
points or vertices) defining the 3D volume in which the Object exists. Metal Objects have a
liquid-like quality, where when two or more Metaballs are brought together, they merge by

smoothly rounding out the connection, appearing as one unified Object.

Text

Text Objects create a two-dimensional representation of a string of characters.

Armature

Armatures are used for rigging 3D models in order to make them poseable and animateable.

Lattice

Lattices are non-renderable wireframes, commonly used for taking additional control over
other Objects with help of the Lattice Modifier.

Empty
Emptiesarenull Objectsthatare simple visual transform nodes thatdonotrender. Theyareuseful
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forcontrollingtheposition or movement of other Objects.

Speaker

Speaker brings to scene source of sound.

Camera

This is the virtual camera that is used to determine what appears in the render.

Lamp

These are used to place light sources in the scene.

Force Field

Force Fields are used in physical simulations. They give simulations external forces, creating

movement, and are represented in the 3D View editor as small control Objects.
Group Instance

Let’s you select from a list of existing Object groups. Once selected, an Empty Object will be

created, with an instance of the selected group (group duplication active).

Objects

The geometry of a scene is constructed from one or more Objects. These Objects can range
from lamps to light your scene, basic 2D and 3D shapes to fill it with models, armatures to

animate those models, to cameras to take pictures or video of it all.

Unit Summary

In this Unit, you have learnt how to
e Work with 3D modelling using various options

e Channelize your work flow that helps you to bring down the complexities of the

software.
e Create basic Objects, selection, duplication and mirroring Objects
e Load the Objects to layers to ensure an organised way of handling complex scenes.
e Create Object with the knowledge of the pivot

e Manipulate the pivot using various options to develop more complicated duplication of
Objects.

e Arrange the Object precisely using one of the most important features of the software
“snap” which gives us more flexibility.
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After learning this Unit, you can download the Open Source Software available on the internet

for free of cost to practice the possibilities of creating 3D Objects

Assignment

e Create “House model” with proper interiors using the basic primitives looking at

the given image.

No need to add colors to the model. (you can do it after learning the texturing unit)The total

length of the video should be 2-5 minutes.
Assessment

1. Explain the various Selection Modes in Blender.
2.  Describe the Method of Duplication and Mirror.
3. Describe the Uses of Layers.

4. Why do we need Snap Tool, explain?

5. Write a brief note on the Object Types in Blender.

6. Explain any three types of Snap Options.
Fill in the Blanks
1. In Object Mode, the last (de)selected item is called the .
2. The simplest form of Object Selection consists of using on it.

3. The icon is used to Snap Objects and Mesh element to several types of scene

elements.
4. will identify the location coordinates of the Object in 3D space.

5. Circle Select is used by moving with dotted circle through Objects with

Resources
While studying this Unit, you can browse the internet links for tutorials and several books and
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Unit-3 Inorganic Modeling

Introduction

Curves and Surfaces are very important for Modeling.

Curves and Surfaces are types of Blender Objects. They are expressed by mathematical
functions rather than a series of points. Using the specific features of both Bezierand NURBs
curves, you will create a model in 3D, and explore how they are computed behind the scenes

than how they appear from a modeler’s perspective.

Bezier curves are generally more intuitive because they start and end at the control points that
you set, but NURBs curves are more efficient for the computer to calculate when there are

many twists and turns in a curve.

Curves are 2D objects, and Surfaces are their 3D extension. Note however, that in Blender,
you only have NURBS Surfaces, no Bezier. Even though curves and Surfaces share the same
object type, they are not the same thing; For example, you cannot have in the same object both

curves and Surfaces.

In this Unit, you will learn the usage of Curves and Surfaces for modeling.
Outcomes

Upon completion of this unit you will be able to:

e Create and work with Curves.

e Edit the Curves using different Modes.

e Working Surface modeling.

e Create Objects using Curves and

e Prepare Curve Deformation and Curve Extrusion

Terminology

Bezier Curve: Adds an open 2D Bezier curve with two control points.

Bezier Circle: Adds a closed, circle-shaped 2D Bezier curve (made of four control
points).

NURBS Curve: It adds an open 2D NURBS curve, with four controls.
NURBS Circle: It adds a closed, circle-shaped 2D NURBS curve (made of eight control
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points).

Path: It adds a NURBS open 3D curve made of five aligned control points, with Endpoint
knots and the Curve Path setting enabled.

NURBS: Non-Uniform Rational B-Splines.
Extrude: Will extrude the curve along both the positive and negative local Z axes.
Bevel Depth: Changes the size of the bevel.

Subdividing: Curve subdivision simply subdivides all selected segments by adding one or
more control points between the selected segments.

Duplication: This command duplicates the selected control points, along with the curve
segments implicitly selected (if any).

Separating Curves: Curve objects that are made of multiple distinct, curves can be separated
into their own objects by selecting the desired segments.

Fill: Fill determines the way a Curve is displayed when it is bevelled.

Introduction to Curves and Surfaces Curves

Bézier Curves

The main elements used in editing Bezier Curves are the Control Points and Handles.

Control Points

A Segment (the actual Curve) is found between two Control Points.

In the image below (Img 3.1), the Control Points can be found in the middleofthepinkline

while the Handles comprise the extensionsfrom the Control Point.

By default, the arrows on the Segment represent the direction and relative speed and direction
of movement Objects will have when moving along the curve. This can be altered by defining

a custom F- Curve.

Segment
Handle

—

Control Point

Handle
Title-Img 3. 1 Bezier Curve in Edit Mode.

Source-Blender.org

Link-http://blender-manual- i18n.readthedocs.io/ja/latest/modeling/curves/introduction.html?highlight=Bezier%20C
urve%20in%20Edit%20Mode.
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Editing Bézier Curves

A Bézier curve can be edited by moving the locations of the Control Points and Handles:

e Step 1: Add a Curve by Shift-A to bring up the Add menu, followed by
Curve » Beziers.

e  Step 2:Press Tab to enter Edit Mode.
e  Step 3: Select one of the Control Points and move it around. Use LMB to confirm the

new location of the Control Point, or use RMB to cancel.

o Step 4: Now select one of the Handles and move it around. Notice how this change the

curvature of the curve.

To add more Control Points:

o Step 1: Select at least two adjacent Control Points.

o Step 2: Press Wand select Subdivide.

Optionally, you can press F6 immediately after the subdivision to modify the number

of subdivisions

Handles

There are Four Bézier Curve Handle types. They can be accessed by pressing V and selecting
from the list that appears, or by pressing the appropriate hotkey combination. Handles can be
rotated, moved, scaled and shrunk/fattened like any vertex in a Mesh.

Bézier Curve Handle Types

1. AutomaticV-A

This handle has a completely automatic length and direction which is set by Blender to ensure

the smoothest result. These handles convert to Aligned handles when moved.

Title-Img 3. 2 Bezier handle type.

Source-
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Link-http://blender-manual- i18n.readthedocs.io/ja/latest/madeling/curves/introduction.html?highlight=Bezier%20C
urve%20in%20Edit%20Mode.

2. Vector V-V
Both parts of a handle always point to the previous handle or the next handle which allows you
to create curves or sections thereof made of straight lines or with sharp corners. Vector handles

convert to free handles when moved.

Title-Img 3. 3 Bezier handle type.

Source-Blender.org

Link-http://blender-manual- i18n.readthedocs.io/ja/latest/modeling/curves/introduction.html?highlight=Bezier%20C
urve%20in%20Edit%20Mode.

3. Aligned V-L

These handles always lie in a straight line, and give a continuous curve without sharp angles.

Source-Blender.org

Link-http://blender-manual- i18n.readthedocs.io/ja/latest/modeling/curves/introduction.html?highlight=Bezier%20C
urve%20in%20Edit%20Mode.

4, FreeV-F

The handles are independent of each other.

Title-Img 3. 5 Bezier handle type.

Source-Blender.org

Link-http://blender-manual- i18n.readthedocs.io/ja/latest/madeling/curves/introduction.html?highlight=Bezier%20C
urve%20in%20Edit%20Mode.
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Additionally, the V-T shortcut can be used to toggle between Free and Aligned handle
types.

NURBS Curves

One of the major differences between Bézier Objects and NURBS Obijects is that Bézier

Curves are approximations.

For example, a Bézier circle approximates a circle, whereas a NURBS circle is an exact
circle.In practice, many of the Bezier curve operations discussed above apply to NURBS
curves in the same manner. The following text will concentrate only on those aspects that are

unique to NURBS curves.

Editing NURBS Curve

A NURBS Curve is edited by moving the location of the Control Points:
o Step1:Place aCurve by Shift-Ato bring up the Add menu, followed by
Curve » NURBS curve.
e Step 2:Press Tab to enter Edit Mode.
o Step 3: Select one of the Control Points and move it around. Use LMB to confirm the

new location of the Control Point, or use RMB to cancel.

To add additional Control Points

o Step 1: select both the Control Points

e Step 2: press Wand

o Step 3: selectSubdivide.

o Step 4: Press F6 immediately after to determine how many subdivisions to make.

Transform Tools

Deforming Tool
o Mode: Edit Mode

¢ Menu: Curve » Transform

The Shear, Warp and Push/Pull transform tools are described in the Transformations sections.

The two other tools, Tilt and Shrink/Fatten Radiusare related to Curve Extrusion.
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Smoothing Tool

e Mode: Edit Mode
e Hotkey: W » smooth

Curve smoothing is available through the specials menu. For Bézier curves, this smoothing
operation reduces the distance between the selected control point/s and their neighbors, while

keeping the neighbors anchored. Does not affect control point tangents.

Mirror Tool

e Mode: Edit Mode

e Menu: Curve » Mirror

e Hotkey: Ctrl-M

The Mirror tool is also available, behaving exactly as with Mesh vertices. Set Bézier
Handle Type

* Mode: Edit Mode

= Panel: Curve Tools » Handles

= Menu: Curve » Control Points » Set Handle Type

= Hotkey: V

Handle types are a property of Bézier curves that can be used to alter features of the curve.
For example, switching to Vector handles can be used to create curves with sharp corners.
Read the Bézier curves page for more details.
Extending Curves

= Mode: Edit Mode

= Menu: Curve » Extrude

= Hotkey: Ctrl-LMB, E

Once a curve is created you can add new segments (in fact, new control points defining new
segments), either by extruding, or placing new handles with Ctrl-LMB. Each new segment is
added to one end of the curve. The Bézier curve can only be extend at the endpoints. Ctrl-
LMB on inner control points will make unconnected duplicates.
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Subdivision

e Mode: Edit Mode

e Panel: Curve Tools

e Menu: Surface tools » Modeling *» Subdivide

e Hotkey: W
Curve subdivision simply subdivides all selected segments by adding one or more control
points between the selected segments. To control the number of cuts, press W to make a
single subdivision. Then press F6 to bring up the Number of Cuts menu.
Duplication

e Mode: Edit Mode

e Menu: Curve » Duplicate

e Hotkey: Shift-D
This command duplicates the selected control points, along with the curve segments implicitly
selected (if any). The copy is selected and placed in Grab mode, so you can move it to another

place.
Joining Curve Segments
e Mode: Edit Mode
e Menu: Curve » Make Segment
e Hotkey: F
Two open curves can be combined into one by creating a segment between the two curves.

To join two separated curves, select one end control point from each curve then press F. The

two curves are joined by a segment to become a single curve.
Separating Curves

e Mode: Edit Mode

e Menu: Curve » Separate

e Hotkey: P

Curve objects that are made of multiple distinct curves can be separated into their own objects
by selecting the desired segments and pressing P. Note, if there is only one curve in a Curve

object, pressing P will create a new Curve object with no control points.
Deleting Elements
e Mode: Edit Mode

e Menu: Curve » Delete...
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e Hotkey: X, Delete

e Selected: This will delete the selected control points, without breaking the curve (i.e.
the adjacent points will be directly linked, joined, once the intermediary ones are
deleted).

e Segment: This option is somewhat the opposite to the preceding one, as it will cut the

curve, without removing any control points, by erasing one selected segment.

Opening and Closing a Curve

e Mode: Edit Mode

e Menu: Curve » Toggle Cyclic

e Hotkey: Alt-C
This toggles between an open curve and closed curve (Cyclic). Only curves with at least one
selected control point will be closed/open. The shape of the closing segment is based on the
start and end handles for Bézier curves, and as usual on adjacent control points for NURBS.
The only time a handle is adjusted after closing is if the handle is an Auto one. Open and

Closed curves is the same Bézier curve open and closed.

Curve Extrution

e Mode: Object or Edit Mode

e Panel: Curve and Surface

e Extrude
Turns a one-dimensional curve into a two-dimensional curve by giving it height. Note that
this is not related to Extrude used in Mesh edit-mode. With a scale of one, an Extrusion of 0.5

will extrude the curve 0.5 BU in both directions, perpendicular to the curves normals.

"

Bézier Circle 0.0 extrude Extruded by 0.5 (Object

(Edit Mode). Mode).
Title-Img 3. 6 Curve Extrution
Attribution- Source-Blender.org
Link-https://easyblend.org/html/modeling/curves/editing/extrude.html
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Tilt This setting controls how the normals (visualization: arrows) twist around each control
point — so it is only relevant with 3D curves! You set it using the Tilt transform tool in the T
tool shelf, the N » transform » Mean tilt, or Curve » Transform » Tilt.

You can also reset it to its default value (i.e. perpendicular to the original curve plane) with
Alt-T, Curve » Control Points » Clear Tilt.

With NURBS, the tilt is always smoothly interpolated. However, with Bézier, you can
choose the interpolation algorithm between Linear, Ease, B-Spline, and Cardinal, in the

Properties Editor » Object Data » Active Spline » Tilt

Title-Img 3. 2 30-degree Mean Tilt of all control points.

Source-Blender.org

Link-https://easyblend.org/html/modeling/curves/editing/extrude.html

Bevel Depth

This will add a bevel to the Extrusion. Refer Img 3.8 for its effects... Note that the bevel makes

the Extrusion wider and higher. If set to 0.0, there is no bevel.

Title-Img 3. 3Bevel depth of 0.25, fill set to full, zero Mean Tilt.

Source-Blender.org
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Bevel Resolution

It controls the resolution of the bevel created by a Bevel Depth higher thanzero. IfsetthetoO
(thedefault), thebevelisasimple‘“flat” Surface. Higher values will smooth, round off the bevel,

similar to the resolution settings of the curve itself.

Title-Img 3. 4 Bevel resolution set to 10.

Source-Blender.org

Link-https://easyblend.org/html/modeling/curves/editing/extrude.html

Offset

Offset Moves the Extrusion parallel to the curve normal. Almost like scaling

-10ffset, 0.5 Extrusion, 0.25 Bevel Depth,
10 Bevelresolutions

Radius

The Radius allows you to directly control the width of the Extrusion along the “spinal”

curve. The Radius of the points is set using the Shrink/Fatten Radius transform tool Alt-

S, the Curve » Transform »

Shrink/Fatten Radius, or the N » transform » Radius.
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N

Title-Img 3. 5 One control point radius set to zero

Source-Blender.org

Link-https://easyblend.org/html/modeling/curves/editing/extrude.html

Three Sub-Classes of Curve:

We have three sub-classes of results, depending on whether the curve is open or closed or
3D.

Open 2D Curve

The Extrusion will create a “wall” or “ribbon” following the curve shape. If using a Bevel
Depth, the wall becomes a sort of slide or gutter. If your normals are facing the wrong way

you can switch their direction as shown here.

Title-Img 3. 6 Open 2D Curve with Alt-C, fill set to none, zero offset, 0.5 Extrusion, 0.25 Bevel

Depth, 10 Bevel resolution.

Source-Blender.org

Link-https://docs.blender.org/manual/en/dev/imodeling/curves/properties/geometry.html
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Closed 2D Curve

This is probably the most useful situation, as it will quickly create a volume, with (by default)
two flat and parallel Surfaces filling the two sides of the extruded “wall”. You can remove one

or both faces by choosing the fill mode: both, front, back, or none.

The optional bevel depth will always create a 90 degree bevels here.

Title-Img 3. 7 Closed 2D Curve, 0.5 extrude, 0.25 Bevel Depth, 10 Bevel resolution, Fill: Both.

Source-Blender.org

Link-https://docs.blender.org/manual/en/devimodeling/curves/properties/geometry.html

Advanced Extrution

These Extrusions use one or two additional curve objects, to create very complex organic

shapes.

To enable this type of Extrusion, you must type a valid curve object name in the Bevel Object
field of the curve you are going to use as the “spinal column” of your Extrusion. The “bevel”
curve will control the cross section of the extruded object. Whether the Bevel Object curve is
2Dor3Dhasnoimportance, butifitisclosed, itwill createa“tube-like” Extrusion; otherwise you
will get a sort of gutter or slide object...

The object is extruded along the entire length of all internal curves. By default, the width of the
Extrusionisconstant, but you have two ways to control it,

1. Radius property of control points

2. Taper Object.
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Taper Curve

Taper Curve is evaluated along the local X axis, using the local Y axis for width control. Note

also that:
It must be an open curve.
The taper is applied independently to all curves of the extruded object.

Only the first curve in a Taper Object is evaluated, even if you have several separated

segments.

The scaling starts at the first control-point on the left and moves along the curve to the last
control-point on the right.

Negative scaling, (negative local Y on the Taper Curve) is possible as well. However,

rendering artifacts may appear.
It might need to increase the curve resolution to see more detail of the taper.

With closed curves, the Taper Curve in Taper Object acts along the whole curve (perimeter of
the object), not just the length of the object, and varies the Extrusion depth. In these cases, you
want the relative height of the Taper Object Taper Curve at both ends to be the same, so that
the cyclic point (the place where the endpoint of the curve connects to the beginning) is a

smooth transition.

Let us taper a simple curve circle extruded object using a Taper Curve.
e Step 1: Add acurve,
e Step 2: Then exit Edit Mode.
e Step 3: Add another one (a closed one, like a circle);
e Step4: Callit“Bevel Curve”,
e Step 5: Enter its name in the Bevel Object field of the first curve (Curve and Surface
tab). We now have a pipe.
e Step6: Add athird curve while in Object Mode and
e Step 7: Call it “Taper Curve”.
e Step 8: Adjust the left control-point by raising it up about 5 units.
e Step 9: Now return tothe Object tab,
e Step 10: Edit the first curve’s Taper Object field in the Curve and Surface panel to

reference the new Taper Curve which we called “Taper Curve”.

When you hit enter the Taper Curve is applied immediately, with the results shown in Img

3.13 Circle curve set as Bevel Object.
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Title-Img 3. 8Taper curve

Circle curve set as Bevel Taper extruded curve.
Object.

Source-Blender.org

Link-https://docs.blender.org/manual/en/dev/modeling/curves/properties/geometry.html

You can see the Taper Curve being applied to the extruded object. Notice how the pipe’s
volume shrinks to nothing as the Taper Curve goes from left to right. If the Taper Curve went
below the local Y axis the pipe’s inside would become the outside, which would lead to

rendering artifacts. Of course, as an artist, that may be what you are looking for!

Taper Examples

Title-Img 3. 9Taper example 1.

Source-Blender.org

Link- https://docs.blender.org/manual/en/dev/modeling/curves/properties/geometry.html

In Taper example 1 (Img 3.14), You can clearly see the effect the left Taper Curve has on the
right curve object. Here the left Taper Curve is closer to the object center and that results in a

smaller curve object to the right.
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Title-Img 3. 10Taper example 2.

Source-Blender.org

Link- https://docs.blender.org/manual/en/dev/modeling/curves/properties/geometry.html

In Taper example 2 (Img 3.15), A control point in the Taper Curve to the left is moved away
from the center and that gives a wider result to the curve object on the right.

Title-Img 3. 11 Taper example 3.

Source-Blender.org Link-

https://docs.blender.org/manual/en/dev/modeling/curves/properties/geometry.html

In Taper example 3 (Img 3.16), We see the use of a more irregular Taper Curve applied to a
curve circle.

Title-Img 3. 12 Bevel Extrusion with Tilt example.
Source-Blender.org
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Surfaces

Surface Editing

Curves are 2D objects, and Surfaces are their 3D extension. Note however, that in Blender,
you only have NURBS Surfaces, no Bezier (you have the Bezier knot type, though; see below),
nor polygonal (but for these, you have Meshes!). Even though curves and Surfaces share the
same object type (with texts also...), they are not the same thing; for example, you cannot have

in the same object both curves and Surfaces.

Title-Img 3. 13Nurbs Surface in edit mode

Source-Blender.org

Link-https://docs.blender.org/manual/en/devimodeling/surfaces/introduction.html

Nurbs Surface in Edit Mode

You may ask yourself “The Surface appears to be 3D, why is it only 2D?”” In order to be 3D,
the object needs to have “VVolume”, and a Surface, even when it is closed, does not have volume;
it is infinitely thin. If it had a volume the Surface would have a thickness (its third dimension).
Hence, it is only a 2D object, and has only two interpolation dimensions or axes or coordinates
(if you know a bit of math, think of non-euclidean geometry — well, Surfaces are just non-

euclidean 2D planes...).
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Primitives

To get started in creating Surfaces, there are four preset NURBS Surfaces, found in the Add

» Surface as

1. NURBS Surface
2. NURBS Tube
3. NURBS Sphere

4. NURBS Torus

Title-Img 3. 14 NURBSSurface primitives.
Source-Blender.org

Link- https://docs.blender.org/manual/en/dev/modeling/surfaces/primitives.html#comm_on-options

Properties

Title-Img 3. 15 Surface Properties.

Source-Blender.org

Link-https://docs.blender.org/manual/en/dev/imodeling/surfaces/properties.html
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Shape

A Preview U: 3 v Preview V: N
“ Render U: 0+ )|« Renderv: ok

Title-1mg 3. 16 Shape panel.

Source-Blender.org

Link-https://docs.blender.org/manual/en/dev/modeling/surfaces/properties.html

You can adjust the resolution separately for both preview and render, to not slow things
down in the viewport, but still get good render results.

Preview

U, Vv

Render

u Vv

Bezier Endpoint

Just like with NURBS curves, NURBS Surfaces have two knot vectors, one for each U and V axis.
Here again, they can be one of Cyclic, Endpoint, or Bezier, with the same properties as for

curves. And as with curves, only Open Surfaces (in the relevant direction) are affected by this
setting.

Title-Img 3. 17Endpoint U.

Source-Blender.org

Link-https://docs.blender.org/manual/en/dev/modeling/surfaces/properties.html
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In Img 3.22 Endpoint U, the U interpolation axisislabeledas “U” and the V interpolation axis is
labeled as “V”. The U’s interpolation axis has been set to Endpoint and as such the Surface now

extends to the outeredges from E1 to E2 along the U interpolation axis.

Adding or Extruding
. Mode: Edit Mode
. Menu: Surface » Extrude

. Hotkey: E, Ctrl-LMB

Unlike Meshes or curves, you cannot generally directly add new control points to a Surface
(with Ctrl-LMB clicks), as you can only extend a Surface by adding a whole U- or V-row at
once. The only exception is when working on a NURBS Surface curve, i.e. a Surface with only

one control point on each U- or V-row. In this special case, all works exactly as with curves.

Most of the time, only Extrusion is available. As usual, once the tool is activated the Extrusion
happens immediately and you are placed into Grab mode, ready to drag the new extruded

Surface to its destination.

There are two things very important to understand:

Surfaces are 2D objects. So, you cannot extrude anything inside a Surface (e.g. “inner” row); it

wouldnotmakeanysense!

Thecontrol “grid” must remain “squarish”, which means that youcanonlyextrudeawhole row,not

partsofrowshereand there.

To summarize, the Extrude tool will only work, when only one whole border row is selected,

otherwise nothing happens.
Examples

Selecting control-point to show a typical Extrusion along the side of a Surface.

In Img 3.23, Selecting control-point and Shift-R, a border row of control points was
highlighted by selecting a single control point, and then using the handy row select tool Shift-
R to select the rest of the control points.
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Title-Img 3. 18 Selecting control point
Source-Blender.org

Link-https:/docs.blender.org/manual/en/devimodeling/surfaces/editing.html

The edge is then extruded using E as shown in Img 3.24 Extruding. Notice how the Mesh has
bunched up next to the highlighted edge. That is because the new extruded Surface section is
bunched up there as well.

Title-1mg 3. 19 Extruding

Source-Blender.org

Link-https://docs.blender.org/manual/en/dev/imodeling/surfaces/editing.html

By moving the new section away from the area, the Surface begins to “un-bunch”.

You can continue this process of extruding or adding new Surface sections until you have
reached the final shape for your model.
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Deleting Elements
e Mode: Edit Mode

e Menu: Curve » Delete...

o Hotkey: X, Delete

The Erase pop-up menu of Surfaces offers an option:

e Selected

This will delete the selected rows, without breaking the Surface (i.e. the adjacent rows will be
directly linked, joined, once the intermediary ones are deleted). The selection must abide by

the following rules:

Whole rows, and only whole rows must be selected. Only rows along the same axis must be

selected (i.e. you cannot delete both U- and VV-rows at the same time).

Example

Title-Img 3. 20 Before and After

Source- Blender.org

Link-https://docs.blender.org/manual/en/dev/imodeling/surfaces/editing.html

In Img 3. 21 Before and after (left) a row of control points has been selected by initially selecting
the one control point and using Shift-R to select the remaining control points. Then, using the

Delete Menu X, the selected row of control points is erased, resulting in Img 3. 22 Before and after
(right).
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Joining or Merging Surfaces
e Mode: Edit Mode
e Menu: Surface » Make Segment

e Hotkey: F

This command is equivalent to creating edges or Faces for Meshes (hence its shortcut), and so
it only works in Edit Mode. The selection must contain only border rows of the same
resolution (with the same number of control points), else Blender will try to do its best to guess
what to merge with, or the merge will fail (either silently, or stating that Resolution does not
match if rows with different number of points are selected, or that there are too few selections

to merge if you only selected points in one Surface).

Examples

Title-1mg 3. 23 Before and After

Joining ready. Joining complete.

Source-Blender.org

Link-https://docs.blender.org/manual/en/dev/imodeling/surfaces/editing.html
Unit summary

In this Unit, you have learnt what is 3D Interface and how to
e Create Objects and work with Curves and Surfaces in Blender
e Edit the Curves and Surfaces using different Modes in Blender
e Work with Surface modelling
e Work with Nurbs modelling
o Work effectively with 2D shapes

e Prepare Curve Deformation and Curve Extrusion

After learning this Unit, you can download the Open Source Software available on the

internet for free of cost to practice the possibilities of creating 3D Interface.

Assignment
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o CreateaFlower Vase, a Wine Glassand a Cup using Nurbs curves
Assessment
e Explain Nurbs Modelling.

e Write a brief note on the Editing methods in Curve.

e Explain Bezier handle types.

e Describe the properties of 2D and 3D shapes. Write a brief note on Extending curves
Explain the types of Curve Extrusion

Fill in the Blanks

1. are the most commonly used curves for designing letters or logos.

2. turns a one-dimensional curve into a two-dimensional curve by giving it
height.

3. moves the Extrusion parallel to the curve normal.

4. allows you to directly control the width of the Extrusion along the

“spinal” curve.

5. handle has a completely automatic length and direction which is set by

Blender to ensure the smoothest result.

Resources

While studying this Unit, you can browse the internet links for online tutorials and several

books and training DVDs available in the Blender Store and on the Blender Cloud.

e wiki.blender.org

e archive.org

e www.blender.org

e docs.blender.org
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Unit 4 Organic Modeling

Introduction

In this Unit, you will learn the creation of a 3D scene and the usage of three key

components to create the real-time geometry Modelling in Blender.

You will also learn to use the specific features of your chosen 3D software, each one of these
Primitives can be manipulated to produce an Object. You will create a model in 3D, and

explore the various modelling methods used in the production.

There are three basic methods that will be used to create a 3D model, and you will understand

how to create amodel using each technique.

Outcomes

Upon completion of this unit you will be able to:
e Create Object with 3D Primitives
e Edit the Object with different Modes
e Mesh Modelling
e Create Polygon Objects
e Analyse the Mesh

Terminology

Structure: With Meshes, everything is built from three basic structures: Vertices, Edges
and Faces.

Vertices: A vertex is primarily a single point or position in 3D space.

Edges: An edge always connects two vertices by a straight line.

Faces: Faces are used to build the actual surface of the Object.

Loops: Edge and Face Loops are sets of faces or edges that form continuous
“loops”.

Edge Lops: Loops (1 and 2) in Img 4. 1 Edge and Face Loops are edge Loops.

Face Lops: These are a logical extension of Edge Loops in that they consist of the
faces between two Edge Loops.
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Edge Ring: In Edge select mode, holding Ctrl-Alt while selecting an edge selects a
sequence of edges that are not connected.

Subdividing:  Technique for adding more geometry to a Mesh. It creates new vertices on
subdivided edges, new edges between subdivisions and new faces based on
new edges.

Tessellation: ~ The tiling of a plane using one or more geometric shapes usually
resulting in Micro polygons.

Coplanar: Refers to any set of elements that are all aligned to the same 2D plane in
3D space.

Modeling Modes

3D View has three principal modes that allow for the creation, editing and manipulation of
the Mesh models. Each of the three modes has a variety of tools. Some tools may be found in

one or more of the modes.
Modes used forModeling

Creation of a Mesh Primitivetypically starts by adding a Mesh Objectin Object Mode. Limited
types of editing such as size, location, and orientation can be accomplished in Object Mode.

Object Mode also provides the means to Join and Group Multiple Mesh Primitives.

e Object Mode

« Edit Mode

e Sculpt Mode
More detailed editing of the Mesh model shape is done in Edit Mode, and Sculpt Mode. The
nature of these three modes determines the tools that are available within the various panels of
3D View. Switching between modes while Modelling is common. Some tools may be available

in more than one mode while others may be unique to a particular mode.
You can work with Geometric Objects in two modes.
Object Mode

Object Mode Operations in Object Mode affect the whole Object. Object Mode has the
following header in 3D View:

O3/ = Covectode + @ +|% +&) I Giobal ¢ |gumms ammms B0 ] 2 )

Title-Img 4. 1 Object Mode Header.
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Edit Mode

Operations in Edit Mode affect only the geometry of an Object, but not global properties such
as location or rotation. Edit Mode has the following header in 3D View:

O3 = ©editmode +/ @4 % Il ciotal  +| @[

Title-Img 4. 2 Edit Mode Header.

Source-Blender.org
Link-https://docs.blender.org/manual/en/dev/modeling/meshes/introduction.html

Visualization

Title-Img 4. 3 One cube selected

Source-Blender.org
Link-https://docs.blender.org/manual/en/dev/modeling/meshes/introduction.html

Title-1mg 4. 4 Two cube selected before entering edit mode

Source-Blender.org

Link-https://docs.blender.org/manual/en/dev/modeling/meshes/introduction.html
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By default, Blender highlights selected geometry in orange in both Object Mode and Edit
Mode.

e In Object Mode with Wireframe shading enabled Z, Objects are displayed in black when
unselected and in orange when selected. If more than one Object is selected, all selected
Objects except the active Object, typically the Object last selected, are displayed in a
darker orange color. Similarly, in Edit Mode, unselected geometry is drawn in black
while selected faces, edges, or vertices are drawn in orange. The active face is highlighted

in white.

« In Edit Mode, only one Mesh can be edited at the time. However, several Objects can be
joined into a single Mesh (Ctrl-J in Object Mode) and then separated again (P in Edit
Mode). If multiple Objects are selected before entering Edit Mode, all the selected Objects
remain highlighted in orange indicating that they are part of the active selection set.

If two vertices joined by an edge are selected in Vertex selection mode, the edge between them
is highlighted too. Similarly, if enough vertices or edges are selected to define a face, that face

is also highlighted.

Tool Shelf

Extrude

Title-Img 4. 5 The Tool Shelf panel in edit mode.
Attribution- Source-Blender.org

Link-https://docs.blender.org/manual/en/dev/modeling/meshes/introduction.html

Open/Close the Mesh Tools panel using T. When entering Edit Mode, several Mesh tools
become available.
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Most of these tools are also available as shortcuts (displayed in the Tooltips for each tool)
and/or in the Specials Menu W, the Edge menu Ctrl-E, and Face menu Ctrl-F. The properties
of each tool are displayed in the operator panel at the bottom of the ToolShelf.

Properties Region

Local

Title-Img 4. 6 The Properties Region in edit mode.
Source-Blender.org

Link-https://docs.blender.org/manual/en/dev/modeling/meshes/introduction.html

Open/close the Properties Region using N.

In the Properties Region, panels directly related to Mesh editing are the Transform panel, where
numeric values can be entered, and the Mesh Display panel, where for example normals and

numeric values for distances, angles, and areas can be turned on.

With Meshes, everythingisbuiltfrom threebasicstructures: Vertices, Edges and Faces.
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Title-Img 4. 7 Example of Mesh structure.
Source-Blender.org

Link-https://docs.blender.org/manual/en/dev/modeling/meshes/structure.html

Vertices

A vertex is primarily a single point or positionin 3D space. It is usually invisible in rendering
and in Object Mode. Do not mistake the center point of an Object for a vertex. It looks similar,
but it is bigger and you cannot select it. Refer Vertex example (Img 4.8). Shows the center

point labelled as “A”; “B” and “C” are vertices.

Title-Img 4. 8 Vertex example

Source-Blender.org

Link-https://docs.blender.org/manual/en/dev/modeling/meshes/structure.html

A simple way to create a new vertex is to click Ctrl-LMB in Edit Mode. Of course, as a

computer screen is two-dimensional, Blender cannot determine all three vertex coordinates
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from a single mouse click, so the new vertex is placed at the depth of 3D cursor. Using the
method described above (Img 4.8), any vertices selected previously are automatically
connected to the new ones by an edge. In the image above, the vertex labelled “C” is a new
vertex added to the cube with a new edge added between “B” and “C”.

Edges
An Edge always connects two vertices by a straight line. The edges are the “wires” you see
when you look at a Mesh in wireframe view. They are usually invisible on the rendered image.

They are used to construct faces. Create an edge by selecting two vertices and pressing F.

Face

A Face is defined as the area between either three (triangles), four (quadrangles) or more
(ngons) vertices, with an edge on every side. These are often abbreviated to tris, quads &
ngons.

Triangles are always flat and therefore easy to calculate. On the other hand, quadrangles

“deform well” and are therefore preferred for subdivision Modelling.

While you could build a cube with triangular faces, it would just look more confusing in Edit
Mode.

Loops

Title-Img 4. 9 Edge and Face Loops

Source-Blender.org

Link- https://docs.blender.org/manual/en/dev/modeling/meshes/structure.html#fig- mesh-topo-loop

Edge and Face Loops are sets of faces or edges that form continuous “loops” as shown in Img
4.9.

Edge and Face Loops:
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e Toprow (1-4)showsasolidview,

o Bottom row (5 - 8) a wireframe view of the same loops.

In the image above (Img 4. 9), loops that do not end in poles are cyclic(1 and 3). They start and
end at the same vertex and divide the model into two partitions. Loops can be a quick and
powerful tool to work with specific, continuous regions of a Mesh and are a prerequisite for

Organic Character Animation.

Edge Loops

Loops (1 and 2) in Img 4. 9Edge and Face Loops are edge Loops. They connect vertices so
that each one on the loop has exactly two neighbours that are not on the loop and placed on

both sides of the loop (except the start and end vertex in case of poles).

Edge Loops are an important concept especially in organic (subsurface) Modelling and
character animation. When used correctly, they allow you to build models with relatively
few vertices that look very natural when used as subdivision surfaces and deform very well in

animation.

Face Loops

These are a logical extension of Edge Loops in that they consist of the faces between two Edge
Loops, as shown in loops (3 and 4) in Img 4. 9 Edge and Face Loops. Note that for non-circular
loops (4) the faces containing the poles are not included in a Face Loop. (Refer
Img 4. 9)

Selection Mode

Select Mode Header Widgets

¢ Mode: Edit Mode
¢ Menu: 3D View Header » Select Mode
o Hotkey: Ctrl-Tab
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In Edit Mode, there are three different selection modes. You can enter the different modes by

selecting one of the three buttons in the header.

Title-Img 4. 6 Edit Mode selection buttons

Source-Blender.org

Link- https://docs.blender.org/manual/en/dev/modeling/meshes/selecting/introduction.html

Vertices

In this mode, vertices are drawn as points.

o Selected vertices are drawn inorange,
+ Unselected vertices in black

o Active or last selected vertex inwhite

Edges
In this mode, the vertices are not drawn. Instead,

o Selected edges are drawn in orange,
o Unselected edges black,

e Active or last selected edge inwhite.

Faces

In this mode, the faces are drawn with a selection point in the middle which is used for
selecting a face.

e Selected faces and their selection point are drawn in orange,

e Unselected faces are drawn in black,

e Activeor last selected face is highlighted in white.

Almost all tools are available in all three Mesh selection modes. So, you can Rotate, Scale,
Extrude, etc. in all modes. Of course, rotating and scaling a single vertex will not do anything
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useful (without setting the pivot point to another location), so some tools are applicable in

some modes.

Selection Loops
You can easily select loops of components:
Edge Loops and Vertex Loops

e Mode: Edit Mode —> Vertex or Edge select mode

e Menu: Select » Edge Loop or Mesh » Edges » Edge Loop
o Hotkey: Alt-RMB or Ctrl-E» Edge Loop

Holding Alt while selecting an edge selects a loop of edges that are connected in a line end to
end, passing through the edge under the mouse pointer. Holding Alt-Shift while clicking adds

to the current selection.

Edge loops can also be selected based on an existing edge selection, using either Select » Edge

Loop, or the Edge Loop Select option of the Edge Specials Menu Ctrl-E.

Title-Img 4. 7 Longitudinal and latitudinal edge loops

Source-Blender.org

Link- https://docs.blender.org/manual/en/dev/modeling/meshes/selecting/advanced.html

Face Loops

« Mode: Edit Mode —> Face or Vertex select modes
e Hotkey: Alt-RMB

In face select mode, holding Alt while selecting an edge selects a loop of faces that are
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connected in a line end to end, along their opposite edges.

Invertexselectmode, the same can be accomplished by using Ctrl-Altto select an edge, which

selects the face loop implicitly.

Title-1mg 4. 8 Face loop selection

Source-Blender.org

Link- https://docs.blender.org/manual/en/dev/modeling/meshes/selecting/advanced.html

This face loop was selected by clicking with Alt-RMB on an edge, in face select mode. The
loop extends perpendicular from the edge that was selected.

Title-Img 4. 9AIt versus Ctrl-Alt in vertex select mode

Source-Blender.org

Link- https://docs.blender.org/manual/en/dev/modeling/meshes/selecting/advanced.html

A face loop can also be selected in Vertex select mode. Technically Ctrl- Alt-RMB will select
an Edge Ring, however, in Vertex select mode, selecting an Edge Ring implicitly selects a
Face Loop since selecting opposite edges of a face implicitly selects the entire face.

Edge Ring

o Mode: Edit Mode —> Edge select mode
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e Menu: Select » Edge Ring or Mesh » Edges » Edge Ring
o Hotkey: Ctrl-Alt-RMB or Ctrl-E »Select » Edge Ring

In Edge select mode, holding Ctrl-Alt while selecting an edge selects a sequence of edges that
are not connected, but on opposite sides to each other continuing along a face loop.

As with edge loops, you can also select edge rings based on current selection, using either

Select » Edge Ring, or the Edge Ring Select option of the Edge Specials Menu Ctrl-E.

Title-Img 4. 10 A selected edge loop, and a selected edge ring

Source-Blender.org

Link- https://docs.blender.org/manual/en/dev/modeling/meshes/selecting/advanced.html

In Img 4.14, A selected edge loop, and a selected edge ring. The same edgewasclickedon, but
two different “groups of edges” were selected, based on the different commands. One is based

on edges during computation and the other is based on faces.

Duplicating / Mesh Editing Tools

This section covers Mesh editing tools that add additional geometry by duplicating existing

geometry in some way.
Duplicate Geometry

Extrusion
Spin

Screw

Duplicate Geometry Tool
e Mode: Edit Mode
e Menu: Mesh » Duplicate

e Hotkey: Shift-D
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This tool simply duplicates the selected elements, without creating any links with the rest of
the Mesh (unlike extrude, for example), and places the duplicate at the location of the original.
Once the duplication is done, only the new duplicated elements are selected, and you are

automatically placed in grab/move mode, so you can translate your copy elsewhere.

Extrude Tool

Extrude Region
e Mode: Edit Mode

e Panel: Mesh Tools » Extrude
e Menu: Mesh» Extrude Region
e Hotkey: E or Alt-E

One tool of paramount importance for working with Meshes is the Extrude tool. It allows you
to create parallelepipeds from rectangles and cylinders from circles, as well as easily create

such things as tree limbs. Extrudeisoneofthemostfrequentlyused ModellingtoolsinBlender

The selection is extruded along the common normal of selected faces. In every other case the
extrusion can be limited to a single axis by specifying an axis (e.g. X to limit to the X axis or
Shift-X to the YZ plane. When extruding along the face normal, limiting movement to the
global Z axis requires pressing Z twice, once to disable the face normal Z axis limit, and once
to enable the global Z axis limit.

Selected face During extrude Set to Z axis

Title-Img 4. 15 Extrude face
Source-Blender.org

Link- https://docs.blender.org/manual/en/dev/modeling/meshes/editing/duplicating/extrude.html

Ext Mode: Edit Mode

e Panel: Mesh Tools » Extrude Individual
e Menu: Mesh » Extrude Individual

o Hotkey: Alt-E
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Extrude Individual allows you to extrude a selection of multiple faces as individuals, instead
of as a region. The faces are extruded along their own normals, rather than their average.
This has several consequences: first, “internal” edges (i.e. edges between two selected faces)

are no longer deleted (the original facesare).

Title-Img 4. 11 Selection of multiple faces, extruded using extrude region and
Extruded using Extrude Individual
Source-Blender.org

Link- https://docs.blender.org/manual/en/dev/modeling/meshes/editing/duplicating/extrude.html

Extrude Edges and Vertices Only

e Mode: Edit Mode, Vertex and Edge
o Hotkey: Alt-E

If vertices are selected while doing an extrude, but they do not form an edge or face, they will
extrude as expected, forming a non-manifold edge. Similarly, if edges are selected that do not

form a face, they will extrude to form a face.

Title-Img 4. 12 Single vertex extruded. Single edge extruded

Source-Blender.org

Link- https://docs.blender.org/manual/en/dev/modeling/meshes/editing/duplicating/extrude.html

Title-Img 4. 13Single edge extruded. Edge only extrude
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Source-Blender.org

Link- https://docs.blender.org/manual/en/dev/modeling/meshes/editing/duplicating/extrude.html

Inset Tool

o Mode: Edit Mode

e Menu: Mesh » Faces » Inset

o Hotkey: I

This tool takes the currently selected faces and creates an inset of them, with adjustable
thickness and depth. The tool is modal, such that when you activate it, you may adjust the

thickness with your mouse position. You may also adjust the depth of the inset during the

modal operation by holding Ctrl.

Selection to inset Selection with inset
Title-Img 4. 14Single vertex extruded. Single edge extruded
Source-Blender.org

Link- https://docs.blender.org/manual/en/dev/modeling/meshes/editing/duplicating/inset.html

Spin Tool
e Mode: Edit Mode

e Panel: Mesh Tools
Use the Spin tool to create the sort of Objects that you would produce on alathe (this tool is
often called a “lathe”-tool or a “sweep-tool in the literature, for this reason). In fact, it does a
sort of circular extrusion of your selected elements, center on 3D cursor, and around the axis

perpendicular to the working view...
The point of view will determine around which axis the extrusion spins.

The position of 3D cursor will be the center of the rotation. (Refer Img. 4.20)
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Example

Title-Img 4. 15Glass profile
Source-Blender.org

Link-https://docs.blender.org/manual/en/dev/modeling/meshes/editing/duplicating/spin.html?highlight=glass%20profile

First, create a Mesh representing the profile of your Object. If you are Modelling a hollow
Object, it is a good idea to thicken the outline. Img.4.20 Glass profile Shows the profile for a
wine glass we will model as a demonstration.

Go to the Edit Mode and select all the vertices of the Profile with A.

We will be rotating the Object around the cursor in the top view, so switch to the top view with
Numpad?.

Title-Img 4. 16 Glass profile, top view in Edit Mode, just before spinning.
Source-Blender.org
Link-

https://docs.blender.org/manual/en/dev/modeling/meshes/editing/duplicating/spin.html?highlight=glass%20profile
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Place the cursor along the center of the profile by selecting one of the vertices along the center,

and snapping 3D cursor to that location with

Mesh » Cursor » Selection. (Img 4. 171 Glass profile, top view in Edit Mode, just before
spinning.) Shows the wine glass profile from topview, with the cursor correctly positioned.

Click the Spin button. If you have more than one 3D View open, the cursor will change to an
arrow withaquestion mark and you will have to click in the area containing the top view before

continuing. If you have only one 3D View open, the spin will happen immediately. Img 4. 18
Spun profile Shows the result of a successful spin.

Title-1mg 4. 19 Spun Profile with an angle of 360 and 120.

Angle

Source-Blender.org
Link-
https://docs.blender.org/manual/en/dev/modeling/meshes/editing/duplicating/spin.htmlI?highlight=glass%20profile

Result of spin operation ResultofDuplienabled

Title-Img 4. 20 Result of spin and Dupli
Source-Blender.org

Link-https://docs.blender.org/manual/en/dev/modeling/meshes/editing/duplicating/spin.html?highlight=glass%20profile

Merge Duplicates
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Title-1mg 4. 21Duplicate Vertices

Source-Blender.org
Link-
https://docs.blender.org/manual/en/dev/modeling/meshes/editing/duplicating/spin.html?highlight=glass%20profile

The spin operation leaves duplicate vertices along the profile. You can select all vertices at the
seam with Box select B shown in Img 4. 24 Duplicate vertices. Seam vertex selection and
perform a Remove Doubles operation.

Bevel Tool
e Mode: Edit Mode
e Menu: Mesh »Edges *Bevel or Ctrl-E»>Bevel

o Usage

The Bevel tool works only on selected edges. It will recognize any edges included in a vertex
or face selection as well, and perform the bevel the same as if those edges were explicitly
selected. In “vertex only” mode, the Bevel tool works on selected vertices instead ofedges. The
Bevel tool smooths the edges and/or “corners” (vertices) by replacing them with faces
making smooth profiles with a specified number of segments (see the options below Img 4. 25

for details about the bevel algorithm).

Use Ctrl-B or a method listed above to run the tool. Move the mouse to interactively specify
the bevel offset, and scroll the Wheel to increase or decrease the number of segments. (See Img
4. 25)
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Edge before Edge Bevel Vertex bevel

beveling

Title-lmg 4. 22Bevel
Source-Blender.org

Link- https://docs.blender.org/manual/en/dev/modeling/meshes/editing/subdividing/bevel.html

Merge Vertices
This tool allows you to merge all selected vertices to a unique one, deleting all others. You

can choose the location of the surviving vertex in the menu this tool pops up before executing.

Unit summary

e Create Object with 3D Mesh / Primitives
e Edit the Object with different Modes

e Work with Mesh Modelling

e Create Polygon Objects

e Analyse the Mesh

After learning this Unit, you can download the Open Image Source Software available on the

internet for free of cost to practice the possibilities of creating 3D Objects.

Assignment

Createaflowervase,awineglassand acupusing Nurbscurves.

Assessment

1. Explain the Modelling Modes in Blender
2. Write a brief note on the Structure of a Mesh

3. Explain the Loops used in Polygon Modelling
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4. Describe the types of selection modes in Mesh modelling
5. Write a brief note on Edge/Face tool

6. How is Mirror Editing tool used?

Fill in the Blanks

1. _ isavailable in either Edit Mode or Object Mode.

2. Selected vertices are drawn in___color, unselected vertices in__color.

3. Pressing Key when selecting a higher selection mode, all elements

touching the current selection will be added.
4. A___isprimarily a single point or position in 3D space.

5. Operations in effect only the geometry of an Object.
Resources

While studying this Unit, you can browse the internet links for online tutorials and several
books and training DVDs available in the Blender Store and on the Blender Cloud.

e wiki.blender.org

e archive.org

e www.blender.org

e docs.blender.org
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3D Animation

Block — 2: 3D Shading
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Unit-1 Introduction to Materials & Shader

Introduction

A Material is defined as the Artistic Qualities of the substance that an object is made of. To
define this in the simplest form, you can use the materials to show the substance of how an
object is made of, or to “paint” the object with different colors. Usually, the substance is
represented by its surface qualities (color, shininess, reflectance, etc.) but it can also exhibit
more complicated effects such as transparency, diffraction and sub-surface scattering. Typical
materials might be brass, skin, glass, or linen. The basic (un-textured) Blender material is
uniform across each face of an object (although the various pixels of each face of the object
may appear differently because of lighting effects). However, different faces of the object may
use different materials. In Blender, Materials can describe the substance: e.g. polished brass,
dirty glass or embroidered linen. In this Unit, you will learn about Materials and Shader in

Blender.

Outcomes

Upon completion of this unit you will be able to:

e Apply Materials and Shaders to your 3D Scenes

e Demonstrate the utility of Material Panel and its Slots
e Use Multiple Materials

e Practice Material Operations like Naming and Linking
e Use Material Type and Assigning a Material

e Reuse Existing Materials

Terminology

BSDF: Bidirectional Scattering Distribution Function is defined as how light is
reflected and refracted at a surface.

Reflection: BSDF Reflects an incoming ray on the same side of the surface.

Transmission:  BSDF Transmits an incoming ray through the surface, leaving on the
other side.

Refraction: BSDF refraction is a type of Transmission, transmitting an incoming ray
and changing its direction as it exists on the other side of the surface.

Functions of Materials

Before you can describe how to design effectively with materials, you must understand how

simulated light and surfaces interact in Blender’s rendering engine and how material settings
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control those interactions. A deep understanding of the engine will help you to get the most

from it.

The Rendered Image you create with Blender is a projection of the scene onto an imaginary
surface called the Viewing Plane. The viewing plane is analogous to the film in a traditional
camera, or the rods and cones in the human eye, except that it receives simulated light, not

real light.

To render an image of a scene, you must first determine what light from the scene is arriving
at each point on the viewing plane? The best way to answer this question is to follow a straight
line (the simulated light ray) backwards through that point on the viewing plane and the focal
point (the location of the camera) until it hits a renderable surface in the scene, at which point
you can determine what light would strike that point. (Refer image 1.1)

The surface properties and Incident Light Angle tell us how much of that light would be

reflected along the IncidentViewing Angle (Rendering Engine Basic Principle).

Incident
Light
Angle

Viewing
Camera ;
Plane Incident
Viewing
Angle

Renderable
Surface

Title- Img 1. 1 Rendering Engine Basic Principle
Source-

Link- http://blender-manual- i18n.readthedocs.io/ja/latest/render/blender _render/materials/introduction.ht ml

Two basic types of phenomena would take place at any point on a surface when a light ray
strikes it:
1. Diffusion

2. Specular Reflection

Diffusion and Specular reflection are distinguished from each other mainly by the relationship
between the Incident Light Angle and the Reflected Light Angle.

The shading (or coloring) of the object during render will then consider the base color (as
modified by the diffusion and specular reflection phenomenon) and the light intensity.
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Using the Internal Ray Tracer, other (more advanced) phenomena could occur.

In Ray-Traced Reflections, the point of a surface struck by a light ray will return the color of

its surrounding environment, according to the rate of reflection of the material (mixing the

base color and the surrounding environment) and the viewing angle.

On the other hand, in Ray-Traced Refractions, the point of a surface struck by a light ray will

return the color of its background environment, according to the rate of transparency (mixing

the base color and the background environment along with its optional filtering value) of the

material and the optional index of refraction of the material, which will distort the viewing

angle.

Of course, shading of the object hit by a light ray will be about mixing all these phenomena at

the same time during the rendering.

Material Settings

While rendering, the appearance of the object depends upon many inter-related settings:

World (Ambient color, Radiosity, Ambient Occlusion)
Lights

Material settings (including ambient, emission, and every other setting on every
panel in that tab)

Texture(s) and how they are mixed

Material Nodes

Camera

Viewing Angle

Obstructions and transparent occlusions

Shadows from other opaque/transparent objects

Render settings

Object dimensions (SS settings are relevant to dimensions)

Object shape (refractions, Fresnel effects)

As stated above, the material settings usually determine the surface properties of the object.

There are several ways in which materials can be set up in Blender. Generally, these are not

compatible.

You must choose which method you are going to use for each particular object in your scene:

Step 1: you can set the Properties in the various Material Panels.

Step 2: you can use Nodes; a Graphical Nodes Editor is available.

Step 3: you can directly set the colour of object surfaces using various special effects.
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Strictly, these are not the materials at all, however they are included here because they will

affect the appearance of your objects. These include
e Vertex Painting,
e Wire Rendering,
e Volume Rendering, and

e Halo Rendering

The exact effect of Material settings can be affected by the number of system settings.

1 First and foremost is the Render Engine used: Cycles and the Blender Render Engine
(aka Blender Internal or BI) require quite different illumination levels to achieve similar

results, and even then, the appearance of objects would be quite different.

2. Also, the material properties settings can be affected by the Texture Method used (Single
Texture, Multitexture or GLSL).

So, it is always recommended to select the appropriate system settings before starting the

design of materials.

Shaders

Materials define the appearance of meshes, curves and other objects. They consist of Three

Shaders, which define the appearance of the

1. Surface of the mesh,
2. Volume inside the mesh, and

3. Displacement of the surface of the mesh.

Surface Volume Displacement

Title- Img 1. 2 Materials with shaders

Source- Blender.org

Link- https://docs.blender.org/manual/en/dev/render/cycles/materials/introduction. html
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Surface Shader

The Surface Shader defines the light interaction at the surface of the mesh. One or more

BSDFs specify if incoming light is reflected back, refracted into the mesh, or absorbed.

Emission defines how light is emitted from the surface, allowing any surface to become a

light source.

Material Panel

Materials can be linked to Objects and Object’s data in the

Materials Tab » Materials Panel

Here, you can manage how materials are linked to objects, meshes, etc. and activate a material
for editing in the rest of the panels. (Refer 1.3)
Title-Img 1.3 Material panel

Wire Volume

Source- Blender.org

Link- https://docs.blender.org/manual/en/dev/render/blender render/materials/ma terial panel.html

Material slots - Active Material

The object’s material slotsare displayed ina List View. (Refer 1.4)
e Specials

e Copy and paste the selected material slot.

e Multiple materials

e Meshes can handle having more than one material. Materials can be mapped
on a per-face basis, as detailed on the Multiple Materials. In edit mode, the
following tools appear:
e Assign
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e Assign the material in the selected material slot to selected vertices.

e Select

e Select vertices assigned to the selected material slot.

e Deselect
Deselect vertices assigned to the selected material slot.
Materials Slots

The object’s material slots are displayed ina List View.

List View

il Group.001

Title-Img 1. 4 List view

Source- Blender.org

Link- https://docs.blender.org/manual/en/dev/interface/controls/templates/list_pre sets.html#ui-list-view

This control is useful to manage lists of items. They can be found in example in the object

data properties.

Select
To select an item, LMB on it.
e Rename
By double clicking on an item, you can edit its name via a text field. This can also be
achieved by pressing Ctrl-LMB over it.
e Resize
The list view can be resized to show more or fewer items. Hover the mouse over the handle
(==) then click and drag the handle to expand or shrink the list.
o Filter
Click the Show filtering options button (+) to toggle filter option buttons.
Search Type part of a list item’s name in the filter text field to filter items by their name.
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Filter Include When the magnifying glass icon has a + sign then only items that match
the text will be displayed.
Filter Exclude When the magnifying glass icon has a - sign then only items that do not
match text will be displayed.
e Sort
Sort list items.
Alphabetical This button switches between alphabetical and non-alphabetical ordering.
Inverse Sort objects in ascending or descending order. This also applies to alphabetical
sorting, if selected.
On the right of the list view are additional buttons:
e Add+
Adds a new item.

Remove -

To remove the selected item.

Specials
The down arrow on dark background opens a pop-up menu with operators’ context-

sensitive to the item type. i.e. copy paste, or operations on all items.

Move Up
The button showing an up arrow moves the selected item up one position.

Move Down

The down arrow moves the item down.

Presets

Title-Img 1. 5 Presets without and with specials
Attribution- Source- Blender.org

Link- https://docs.blender.org/manual/en/dev/interface/controls/templates/list_presets.html#ui-list-view
e Selector

A list of available presets. A selection will override the included properties.

e Add+

New presets can be added based on the preset included properties, which will be saved for later
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re-use. A pop-up opens, where you can set a name after which you can select it from the list
and in some cases additional settings.

e Remove -
Deletes the selected preset.

e Specials

The down arrow on dark background opens a pop-up menu with operators’ context-sensitive
to the preset type. i.e. copy paste.
Multiple Materials

Normally, different colors or patterns on an object are achieved by adding textures to your
materials. However, in some applications you can obtain multiple colors on an object by assigning

different materials to the individual faces of the object.

Title-Img 1. 4Add new material

Attribution- Source- Blender.org

Link- https://docs.blender.org/manual/en/dev/render/blender_render/materials/assigning_a_material.html

To apply several materials to different faces of the same object, you use the Material Slots options
(3) in the Materials Header Panel. (Refer 1.6)

DR =

Wire Volume

Title-Img 1. 5 Material menu in edit mode

Attribution- Source- Blender.org
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The workflow for applying a Second Material to some faces of an object covered by a Base
Material is as follows:
Step 1:
In Object Mode, apply the Base Material to the whole object (as shown in Assigning a
material)
Step 2:

Create/select the Second Material (the whole object will change to this new material).
Step 3:

In the Active Material box (2), re-select the base material.
Step 4:

Go to Edit Mode and Face Select (a new box appears above the Active Material box with
Assign/Select/Deselect).
Step 5:
Select the face/faces to be coloured with the second material.
Step 6:
In the Object Material Slots box (3), click the Plus to create a new slot, and while this
is still active, click on the second material in the Available Materials list.
Step 7:
Click the Assign button, and the second material will appear on the selected object
faces.
You can also make this new material a copy of an existing material by adding the data-block:
e Select the object,
e et the material,
e (R Click) and Copy data to clipboard.
When you have renamed the material,

e click“Link: Data” to link to the existing material.
e Proceed to assign faces as required.

Note: If you change the material on the original object, the new object color changes too.
Meshes can handle having more than one material. Materials can be mapped on a per-face
basis, as detailed on the Multiple Materials. In Edit Mode, the following tools appear:

e Assign
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Assign the material in the selected material slot to selected vertices.
e Select
Select vertices assigned to the selected material slot.

e Deselect

Deselect vertices assigned to the selected material slot.
Material Naming and Linking

e Material
The Material Data-Block Menu for the selected material slot.

e Nodes
Toogle that designates this material to be a material node setup, and not from the Material
/Ramps / Shaders settings.

e Data-block Links
It specifies whether the material is to be linked to the Object or to the Object Data. The Link
selector has two choices: 1. Data and 2. Object. These two menu choices determine whether
the material is linked to the object or to the data, (i.e. a mesh or curve).

e The Data Menu Item determines that this material will be linked to the mesh’s data-block
which is then linked to the object’s data-block.

e The Object Menu Item determines that the material will be linked to the object’s data-block
directly.

This will have consequences, of course. For example, different objects may share the same mesh
data-block. Since this data-block defines the shape of the object, any change in “Edit Mode” will
be reflected on all those objects. Moreover, anything linked to that mesh data-block will be shared
by every object that shares that mesh. So, if the material is linked to the mesh, every object will

share it.

On the other hand, if the material is linked directly to the object data-block, the objects can have

different materials and still share the same mesh.

Brief explanation: If connected to the object, you can have several instances of the same Object Data

using different materials.
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Unit 2 Introduction to Shader & Texture Editing

Introduction

Materials can have a Wide Array of Properties. It is the combination of things that define the

way how the Material looks, and how objects will appear when rendered. These properties

are set using the various panels in the Material tab.

Remember that the appearance of your Materials is affected by the way that they are rendered

(surface, wire, volume or halo), and by the rendering engine (Blender, Cycles, or Game) used.

Most properties for images rendered using Cycles can only be controlled using the Node

system.

Outcomes

In this Unit, you will learn about how to design Materials and Shaders.

Upon completion of this unit you will be able to:

e Design suitable Materials and Shaders to your 3D Scenes

Terminology

Preview:

Diffuse Shaders:

Specular Shaders:

Color ramps:

Shading:

Utilize Materials effectively to shade the 3D Objects
Create Color Ramps, Specular, Transparency, Reflection and Refraction
Use Material properties and

Practice Material Operations on 3D Scenes.

A Preview of the current Material mapped on

to one of the basic objects.

The basic color of the Material, together with different models for
dispersion.

The reflected highlights: color, strength and different models for

dispersion.

How to vary the base color over a surface in both Diffuse and

Specular Shaders.

Properties of various characteristics of the shading model for the

Material.
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Transparency:

Mirror:

Subsurface

scattering:

Strand:

Options:

Shadow:

Game settings:

Diffuse Shaders

Sets options for objects in which light can pass through.

(Only Blender Render): Reflective properties of the Material.

(Only Blender Render): Simulates semi- translucent objects in
which light enters, bounces around, then exits in a different place.

(Only Blender Render): For use when surfaces are covered with

hair, fur, etc.

Various options for shading and colouring the object.

Controls how objects using this Material cast and receive shadows.

(Only Blender Render): Controls settings for real-time rendering of

Game Engine objects.

A Diffuse Shader is determined by the General Color of a Material when light shines on

it. Most Shaders that are designed to mimic reality give a smooth falloff from bright to dark from

the point of the strongest illumination to the shadowed areas, however Blender also has other

Shaders for various special effects.

Common Options

All Diffuse Shaders have the following options:

Color

Select the base Diffusecolor of the Material.

Intensity

The Shader’s brightness, or more accurately, the amount of incident light energy that is

Diffusely reflected towards the camera.

Ramp

Allows you to set the range of colors for the Material, and define

how the range will vary over a surface.
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Technical Details

Light striking a surface and then re-irradiated via a Diffusion phenomenon will be scattered,
I.e., re-irradiated in all directions isotopically. This means that the camera will see the same
amount of light from that surface point no matter what the incident viewing angle is. This
quality makes Diffuse light viewpoint independent. Of course, the amount of light that strikes
the surface depends on the incident light angle. If most of the light striking a surface is reflected
Diffusely, the surface will have a matte appearance (Light re-irradiated in the diffusion

phenomenon).

ad

Wiewing .
Flans Reflected
Light
Angle

Renderable
Surface

Title- Img 2. 1 Light re-irradiated in the diffusion phenomenon.

Source- blender.org

Link https://docs.blender.org/manual/en/dev/render/blender render/materials/properties/diffuse shaders.html

Types of Diffuse Shaders

Blinn
Int: 1.5, Hard: 100
5.0

Cook-Torr Phong
s a , Hard: 50
Int: 1.0, Hard: 100 Int: 0.5, Hard: 50 10R: 5.0

Wardlso
Int: 1.0, Slope: 0.1

Lambert Shader
Title- Img 2.2 Lambert Shader.
Source- blender.org

Link-https://docs.blender.org/manual/en/dev/render/blender render/materials/properties/diffuse shaders.html

This is Blender’s default Diffuse Shader, and is a good general all- around workhorse for
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Materials showing low levels of Specular reflection.

Johann Heinrich Lambert (1728-1777) was a Swiss mathematician, physicist and
astronomer who published the works on the reflection of light, most notably the Beer-Lambert

Law, which formulates the law of light absorption.

This Shader has only the default option, determining how much of available light is reflected.

Default is 0.8 to allow other objects to be brighter.

Lambert

Title- Img 2.3 The Lambert Diffuse Shader settings.

Source-blender.org

Link-https://docs.blender.org/manual/en/dev/render/blender render/materials/p roperties/diffuse shaders.html

Oren-Nayar Shader
Title- Img 2.4 Oren-Nayar Shader.

- Blinn
Cook-Torr Phong
. Int: 1.5, Hard: 100
: . t: ard: Y
Int: 1.0, Hard: 100 Int: 0.5, Hard: 50 IOR: 5.0

Wardlso
Int: 1.0, Slope: 0.1

Source-blender.org Link-

https://docs.blender.org/manual/en/dev/render/blender render/materials/p roperties/diffuse shaders.html

Oren-Nayar has taken a somewhat more ‘physical’ approach to the diffusion phenomena as

it considers the amount of microscopic roughness of the surface.

Michael Oren and Shree K. NayarTheir reflectance model developed in the early 1990s, is

ageneralization of Lambert’s law now widely used in Computer Graphics.
Options
Roughness

The roughness of the surface, and hence, the amount of Diffuse scattering.
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Oren-Nayar

Title-Img 2.5 The Oren-Nayar Diffuse Shader settings.

Source-blender.org

Link-https://docs.blender.org/manual/en/dev/render/blender render/materials/p roperties/diffuse shaders.html

Toon Shader

Blinn
Int: 1.5, Hard: 100
IOR: 5.0

Cook-Torr
Int: 1.0, Hard: 100

Wardlso
Int: 1.0, Slope: 0.1

Title- Img2.6 Toon Shader, Different Spec.
Source-blender.org

Link-https://docs.blender.org/manual/en/dev/render/blender render/materials/properties/diffuse shaders.html

Size: 0.5 Size: 1.0
Smooth: 0.2 Smooth: 0.5

Size: 0.5
Smooth: 0.8
Toon Spec

Title-Img 2.7 Toon Shader Variations.
Source-blender.org

Link-https://docs.blender.org/manual/en/dev/render/blender render/materials/properties/diffuse shaders.html
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Toon Shader is a very ‘un-physical’ Shader that is not meant to fake reality, however to
produce cartoon cell styled rendering, with clear boundaries between light and shadow and
uniformly lit/shadowed regions.

Options Size

The size of the lit area.

Smooth

The softness of the boundary is between lit and shadowed areas.

Title-Img 2.8 Toon Diffuse Shader settings.
Source-blender.org

Link-https://docs.blender.org/manual/en/dev/render/blender render/materials/properties/diffuse shaders.html

MinnaertShader

Int: 1.5, Hard: 100
IOR: 5.0

Wardiso
Int: 1.0, Slope: 0.1

Title- Img 2.9 Minnaert Shader.

Source-blender.org

Link-https://docs.blender.org/manual/en/dev/render/blender render/materials/properties/diffuse shaders.html
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Minnaert Shader works by darkening parts of the standard Lambert Shader.
So, if Dark is 1, you get exactly the Lambertian result.

Higher darkness values will darken the center of an object (where it points towards the viewer).

Lower darkness values will lighten the edges of the object, making it look somewhat

velvet.

Marcel Minnaert (1893-1970) was a Belgian astronomer interested in the effects of the
atmosphere on light and images who in 1954 published a book entitled “The Nature of Light
and Color in the Open Air”.

Options
Dark

Thedarknessof the ‘lit’ areas (higher) orthedarkness of the edges pointing away from the light

source (lower).

Minnaert

Title-Img2.10 Minnaert Diffuse Shader settings.

Fresnel Shader

Source-blender.org

Link-https://docs.blender.org/manual/en/dev/render/blender render/materials/p roperties/diffuse shaders.html

Reference

Mode: All Modes
Panel: Shading/Material Shaders
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Fresnel: 0.5
Factor: 4.0

Title- Img 2. 11 Various settings for the Fresnel Shader, Cook-Torr Specular Shader
kept at Intensity 0.5, Hardness: 50.

Source-blender.org
Link-https://docs.blender.org/manual/en/dev/render/blender render/materials/properties/diffuse shaders.html

Blinn

Cook-Torr Phong ’
Int: 1.0, Hard: 100 Int: 0.5, Hard: 50 lnE 1o Haniion
I0R: 5.0

Wardlso
Int: 1.0, Slope: 0.1

Title-Img2.12 Fresnel Shader, Different Spec.

Source-blender.org Link-
https://docs.blender.org/manual/en/dev/render/blender render/materials/p roperties/diffuse shaders.html

With a Fresnel Shader, the amount of Diffuse reflected light depends on the incidence angle,

i.e. from the direction of the light source.

Areas pointing directly towards the light source appear darker; Areas perpendicular to the incoming
light become brighter.

Augustin-Jean Fresnel (1788-1827) was a French physicist who contributed significantly to
the establishment of the theory of wave optics.
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Options

Title- Img 2.13 The Fresnel Diffuse Shader settings.

Fresnel

Source-blender.org Link-

https://docs.blender.org/manual/en/dev/render/blender render/materials/p roperties/diffuse shaders.html

Fresnel

Power of the Fresnel effect, 5.0 is max.

Factor: Blending factor of the Fresnel factor to blend in, 5.0

Emit:
Amount of light to emit
Ambient

Amount of global ambient color the Material receives
Translucency

Amount of Diffuse shading on the back side
Shadeless

Make this Material insensitive to light or shadow

Specular Shaders

Tangent Shading

Use the Material’s tangent vector instead of the normal for shading — for

anisotropic shading effects (e.g. soft hair and brushed metal).

Specular Shaders create the bright highlights that one would see on a glossy surface,
mimicking the reflection of light sources. Unlike Diffuse shading, Specular reflection is
viewpoint dependent. According to Smnell’s Law, light striking a Specular surface will be
reflected at an angle which mirrors the incident lightangle (withregardtothesurface’snormal),

whichmakesthe viewing angle very important.
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Common Options

Each Specular Shader shares the following common options:

Specular Color
The color of the Specular highlight

Intensity

The intensity, or brightness of the Specular highlight. This has a range of [0-1].

Ramp

Allows you to set a range of Specularcolors for Material, and define how the range will vary

over a surface.

As a result, a Material has at least two different colors, a Diffuse, and a Specular one. The

Specular color is normally set to pure white (the same “pure white” as the reflected light

source), however, it can be set to different values for various effects (e.g. metals tend to have

colored highlights).

Technical Details

Title- Img 2.14 Specular Reflection.

Viewing

Pluis Camera

Source-blender.org
Link-

Lamp

Incident
Light
Angle

Reflected
Light
Angla

Renderatle
Surface

https://docs.blender.org/manual/en/dev/render/blender render/materials/properties/specular _shaders.html?highlig

ht=specular%?20reflection
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In reality, the quality of Diffuse and Specular reflection is generated during the same process
of light scattering, however are not the same. Diffusion is actually subsurface scattering at a
very small scale.

Imagine that a surface is made up of extremely microscopic semi- transparent, reflective facets.
The sharpness of Specular reflection is determined by the distribution of the angle of these

microfacets on the surface of an object. The deeper and jagged these facets are, the

more the light spreads when it hits the surface. When these facets are flatter against the “macro
surface”, the surface will have a tighter reflection, closer to a mirror. This is a condensed
explanation of the generally accepted microfacet theory of reflectance, which is the basis of all

modern BRDFs (Bi-directional Reflectance Distribution Functions), or shading models.

Because these microfacets are transparent, some light that hits them travels into the surface
and Diffuses. The light that makes it back out is roughly Lambertian most of the time, meaning
that it spreads evenly in all directions. It is also attenuated by the pigmentation in the surface,
hence creating what you perceive as Diffuse, and the color of an object.

Note that at glancing angles, the reflectivity of a surface will always go to 1. (Referlmg 2.14)
Cook-Torrance Shader

Title-Img 2.15 Cook-Torrance Shader(Lambert 0.8).

Source-blender.org
Link-

https://docs.blender.org/manual/en/dev/render/blender render/materials/properties/specular _shaders.html?highlig

ht=specular%20reflection

Cook-Torrance is a basic SpecularShader that is most useful for creating shiny plastic

surfaces. It is a slightly optimized version of Phong.

Robert L. Cook (LucasFilm) and Kenneth E. Torrance (Cornell University) In their 1982
paper A Reflectance Model for Computer Graphics (PDF), they described “a new reflectance

model for rendering computer synthesized images” and applied it to the simulation of metal
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and plastic.
Option
Hardness

Size of the Specular highlight

PhongShader

Int0.2
Hard 200

Title-Img 2.16 Phong Shader (Lambert 0.8).

Source-blender.org
Link

https://docs.blender.org/manual/en/dev/render/blender render/materials/properties/specular_shaders.html?highlig

ht=specular%20reflection

Phong is a basic Shader that is very similar to CookTorr, however, it is better for skin and

organic surfaces.

Bui TuongPhong (1942-1975) was a Vietnamese-born Computer Graphics pioneer that
developed the first algorithm for simulating Specular phenomenon. His model included
components not only for Specular lighting, but also Diffuse and ambient lighting.

Option
Hardness

Size of the Specular highlight.

BlinnShader
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Title-Img 2. 17 Blinn Shader (Oren-Nayar Int 0.8, Rough 0.5).
Source-blender.org
Link

https://docs.blender.org/manual/en/dev/render/blender render/materials/properties/specular _shaders.html?highlig

ht=specular%20reflection

Blinn is a more ‘physical’ Specular Shader, often used with the Oren-Nayar Diffuse Shader.
It can be more controllable because it adds a fourth option, an index of refraction, to the

above mentioned three.

James F. Blinn worked at NASA’s Jet Propulsion Laboratory and became widely known for
his work on Carl Sagan’s TV documentary Cosmos. The model he described in his 1977
paper Models of Light Reflection for Computer Synthesized Pictures (PDF) included
changes in Specular intensity with light direction and more accurately positioned highlights on

asurface.
Options

Hardness

Size of the Specular highlight. The BlinnShader is capable of much tighter Specular highlights
than PhongorCookTorr.

IOR
‘Index of Refraction’. This parameter is not actually used to compute refraction of light rays
through the Material (a ray tracer is needed for that), however to correctly compute Specular

reflection intensity and extension via Snell’s Law.
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Toon Shader

Title-Img 2. 18 Toon Specular Shader (Toon Diffuse, Int 0.8, Size & Smooth match).
Source-blender.org
Link-

https://docs.blender.org/manual/en/dev/render/blender render/materials/properties/specular shaders.html?highl

ight=specular%?20reflection

Toon Specular Shader matches the Toon Diffuse Shader. It is designed to produce the
sharp, uniform highlights of cartoon cells.

Options
Size: Size of the Specular highlight.

Smooth: Softness of the highlight’s edge.
Ward Isotropic Shader

Int 0.2 Int 0.5 Int 1.0
Slope 0.1 Slope 0.2 Slope 0.4

Int 1.0
Slope 0.0

Title- Img2.19 Ward isotropic Shader.

Source-blender.org
Link-

https://docs.blender.org/manual/en/dev/render/blender render/materials/properties/specular _shaders.html?highlig

ht=specular%20reflection
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Ward Isotropic is a flexible Specular Shader that can be useful for metal or plastic.

Gregory J. Ward developed a relatively simple model that obeyed the most basic laws of
physics. In his 1992 paper, “Measuring and modeling anisotropic reaction”, Ward introduced a
Bidirectional Reflectance Distribution Function (BRDF) since then widely used in
Computer Graphics because the few parameters it uses are simple to control. His model could
represent both isotropicsurfaces (independent of light direction) and anisotropic surfaces
(direction dependent). In Blender, the Ward Specular Shader is still called “Ward Isotropic”

however is actually anisotropic.
Option

Slope

Standard deviation for surface slope. Previously known as the root-mean-square or
rms value, this parameter in effect controls the size of the Specular highlight, though using a
different method to that of the other Specular Shaders. It is capable of extremely sharp
highlights.

Color Ramps Shading

In many real-life situations, like skin or metals, the color of Diffuse and Specular reflections
can differ slightly, based on the amount of energy a surface receives or on the light angle of

incidence. The Ramp Shader options in Blender allow you to

o seta range of colors for a Material,
o define how the range will vary over a surface,

o how it blends with the ‘actual color’ (typically from a Material or as output of a texture).

Ramps allow you to precisely control the color gradient across a Material, rather than just a
simple blend from a brightened color to a darkened color, from the most strongly lit area to the
darkest lit area. As well as several options for controlling the gradient from lit to shadowed,
ramps also provide ‘normal’ input, to define a gradient from surfaces facing the camera to
surfaces facing away from the camera. This is often used for Materials of metallic car paint

that change color based on viewing angle.

Since texture calculations in Blender happen before shading, the Ramp Shader can
completely replace texture or Material color. However, using the mixing options and Alpha

values, it is possible to create an additional layer of shading in Blender Materials.
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Options

Title- Img 2.20 Ramps Panel.

Linear

Source-blender.org Link-

https://docs.blender.org/manual/en/dev/render/blender render/materials/p roperties/ramps.html

For the first part of the color ramp option, see Color Ramp Widget.(Refer Img 2.20)

Input

The input menu contains the following options for defining the gradient:

Shader

The value as delivered by the Material’s Shader (Lambert, Cook Torrance) defines the color.
Here the amount of light does not matter for color, only the direction of the light.

Energy

As Shader, now also lamp energy, color, and distance are considered. This makes the Material

change color when more light shines on it.

Normal
The surface normal, relative to the camera, is used for the Ramp Shader. This is possible with

a texture as well, however added for convenience.

Result

While all three previous options work per lamp, this option only works after shading
calculations. This allows full control over the entire shading, including ‘Toon’ style
results. Using alpha values here is most useful for tweaking a finishing touch to a Material.
Blend

A list of the various Color Blend Modes are available for blending the ramp Shader with
the color from Input.

Factor

This slider denotes the overall factor of the ramp Shader with the color from Input.
Shading Panel

While all three previous options work per lamp, this option only works after shading
calculations. This allows full control over the entire shading, including ‘Toon’ style results.
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Using alpha values here is most useful for tweaking a finishing touch to a Material.

A list of the various Color Blend Modes are available for blending the ramp Shader with the
color from Input.

This slider denotes the overall factor of the ramp Shader with the color from Input. In the
separate Shading panel SIX MORE OPTIONS are available:

Title- Img 2.21 Shading menu, default settings.

Source-blender.org

Link-https://docs.blender.org/manual/en/dev/render/blender render/materials/p roperties/ramps.html

Emit

Amount of light to emit.

Ambient
Amount of global ambient color the Material receives. Each Material has an Ambient slider

that lets you choose how much ambient light that object receives. Set to 1.0 by default.

Ambient Color

You should set this slider depending on the amount of ambientlightyouthinkthe objectwill
receive.Something deep in the cave will not get any ambient light, whereas something close
to the entrance will get more. Note that you can animate this effect, to change it as the object

comes out of the shadows and into the light.

Translucency

Amount of light from the back side that shows through.

Shadeless
Disables the calculation of any shading. This makes the Material insensitive to light or shadow,

resulting in a solid, uniform color for the whole object.

Tangent Shading
Use the Material’s tangent vector instead of the normal for shading, i.e. for anisotropic

shading effects (like soft hair and brushed metal).
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Cubic Interpolation
Use cubic interpolation for Diffuse values, for smoother transitions between light areas and
shadowed areas. Enhances the perceived contrast.

Without Cubic With Cubic enabled
enabled.
Cubic enabled.

Title- Img 2. 22 Shading menu, default settings.
Source-blender.org

Link-http://blender-manual.readthedocs.io/en/master/render/blender render/materials/properti es/shading.html

Transparency Panel
Materials in Blender can be set to be transparent, so that light can pass through any objects
using the Material. Transparency is controlled using an “alpha” channel, where each pixel has
an additional value, range 0-1, in addition to its RGB color values.
e If alpha=0, then the pixel is transparent, and the RGB values forthe
surface contributenothingtothe pixel’sappearance;
e |If alpha=1, the surface is fully opaque, and the color of the surface

determines the final color of the pixel.

ZTransparency  Raytrace

Title-Img 2.23 Transparency Panel.

Source-blender.org Link-
111


http://blender-manual.readthedocs.io/en/master/render/blender_render/materials/properties/shading.html
http://blender-manual.readthedocs.io/en/master/render/blender_render/materials/properties/shading.html
http://blender-manual.readthedocs.io/en/master/render/blender_render/materials/properties/shading.html

https://docs.blender.org/manual/en/dev/render/blender render/materials/p roperties/transparency.html

In Blender, there are three ways in which the transparency of a Material can be set:
1. Mask,
2. Z-Buffer
3. Ray-trace

Each of these is explained in more detail below. The Material Preview option with a sphere

object gives a good demonstration of the capabilities of these three options.

Options

Z Transparency

Title- Img 2. 24 The Transparency Panel.

Source-blender.org

Link-https://docs.blender.org/manual/en/dev/render/blender render/materials/p roperties/transparency.html

IOR

In addition to the common options given above, the following property controls are available:
Index of Refraction. Sets how much a ray traveling through the Material will be refracted,

hence producing a distorted image of its background.

Filter
Amount of filtering for transparent ray trace. The higher this value, the more the base color of

the Material will show. The Material will still be transparent; however, it will start to take on
the color of the Material. Disabled (0.0) by default.

Falloff

How fast light is absorbed as it passes through the Material. Gives ‘depth’ and ‘thicknesses

to glass.
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Limit

Materials thicker than this are not transparent. This is used to control the threshold after which
the filter color starts to come into play.

Depth

Sets the maximum number of transparent surfaces a single ray can travel through. There is
no typical value. Transparent objects outside the Depth range will be rendered pitch black if
viewed through the transparent object that the Depth is set for. In other words, if you notice
black areas on the surface of a transparent object, the solution is probably to increase its Depth
value (this is a common issue with ray tracing transparent objects). You may also need to turn
on transparent shadows on the background object.

Gloss

Settings for the glossiness of the Material.

Amount

The clarity of the refraction. Set this to something lower than zero to get a blurry refraction.
Threshold

Threshold for adaptive sampling. If a sample contributes less than this amount (as a

percentage), sampling is stopped.

Index of Refraction (IOR)

Title- Img 2. 25 Influence of IOR of an Object on the distortion of the background: spheres
of Water, Glass and Diamond (top to bottom).

Source-blender.org
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Link-

https://docs.blender.org/manual/en/dev/render/blender render/materials/properties/transparency.html

There are different values for typical Materials:

e Air: 1.000 (no refraction),
e Alcohol: 1.329,

e Glass: 1.517,

e Plastic: 1.460,

e Water: 1.333 and

e Diamond: 2.417

Fresnel

F3 l!% B

EsREARESY

D3L [D4 DS

With alpha buffered
transparency.

Z Transparency

Settings for Fresnel using Z

Settings for Fresnel using ray- traced.  transparency.

Title- Img 2. 26 Fresnel Effect
Source-blender.org
Link-

https://docs.blender.org/manual/en/dev/render/blender_render/materials/properties/transparency.html
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Depth

Title- Img 2. 27 Depth

Source-blender.org Link-

https://docs.blender.org/manual/en/dev/render/blender render/materials/p roperties/transparency.html

Increasing Depth also considerably increases render time. Each time a light ray passes
through a surface, the ray-tracing algorithm is called recursively. In the example above, each
side of each glass has an exterior and an interior surface. Light rays thus have to pass through
four surfaces for each glass.

However not only that, at every point on a surface, some of the light can be reflected, or
mirrored off the surface in various directions. This results in multiple rays needing to be
calculated for each point (often referred to as a tree of rays). In each of the rendered images
above there are 640x400=256 000 pixels. By increasing Depth, at least one tree of rays is
added to each pixel.
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No transparent shadows. No transparent shadows, environment
lighting enabled.

Transparent shadows enabled, alpha set As previous, alpha set to 0.25.
to 0.0.

Transparent shadows with ambient As previous, distance increased to 2
occlusion set to multiply, distance 1 (diameter of sphere).
(radius of sphere).

Title- Img 2. 28 Transparent Shadows

Source-blender.org

Link-https://docs.blender.org/manual/en/devirender/blender render/materials/p roperties/transparency.html

Transparent shadows

By default, the shadows of transparent objects are rendered solid black, as if the object was

not transparent at all. However, in reality, the more transparent an object is, the lighter its

shadow will be.

In Blender, transparent shadows are set on the Materials that receive the shadows from the

transparent object. This is enabled and disabled with the Receive Transparent button, in the
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Material
e Shadow panel. The shadow’s brightness is dependent on the Alpha value of the shadow

casting Material.

Alternatives to transparent ray-traced shadows can be found in the World tab, namely the
Ambient Occlusion, Environment Lighting, and Gather panels. Alternatively, a texture can

be used to control the Intensity value of the shadow-receiving Material.

Mirror Reflection

Mirror reflections are computed in the Blender Render and Cycles render engines using ray
tracing. (NB: Reflections are not available in the Game Engine.) Ray tracing can be used to

make a Material reflect its surroundings, like a mirror.

The principle of ray-traced reflections is very simple: a ray is fired from the camera and travels

through the scene until it encounters an object.

o I the first object hit by the ray is not reflective, then the ray takes the color of the
object.

o If the object is reflective, then the ray bounces from its current location and travels up
to another object, and so on, until a non-reflective object is finally met and gives the
whole chain of rays its color.

Eventually, the first reflective object inherits the colors of its environment, proportional to its

Reflectivity value. Obviously, if there are only reflective objects in the scene, then the render could last

forever. Hence a mechanism for limiting the travel of a single ray is set through the Depth value: this

parameter sets the maximum number of bounces allowed for a single ray.

Options

Title- Img 2. 28 The Mirror Panel.
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%20panel

Enable ray-traced reflections

Enable or disable ray-traced reflections

Reflectivity
Sets the amount of reflectiveness of the object. Use a value of 1.0 if you need a perfect mirror,

or set it to 0.0 if you do not want any reflection.

Mirror Color

Title- Img 2. 29 Picking a mirror color.

Source-blender.org Link-
https://docs.blender.org/manual/en/dev/render/blender render/materials/properties/mirror.html?highlight=mirror

%20panel

Color of mirrored reflection by default, an almost perfectly reflective Material like chrome, or
a mirror object, will reflect the exact colors of its surrounding. However, some other equally
reflective Materials tint the reflections with their own color. This is the case for well-polished
copper and gold, for example. In order to replicate this within Blender, you have to set the
Mirror Color accordingly. To set a mirror color, simply click the color button in the mirror
panel and select a color.

Options Fresnel

Sets the power of the Fresnel effect. The Fresnel effect controls how reflective the Material is,
depending on the angle between the surface normal and the viewing direction. Typically, the
larger the angle, the more reflective a Material becomes (this generally occurs on the outline
of objects).

Blend

A controlling factor to adjust how the blending happens between the reflective and non-
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reflective areas.

Depth

Maximum allowed number of light inter-reflections. If your scene contains many reflective
objects and/or if the camera zooms in on such a reflective object, you will need to increase
this value if you want to see surrounding reflections in the reflection of the reflected object.
In this case, a Depth of 4 or 5 is typically a good value.

Max Distance

Maximum distance of reflected rays away from camera (Z-Depth) in Blender Units.
Reflections further than this range fade out to reduce compute time.

Fade to

The color that rays with no intersection within the Max Distance take. Material color can

be best for indoor scenes, Sky color (World settings) for outdoor scenes.

Title- Img 2.30 Suzanne in the Fun House

Source-blender.org Link-
https://docs.blender.org/manual/en/dev/render/blender_render/materials/properties/mirror.html?highlight=mirror
%20panel

Gloss

In paint, a high-gloss finish is very smooth and shiny. A flat, or low gloss, finish disperses the
light and gives a very blurry reflection. Also, uneven or waxed-however-grainy surfaces (such
as car paint) are not perfect and therefore slightly need a Gloss greater than 1.0

In the example to the right, the left mirror has a Gloss of 0.98, the middle is Gloss = 1.0, and
the right one has Gloss of 0.90. Use this setting to make a realistic reflection, all the way up
to a completely foggy mirror. You can also use this value to mimic depth of field in mirrors.
Amount

The shininess of the reflection. Values < 1.0 give Diffuse, blurry reflections and activate the
settings below.

Threshold

Threshold for adaptive sampling. If a sampling contributes less than this amount (as

percentage), sampling is stopped. Raising the threshold will make the adaptive sampler skip
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more often, however, the reflections could become noisier.

Samples

Number of cone samples averaged for blurry reflection. More samples will give a smoother

result, however will also increase render time.

Anisotropic

Title- Img 2. 31 Anisotropic tangent reflecting spheres with anisotropic setto 0.0, 0.75, 1.0.
(.blend)
Source-blender.org

Link-https://docs.blender.org/manual/en/dev/render/blender render/materials/p roperties/mirror.html

The shape of the reflection, from 0.0 (circular) to 1.0 (fully stretched along the tangent). If the
Tangent Shading is on, Blender automatically renders blurry reflections as anisotropic
reflections. When Tangent is switched on, the Anisotropic slider controls the strength of this
anisotropic reflection, with a range of 1.0 (default) being fully anisotropic and 0.0 being fully

circular, as is when tangent shading on the Material is switched off.

Anisotropic ray-traced reflection uses the same tangent vectors as for tangent shading, so
you can modify the angle and layout the same way, with the auto-generated tangents, or based
on the mesh’s UV co-ordinates.

Examples Fresnel
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Title- Img 2. 32 Demonstration of Fresnel effect with values equal to (from top to bottom)
0.0, 2.5 and 5.0.

Source-blender.org Link-

https://docs.blender.org/manual/en/dev/render/blender render/materials/p roperties/mirror.html

Let us undertake a small experiment in order to understand what Fresnel is really about. After
a rainy day, go out and stand over a puddle of water. You can see the ground through the
puddle. If you kneel just in front of the puddle, your face close to the ground, and look again
at a distant point on the puddle of water, the liquid surface part which is closer to you lets you
see the ground, however if you move your gaze towards the other end of the puddle, then the
ground is gradually masked until all you see is the reflection of the sky. This is the Fresnel
effect: having a surface sharing reflective and non-reflective properties according to the

viewing angle and the surface normal.

In Demonstration of Fresnel effect with values equal to (from top to bottom) 0.0, 2.5 and 5.0, this
behavior is demonstrated for a perfectly reflective Material (Mirror Reflectivity 1.0).

e Fresnel 0.0 stands for a perfect mirror Material,

e Fresnel 5. 0 could stand for a glossy Material.

It is barely noticeable however in the lower picture, the Material is perfectly reflective around

the edges.

The smoothness of the Fresnel limit can be further controlled using the Blend slider.
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Subsurface Scattering (SSS)

Many organic and inorganic Materials are not totally opaque right at the surface, so light does
not just bounce off the top surface. Instead, some light also penetrates the skin surface deeply,
and scatters around inside, taking on the color of the insides and emerging back out at a
different location. Human/animal skin, the skin of grapes, tomatoes, fruits, wax, gels (like
honey, or Jello) and so on all have Subsurface Scattering (SSS), and photo-realism really

cannot be achieved without it.

It is important to understand that Subsurface Scattering and Diffuse are one and the same.
The difference is in how far light can Diffuse beneath the surface before it is absorbed or

transmitted back out.
How it works

Actually, calculating the light path beneath the surface of an object is not practical. However,

it has been shown that it is not necessary to do this, and that one can use a different approach.

Blender calculates SSS in two steps:

Step 1: At first, the irradiance, or brightness of the surface is calculated, from the front side
of the object as well as from its back side. This is pretty much the same as in a normal render.
Ambient Occlusion, Radiosity, the type of Diffuse Shader, the light color, etc. are considered.

Step 2: In the second step, the final image is rendered, however now the SSS Shader replaces
the Diffuse Shader. Instead of the lamps, the calculated lightmap is used. The brightness of a
surface point is the calculated “Average” of the brightness of its surrounding points.
Depending on your settings the whole surface may be considered, and it is a bit more
complicated than simply calculating the average, however do not bother too much with the
math behind it.

Instead, let us see what SSS does to a distinct light point.

122



No SSS. Small SSS radius.
SSS radius enlarged. SSS with very large red
radius value.

Title- Img 2.33 SSS.

Source-blender.org Link-

https://docs.blender.org/manual/en/dev/render/blender render/materials/properties/subsurface scattering.html

If you turn on SSS, the light is distributed over a larger area. The size of this area depends
on the radius values. Instead of distributing all colors with the same amount, you may choose
different radius values for each of the RGB colors. If you use a very large radius value for a

color, its light is evenly distributed over the whole object.

Enabling Subsurface Scattering

Front: 1.000
Back: 1.000

Error: 0.050  *
Title- Img 2. 34 The SSS Panel. SSS is already enabled.

Source-blender.org Link-
https://docs.blender.org/manual/en/dev/render/blender render/materials/p roperties/subsurface scattering.html
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Step 1: Enable SSS by clicking on the Subsurface Scattering button.

Step 2: Accessible at the top are various presets. When you select a preset, the Radius values,
the RGB Radius and the 10R are set for you. The remaining options are not set (because they

are mostly dependent on the size of your object).

SubsurfaceScatteringdoes not need ray tracing. However, since it is dependent on the incident

light and shadows, you need proper shadow calculation (which may need ray tracing).

Developing your own SSS Material

The Traditional Approach

A more common however less intuitive approach is to use “layering”. This is a simplified

version of the layering approach. See the external links for more information:

Step 1:

Set the SSS color on a value of your choice, normally the predominant color of the object. If

you want to use different radii for the colors, do not make it too dark.
Step 2:

Set the scale factor. If you want to see much translucency you need small objects or large

scale values.

Step 3:

Set the radius values.
Step 4:

Adjust the brightness with the Frontand Backvalues.

A more intuitive approach

Step 1

Set the Scattering color to 0.5

Step 2

Set the Front weight to 2.0

Step 3

Set the scale factor based on the size of your object relative to the scene. If you want to see much
translucency you need small objects or large scale values.

Step 4

Set the radius values appropriately.
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Examples

Skin

Scale: 1. Scale: 2. Scale: 3. Scale: 4. Scale: 5.

Title-Img 2.35 Increasing SSS scale (blend-file)

Source-blender.org Link-

https://docs.blender.org/manual/en/dev/render/blender render/materials/p roperties/subsurface scattering.html

Strands

The Strand section of the Material tab is specific to the rendering of Hair particles. There

are two different strand methods available:
Polygon strands

This is the default (old) method. The strands are rendered as flat polygons. The number of
polygons depend on the Steps settings in the Particles system tab.

Strand Primitive

You activate Strand Primitive with the button Strand render in the Render panel of the
particle system. The hair curves are not stored as polygons; only the key points are stored,
which are then converted to polygons on the fly. A second difference is the way transparency
works. Rather than rendering using the existing system, all strand segments in a part are sorted

front to back and rendered in that order.
Polygon strands

« Work well with greater width, so you can use them as an alternative to billboards because
the strands may have an animated shape.
o Can be textured with a UV-Texture along the strands.

« Are seen by ray tracing.

Strand Primitives
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Are more memory efficient and faster, to make rendering of large amounts of fur and grass
possible. For good performance, the render steps button should be lowered (e.g.2 should
be good enough fur), since the result will be a smoothed curve anyway. You need 1 to 2 render
steps less than steps in the 3D View. Also, using more render parts helps to reduce memory

usage.

o Have a distance of vision reduction (in the Render panel under Child Simplification) for
children from faces.

e May be faded out towards the tip without an additional texture.

e Arenotray traced. So, they are not visible through ray- transparent Materials or in a
ray mirror (you can use Environment Mapping for that).

e Have shape problems if they are rendered with a greater width.

e Cannot carry a UV-Texture along the strand.

Strands Shading

3,00 00000 Width Fade: 0.000

4 Tip:1.00000 ¢ [
|
“ Minimum: 0.001 *

V&l
o Tangent Shading

Title- Img 2.36 Strands Panel.
Root Tip

Source-blender.org Link-

https://docs.blender.org/manual/en/dev/render/blender render/materials/p roperties/subsurface scattering.html

Strands are rendered with the Material of the underlying face/vertex, including shading with
a UV-Texture. Since you can assign more than one Material to each face, each particle system
may have its own Material and the Material of the underlying face can be different from the

Material of the strands.

Additionally, strands can be shaded along the strand (from root to tip) with a mono-

dimensional texture; only polygon strands can carry a two-dimensional UV-Texture.
Options:

The options for strand shading are in the Strands section of the Materialtab. (Refer Img 2.37)
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Width of the hair at the root. Width of 42the hair at the tip.

Minimum

This is the minimum thickness (in pixels) of the strands. Strands below that size are not
rendered smaller, however are faded to alpha (well, the fading works only for strand

primitives). This gives a much better rendering result for thin hair.

Blender Units

Normally strands are quite thin; the thickness is given in screen pixels. If you use Blender
Units (BU) you may set the root value up to 2 BU, and the tip value up to 1 BU. You have
to consider the overall object size, because the smallest possible size is 0.001 BU. So if you

use 1 BU for 1 meter the smallest possible size would be 1 mm (too thick for thin hair).

Use Tangent Shading

Calculates the light as if the strands were very thin and round. This makes the hair appear
brighter and shinier. Disabling the “Tangent Shading” option will still render nicely,
however resembles more solid strands, as though made of metal or wood.

Shape Slider

This slider allows you to control the interpolation. Default (0.0) is a linear interpolation
between Root and Tip. A negative value will make the strand narrower (spiky), a positive

value will make it fatter.

Title- Img 2. 37 Various Shape settings. From left to right, O (root and tip are equal in the first),
0,-0.4,-0.9,04,0.9.

Source-blender.org Link-

https://docs.blender.org/manual/en/dev/render/blender_render/materials/p roperties/strands.html

Width Fade

To fade out along the width of the strand. This works only for Strand Primitives. 0.0 is no
fading at all, 1.0 linear fading out.

UV Layer

127


https://docs.blender.org/manual/en/dev/render/blender_render/materials/properties/strands.html
https://docs.blender.org/manual/en/dev/render/blender_render/materials/properties/strands.html

You can texture polygon strands with a UV-Texture. Fill in the name of the UV-Set (not the
texture) here. You also must load the texture in the Texture tab and Material tab (Mapping:

UV) you may use every Influence setting you like — especially the alpha value;

Refer Img 2.38 ->From left to right, O (root and tip are equal in the first), 0, -0.4, -0.9, 0.4,
0.9.).

Surface Diffuse
Computes the strand normal, taking the normal at the surface into account. This eases the
coloring and lighting of hair a lot, especially for Strand Primitives. Essentially hair reacts

similar to ordinary surfaces and do not show exaggerated strong and large Specular highlights.

Distance
The distance in Blender Units over which to blend in the normal at the surface (if you want to

use Surface Diffuse only for Grass/Fur at greater distances).

Texturing along the Strand
Strands can be textured along the strand, i.e. from root to tip. To do that you must select
Strand/Particle in the Coordinates select menu in the Mapping panel of the Material tab.

Pretty much the most important setting is shown in Image 2.39 ->Fading a strand to alpha.
How to fade the tip of a strand to alpha to make nice, fuzzy-looking hair. Normally you would

use a linear blend texture for this.

Strand [ Particle

Fading a strand to alpha. The render result.

Title- Img 2. 38Texturing along the strand

Source-blender.org Link-

https://docs.blender.org/manual/en/dev/render/blender render/materials/p roperties/strands.html

You may of course set any attribute you like, especially color. Be careful with Specularity;

hairs tend to get too shiny.

Strand Render Simplification
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If you use Strand Primitives (Strand render button) and haveactivated Interpolated Children,
the Child Simplification option appears. The strand render has options to remove child strands

astheobject’s facesbecome smaller.

7 Child Simplification

Title- Img 2. 39 Strand render child simplification.

Source-blender.org Link-

https://docs.blender.org/manual/en/dev/render/blender render/materials/p roperties/strands.html

Material Options Panel

+" Use Mist

Title- Img 2. 40 Material Options panel

Source-blender.org Link-

https://docs.blender.org/manual/en/dev/render/blender render/materials/p roperties/options.html

Shadows Panel

This panel provides a series of control options concerning how objects using this Material
will appear in the rendered image. All controls are set default to “Off” unless otherwise stated.

The Shadows that appear in a scene are affected by a combination of the layout of objects,

the shape of the objects, the Materials of the objects, and the lighting. In Blender, the Display
Mode (Single Texture, Multitexture, or GLSL) also affects the appearance of shadows.

129


https://docs.blender.org/manual/en/dev/render/blender_render/materials/properties/strands.html
https://docs.blender.org/manual/en/dev/render/blender_render/materials/properties/strands.html
https://docs.blender.org/manual/en/dev/render/blender_render/materials/properties/options.html
https://docs.blender.org/manual/en/dev/render/blender_render/materials/properties/options.html

Title- Img 2. 41 Shadow Panel.

v Cast

' Cast Buffer Shadows
hadow and Distar
+ Auto Ray Bias

",

Cast Approximate

Source-blender.org
Link-
https://docs.blender.org/manual/en/dev/render/blender render/materials/properties/shadows.html?highlight=shad

ows%20panel

The Shadow panel in the Materials Properties editor(Refer Img 2.42) controls the effects that
the Material can have on the shadows that appear in the scene. The various properties are

described in the sections below.

Title- Img 2. 42 Scene with all shadow properties off.

Source-blender.org Link-
https://docs.blender.org/manual/en/dev/render/blender render/materials/properties/shadows.html?highlight=sha

dows%20panel

Options

The following properties can be set for each individual Material with which objects in the
scene are shaded. The effects are illustrated with rendered images for a simple scene (Refer
Img 2.43) consisting of two “posts”, one with red (totally non-transparent) Material one with
green (partially transparent) Material set up on a light blue plane to receive the shadows.

The illustrations were all taken in Blender Render engine, with Multitexture mode.
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Shadow Receiving Object Material

The following options affect the Material that receives shadows:

Receive

Allows this Material to receive full-intensity shadows (Refer Img 2.44 Plane with Receive.).

Receive Transparent
Allows this Material to receive shadows whose intensity is modified by the transparency and
color of the shadow-casting object (Refer Img 2.44 Plane with Receive and Receive

Transparency.).

Plane with Receive and
Plane with Recsive. Receive Transparancy.

Title- Img 2. 43Shadow receiving object material

Source-blender.org Link-
https://docs.blender.org/manual/en/dev/render/blender render/materials/properties/shadows.html?highlight=shad

ows%20panel

Shadow Casting Object Material

The following options affect the Material that casts shadows:

Cast Only
Causes objects with the Material to only cast a shadow, and not appear in renders. (Refer Img
2.45 - Posts with Cast Only.).

Casting Alpha
Sets the Alpha of shadow casting. Used for irregular and deep shadow buffering.

Shadows Only
Renders shadows as Materials alpha value, making Materials transparent, except for areas
where it receives shadows from other objects, and it retains its own transparency (Refer Img
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2.45 - Posts with Shadows Only). Note the faint image of the partly- transparent post.
Shadow Only Type
Set the type of shadows used when Shadows only is enabled.

e Shadow and Distance
o Shadow Only
e Shadows and Shading

Posts with Cast Only. Posts with Shadows Only.

Title- Img 2. 44 Shadow & cast
Source-blender.org Link-

https://docs.blender.org/manual/en/dev/render/blender render/materials/properties/shadows.html?highlight=sha
dows%20pane

Buffered Shadow Options

In addition to the shadow options described above, there are further Material properties which
control buffered shadow features. See Section On-Spot Buffered Shadows for further

discussion of these techniques.

Unit summary
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In this Unit, we have learnt what is the Material and how to

Use Shaders, Colors

Preview those Shaders with Specular and Ramps in your Material editor

Edit the Properties of the Shaders

Work on Transparency settings to create Reflection and Refractions using Index
tables to create Mirrors and Glasses

Work on Subsurface Scattering which helps the objects to create scattering of lights

and shadows within the objects.

After learning of this Unit, you can download the Open Source Software available on the

internet for free of cost to practice the possibilities of creating Materials.

Assignment

CreateaSimple LivingRoomwith few objects like Chairs, Tables, FlowerVases,Metal Objects,

Papers/Files/Books,Glassesetc.,and assign Shaders to the scene. Use Index of Refraction

table https://en.wikipedia.org/wiki/List of refractive indices

Use these key words “living room”, “3d Shaders” on https://www.google.com to collect the

reference imagesto build your shadingscenes.

Assessment

Define Diffuse Shader

Differentiate between Lambert Shader and Toon Shader

Write notes about Specular Shaders with Illustrations

Explain the Process of making a Glass Shader

List the IOR values of any 5 common Materials based on Liquids, Transparent

Materials, Opaque Materials, Gemstones and Metals

Write notes about Subsurface Scattering and its usage inthe real-time situations
Describe the use of Strands Shader
Define Shadows in 3D Mode

Resources

While studying this course, you can browse the internet links for video tutorials and to

download the relevant texture maps to assign on the objects that you have created and use the
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same for your assignments.

e wiki.blender.org

e archive.org

e www.blender.org

e docs.blender.org
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Unit 3 Shading Organic Models

Introduction

Our eyes have been trained to believe that an image is real if it shows Artifacts that result
from the Mechanical Process of photography.

Three examples of these Artifacts are
1. Motion Blur
2. Depth of Field
3. Lens Flares
We will learn about Motion Blur and Depth of Field in the next Unit 04.

We will learn about Lens Flares in this Unit, which can be produced with special Materials
and Shader. A simulated lens flare tells the viewer that the image was created with a camera,
which makes the viewer think that it is authentic.

Many things can happen to the light as it passes through the volume, which will influence the
final color that arrives at the camera. This represents physical interactions that happen in the
real world. Most of these are dependent on the density of the volume, which can either be a

constant density throughout, or varied, controlled by a texture.

It is by controlling the density that one can get the typical ‘Volumetric’ Effects such as clouds

or thick smoke or fire using Volume Rendering.

Outcomes

Upon completion of this unit you will be able to:
e Create Special Effects for your 3D Scenes using the Materials and Shaders;
e Identify the different type of Material effects available in Blender to create
Authentic Photo Effects;
¢ Create Volume Renders for light that passes through Materials;
e Create Fire and Fog Effects

e Design various styles of rendering using Special Materials and Shaders
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Terminology

Alpha:

Diffuse Color:

Size:

Seed:

Hardness:

Vertex

Normal:

Halo Rendering

This is the Transparency information of the Shader.
The color of the Halo itself.
Sets the dimension of the Halo.

If non-zero, it will randomize the ring dimension and line location.
To use, give any (integer) number to start the random-number
generator.

Sets the hardness of the Halo. Like specular hardness

Use the vertex normal to specify the dimension of the Halo.

Title- Img3.1 Activating Halo rendering.

Source-blender.org Link-

https://docs.blender.org/manual/en/dev/render/blender_render/materials/special effects/halo.html?highlight=activat

ing%20halo%20rendering

Halo Material renders each object’s points as glowing dots or some little clouds of light.

Although they are not really lights, because they do not cast light into the scene like a lamp.

These are called Halos because you can see them, however, they do not have any substance.

Halos are rendered with Vertex Shaders and not with Face Shaders.

This Material is useful for simulating special effects, like Particle effects or Lens Flares.
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Options

Title- Img 3. 2 Halo panels.
Source-blender.org
Link-
https://docs.blender.org/manual/en/dev/render/blender_render/materials/special_effects/halo.html?highlight=activat
ing%20halo%20rendering

To enable Halos, Step 1: Press the Halo button in the Material menu’s top panel. As
you would see in the 3D View, the Mesh faces are no longer rendered. Instead just the
Vertex is rendered, since that is where each Halo will originate. Halos can be hard to
find in a crowded scene, so name it well for easy location in the outliner. In the roperties
Editors, we normally find the Diffuse, Specular, and Shading panels. Now, we see
Panels relative to the Halo characteristics:
Halo Panel

Alpha The transparency.

Diffuse Color  The color of the Halo itself.

Seed If non-zero, it randomizes the ring dimension and line location. To use,

give any (integer) number to start the random-number generator.

Size Sets the dimension of the Halo
Hardness Sets the hardness of the Halo. Like specular hardness
Add Determine how much the Halo colors are ‘added to’, rather than mixed

with, the colors of the objects behind and together with other Halos. By
increasing Add, the Halo will appear to light up objects that move
behind it or through the Halo field. (Refer Img 3.3)
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Title- Img 3. 3 Effect of Add. Source-blender.org
Link-
https://docs.blender.org/manual/en/dev/render/blender_render/materials/special _effects/halo.html?highlight=activat
ing%20halo%20rendering

Texture Gives Halo a texture. By default, textures are applied to objects with
Object coordinates and reflects on the Halos by affecting their color
based on the color of the vertex originating the Halo. Enable this
feature to have the texture take effect within the Halo, and hence
to have it with varying colors or transparencies; this will map the
whole texture to every Halo. This technique proves very useful
when you want to create a realistic rain effect using particle
systems, or similar.

Vertex Normal Use the vertex normal to specify the dimension of the Halo.

Extreme Alpha Boosts alpha.

Shaded Let Halo receive light and shadows from external objects. When
shaded is enabled, the Halo will be affected by local light; a lamp will
make it brighter and affect its diffuse color and intensity.

Soft Softens the edges of the Halos at intersections with other geometry. In
addition, several other special effects are available. To enable some of
these effects, set the number of points/rings, or set the color of each

effect individually:
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You cannot use color ramps. Lines, Rings and an assortment of special effects are available
with the relevant toggle buttons, which include Flare, Rings, Lines, Star, Texture, Extreme
Alpha, and Shaded. Halo Variations shows the result of applying a Halo Material to a single

vertex mesh.

halo+rings halotlines

© *

all of them

Title- Img 3. 4 Halo Variations

Source-blender.org
Link-
https://docs.blender.org/manual/en/dev/render/blender_render/materials/special effects/halo.html?highlight=activat

ing%20halo%20rendering

Flare Panel Enabling Flare Renders the Halo as a lens flare.

Size Sets the factor by which the flare is larger than the Halo.
Boost Give the flare extra strength.

Seed Specifies an offset in the flare seed table.

Subflares Sets the number of subflares.

Subsize Sets the dimensions of the subflares, dots, and circles.
Lens Flares

Our eyes have been trained to believe that an image is real if it shows Artifacts that result

from the Mechanical Process of photography.
Three examples of these Artifacts are

1. Motion Blur

2. Depth of Field

3. Lens Flares
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We will learn about Motion Blur and Depth of Field in the next Unit 04.

Now, we learn about Lens Flares in this Unit, which can be produced with special Materials
and Shader. A simulated lens flare tells the viewer that the image was created with a

camera, which makes the viewer think that it is authentic.

We create Lens Flares in Blender from a mesh object using first the Halo button and then
the Flare options in the Shaders Panel of the Material settings. Try turning on Rings and
Lines, however, keep the colors for these settings fairly subtle. Play with the Flares:
number and Fl. seed: settings until you arrive at something that is pleasing to the eye. You

might need to play with Boost: for a stronger effect.

Note that this tool does not simulate the physics of photons traveling through a glass lens; it’s

just an eye candy.

Blender’s LensFlare looksnice inmotion, and disappears when another object occludes the flare

mesh.

Title- Img 3. 4Lens Flare. Source-blender.org

Link-
https://docs.blender.org/manual/en/dev/render/blender _render/materials/special effects/halo.html?highlight=activat
ing%?20halo%20rendering

Halo Texturing

By default, textures are applied to objects with Object coordinates and reflects on the Halos
by affecting their color, as a whole, on the basis of the color of the vertex originating the Halo.
To have the texture take effect within the Halo, and hence to have it with varying colors or
transparencies press the Texture button; this will map the whole texture to every Halo. This
technique proves very useful when you want to create a realistic rain effect using particle

systems, or similar.
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Another Option is Shaded. When shaded is enabled, the Halo will be affect by local light; a

lamp will make it brighter and affect its diffuse color and intensity.

Examples
Dot-Matrix Display

Let us use a Halo Material to create a dot-matrix display:

Step 1: To begin, add a grid with the dimensions 32x16. Then add a camera and adjust your

scene so that you have a nice view of the billboard.

Step 2: Use a 2D image program to create some red text on a black background, using a simple
and bold font, you can just save the picture on your hard drive as Dot-matrix image texture and
show an image 512 pixels wide by 64 pixels high, with some black space at both sides.

Title- Img 3. 5Dot matrix image texture. Source-blender.org

Link-
https://docs.blender.org/manual/en/dev/render/blender_render/materials/special _effects/halo.html?highlight=activat
ing%20halo%20rendering

Step 3: Add a Material for the billboard, and set it to the type Halo. Set the Halo Size

to 0.06 and when you render the scene you should see a grid of white spots.

Step 4: Add a Texture, then change to the Texture Buttons and make it an image texture. When
you load your picture, and render again you should see some red tinted dots in the grid. (Refer

Img 3.6)
Step 5: Return to the Material Buttons and adjust the size X

parameter to about 0.5 then render again; the text should now be centered on the Billboard.

Step 6: To remove the white dots, adjust the Material color to a dark red and render. You
should now have only red dots; however, the billboard is still too dark. To fix this enter Edit
Mode for the board and copy all vertices using the Shift-D shortcut (take care not to move
them!). Then adjust the brightness with the Add value in the Halo panel. (Refer Img 3.7)
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Title- Img 3. 6Dot Matrix display

Source-blender.org Link-

https://docs.blender.org/manual/en/dev/render/blender render/materials/special effects/halo.html?highlight

=activating%20halo%20rendering

You can now animate the texture to move over the billboard, using the Offset X value in the
Texture tab of the Mapping panel. (You could use a higher resolution for the grid, however, if
you do you must adjust the size of the Halos by shrinking them, or they will overlap. (Refer

Img 3.7 Dot Matrix display).

Volume Rendering

Title- Img 3. 7Activation volume rendering.
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Source-blender.org Link-

https://docs.blender.org/manual/en/dev/render/blender render/materials/special effects/volume.h

tml?highlight=activation%20volume%620rendering

Title- Img 3. 8Volume rendering.

Source-blender.org Link-

https://docs.blender.org/manual/en/dev/render/blender _render/materials/special effects/volume.html?highlight=activati

on%20volume%20rendering

Volume Rendering is a method for rendering light as it passes through participating media, within
a 3D region. The implementation in Blender a physically based model, which represents the

various interactions of light in a volume relatively realistically.

Rendering a volume is different than Solid Render. For volume light enters a 3D region of space (defined
as the volume) that may be filled with small particles, such as smoke, mist or clouds. The light bounces
around off the various molecules, being scattered or absorbed, until some light passes through the volume
and reaches the camera. For that volume to be visible, the renderer must figure out how much Material the
light has passed through and how it has acted and reacted within that volume, the volume object needs to
contain a 3D region of space, for example a manifold closed mesh, such as a cube, not just a flat
surface like a plane. To get an image, the renderer must step through that region,andseehowmuch ‘stuff’is
there(density)toseehowlight is absorbed or scattered or whatever. This can be a time-consuming process

since it must check a lot of points in space and evaluate the density at each.

Options

Title- Img 3. 9 Constant density vs textured density. Source-blender.org
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Link-

https://docs.blender.org/manual/en/dev/render/blender render/materials/special _effects/volume.html?highlight=activati

o0n%20volume%20rendering

Many things can happen to the light as it passes through the volume, which will influence the final
color that arrives at the camera. These represent physical interactions that happen in the real world,
and most of these are dependent on the density of the volume, which can either be a constant
density throughout, or varied, controlled by a texture. It is by controlling the density that one can

get the typical ‘volumetric’ effects such as clouds or thick smoke.

Density

The base density of the Material. Other densities from textures are added on top.

Density Scale

A global multiplier to increase or decrease the apparent density. This can be useful for getting

consistent results across different scene scales.

Shading

Title- Img 3. 10 Spot lamp scattering in a constant volume.

Source-blender.org
Link-
https://docs.blender.org/manual/en/dev/render/blender_render/materials/special_effects/volume.html?highlight=activati

on%?20volume%20rendering
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When light enters a volume from an external source, it does not just pass straight through. Light
gets scattered off tiny particles in the volume, and some proportion of that light reaches the camera.
This property makes it possible to see light beams as they travel though a volume and are scattered

towards the eye.

Options

Title- Img 3. 11 Shading options.

Source-blender.org
Link-

https://docs.blender.org/manual/en/dev/render/blender _render/materials/special_effects/volume.html?highlight=activati

on%20volume%20rendering

Scattering

The amount of light that is scattered out of the volume. The more light that is scattered out of the
volume, the less it will penetrate through the rest of the volume. Raising this parameter can have
the effect of making the volume seem denser, as the light is scattered out quickly at the ‘surface’

of the volume, leaving the areas internal to the volume darker, as the light does not reach it.

Note in the examples below, the less light that is scattered out of the volume, the more easily it
penetrates throughout the volume and to the shadow.

Scattering: Scattering: Scattering: Scattering:
0.5. 1.0. 2.0. 5.0.

Title- Img 3. 12 Scattering Source-blender.org

Link-

https://docs.blender.org/manual/en/dev/render/blender_render/materials/special effects/volume.html?hi

ghlight=activation%20volume%?20rendering
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Title- Img 3. 13 Isotropic and Anisotropic scattering.

Source-blender.org Link-

https://docs.blender.org/manual/en/dev/render/blender _render/materials/special effects/volume.html?highlight=activati

on%20volume%20rendering

Types of Scattering

The default method for scattering light in a volume is for the light to be deflected evenly in all

directions, also known as Isotropic scattering.

e In real life, different types of media can scatter light in_different angular directions, known

as Anisotropic scattering.
e Back-scattering means that light is scattered more towards the incoming light direction.

e Forward-scattering means it is scattered along the same direction as the light is traveling.

Asymmetry

Asymmetry controls the range between back-scattering (-1.0) and forward-scattering (1.0). The

default value of 0.0 gives Isotropic scattering (even in all directions).

Transmission

Transmission is a general term for light that is transmitted throughout a volume.
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This transmitted light can be the result of various interactions, for example:

e the left-over result of incoming light after it has reflected/scattered out of the volume
o the left-over result of light after being absorbed by the volume (and converted to heat)

Here, the transmission color is used to set the result color that light becomes after it is transmitted
through the volume.

Transmission Color
The resultant color of light that is transmitted through the volume.

Note in the examples below, as more light is scattered out of the volume, there is less available

to be transmitted through.

Transmission Transmissio Transmissio Transmissio
color: n color: n color: n color:
Yellow, Yellow, Yellow, Yellow,
Scattering: Scattering: Scattering: Scattering:
0.5. 1.0. 2.0. 5.0.

Title- Img 3. 14 Transmission of color. Source-blender.org
Link-

https://docs.blender.org/manual/en/dev/render/blender_render/materials/special effects/volume.html?highlight=activati

on%20volume%20rendering

e Emission

Some volumes can emit light where there was none before, via chemical or thermal processes,
such as fire. This light is generated from the volume itself and is independent of light coming

from external sources.

Currently, this emitted light does not affect other volumes or surfaces (like surface Material

type, ‘Emit’ option).

e Emission Color
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The color of light that is emitted by the volume.

Emission

An intensity multiplier for the emitted color, for scaling up and down.

Emission Emission Emission Emission
0.25, 0.25, 0.25, 0.25,
Scattering: 0.5. Scattering: 1.0. Scattering: 2.0. Scattering: 5.0.

Title- Img 3. 15 Emission

Source-blender.org Link-

https://docs.blender.org/manual/en/dev/render/blender _render/materials/special effects/volume.html?highlight=activati

on%20volume%20rendering

Reflection

The Reflection parameters can be used to tint or scale the light that is scattered out of the volume.
This affects only the light that has come from lamps and been scattered out, it does not affect the
color of transmitted or emitted light and is.

These settings are not physically correct, because they do not conserve energy. This means the
light scattering out does not affect the remaining light, that is transmitted throughout the rest of the

volume.

For example, if the orange components of the light are scattered out of the volume towards the
camera, only the inverse of that (blue) will remain to continue penetrating through the
volume,causing the volume to take on a multi-colored appearance, which can be difficult to use.
To make it a bit easier to plainly set the color of the volume, you can use the reflection
parameters to quickly set an overall tint.

e Reflection Color

The color of light that is scattered out of the volume.
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e Reflection

An intensity multiplier for the reflection, for scaling up and down.

Reflection: Reflection: Reflection: Reflection:
Green, Green, Green, Green,
Scattering: Scattering: Scattering: Scattering:
0.5. 1.0. 2.0. 5.0.

Reflection: Reflection: Reflection: Reflection:
Green, Green, Green, Green,
Transmissio Transmissio Transmissio Transmissio

n: Yellow, n: Yellow, n: Yellow, n: Yellow,

Scattering: 0.5. Scattering: 1.0. Scattering: 2.0. Scattering: 5.0.

Title- Img 3. 16 Reflection
Source-blender.org Link-

https://docs.blender.org/manual/en/dev/render/blender_render/materials/special _effects/volume.html?highlight=activati

on%20volume%20rendering

Lighting

Shaded

" Light Cache
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Lighting Mode
Shadeless
Shadowed
Shaded

Multiple Scattering
Shaded + Multiple
Scattering

Shaded Options
External Shadows
Light Cache

Resolution

Title- Img 3.17 Lighting options. Source-blender.org

Shadeless is the simplest, useful for thin, wispy mist or steam.

Shadowed is similar, however, with shadows of external objects.

Shaded uses a volumetric single-scattering method, for self-shading

the volume as light penetrates through.
Allows multiple scatter calculations.

Combines Shaded and Multiple Scattering functionality.

Receive shadows from sources outside the volume (temporary).
Pre-calculate the shading information into a voxel grid, speeds up
shading at slightly less accuracy.

Resolution of the voxel grid, low resolutions are faster, high

resolutions use more memory.

Multiple Scattering Options

Diffusion
Spread
Intensity

Transparency

Link-

Diffusion factor, the strength of the blurring effect.
Proportional distance over which the light is diffused.
Multiplier for multiple scattered light energy.
The transparency settings are the same as Solid
Render except you have less settings. For volume

rendering you only have:
e Mask
e Z Transparency

e Raytrace

https://docs.blender.org/manual/en/dev/render/blender_render/materials/special effects/volume.html?highlight=activati

on%20volume%20rendering

Several shading modes are available, providing a range of options between fast to render and

physically accurate.
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Integration

Title- Img 3. 18 Integration options. Source-blender.org

Link-

https://docs.blender.org/manual/en/dev/render/blender_render/materials/special_effects/volume.htmlI?highlight=

activation%20volume%?20rendering

Step Calculation
Method

Randomized
Constant

Step Size

Depth Cutoff

Options

Source-blender.org Link-

Method of calculating the step through the volume.

Randomized method of calculating the step.
Constant method of calculating the step.

Distance between subsequent volume depth samples. Step Sizes
determine how noisy the volume is. Higher values result in lower

render times and higher noise.

Stop ray marching early if transmission drops below this
luminance threshold. Higher values will give a speedup in dense

volumes at the expense of accuracy.

* Traceable

Title- Img 3. 19Material volume options.

https://docs.blender.org/manual/en/dev/render/blender _render/materials/special _effects/volume.html?highlight=activati

on%20volume%20rendering

e Traceable
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Allow this Material to calculate ray tracing.
e Full Oversample
Force this Material to render full shading/textures for all anti-aliasing samples.
e Use Mist
Use mist with this Material (in world settings).
e Light Group
Limit lighting of this Material to lamps in this group.
e Exclusive

Material uses this group exclusively. Lamps are excluded from other scene lighting.

Smoke and Fire

Create the Material The Material must be a Volumetric Material with a Density of 0, and
a high-Density Scale.

Surface Wire

Title- Img 3. 20The Material Settings.

Source-blender.org Link-

https://docs.blender.org/manual/en/dev/render/blender_render/materials/special _effects/volume.html?highlight=activati

on%20volume%20rendering
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Smoke requires a complex Material to render correctly.
Step 1: Select the big cube

Step 2: Go to the Material tab.

Step 3: Change the Material to “Volume’ S

Step 4: Set the density to 0. If you set the density to values bigger than 0 the domain
cube will be filled with the volume Material.

The other settings will affect the smoke, though. We’ll coverthose later.

Add the Texture

In addition, Smoke requires its own texture, you can use a Volumetric Texture known as VVoxel

Data. You must remember to set the domain object and change the influence.

H

Title- Img 3. 21The texture settings.Source-blender.org
Link-

https://docs.blender.org/manual/en/dev/render/blender_render/materials/special effects/volume.html?highlight=activati

on%20volume%20rendering

Step 1: Go to the Texture tab
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Step 2: Change the Type to VoxelData.
Step 3: Under the Voxel Data-Settings, set the Domain Object to our domaincube (it should be listed

justas ‘Cube’ since we are using Blender’s default cube.

Step 4: Under Influence check ‘Density’ and leave it at1.000 (Emission should be automatically
checked, to0).

Now you should be able to render single frame. You can choose to color your

smoke as well, by turning Emission Color back on.

Title- Img 3. 22Finished Result.

Source-blender.org
Link-

https://docs.blender.org/manual/en/dev/render/blender_render/materials/special_effects/volume.html?highlight=activati

on%20volume%20rendering

Smoke Simulator with fire texture

You can also turn your smoke into fire with another texture!

Title- Img 3. 23 The Fire Material.
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Source-blender.org Link-

https://docs.blender.org/manual/en/dev/render/blender_render/materials/special _effects/volume.html?highlight=activati

o0n%20volume%20rendering

To make fire,

Step 1: Turn up the Emission Value in the Materials panel

Step 2: Add another texture (Keep the old texture or the smoke will not show)
Step 3: Give it a fiery color ramp, which colors are based on the alpha

Step 4: Change the influence on Emission and Emission color

Step 5: Change the blend to Multiply

155


https://docs.blender.org/manual/en/dev/render/blender_render/materials/special_effects/volume.html?highlight=activation%20volume%20rendering
https://docs.blender.org/manual/en/dev/render/blender_render/materials/special_effects/volume.html?highlight=activation%20volume%20rendering
https://docs.blender.org/manual/en/dev/render/blender_render/materials/special_effects/volume.html?highlight=activation%20volume%20rendering

Material

Multiply

Title- Img 3. 24 The fire texture settings.
Source-blender.org
Link-

https://docs.blender.org/manual/en/dev/render/blender_render/materials/special effects/volume.html?highlight=activati

on%20volume%20rendering
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Title- Img 3. 25 The fire render.
Source blender.org
Link-

https://docs.blender.org/manual/en/dev/render/blender_render/materials/special effects/volume.html?highlight=activati

on%20volume%20rendering

Wire Render

Deselect
'{'F @ Data#

olurne Halo

Title-Img 3. 26Wire Render.

Attribution- Source-blender.org

Link-
https://docs.blender.org/manual/en/dev/render/blender_render/materials/special_effects/wire.html?highlight=wire%?2

Orender

The Wire Render option in the Materials section provides a way of showing a rendered mage of
the edges in an object. Each edge is rendered as a single-pixel image of the edges which make up
the mesh. The colors, alpha and other relevant properties of the lines are selected with the same

control panels as provided by the Surface rendered image.
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Title-Img 3. 27 Wire Render.

Source-blender.org Link-

https://docs.blender.org/manual/en/dev/render/blender _render/materials/special effects/wire.html?highlight=wire%20re

nder
Unit summary
In this Unit, you have learnt how to
e Use Special Effects Materials

e Create Add-on effects to your 3D Obijects like create Glow, Halo, Streaks Lens
flare and blurs

e Create Photorealistic effects to your 3D Scene, also known as Post render effects
in many other applications.

e Use Integrating effects such as Halo texturing, Volume rendering by using lights
e Create fire, smoke and transparency in your 3D Project
e Create Special render style using Wire Render

After learning of this Unit, you can download the Open Source Software available on the

internet for free of cost to practice the possibilities of creating Materials.

158


https://docs.blender.org/manual/en/dev/render/blender_render/materials/special_effects/wire.html?highlight=wire%20render
https://docs.blender.org/manual/en/dev/render/blender_render/materials/special_effects/wire.html?highlight=wire%20render
https://docs.blender.org/manual/en/dev/render/blender_render/materials/special_effects/wire.html?highlight=wire%20render
https://www.blender.org/download/
https://www.blender.org/download/

Assignment

Create a Simple Study Room with few objects like Chair and Study Tables in the corner of the
room along with a Table Lamp, few books, pencils, pens beside and assign Normal Shaders and

Special Shaders to the scene.

Use these key words “Study room”, “3D Volume light effects” on https://www.google.com to

collect the reference images to build your shading scene.
Assessment

e Write down the steps to create Stars in Halo Effects

Explain the process of making a Lens Flare
e Describe Halo Textures with examples

e Write the use of Volume Rendering

e Explain Light Scattering in Volume Render

e Explain the process of creating Fire and Smoke using VVolume Render

e State how to use Wire Render

e Define Reflection and Refraction in Scattering of Volume Materials.

Resources

While studying this course, you can browse the internet links for video tutorials and to download
the relevant texture maps to assign on the objects that you have created and use the same for your

assignments.
Links to Download Open Projects

The iconic Blender Institute Open Movies. Featuring all the production files, assets, artwork, and

never-seen-before content.
https://cloud.blender.org/open-projects

e wiki.blender.org

e archive.org

e www.blender.org

e docs.blender.org
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Unit 4 Textures and Mapping

Introduction

In Computer Graphics Imaginary (CGI), Texture Mapping is a method to add detail to surfaces

by projecting images and patterns onto those surfaces.

The projected images and patterns can be set to affect not only color, however, also specularity,
reflection, transparency, and even fake 3-dimensional depth. Most often, the images and
patterns are projected during render time, however, Texture Mapping is also used to sculpt, paint

and deform objects.

In this Unit, you will learn more about Textures and Mapping.

Outcomes

Upon completion of this unit you will be able to:

e Create appropriate Textures for 3D Objects

List the different type of mapping techniques
e Design various blending modes to mix textures with Shaders

e Create more natural effect using Bump, Normal and Displacement mapping
techniques

e Organize the maps for various texture types and Procedural mapping for complex 3D

scenes
Terminology
CGI: Computer Graphics Imaginary
Environment It take a render of the 3D scene and apply it to a texture, to use for
maps: faking reflections.
Hue: Specifies how the hue rotation of the image.
360° are mapped to (0 to 1). The hue shift of 0 (-180°) and 1 (+180°)
have the same result.
A saturation of 0 removes hues from the image, resulting in a
Saturation: grayscale image. A shift greater 1.0 increases saturation.
Value is the overall brightness of the image. De/Increasing values
Value:

shift an image darker/lighter.
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Controls the amount of influence the node exerts on the output

Factor: image.
Image: Standard image input.
Properties: The transformations are relative shifts. In the Shader and texture

context the following properties are available as input sockets.

Material Textures

The Material settings that you have seen so far produce smooth, uniform objects, however, such
objects are not particularly true to reality, where uniformity tends to be uncommon and out of
place. In order to deal with this unrealistic uniformity, Blender allows the user to apply “textures”

which can modify the reflectivity, specularity, roughness and other surface qualities of a Material.

Title-Img 4. 1 Textures Layer on base Material.

Source-blender.org Link-

https://docs.blender.org/manual/en/dev/render/blender_render/textures/introduction.html?highlight=textures%20layer%
20base%20material

Textures are like additional layers on top of the base Material. Textures affect one or more
aspects of the Object’s Net Coloring. The net color you see is a sort of layering of effects, as

shown in the example image (Refer Img 4. 1). The layers are:

. Your Object, lit with ambient light based on your world settings.

. Your Base Material, which colors the whole surface in a uniform color that reacts to light,
giving different shades of the diffuse, specular, and mirror colors based on the way light

passes through and into the surface of the object.
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. A Primary Texture Layer that overlays a purple marble coloring.

. A Second Cloud Texture that makes the surface transparent in a misty/foggy sort of way
by affecting the Alpha value.

. These two textures are mixed with the base Material to provide the net effect: a cube of

purplish-brown fog. (Net Mixed Textured Effect)

Title-Img 4. 2 Some Metal Textures.

Source-blender.org Link-

https://docs.blender.org/manual/en/dev/render/blender_render/textures/introduction.html?highlight=textures%20layer%
20base%20material

This notion of using more than one texture, to achieve a combined effect, is one of the “hidden
secrets” Of creating realistic-looking objects. If you carefully “look at the light” while examining
any real-life object, you will observe that the final appearance of that object is best described as
the combination, in different ways and in different amounts, of several distinct underlying visual
characteristics. These characteristics might be more (or less) strongly apparent at different
angles, under different lighting conditions, and so forth. Blender allows you to achieve this in

many ways.

You can use “a stack of texture layers” as described in this Unit, or you can also use arbitrarily-

complex networks of “texture nodes” as discussed here.

Texture Panel

In the Properties Editor, choose the Texture Tab: this will show the Texture Panel.
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&3 Clouds

Title-Img 4. 3 Texture Panel.
Source-blender.org Link-

https://docs.blender.org/manual/en/dev/render/blender _render/textures/introduction.html?highlight=textures%20layer%
20base%20material

Texture Context The radio button selects the texture data type, that is, the kind of texture that is
being edited.

World

World Background.

Material/Lamp

Material type is described in the following section. Lamps Textures in the lightning section. Brush
Brush textures are applied in Painting & Sculpting.

Textures Stack Active Texture

The Texture slots are displayed in a List Views & Presets. The order in the stack defines how
textures are overlayed in the rendered image. The checkbox enables/disables the selected texture.

Texture Data-Block Texture
The Texture Data-Block Menu for the selected texture slot.
Texture Type

Choose the type of texture that is used for the current texture data-block.These types are described in
detail in this Unit.

Assigning a Texture

This page just shows how to add a texture to a slot. The Texture Panel is explained on the previous

page.
163


https://docs.blender.org/manual/en/dev/render/blender_render/textures/introduction.html?highlight=textures%20layer%20base%20material
https://docs.blender.org/manual/en/dev/render/blender_render/textures/introduction.html?highlight=textures%20layer%20base%20material
https://docs.blender.org/manual/en/dev/render/blender_render/textures/introduction.html?highlight=textures%20layer%20base%20material

£ Clouds

Title-Img 4. 4 Texture Panel.

Source-blender.org

Link-http://blender-manual-

i18n.readthedocs.io/ja/latest/render/blender render/textures/assigning a_tex ture.html

Creating a new Texture Data-Block in a new Texture Slot Step 1:
Select an empty slot

Step 2: click onthe Newbutton. This will do two

things:

. It will create a new texture data-block.

. Also, it will add a new slot in the textures stack.

Creating a new Texture Data-Block in a non-empty slot Step 1:
Select a non-empty slot
Step 2: Click on the Plus button. This will do two

things:

. It will create a new texture data-block, with a new name, by making a copy of the texture
data-block assigned to the selected slot.

. It will assign this new data-block to the selected slot.

Sharing a Texture Data-Block in a non-empty slot

Step 1: Select a non-empty slot
Step 2: Click on the Browse button. This will open a menu showing all the available Texture data-
blocks in this file.

Step 3: Choose a texture data-block in the menu to assign it to the selected slot.
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This will share the chosen texture with more than one object, hence the Number of users shown in
the texture data-block will increase by one.

Texture Properties

Material

Title-Img 4. 5 Texture Preview Panel.
Source-blender.org

Link-http://blender-manual- i18n.readthedocs.io/ja/latest/render/blender _render/textures/options.htmli?hi

ghlight=Texture%20Preview%20Panel

The Texture Preview Panel provides a quick pre-visualization of how the texture looks on its

own, without mapping.

Preview

Choose to display only the flat texture, only the Material Preview, or both side-by-side.

Texture, Material/World, Both Show Alpha

Show alpha in preview:

& If Alpha: Use is checked in the Image Sampling Panel, the image’s alpha channel is
displayed.
& If Alpha: Use is unchecked, an alpha channel based on averaged RGB values is displayed

like it would be used by the Alpha slider in the Influence Panel.

Colors

Title-1mg 4. 6 Colors Panel.
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Link-http://blender-manual- i18n.readthedocs.io/ja/latest/render/blender render/textures/options.html?hi

ghlight=Texture%20Preview%20Panel

The Ramp button activates a color ramp which allows you to remap the colors of a texture to new
ones.

The color of a texture can be modified with the Brightness, Contrast, and Saturation buttons.
All textures with RGB-Values, including Imagesand Environment Maps, may be modified with the
RGB sliders.

R,G,B Tint the color of a texture by brightening each Red, Green and Blue
channel.
Brightness Change the overall brightness/intensity of the texture.
Contrast Change the contrast of the texture.
Saturation Change the saturation of the texture.
Mapping

Textures need mapping coordinates, to determine how they are applied to the object. The mapping

specifies how the texture will ultimately wrap itself to the object.

For example, a 2D image texture could be configured to wrap itself around a cylindrical shaped
object.

Title-Img 4. 7 Mapping Panel.

Source-blender.org Link-

https://docs.blender.org/manual/en/dev/render/blender_render/textures/pro perties/mapping.html

Coordinates

Mapping works by using a set of coordinates to guide the mapping process. These coordinates

can come from anywhere, usually the object to which the texture is being applied to.
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Global The scene’s global 3D coordinates. This is also useful for animations; if you
move the object, the texture moves across it. It can be useful for letting

objects appear or disappear at a certain position in space.

Object Uses an object as source for coordinates. Often used with an Empty, this is an
easy way to place a small image at a given point on the object. This object

can also be animated, to move a texture around or through a surface.
Object Select the name of an object.

Generated The original unreformed coordinates of the object. This is the default option
for mapping textures.

v UV mapping is a very precise way of mapping a 2D texture to a 3D surface.

Each vertex of a mesh has its own UV co-ordinates which can be unwrapped
and laid flat like a skin. You can almost think of UV coordinates as a
mapping that works on a 2D plane with its own local coordinate system to the
plane on which it is operating on. This mapping is especially useful when
using 2D images as textures, as seen in UV Mapping. You can use multiple

textures with one set of UV coordinates.
Layer UV layer to use for mapping.

Strand/Particle Uses normalized 1D strand texture coordinate or particle age (X) and trail

position (Y). Use when texture is applied to hair strands or particles.

Window The rendered image window coordinates. This is well suited to blending two
objects.
Normal Uses the direction of the surface’s normal vector as coordinates. This is very

useful when creating certain special effects that depend on viewing angle.

Reflection Uses the direction of the reflection vector as coordinates. This is useful for
adding reflection maps. You will need this input when Environment

Mapping.

Stress Uses the difference of edge length compared to original coordinates of the

mesh. This is useful, for example, when a mesh is deformed by modifiers.

Tangent Uses the optional tangent vector as texture coordinates.
Flat

167



Flat mapping gives the best results on single planar faces. It does produce interesting
effects on the sphere, however, compared to a sphere-mapped sphere the
result looks flat. On faces that are not in the mapping plane the last pixel of
3D Animation 121 the texture is extended, which produces stripes on the cube
and cylinder.
Cube Cube Cube mapping often gives the most useful results when the objects
are not too curvy and organic (notice the seams on the sphere).
Tube Tube mapping maps the texture around an object like a label on a bottle.
The texture is therefore more stretched on the cylinder. This mapping is of
course very good for making the label on a bottle or assigning stickers to
rounded objects. However, this is not a cylindrical mapping so the ends of the
cylinder are undefined.
Sphere Sphere mapping is the best type for mapping a sphere, and it is perfect for
making planets and similar objects. It is often very useful for creating organic

objects. It also produces interesting effects on a cylinder.

Inheriting coordinates from the parent object

From Dupli

Duplis instance from vertices, faces, or particles, inherit texture coordinates from their parent.
Coordinate Offset, Scaling and Transformation

Offset
The texture co-ordinates can be translated by an offset. Enlarging of the Offset

moves the texture towards the top left.

Size

These buttons allow you to change the mapping of axes between the texture’s own coordinate
system, and the mapping system you choose (Generated, UV, and etcetera.) More precisely, to
each axis of the texture corresponds one of four choices that allow you to select to which axis in

the mapping system it maps! This implies several points:

e For 2D textures (such as images), only the first two rows are relevant, as they have no Z data.

e You can rotate a 2D picture a quarter turn by setting the first row (i.e. X texture axis) to Y,

and the second row (Y texture axis) to X.

e When you map no texture axis (i.e. the three “void”buttonsareset), youwill getasolid uniform

texture, as you use zero dimension (i.e. a dot, or pixel) of it (and then Blender extends or repeats
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this point’s color along all axes.)

e When you only map one texture axis (i.e. two “void” buttons are enabled) you will get a
“striped” texture, as you only use one dimension (i.e. a line of pixel) of it, (and then Blender

stretches this line along the two other axes).

e The same goes, for 3D textures (i.e. procedural ones), when one axis is mapped to nothing,

Blender extends the plan (“slice”) along therelevant third axis.

Texture Blending Modes

Blending Modes are different methods of controlling how the texture influences Material
properties. While a blending mode defines, the specific operation performed, blending factor
controls the amount, the overall “strength” of this operation. For textures, such blending factor is
set via sliders in the Influence Panel.
Blend Blending operation to perform.

RGB to Intensity

With this option enabled, an RGB texture (affects color) is used as an intensity texture (affects a

value).

Blend Color

If the texture is mapped to Color, what color is blended in according to the intensity of the

texture?

Negative

The effect of the Texture is negated. Normally white means on, black means off, Negative

reverses that.

Stencil

The active texture is used as a mask for all following textures. This is useful for semitransparent
textures and “Dirt Maps”. Black sets the pixel to “untexturable”. The Stencil mode works similar
to a layer mask in a 2D program. The effect of a stencil texture cannot be overridden, only

extended. You need an intensity map as input.

Destination Value

The value (not for RGB) with which the Intensity texture blends with the current value. Two
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examples:

e The Emit value is normally 0. With a texture mapped to Emit you will get maximal effect,

because DVar is 1 by default. If you set DVar to 0 no texture will have any effect.

e If you want transparent Material, and use a texture mapped to Alpha, nothing happens with
the default settings, because the Alpha value in the Material Panel is 1. So you have to set
DVar to 0 to get transparent Material (and of course Z Transparency also). This is a common
problem for beginners. Or do it the other way round: set Alpha to 0 and leave Dvar on 1. Of

course, the texture is used inverted then.

Types of Maps

There are two types of Maps.

1. Bump Maps

2. Normal Maps

Bump Maps and Normal Maps both serve the same purpose: they simulate the impression of a
detailed 3D surface, by modifying the shading as if the surface had lots of small angles, rather
than being completely flat. Because it is just modifying the shading of each pixel, this will not
cast any shadows and will not obstruct other objects. If the camera angle is too flat to the surface,

you will notice that the surface is not really shaped.

Both Bump Maps and Normal Maps work by modifying the normal angle (the direction pointing
perpendicular from a face), which influences how a pixel is shaded. Although the terms Bump
Map and Normal Map are often used synonymously, there are certain differences.

Bump maps

These are textures that store an intensity, the relative height of pixels from the viewpoint of the
camera. The pixels seem to be moved by the required distance in the direction of the face normal.
(The“bump” consistsonly of adisplacement, which takes place along the existing, and unchanged,
normal-vector of the face.) You may either use grayscale pictures or the intensity values of a RGB-

Texture (including images).
Normal maps

These are images that store a direction, the direction of normal directly in the RGB values of an
image. They are much more accurate, as rather than only simulating the pixel being away from
the face along a line, they can simulate that pixel being moved at any direction, in an arbitrary
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way. The drawbacks to normal maps are that unlike bump maps, which can easily be painted by
hand, normal maps usually must be generated in some way, often from higher resolution geometry
than the geometry you are applying the map to.

Normal maps in Blender store a normal as follows:
e Red maps from (0 - 255) to X (-1.0 - 1.0)
e Green maps from (0 - 255) to Y (-1.0 - 1.0)
e Blue maps from (0 - 255) to Z (0.0 - 1.0)

Since normal all points towards a viewer, negative Z-values are not stored (they would be invisible
anyway). In Blender, we store a full blue range, although some other implementations also map

blue colors (128 - 255) to (0.0 - 1.0). The latter convention is used in “Doom 3” for example.

Workflow

The steps involved in making and using Bump and Normal Maps are:

Step 1: Model a highly detailed (“hi-poly”) model.
Step 2: Bake the Bump and/or Normal maps.
Step 3: Make a low-poly, less detailed model.

Step 4: Map the map to the low-poly model using a common coordinate
system.

Consult the Modeling section for how to model a highly detailed model using the Mesh tools.
How much detail you put in is totally up to you. The more ridges and details (knobs, creases,

protrusions) you put in, the more detailed your map will be. (Step 1)

Baking a map, simply put, is to take the detail of a high polygon mesh, and apply it to a similar
object. The similar object is identical to the high-poly mesh except with less vertices. Use the

Render Bake feature in Blender to accomplish this. (Step 2)

Modeling a low-poly using Blender’s Mesh editing tools. In general, the same or similar faces
should exist that reflect the model. For example, a highly detailed ear may have 1000 faces in the
high-poly model. In the low-poly model, this may be replaced with a single plane, oriented in the
same direction as the detailed ear mesh. (Tip: Blender’s multi-resolution mesh modeling feature can

be used to good effect here.) (Step 3)

Mapping is the process of applying a texture to the low-poly mesh. Consult the Textures Mapping
section for more information on applying a texture to a mesh’s Material. Special considerations for

Bump and Normal Maps is: (Step 4)
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e When using a Bump map, map the texture to Normal and enable No RGB.

e When using a Normal map, map the texture to Normal.

The coordinate systems of the two objects must match. For example, if you bake using a UV map
of the high-poly model, you must UV map the low poly model and line up its UV coordinates to
match the outline of the high-poly image.

Displacement Maps
Displacement mapping allows a texture input to manipulate the position of vertices on rendered geometry.
Unlike Normal or Bump mapping, where the shading is distorted to give an illusion of a bump (discussed

on the previous page), Displacement Maps create real bumps, creases, ridges, etc in the actual

mesh. Thus, the mesh deformations can cast shadows, occlude other objects, and do everything
that changes in real geometry can do, however,, on the other hand, requires a lot more vertices

towork.
Options

In the Influence Panel, the strength of the displacement is controlled by the

Displace and Normal sliders:

e |f a texture provides only normal information (e.g. Stucci), vertices move according to the

texture’s normal data. The normal displacement is controlled by the Normal slider.

e |f a texture provides only intensity information (e.g. Magic, derived from color), vertices
move along the directions of their normal (a vertex has no normal itself, it is the resulting
vector of the adjacent faces). White pixels move outward in the direction of the normal, black
pixels move in the opposite direction. The amount of displacement is controlled with the
Displace slider.

The two modes are not exclusive. Many texture types provide both information (Clouds, Wood,
Marble, and Image). The amount of each type can be mixed using the respective sliders. Intensity
displacement gives a smoother, more continuous surface, since the vertices are displaced only
outward. Normal displacement gives a more aggregated surface, since the vertices are displaced

in multiple directions.

The depth of the displacement is scaled with an object’s scale, however, not with the relative size
of the data. This means if you double the size of an object in object mode, the depth of the
displacement is also doubled, so the relative displacement appears the same. If you scale inside
Edit Mode, the displacement depth is not changed, and thus the relative depth appears smaller.
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Subdivision Surface Meshes

Rendered face size is controlled with render subdivision level. Displacement really likes smooth

normal.

Manually (Edit Mode) subdivided meshes
Control render faces with number of subdivides. (This can be combined with the above methods).
Displaces exactly the same Simple Subdivision Surface, however, the overhead of drawing extra

faces can slow down editing.

Meta Objects

Control render faces with render wire size. Small wire == more faces.

The following are available, however, currently do not work well. It is recommended that you
convert these to meshes before rendering.

Open NURBS Surfaces
Control render faces with U/V Surface Resolution. Higher numbers give more faces. (Note normal

errors).

Closed NURBS Surfaces

Control with Surface Resolution controls. (Note the normal errors, and how implicit seam shows).

Curves and Text
Control with Surface Resolution controls. Higher gives more render faces. (Note that the large flat
surfaces have few render faces to displace).

Texture Types
The term Image Texture simply means that a graphic image, which is a pixel grid composed of
R, G, B, and sometimes Alpha values. It is used as the input source to the texture. As with other

types of textures, this information can be used in a number of ways, not only as a simple “decal”.

Video textures are some kind of Image textures and based on movie file or sequence of successive

numbered separate images. They are added in the same way that image textures are.

When the Texture Type Image or Movie is selected, three new Panels present themselves allowing
to control most aspects of how image textures are applied:

1. Image,

2. Image Sampling, and

3. Image Mapping.
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UV Textures vs. Procedural Textures

A Material Texture, that has a Map Input of UV, and is an image texture that is mapped to Color,
is equivalent to a UV Texture. It provides much more flexibility, because it can be sized and
offset, and the degree to which it affects the color of your object can be controlled in the Map To
Panel. In addition, you can have different images for each texture channel; one for color, one for

alpha, one for normals, one for specularity, one for reflectivity, etc.

Procedural textures, like Clouds, are incredibly simple and useful for adding realism and details

to an image.
UV Texture Procedural Texture
Image maps to precise Pattern is generated dynamically, and is mapped to the entire

coordinates on the selected  mesh (or portion covered by that Material).

faces of the mesh.

Image maps once to a range ofMaps once to all the faces to which that Material is assigned;

mesh faces specifically either the whole mesh or a portion.

selected.

Image is mapped Size XYZ in the Map Input allows tiling the texture many times
once to faces. across faces. Number of times depends on size of mesh.

Affect the color and Can also affect normal (bumpiness),

The alpha of the object. reflectivity, emit, displacement, and a dozen other aspects of the

mesh’s appearance; can even warp or stencil subsequent
textures.

Can have many for a mesh.  Can be layered, up to 10 textures can be applied, layering on one
another. Many mix methods for mixing multiple channels
together.

Any Image type (still, video, Many different types: clouds, wood grain, marble, noise, and

rendered). Generated test grid even magic.

available.

Provides the UV layout for ~ Noise is the only animated procedural texture.

animated textures.

Takes very limited Uses no or little memory; instead uses CPU compute power.

graphics memory
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So, in asense, asingle UV texture for a mesh is simpler, however, more limited than using multiple
textures (mapped to UV coordinates), because they do one specific thing very well: adding image
details to a range of faces of a mesh. They work together if the procedural texture maps to the UV

coordinates specified in your layout.

As discussed earlier, you can map multiple UV textures to different images using the UV
Coordinate mapping system in the Map Input Panel.
Options
Image
In the Image Panel, we tell Blender which source file to use.
Image Sampling
In the Image Sampling Panel, we can control how the information is retrieved from the

image.

Background image. Foreground image.

Title-Img 4. 8 Image Sampling
Source-blender.org Link-

https://docs.blender.org/manual/en/dev/render/blender_render/textures/type s/image/options.html

The two images presented here are used to demonstrate the different image options.

e Background image is an ordinary JPG-file,

e Foreground image is a PNG-file with various alpha and grayscale values.

The vertical bar on the right side of the foreground image is an
Alpha blend, the horizontal bar has 50% alpha.
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Foreground image with Use
alpha. The alpha values of the Foreground image with

pixels are evaluated. Calculate alpha.

Title-Img 4. 9 Image Sampling
Source-blender.org Link-

https://docs.blender.org/manual/en/dev/render/blender_render/textures/type s/image/options.html

Alpha
Options related to transparency.
Use
Works with PNG and TGA files since they can save transparency information (Foreground Image
with Use Alpha). Where the alpha value in the image is less than 1.0, the object will be partially

transparent and stuff behind it will show.

Calculate
Calculate an alpha based on the RGB values of the Image. Black (0, 0, 0) is transparent, white (1,
1, 1) opaque. Enable this option if the image texture is a mask. Note that mask images can use

shades of gray that translate to semi- transparency, like ghosts, flames, and smoke/fog.

Invert

Reverses the alpha value. Use this option if the mask image has white where you want it
transparent and vice-versa.

Flip X/Y Axis

Rotates the image 90 degreescounterclockwise when rendered.
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v MIP Map

v Interpolation

Title-1mg 4. 10 Image Sampling Panel

Source-blender.org Link-

https://docs.blender.org/manual/en/dev/render/blender_render/textures/type s/image/options.html

Normal Map
This tells Blender that the image is to be used to create the illusion of a bumpy surface, with each
of the three RGB channels controlling how to fake a shadow from a surface irregularity. Needs

specially prepared input pictures.

Derivative Map

Use red and green as derivative values.

MIP Map

MIP Maps are pre-calculated, smaller, filtered Textures for a certain size. A series of pictures is
generated, each half the size of the former one. This optimizes the filtering process. By default,
this option is enabled and speeds up rendering (especially useful in the Game Engine). When this
option is OFF, you generally get a sharper image, however, this can significantly increase
calculation time if the filter dimension (see below) becomes large. Without MIP Maps, you may
get varying pictures from slightly different camera angles, when the Textures become very small.

This would be noticeable in an animation.

MIP Map Gaussian filter
Used in conjunction with MIP Map, it enables the MIP Map to be made smaller based on color
similarities. In the Game Engine, you want your textures, especially your MIP Map textures, to be

as small as possible to increase rendering speed and frame rate.

Interpolation

This option interpolates the pixels of an image. This becomes visible when you enlarge the picture.
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By default, this option is on. Turn this option off to keep the individual pixels visible and if they
are correctly anti-aliased. This last feature is useful for regular patterns, such as lines and tiles;

they remain ‘sharp’ even when enlarged considerably. When you enlarge this10x10 pixel Image

LHTthe difference with and without Interpolation is clearly visible. Turn this image off if you are

using digital photos to preserve crispness.

Enlarged Image texture without and with Interpolation

Title-Img 4. 11Enlarged Image texture without and with Interpolation

Source-blender.org Link-

https://docs.blender.org/manual/en/dev/render/blender_render/textures/type s/image/options.html

Filter

The filter size used in rendering, and also by the options MipMap and Interpolation. If you notice
gray lines or outlines around the textured object, particularly where the image is transparent, turn
this value down from 1.0 to 0.1 or so.

Texture Filter Type

Texture filter to use for image sampling. Just like a pixelrepresents a picture element, a
texelrepresents a texture element. When a texture (2D texture space) is mapped onto a 3D model
(3D model space), different algorithms can be used to compute a value for each pixel based on
samplings from several texels.

Box

A fast and simple nearest-neighbor interpolation known as Monte Carlo integration

EWA (Elliptical Weighted Average)
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One of the most efficient direct convolution algorithms developed by Paul Heckbert and Ned
Greene in the 1980s. For each Texel, EWA samples, weights, and accumulates texels within an
elliptical footprint and then divides the result by the sum of the weights.

Eccentricity

Maximum Eccentricity. Higher values give less blur at distant/oblique angles, however, is slower
FELINE (Fast Elliptical Lines)

Uses several isotropic probes at several points along a line in texture space to produce an
anisotropic filter to reduce aliasing artifacts without considerably increasing rendering time.
Probes

Number of probes to use. An integer between 1 and 256. Further reading: McCormack, J;
Farkas, KI; Perry, R; Jouppi, NP (1999) Simple and Table Feline: Fast Elliptical Lines for
Anisotropic Texture Mapping, WRL

Area

Avrea filter to use for image sampling.

Eccentricity

Maximum Eccentricity. Higher values give less blur at distant/oblique angles, however, is
slower.

Filter Size

The filter size used by MIP Map and Interpolation.

Minimum Filter Size
Use Filter Size as a minimal filter value in pixels.

Image Mapping

Title-Img 4. 12Image Mapping Panel

Source-blender.org Link-

https://docs.blender.org/manual/en/dev/render/blender_render/textures/type s/image/options.html

Extend
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In the Image MappingPanel, we can control how the image is mapped or projected onto the 3D
model

Extension

Outside the image the colors of the edges are extended.

Clip

Clip to image size and set exterior pixels as transparent. Outside the image, an alpha value of 0.0
is returned. This allows you to ‘paste’ a small logo on a large object.

Clip Cube

Clips to cubic-shaped area around the images and sets exterior pixels as transparent. The same as
Clip, however, nowthe ‘Z’ coordinate is calculated as well. An alpha value of 0.0 is returned
outside a cube-shaped area around the image.

Repeat

The image is repeated horizontally and vertically.

Mirror

Mirror on X/Y axes. This buttons allow you to map the texture as a mirror, or automatic flip of
the image, in the corresponding X and/or Y direction.

Checker

Checkerboards quickly made. You can use the option size on the Mapping Panel as well to create

the desired number of checkers Even / Odd Set even/odd tiles

Distance

Governs the distance between the checkers in parts of the texture size.

Crop Minimum / Crop Maximum
The offset and the size of the texture in relation to the texture space. Pixels outside this space are
ignored. Use these to crop, or choose a portion of a larger image to use as the texture.Procedural

Textures
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Introduction

Wood

t Voronoi
Stucci

Noise
Musgrave
Marble
Magic

Distorted Noise
Clouds

Blend

None

& Clouds

Title-Img 4. 13Texture type list

Source-blender.org Link-

https://docs.blender.org/manual/en/dev/render/blender_render/textures/type s/procedural/introduction.html

The Texture Type list in the Texture Panel of the Texture buttons. (Non-procedural textures

darkened out)

Procedural textures are textures that are defined mathematically. They are generally relatively
simple to use, because they do not need to be mapped in a special way. This does not mean that

procedural textures cannot become very complex.

These types of textures are ‘real’ 3D. By that, we mean that they fit together perfectly at the edges
and continue to look like what they are meant to look like even when they are cut; as if a block of
wood had really been cut in two. Procedural textures are not filtered or anti-aliased. This is hardly

ever a problem: the user can easily keep the specified frequencies within acceptable limits.

Common options
Noise Basis

Each noise-based Blender texture (with the exception of VVoronoi and simple noise) has a Noise
Basis setting that allows the user to select which algorithm is used to generate the texture. This

list includes the original Blender noise algorithm. The Noise Basis settings makes the procedural
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textures extremely flexible (especially Musgrave).

The Noise Basis governs the structural appearance of the texture:
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Title-Img 4. 14Noise basis
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There are two more possible settings for Noise Basis, which are relatively similar to Blender

Original: Improved Perlinand Original Perlin.

Nabla

Almost all

procedural textures in Blender use derivatives for calculating normal for
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Texture Mapping (with an exception Blend and Magic). This is important for Normal and
Displacement Maps. The strength of the effect is controlled with the Nabla Number button.

Blend

Material

Linear

Title-Img 4. 8 Blend Texture Panels.

Source-blender.org Link-
https://docs.blender.org/manual/en/dev/render/blender_render/textures/types/procedural/blend.htmi?highlight=blend%2

Otexture%20panels

Often used for

This is one of the most frequently used procedural textures. You can use blend textures to blend
other textures together (with Stencil), or to create nice effects (especially with the Mapping:
Normal trick).

Note

Remember that if you use a ramp to create a custom blending, you may have to use
No RGB, if the Mapping value needs an intensity input.
Result(s)Intensity.

The Blend texture generates a smoothly interpolated progression.

Options
Progression Profile of blend.
Easing A flowing, non-linear progression.
Spherical A progression with the shape of a three-dimensional ball.
Quadratic Sphere A quadratic progression with the shape of a three-

dimensional ball.
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Radial A radial progression: Horizontal / Vertical. The direction of the

progression is flipped a quarter turn.

Material

Sharp Sharper

Saw T

Blender Ori

Title-Img 4. 9 Marble Texture Panels.

Marble

Source-blender.org Link-
https://docs.blender.org/manual/en/dev/render/blender_render/textures/type
s/procedural/marble.html?highlight=marble%?20texture%20panels

e Often used for
Marble, Fire, Noise with a structure.

e Result(s)

Intensity value only. Bands are generated based on the sine, saw, or triangular formula and noise

turbulence.
Bands are generated based on the sine, saw, or triangular formula and noise turbulence.

Options
Marble

Type
Three settings for soft to more clearly defined Marble.

|Soft, Sharp, Sharper|

Noise basis
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Shape of wave to produce bands.

|Sine, Saw, Triangle|

Noise Type

The noise function works with two methods.

Soft, Hard
Size
The dimensions of the noise table
Depth

The depth of the Marble calculation. A higher value results in greater calculation time,

however, also in finer details.

Turbulence

The turbulence of the sine bands.

Material

Title-1mg 4. 10 Noise Texture Panel.

Noise

Source-blender.org Link-

https://docs.blender.org/manual/en/dev/render/blender_render/textures/type s/procedural/noise.html

Although this looks great, it is not Perlin Noise! This is a true, randomly generated Noise. This

gives a different result every time, for every frame, for every pixel.

Options
There are no options for this noise.

e Often used for
White noise in an animation. This is not well suited if you do not want an
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animation. For Material displacement or bump, use clouds instead.
e Result(s)

Intensity.

Wood

N

Material

Saww Tri

Band Moise Ring Moise

Blender Original

Title-Img 4. 11 Wood Texture Panels.

Source-blender.org Link-
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s/procedural/wood.htmI?highlight=wo00d%20texture%20panels

e Often used for

Woods and ring-shaped patterns.
e Result(s)

Intensity only.

Options
Noise Basis Shape of wave to produce bands Sine, Saw, Triangle
Wood Type Set the bands to either straight or ring-shaped, with or
without turbulence. Bands, Rings, Band Noise, Ring
Noise
Noise Type There are two methods available for the Noise function Soft, Hard
Size Dimension of the Noise table
Turbulence Turbulence of the Band Noise and Ring Noise types
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Environment Maps

Environment maps take a render of the 3D scene and apply it to a texture, to use for faking
reflections. If you want to achieve a very realistic result, raytraced reflections are a good solution.
Environment Maps are another way to create reflective surfaces, however, they are not so simple

to set up.
So why should one use Environment Maps?

e The main reason is probably that they can be much faster than raytracing reflections. In
certain situation, they need to be calculated only once, and may be reused like any ordinary
texture. You may even modify the precalculated Environment Map in an image editor.

e Environment maps can also be blurred and render even faster, because the resolution can
then be lowered. Blurring a reflection with the raytracer always adds to the render time,

sometimes quite a lot.

e Halos (a visualization type for particles) are not visible to raytraced reflections, so you need

to setup environment maps to reflect them.

e Keypoint strands (another visualization type for particles) are also not visible to raytraced

reflections, so you need to setup environment maps to reflect them.

Just as we render the light that reaches the viewing plane using the camera to define a viewpoint,
we can render the light that reaches the surface of an object (and hence, the light that might
ultimately be reflected to the camera). Blender’s environment mapping renders a cubic image
map of the scene in the six cardinal directions from any point. When the six tiles of the image are
mapped onto an object using the Reflection input coordinates, they create the visual complexity

that the eye expects to see from shiny reflections.

Options Important

For correct results, the mapping of an environment map texture must be set to Reflection (reflection

co-ordinates) in the Map Input Panel of the Material tab.

Blender allows three types of environment maps, as you can see in Img 4.19 Reflecting plane

Environment Map settings.:
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Image File

* Resolution: 512 *

Title-Img 4. 12 Reflecting plane Environment Map settings.
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s/lenvironment.html?highlight=reflecting%20plane%20environment%20map%?2 0settings

Static

The map is only calculated once during an animation or after loading a file.

Animated

The map is calculated each time a rendering takes place. This means moving Objects are displayed
correctly in mirroring surfaces.

Image File

When saved as an image file, environment maps can be loaded from disk. This option allows the
fastest rendering with environment maps, and also gives the ability to modify or use the

environment map in an external application.

When using planar reflections, if the camera is the only moving object and you have a reflecting
plane, the Empty must move too and you must use Animated environment map. If the reflecting
object is small and the Empty is in its center, the environment map can be Static, even if the object
itself rotates since the Empty does not move. If, on the other hand, the Object translates the Empty

should follow it and the environment map be of Animated type.

Specials

Clear Environment Map

Clears the currently rendered environment map from memory. This is useful to refresh a Static

environment maps and you have changed things in your scene since the last time the environment

map was rendered. Animated environment maps do this automatically on every render.

Save Environment Map

Saves the currently stored static environment map to disk as an image file. This can be loaded
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again with Load.

Clear All Environment Map
Does the same as Free Data, however, with all environment maps in the scene. This is a useful

shortcut when using recursive environment maps (when the Depth is greater than 0).

Viewpoint Object

Environment maps are created from the perspective of a specified object. Thelocation ofthisobject
willdeterminehow ‘correct’ the reflection looks, though different locations are needed for different

reflecting surfaces. Usually, an Empty is used as this object:

e For planar reflections, the object should be in a location mirrored from the camera, on the
other side of the plane of reflection (see Examples). This is the most accurate usage of

Environment maps.

o For spherical reflections, the object should be in the center of the sphere. Generally, if the
reflecting sphere’s object center point is in the center of its vertices, you can just use the name of the

actual sphere object as the Viewpoint Object

e Forirregular reflections, there is no hard and fast rule, you will probably need to experiment

and hope that the inaccuracy does not matter.

Ignore Layers

The layers are to exclude from the environment map creation. Since environment maps work by
rendering the scene from the location of the Viewpoint Object, you will need to exclude the actual
reflecting surface from the environment map, otherwise it will occlude other objects that should

be reflected on the surface itself.

Eg. If you are rendering an environment map from the center of a sphere, all the environment map
will show by default is the inside of the sphere. You will need to move the sphere to a separate
layer, then exclude that layer from the environment map render, so that the environment map will

show (and hence reflect) all the objects outside the sphere.

Resolution
The resolution of the cubic environment map render. Higher resolutions will give a sharper texture

(reflection), however, will be slower to render.

Depth
The number of recursive environment map renders. If there are multiple reflecting objects using
environment maps in the scene, some may appear solid, as they will not render each other’s

reflections. In order to show reflections within reflections, the environment maps need to be made
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multiple times, recursively, so that the effects of one environment map can be seen in another
environment map. See Examples.

Clipping Start/End

The clipping boundaries of the virtual camera when rendering the environment map. Sets the

minimum and maximum distance from the camera that will be visible in the map.

Minimum Filter Size

Use Filter Size as a minimal filter value in pixels.

Examples

In this example, an empty is used as the Viewpoint Object of the reflecting plane’s environment
map. Itis located in the specular position of the camera with respect to the reflecting surface. (This

is possible, strictly speaking, only for planar reflecting surfaces.)
Environment Map Sampling

Filter Box
Box Filter

EWA
Elliptical Weighted Average. One of the most efficient direct convolution algorithms
developed by Paul Heckbert and Ned Greene in the 1980s. For each Texel, EWA samples,
weights, and accumulates texels within an elliptical footprint and then divides the result by the
sum of the weights.

Eccentricity
Maximum eccentricity  (highergives less  blur atdistant/oblique angles, however, is

also slower)

FELINE

FELINE (Fast Elliptical Lines), uses several isotropic probes at several points along a line in
texture space to produce an anisotropic filter to reduce aliasing artifacts without considerably

increasing rendering time.
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_ Sphere on a reflecting
Planar reflection example.

surface.

Title-Img 4. 13 Reflecting plane Environment Map settings.

Source-blender.org Link-
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Probes
Maximum number of samples (higher gives less blur at distant/oblique angles, however,

is also slower)

Area Eccentricity
Maximum eccentricity (higher gives less blur at distant/oblique angles, however, is also

slower)

Filter Size
The amount of blurring applied to the texture. Higher values will blur the environment map to fake

blurry reflections.

Minimum Filter Size

Use Filter Size as a minimal filter value in pixels.

Examples

In this example, an empty is used as the Viewpoint Object of the reflecting plane’s environment
map. Itis located in the specular position of the camera with respect to the reflecting surface. (This
is possible, strictly speaking, only for planar reflecting surfaces.)

Ideally, the location of the empty would mirror the location of the camera across

the plane of the polygon onto which it is being mapped.

The following images show the effect of the Depth. The first render has depth set to 0. This means
the environment map on the plane has rendered before the environment map of the sphere, so the
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sphere’s reflection is not shown. By raising the Depth, the environment map is rendered

recursively, in order to get reflections of reflections.

Reflecting sphere on a reflecting
Reflecting sphere on a surface with multiple reflections.
reflecting surface.

Title-Img 4. 14 Reflecting sphere

Source-blender.org Link-

https://docs.blender.org/manual/en/dev/render/blender _render/textures/type s/environment.html

Limitations

Because environment maps are calculated from the exact location of the Viewpoint Object’s
object center, and not from actual reflecting surface, they can often be inaccurate, especially with
spheres. In the following image, the rectangular prism and the smaller spheres are touching the
sides of the large reflecting sphere; however, because the environment map is calculated from the
center of the sphere, the surrounding objects look artificially far away.

Title-1mg 4. 15 Inaccurate spherical reflection, the colored objects are artificially offset.

Source-blender.org Link-

https://docs.blender.org/manual/en/dev/render/blender _render/textures/type s/environment.html

Introduction to Nodes
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In addition to creating Materials as just described using all the settings on all the Materials Panels,
Blender allows you to create a Material by routing basic Materials through a set of nodes. Each
node performs some operation on the Material, changing how it will appear when applied to the
mesh, and passes it on to the next node. In this way, very complex Material appearances can be

achieved.

You should already be familiar with general Material concepts and how to create
Materials/textures using the Material menu. You should also have a general understanding of the
texture coordinate systems available in Blender (e.g. Generated, UV, etc.). Also, many aspects of
a node will be skipped here because in later sections you will see the function expanded upon.

Each section builds off the previous.

To start, the node system does not make the Material menu obsolete. Many features and Material
settings are still only accessible through the Material Panel (e.g. Ray Mirror). However, with the
advent of nodes, more complex and fantastic Materials can be created since we now have greater

control.

Just in case you are not (yet) familiar with the concepts: when you create a system of nodes, you
are describing a data-processing pipeline of sorts, where data “flows from” nodes which describe
various sources, “flows through” nodes which represent various processing and filtering stages,
and finally “flows into” nodes which represent outputs or destinations. You can connect the nodes
to one another in many different ways, and you can adjust “knobs,” or parameters, that control the
behavior of each node. This gives you a tremendous amount of creative control. And, it will very

quickly become intuitive.
Having said all that, let us begin with a normal Material.

Here we have the standard Material added to a cube mesh. We could, as we have in the past, add
color and other settings to this Material and it would certainly look nice. however, let us say we
are just not getting what we are looking for? What if we want to control the creation more tightly

or add more complexity? Here is where nodes come in.
Making this node map is accomplished by working in a Node Editor. This section covers:

e Enabling Material Nodes.

e The Node Editor, its basic controls, and working with nodes.
e The specific types of nodes available for Materials.

Accessing the Node Editor
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First, let’s enter the node editor and make sure that the node editor has the Material node button

(the sphere icon) pressed, not the composite or texture node buttons.

Enabling Node Materials

Let us take the base Material and hit the Nodes button next to the Material name in the Material
Panel or the node editor. You will see a change in the Material Panel.

Data ¥

Wire Volume Halo

Title-Img 4. 16Use Material nodes button.

Source-blender.org Link-

https://docs.blender.org/manual/en/dev/render/blender _render/materials/no des/introduction.html

What you have just done is told Blender to make the Material you were on to become the node

tree. Most of the Panels we normally find in the Material menu are now gone.

If you switch to the Compositing screen with Ctrl-Left, if you are on the default screen, you will
find a Node Editor on the top half of the screen. When you enabled Material nodes, a Material node

and an output node were automatically added to the node editor.

- pra: 1000 )

Title-1mg 4. 17Default nodes.

Source-blender.org Link-

https://docs.blender.org/manual/en/dev/render/blender _render/materials/no des/introduction.html

You can also split the 3D View in the default screen in two and change one into a Node Editor.
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It is important to note that you can add a new Material (which you can edit and change like any
other Material in the Material Panel), add an already created Material or append a Material from

another blend-file, and also use the Material that you used to create the node tree.

Title-1mg 4. 18A first Material added to the node setup.

Source-blender.org Link-

https://docs.blender.org/manual/en/dev/render/blender_render/materials/no des/introduction.html

Here, we added a new Material in the Node editor “Material.001”, and as we did, we can access

the properties of this Material in the Material’s menu.
Node Types

Gamma Node

Title-Img 4. 19A first Material added to the node setup.
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Source-blender.org Link-

https://docs.blender.org/manual/en/dev/render/cycles/nodes/types/color/gamma.html?highlight=gamma%20node

Gamma Node.

Use this node to apply a gamma correction.

Inputs
Image
Gamma
Properties

Outputs
Image

Examples

Source-blender.org Link-

Standard image input.
An exponential brightness factor.

This node has no properties.

Standard image input.

Title-1mg 4. 20 Example of Gamma node.

https://docs.blender.org/manual/en/dev/render/cycles/nodes/types/color/ga mma.html?highlight=gamma%?20node

Hue Saturation Value Node
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Title-Img 4. 21Hue Saturation Node.

Source-blender.org Link-
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ht=saturation%20node

This node applies a color transformation in the HSV color space. Called “Hue Saturation Value”

in Shader and texture context.

Inputs
Factor
Image

Properties

Hue

Saturation

Value

Outputs

Image

Controls the amount of influence the node exerts on the output image.
Standard image input.

The transformations are relative shifts. In the Shader and texture context the

following properties are available as input sockets.

Specifies how the hue rotation of the image. 360° are mapped to (0 to 1). The
hue shift of 0 (-180°) and 1 (+180°) have the same result.

A saturation of 0 removes hues from the image, resulting in a grayscale image.
A shift greater 1.0 increases saturation.

Value is the overall brightness of the image. De/Increasing values shift an
image darker/lighter.

Standard image output.
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Hue/Saturation

Tips

Hues are vice

Versa

Hue and
Saturation
work together.
Gray & White
are neutral hues

Changing the
effect over time

HSV Example

Some things to keep in mind that might help you use this node better:

A blue image, with a Hue setting at either end of the spectrum (0 or 1), is
output as yellow (recall that white, minus blue, equals yellow). A yellow

image, with a Hue setting at 0 or 1, is blue.

So, a Hue of 0.5 keeps the blues the same shade of blue, however, Saturation
can deepen or lighten the intensity of that color.

A gray image, where the RGB values are equal, has no hue. Therefore, this
node can only affect it with Value. This applies to all shades of gray, from
black to white; wherever the values are equal.

The Hue and Saturation values can be animated with a Time Node or by
animating the property.

Source-blender.org
Link-

Title-Img 4. 22 A basic example.

https://docs.blender.org/manual/en/dev/render/blender _render/materials/nodes/types/color/hue saturation.html?highligh

t=saturation%20node

Invert Node

Title-1mg 4. 23Invert Node.

Source-blender.org Link-
https://docs.blender.org/manual/en/dev/compositing/types/color/invert.html? highlight=invert%20node
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This node inverts the colors in the input image, producing a negative.

Inputs
Factor Controls the amount of influence the node exerts on the output
image.
Color Standard image input.
Properties In the compositing context, this node has the following properties.
RGB De/activation of the color channel inversion.
Alpha De/activation of the alpha channel inversion.
Outputs
Color Standard image output.
Mix Node

Title-Img 4. 24Mix Node

Source-blender.org

Link-

https://docs.blender.org/manual/en/dev/render/blender _render/materials/nodes/types/color/mix_rgb.html?highlight=mix
%?20node

This node mixes images by working on the individual and correspondingpixelsofthetwoinput
images.Called“MixRGB”in the Shader and texture context.

Inputs

Factor Controls the amount of influence the node exerts on the output
image.

Image The background image. The image size and resolution sets the
dimensions of the output image.

Image The foreground image.

Properties

Mix The Blend types could be selected in the select menu. Add,

Subtract, Multiply, Screen, Divide, Difference, Darken, Lighten,
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Overlay, Dodge, Burn, Hue, Saturation, Value, Color, Soft Light,
Linear Light

Use Alpha If activated, by clicking on the Color and Alpha icon, the Alpha
channel of the second image is used for mixing. When deactivated,
the default, the icon background is a light gray. The alpha channel
of the base image is always used.

Clamp Limit the highest color value to not exceed 1.
Output
Image Standard image output.

Examples

Below are samples of common mix modes and uses, mixing a color or checker with a mask.
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Title-Img 4. 25 Some explanation of the mixing methods above might help you use the Mix node effectively.

Source-blender.org
Link-
https://docs.blender.org/manual/en/dev/render/blender_render/materials/nodes/types/color/mix_rgb.html?highlight=mix

%?20node

Add Adding blue to blue keeps it blue, however, adding blue to red makes purple.
White already has a full amount of blue, so it stays white. Use this to shift a
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color of an image. Adding a blue tinge makes the image feel colder.

Subtract Taking Blue away from white leaves Red and Green, which combined make
Yellow. Taking Blue away from Purple Leaves Red. Use this to desaturate
an image. Taking away yellow makes an image bluer and more depressing.

Multiply Black (0.00) times anything leaves black. Anything times White (1.00) is

itself. Use this to mask out garbage, or to colorize a black-and-white image.

Hue Shows you how much of a color is in an image, ignoring all colors except

what is selected: makes a monochrome picture (style ‘Black & Hue”).

Mix Combines the two images, averaging the two.
Lighten Like bleach makes your whites whiter. Use with a mask to lighten up a little.
Difference Kinda cute in that it takes out a color. The color needed to turn Yellow into

White is Blue. Use this to compare two very similar images to see what had

been done to one to make it the other; sorta like a change log for images.
Darken With the colors set here, is like looking at the world through rose-colored
glasses.

Contrast Enhancement

Here is a small map showing the effects of two other common uses for the RGB Curve: Darken and
Contrast Enhancement. You can see the effect each curve has independently, and the combined

effect when they are mixed equally.

Title-Img 4. 26 Example node setup showing “Darken”, “Enhance Contrast” and “Mix” nodes for composition.

Source-blender.org Link-

https://docs.blender.org/manual/en/dev/render/blender render/materials/no

des/types/color/mix_rgb.html?highlight=mix%20node

As you can hopefully see, our original magic monkey was overexposed by too much light. To cure
an overexposure, you must both darken the image and enhance the contrast.

In the top RGB curve, Darken, only the right side of the curve was lowered; thus, any X input

along the bottom results in a geometrically less Y output. The Enhance Contrast RGB (S shaped)
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curve scales the output such that middle values of X change dramatically; namely, the middle
brightness scale is expanded, and thus, whiter whites and blacker blacks are output. To make this
curve, simply click on the curve and a new control point is added. Drag the point around to bend
the curve as you wish. The Mix node combines these two effects equally, and Suzanne feels much
better.

Watermark images

In the olden days, a pattern was pressed into the paper mesh as it dried, creating a mark that
identified who made the paper and where it came from. The mark was barely perceptible except
in just the right light. Probably the first form of subliminal advertising. Nowadays, people
watermark their images to identify them as personal intellectual property, for subliminal
advertising of the author or hosting service, or simply to track their image’s proliferation throughout

the web.

Blender provides a complete set of tools for you to both encode your watermark and to tell if an

Image has your watermark.

Encoding Your Watermark in an Image

First, construct your own personal watermark. You can use your name, a word, or a shape or image
not easily replicated. While neutral gray works best using the encoding method suggested, you are free
to use other colors or patterns. It can be a single pixel or a whole gradient; it is up to you. In the example
below, we are encoding the watermark in a specific location in the image using the Translate node;
this helps later because we only have to look at a specific location for the mark. We then use the
RGB to BW node to convert the image to numbers that the Map Value node can use to make the image
subliminal. In this case, it reduces the mark to one-tenth of its original intensity. The Add node adds
the corresponding pixels, make the ones containing the mark ever-so-slightly brighter.

Title-1mg 4. 27Embedding your mark in an Image using a Mark and Specific Position.

Source-blender.org Link-
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Of course, if you want people to notice your mark, do not scale it so much, or make it a
contrasting color. There are also many other ways, using other mix settings and fancier rigs. Feel

free to experiment!

Decoding an Image for your Watermark

When you see an image that you think might be yours, use the node map below to compare it to your
stock image (pre-watermarked original). In this map, the Mix node is set to Difference, and the Map
Value node amplifies any difference. The result is routed to a viewer, and you can see how the original

mark stands out, clear as a bell:

K] mokod. .| F T3S
Sirgjelmoge :

Title-Img 4. 28 Checking an image for your watermark.

Source-blender.org Link- https://docs.blender.org/manual/en/devirender/blender_render/materials/no

des/types/color/mix_rgb.html?highlight=mix%20node

Various image compression algorithms lose some of the original; the difference shows as noise.
Experiment with different compression settings and marks to see which works best for you by
having the encoding map in one scene, and the decoding map in another. Use them while
changing Blender’s image format settings, reloading the watermarked image after saving, to get
an acceptable result. In the example above, the mark was clearly visible all the way up to JPEG

compression of 50%.
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RGB Curves Node

Title-Img 4. 29RGB Curves Node.

Source-blender.org Link-

https://docs.blender.org/manual/en/dev/compositing/types/color/rgb_curves. html?highlight=rgh%20curves%20node

This node allows color corrections for each color channel and levels adjustments in the

compositing context.

Inputs

Factor Controls the amount of influence the node exerts on the output image.

Image Standard image input.

Black Level Defines the input color that is (linear) mapped to black.

White Level Defines the input color that is (linear) mapped to white.

Properties

Channel Clicking on one of the channels displays the curve for each. C (Combined
RGB), R (Red), G (Green), B (Blue), L (Luminance)

Curve A Bézier curve that varies the input levels (x-axis) to produce an output
level (y-axis).

Outputs

Image Standard image output.
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Examples

Here are some common curves you can use to achieve desired effects:

Title-Img 4. 30 From left to right: 1. Lighten 2. Negative 3. Decrease Contrast 4. Posterize.

Attribution- Source-blender.org
Link-
https://docs.blender.org/manual/en/dev/compositing/types/color/rgh_curves.html?highlight=rgh%20curves%20node

Color correction using Curves

Title-Img 4. 31Color correction with curves.

Source-blender.org Link-

https://docs.blender.org/manual/en/dev/compositing/types/color/rgb_curves. html?highlight=rgb%20curves%20node

In this example, the image has way too much red in it, so we run it through an RGB node and
reduce the Red channel by about half.

We added a middle dot, so we could make the line into a sideways exponential curve. This kind

of curve evens out the amount of a color in an image as it reaches saturation. Also, read on for
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examples of the Darken and Contrast Enhancement curves.
Color correction using Black/White Levels

RGB PR fex

Title-1mg 4. 32Color correction with Black/White Levels.
Source-blender.org

Link-https://docs.blender.org/manual/en/dev/compositing/types/color/rgb_curves.

htmI?highlight=rgb%20curves%20node

Manually adjusting the RGB curves for color correction can be difficult. Another option for color

correction is to use the Black and White Levels instead, which really might be their main purpose.

In this example, the White Level is set to the color of a bright spot of the sand in the background,
and the Black Level to the color in the center of the fish’s eye. To do this efficiently it is best to
bring up the UV/Image editor showing the original input image. You can thenusethelevels’ color
picker to easily choose the appropriate colors from the input image, zooming into pixel level if

necessary. The result can be fine-tuned with the RGB curves like in the previous example.

The curve for C is used to compensate for the increased contrast that is a side-effect of setting
Black and White Levels.
Effects
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Title-Img 4. 33Changing colors.

Source-blender.org Link-

https://docs.blender.org/manual/en/dev/compositing/types/color/rgb_curves. html?highlight=rgh%20curves%20node

Curves and Black/White Levels can also be used to completely change the colors of an image.

Note that e.g. setting Black Level to red and White Level to blue does not simply substitute black
with red and white with blue as the example image might suggest. Levels do color scaling, not

substitution, however, depending on the settings they can result in the described color substitution.

(What really happens when setting Black Level to pure red and White Level to pure blue is that

the red channel gets inverted, green gets reduced to zero and blue remains unchanged.)

Because of this, the results of setting arbitrary Black/White Levels or RGB curves is hard to

predict, however, can be fun to play with.
Unit summary
In this Unit, we have learnt what is Texture and how to

e map those textures onto your 3D Objects

e use texture Panels and assign textures with various mapping types

e create complex shading texture using blending techniques both with colors and
maps making it more procedural and along with environmental mapping with

reflection and refractions.

After learning of this Unit, you can download the Open Source Software available on

the internet for free of cost to practice the possibilities of creating Materials and

Texturing.

Assignment
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e Texture the 3D Scene appropriately with good high-resolution maps available online, make it

more personalized the way you would decorate your room.

e Usethesekeywords “bedroom designs”, “bedroom furniture” onwww.google.comtocollectthe

referenceimagetobuild your shadingscene.
Assessment
e Explain the process of assigning a Texture to 3D Object
e Write a note on Mapping and Warping
e Listand Explain the projection types in Texture map
e Differentiate Bump and Normal Maps
e Write a note on Displacement Map
e List any five types of Procedural Textures.
o Name the different types of Node in Blender

e Decode an image for your Watermark

Resources

While studying this course, you can browse the following
internet links for video tutorials and to download the relevant texture maps to assign on the objects
that you have created and use the same for your assignments.

Links to Download Open Projects

The iconic Blender Institute Open Movies. Featuring all the production files, assets, artwork, and

never-seen-before content.
https://cloud.blender.org/open-projects

e wiki.blender.org

e archive.org

e www.blender.org

e docs.blender.org
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DMA-201
3D Animation

Block — 111: 3D Animation & Rigging (Practical)
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Unit-1 Introduction to Rigging

Introduction

Rigging is a process done prior to the Animation. Rigging is a process of taking a static
mesh, creating an internal digital skeleton, creating a relationship between the mesh and the
skeleton (known as skinning, enveloping or binding) and adding a set of controls that the animator
can use to push and pull the character around as if he/she is a puppeteer.

Most commonly, characters are Rigged before they are animated because if a character
model doesn't have a Rig, they can't be deformed and moved around. Process of Rigging also
involves Rigging character or creatures and Objects like car, plane, or a robot.

In this Unit, you will learn about the process of Rigging and how it is important in designing

3D animation.

Outcomes

Upon completion of this unit you will be able to

e Explain the Usage of Constraints

e Plan for Adding or Removing Constraints

e Describe the Functions of Header

e Explain the term Header, Target, Space, Influence
e Create IK Constraint

o Create Spline IK Constraint

Terminology

Constraints Constraints are a fantastic way to add
. sophistication and complexity to a Rig

Header A Header sits at the top of every Constraint.

Target The Target field lets you link the Constraint to a Target Object of
. your choosing

Space The frame of reference is called the “space” of the Constraint

World space Transformation, Rotation and Scale are oriented to the world axes

Local Space Transformation, Rotation and  Scale are oriented to

. the parent Object axe
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Influence

IK Solver Constraint

Spline IK Constraint

Stretch to Constraint

Action Constraint

Child of Constraint

. The influence slider determines how much the Constraint will affect

the constrained Object

The Inverse Kinematics Constraint implements the inverse

. kinematics armature posing technique

: The Spline IK Constraint aligns a chain of Bones along a curve

The Stretch To Constraint causes its owner to rotate and scale its Y

: axis towards its Target.

It allows you to control an Action using the transformations of

. another Object.

Child of Constraint is the Constraint version of the standard

. parent/children relationship

Working with Constraints

Constraints control the behavior of one Object with data from another. It can make the eyes of a
tennis player track a tennis ball bouncing across the court. It allows the wheels on a bus to all rotate
together. It helps a dinosaur’s legs bend at the knee automatically. It makes it easy for a hand to
grip the hilt of a sword and the sword to swing with the hand.

Constraints, in Blender, work with Object and Bone.

Object Constraint

Title-Img 1. 1 Object Constraints

Source-blender.org

Link :https://docs.blender.org/manual/en/dev/rigging/constraints/introduction.htmi

Bone Constraint

Title-Img 1. 2 Bone Constraints

Source-blender.org

Link https://docs.blender.org/manual/en/dev/rigging/constraints/introduction.html

Constraints work in combination with each other to form a Constraint Stack.
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Title-Img 1. 3 Constraint Stack
Source-blender.org
Link : https://docs.blender.org/manual/en/dev/rigging/constraints/introduction.htmi

The Constraint Stack is evaluated from top to bottom.

Constraints are a fantastic way to add sophistication and complexity to a Rig. However, be careful
not to rush in too quickly, piling up Constraint upon Constraint until you lose all sense of how they

interact with each other.

Adding/Removing a Constraint

¢® Camera Solver
& Follow Track
(6% Object Solver

Copy Location

Copy Rotation

¥ Copy Scale

Copy Transforms
Limit Distance
Limit Location
Limit Rotation
Limit Scale
Maintain Volume

Transformation

Clamp To

Damped Track

Inverse Kinematics

Locked Track
Spline IK
Stretch To

Track To

Title-Img 1. 4 Adding/Removing Constraint

Source-blender.org

Link:https://docs.blender.org/manual/en/dev/rigging/constraints/interface/adding_

removing.html

To add a Constraint in the Constraints Panel:

Action
Child Of
Floor
Follow Path
Pivot

Rigid Body Joint

Shrinkwrap

. Step 1: Click on the “Add Constraint” menu. (Refer Img 1.4)
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To add a Constraint in 3D View:

o Step 2: Select the Object you would like to constrain.

o Step 3: Press Ctrl-Shift-C and choose a Constraint from the pop-up menu.

If the chosen Constraint needs a Target, Blender will add an empty automatically as the Target

and position it at the center of the constrained Object.

To add a Constraint in 3D View and simultaneously give it a Target:
o Step 1: Select the Target first and then shift-select the Object you would like to constrain.

o Step 2: Press Ctrl-Shift-C and choose a Constraint from the pop-up menu.
To remove a Constraint:

o Step 1: Click on the “X” button in the header.

To remove all Constraints from all selected Object(s):
. Step 2: Click Object » Constraints » Clear Object Constraints in 3D View Header.
J Step 3: Or Pose > Constraints > Clear Pose Constraints (for Bone Constraints).

o Step 4: Or, press Ctrl-Alt-C.

Header

Every Constraint has a header. The interface elements of the header are explained below using a
Copy Location Constraint as an example. (Refer Img 1.5)

WorldSpace 5| €3 WorldSpace

Title-Img 1. 2 A Header sits at the top of every Constraint.

Source-blender.org

Link : https://docs.blender.org/manual/en/dev/rigging/constraints/interface/header.
Expansion Arrow (pointing down or Right)

Show or Hide the settings of the Constraint. Tidy up the Constraint stack by hiding Constraints
that do not currently need attention. Constraints will continue to affect the scene even when hidden.
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e “Copy Location” (first occurrence)

The type of Constraint is determined when a new Constraint is created to help in the process
of Rigging.

o “Copy Location” (second occurrence)

Give the Constraint a meaningful name in this field, something that describes its intent.
Meaningful names help to understand what each Constraint is supposedto do.

The red background is a warning that the Constraint is not yet functional. The background will
turn grey when the Constraint is functioning. When this Copy Location Constraint has a valid

Target in the “Target Field” it will turn grey and begin to function.

e Eyeball (open or closed)

Enable or Disable (Mute/Unmute) the Constraint. Disabling a Constraint will stop its
effect on the scene.

Disabling a Constraint is useful for turning off a Constraint without losing all its settings. Disabling
means you can enable the Constraint later with the settings intact. Disabling is like setting the
influence slider to 0.0.

e Up/Down Arrows

Move a Constraint up or down in the Constraint stack. Since the stack is evaluated from
top to bottom, moving a Constraint in the stack can significantly affect the final outcome
of the stack.

If there is only one Constraint in the stack, the arrows will not be drawn. If the Constraint
is at the top of the stack, only the down arrow will be drawn. If the Constraint is at the
bottom of the stack, only the up arrow will be drawn.

Delete the Constraint from the stack. The settings will be lost. The Constraint will no longer
affect the final outcome of the stack.

Target

The Target field lets you link the Constraint to a Target Object of your choosing. This link
provides data to the Constraint so that it can begin to function. For example, the Copy Location
Constraint needs location data to function. Fill in the Target field, and the Copy Location

Constraint will begin to use location data from the Target Object.
The Target field must be filled in for the Constraint to function. (Refer Img 1.6)
By default, the Target will use the Object Center as the Target point.

o Ifthe Target field links to a Mesh or Lattice Object, a Vertex Group field will appear. Enter
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the name of a vertex group and the Constraint will Target the median point of this vertex group
instead of the Object center.

o If the Target field links to an Armature, a Bone fieldwill appear along with a Head or Tail
slider. Enter the name of a Bone and the Constraint will Target the Bone instead of the entire
armature Object center. Slide the slider and the Constraint will Target the head, the tail or

somewhere in-between.

World Space vy | €| World Space

Title-Img 1. 3 Target Field.
Source-blender.org

Link-https://docs.blender.org/manual/en/dev/rigging/constraints/inter face/common.html

Space

Constraints need a frame of reference in order to function. This frame of reference is called the
“space” of the Constraint. Choosing one space vs. another will change this frame of reference

and substantially alter the behaviour of a Constraint. (Refer Img 1.7)

To understand how changing the space will change the behaviour of the Constraint, consider
experimenting with two empties. Makesure they display as arrows so that you can see the local
axes for each empty. Make sure to size one empty a little larger than the other so that they are
both always visible even if directly on top of each other. Then add a Constraint to one empty that
Targets the other and experiment thoroughly by moving, rotating and scaling the Target in many
different ways.
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Title-Img 1. 4. Space
Source-blender.org

Link:https://docs.blender.org/manual/en/dev/rigging/constraints/interface/c ommon.html

This Constraint is set to use World Space as the frame of referencefor both its Target Space and
its Owner Space.

Influence

The influence slider determines how much the Constraint willaffect the constrained Object.

WorldSpace v | €2 World Space

————

Title-Img 1. 5 Influence

Source-blender.org

Linkhttps://docs.blender.org/manual/en/dev/rigging/constraints/interface/c ommon.html

¢ An influence of 0.0 will have no effect.
o An influence of 1.0 will have the full effect.

o Values between (0.0 and 1.0), will have a partial effect, however, be careful. These partial

effectscan be difficult to control, especially as the Constraint stack grows in complexity.

The influence value is animatable, allowing Constraints to be turned off, or partially on as
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needed. (Refer Img 1.8)
IK Solver Constraint

The Inverse Kinematics Constraint implements the inverse kinematics armature posing
technique. Hence, it is only available for Bones. (Refer Img 1.9)

e To quickly create an IK Constraint with a Target, select a Bone in pose mode, and press Shift-
.

Options

v Use Tail

v’ Stretch

Title-Img 1. 6Inverse Kinematics panel.
Source-blender.org

Link-https://docs.blender.org/manual/en/dev/rigging/constraints/tracking/ik_solver.html

e Target
Must be an armature.

e Bone
A Bone in the armature.

e Pole Target
Obiject for pole rotation.

e lterations
Maximum number of solving iterations.

e Chain Length
How many Bones are included in the IK effect? Set to O toinclude all Bones.

e Use Tail
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Include Bone’s tail as last element in chain.

e Stretch
Enable IK stretching.

e Weight
e Position

e For Tree-IK: Weight of position control for thisTarget.

e Rotation
e Chain follow rotation of Target.

e Target
Disable for Target-less IK.

e Rotation
Chain follows rotation of Target.

Spline IK Constraint

The Spline IK Constraint aligns a chain of Bones along a curve. By leveraging the ease and
flexibility of achieving aesthetically pleasing shapes offered by curves and the predictability and
well- integrated control offered by Bones, Spline IK is an invaluable tool in the Riggers’ toolbox.
It is particularly well suited for Rigging flexible body parts such as tails, tentacles, and spines,

as well as inorganic items such as ropes. (Refer Img 1.10)

To set up Spline IK, it is necessary to have a chain of connected Bones and a curve to constrain

these Bones to:

o Step 1: With the last Bone in the chain selected, add a Spline IK Constraint from the Bone

Constraints tab in the Properties Editor.

e Step 2: Set the ‘Chain Length’ setting to the number of Bones in the chain (starting from and

including the selected Bone) that should be influenced by the curve.

o Step 3: Finally, set Target to the curve that should control the curve.

Options
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v Y Stretch

v Use Curve Radius

None

Title-Img 1. 7. Spline IK panel.
Source-blender.org

Link :https://docs.blender.org/manual/en/dev/rigging/constraints/tracking/s pline_ik.html

e Target
The type of the Target curve.

e Spline Fitting
e Chain Length

How many Bones are included in the chain.
e Even Division
Ignore the relative length of the Bones when fitting to thecurve.

e Chain Offset
Offset the entire chain relative to the root joint.

e Chain Scaling
e Y stretch

Stretch the Y axis of the Bones to fit the curve.
e XZ Scale Mode
o None

Do not scale the X and X axes.
o Bone Original

Use the original scaling of the Bones.

o Volume Preservation
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Scale of the X and Z axes is the inverse of the Yscale.
e Use Curve Radius

Average radius of the endpoints is used to tweak the X andZ scaling of the Bones, on top of
the X and Z scale mode.

Stretch to Constraint

The Stretch To Constraint causes its owner to rotate and scale itsY axis towards its Target. So,
it has the same tracking behavior as the Track To Constraint. However, it assumes that the Y
axis willbe the tracking and stretching axis, and does not give you the option of using a different
one.

It also optionally has some raw volumetric features, so the owner can squash down as the Target
moves closer, or thin out as the Target moves farther away. Note that it is not the real volume of
the owner which is thus preserved, however, rather the virtual one defined by its scale values.
Hence, this feature works evenwith non-volumetric Objects, like empties, 2D meshes or

surfaces,and curves.

With Bones, the “volumetric” variation scales them along their own local axes (remember that
the local Y axis of a Bone is aligned with it, from root to tip). (Refer Img 1.11)

Options

None

Title-Img 1. 8 Stretch To panel.
Source-blender.org

Link: https://docs.blender.org/manual/en/dev/rigging/constraints/track ing/stretch_to.html

e Target (Mesh Object Type)
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This Constraint uses one Target, and is not functional (redstate) when it has none.

e Vertex Group
When Target is a mesh, a new field is display where avertex group can be selected.

e Target (Armature Object Type)
This Constraint uses one Target, and is not functional (redstate) when it has none.

e Bone

When Target is an armature, a new field for a Bone isdisplayed.

e Head/Tail

When using a Bone Target, you can choose where alongthis Bone the Target point lies.
e Rest Length

This number button sets the rest distance between theowner and its Target, i.e. the distance at
which there is no deformation (stretching) of the owner.

e Reset

When clicked, this small button will recalculate the Rest Length value, so that it corresponds to
the actual distance between the owner and its Target (i.e. the distance before this Constraint is
applied).

e Volume

These buttons control which of the X and/or Z axes should be affected (scaled up/down) to
preserve the virtual volume while stretching along the Y axis. If you enable the none button, the
volumetric features are disabled.

e Plane

These buttons are equivalent to the Up ones of the TrackTo Constraint: they control which of
the X or Z axes should be maintained (as much as possible) aligned with the global Z axis, while
tracking the Target with the Y axis.

Relationship

Action Constraint

The Action Constraint is powerful. It allows you to control anAction using the transformations
of another Object.

The underlying idea of the Action Constraint is very similar to the one behind the Drivers, except
that the former uses a whole action (i.e. a bunch a F-Curves of the same type), while the latter
controls a single F-curve of their “owner”

Note that even if the Constraint accepts the Mesh action type, only the Object, Pose and
Constraint types are really working, as Constraints can only affect Objects’ or Bones’ transform

properties, and not meshes’ shapes. Also, note that only the Object transformation (location,
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rotation, scale) is affected by the action, if the action contains keyframes for other properties they
are ignored, as Constraints do not influence those.

As an example, let us assume you have defined an Object action (it can be assigned to any Object, or even
no Obiject at all), and have mapped it on your owner through an Action Constraint, so that moving the
Target in the (0.0 to 2.0) range along its X-Axis maps the action content on the owner in the (0 to 100)
frame range. This will mean that when the Target’s X property is 0.0 the owner will be as if in frame 0 of
the linked action; with the Target’s X property at 1.0 the owner will be as if in frame 50 of thelinked
action, etc. (Refer Img 1.12)

Options

X Location

World Space

Title-Img 1. 9 Action panel.
Source-blender.org

Linkhttps://docs.blender.org/manual/en/dev/rigging/constraints/relationship/action.html
e Target
This Constraint uses one Target, and is not functional (redstate) when it has none.

e Bone

When Target is an armature Object, use this field to selectthe Target Bone.
e Transform Channel

This selector controls which transform property (location, rotation or scale along/around one of
its axes) from the Target to use as “action driver”.

e Target Space
This Constraint allows you to choose in which space toevaluate its Target’s transform properties.

e ToAction
Select the name of the action you want to use.

e Object Action
Bones only, when enabled, this option will make the constrained Bone use the “Object” part of the
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linked action, instead of the “same-named pose” part. This allowsyou to apply the action of an
Object to a Bone.

e Target Range Min/Max
The lower and upper bounds of the driving transform property value.

e Action Range Start/End
The starting and ending frames of the action to be mapped.

Child of Constraint

Child of Constraint is the Constraint version of the standard parent/children relationship
between Obijects (the one establishedthrough the Ctrl-P shortcut, in 3D Views).
Parenting with a Constraint has several advantages and enhancements, compared to the traditional method:

(Refer Img 1.13)
You can have several different parents for the sameObject (weighting their respective influence

with the Influence slider).
As with any Constraint, you can key (i.e. animate)its Influence setting. This allows the Object
which has a Child of Constraint upon it to change over time which Target Object will be

considered theparent, and therefore have influence over the Child of Constraint Object.

Options

Child Of <

Ifu:“ pty .)(

Title-Img 1. 10 Child Of panel
Source-blender.org
Link- https://docs.blender.org/manual/en/dev/rigging/constraints/relationship/child_of.html

e Target

The Target Object that this Object will act as a child of. ThisConstraint uses one Target, and is not
functional (red state)when it has none. If Target is an armature or a mesh, a newname field appears
where a name of a Bone or a Vertex Group can be selected.

e Location X,VY,Z

Each of these buttons will make the parent affect or not affect the location along the corresponding
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axis.

e Rotation X,VY,Z

Each of these buttons will make the parent affect or not affect the rotation around the corresponding
axis.

e ScaleX,Y,Z

Each of these buttons will make the parent affect or not affect the scale along the corresponding
axis.

e Set Inverse

By default, when you parent your owner to your Target,the Target becomes the origin of the
owner’s space. This means that the location, rotation and scale of the owner are offset by the same
properties of the Target. In other words, the owner is transformed when you parent it to your
Target. This might not be desired! So, if you want to restore your owner to its before-parenting
state, click on the Set Inverse button.

e Clear Inverse

This button reverses (cancels) the effects of the above one, restoring the owner/child to its default
state regarding its Target/parent.

Technical Note
If you use this Constraint with all channels on, it will use a straight matrix multiplication for the
parent relationship, not decomposing the parent matrix into loc /rot/size. This ensures any

transformation correctly gets applied, also for combinations ofrotated and non-uniform scaled
parents.

Unit summary
In this Unit, you have learnt what is Rigging and how to

e Use the Constraints

e Do Adding or Removing Constraints

e Describe the Functions of Header

e Explain the term Header, Target, Space, Influence

o Edit the Properties of the Header panel, working on Parentand Child relationship

e Create IK Constraint

e Create Spline IK Constraint
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After learning this Unit, you can download the Open Source Software available on the internet

for free of cost to practice the possibilities of creating Rig.

Assignment

e Create a basic Mechanical Rig referring to the YouTube video link

Assessment

e Define Constraints.

e State the Differentiate between Local space and World space.

e Write notes on Adding and Deleting Constraints withexamples.
e Describe the Process of making a Parent Constraint.

e Write a brief note on the uses of Header.

e Explain Parent and Child Constraint.

e Write down the process of Creating Spline IK.

e Define Stretch Constraint

Fill in the Blanks

1. is a good first Constraint to explore in thebeginning.

2. sits at the top of every Constraint.

3. Enables or Disables (Mute/Unmute) theConstraint.

4, allows you to control an Action using thetransformations of
another Object.

5. The slider determines how much theConstraint will affect the

constrained Object.

Resources

While studying this Unit, you can browse the internet links for online video tutorials and several
books and training DVDs available in the Blender Store and on the Blender Cloud.

e wiki.blender.org

e archive.org

e www.blender.org

e docs.blender.org
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Unit-2 Introduction to Working withArmature

Introduction

An Armature in Blender is similar to the Armature of a real skeleton. Just like a real skeleton,
an Armature can consist ofmany Bones. These Bones can be moved around and anythingthat
they are attached to or associated with will move and deform in a similar way. An “Armature” is
a type of Object used for rigging. Armature Object borrows many ideas from real life skeletons.

As Armatures are designed to be posed, either for a static oranimated scene, they have a specific
state, called “rest position”. This is the Armature’s default “shape”, the default
position/rotation/scale of its Bones, as set in Edit mode.

In Edit mode, you will always see your Armature in rest position, whereas in Object and Pose
mode, you usually get the current “pose” of the Armature (unless you enable the Rest Position
button of the Armature panel).

This unit will describe how you can work with Armatures in Blender.
Outcomes
Upon completion of this unit you will be able to:

e Explain the Usage of Bones

e List the types of Armature structure

e Manage to Edit an Armature

e Arrange Linking Objects to Bone

e Set up Mesh and Armature using Skinning

e Create Poses for the Rigged Character
Terminology

Armatures - Armature is the Object type used for rigging and it borrows many
ideas from real life skeletons

Roll . Activating Axes checkbox on the will show localaxes for each Bone’s
tip.

Bones Influence . Basically, a Bone controls geometry when

vertices “follow” the Bone
Armature Layers : Each Armature has 32 “Armature layers” which allow you to organize

your Armature by “regrouping” sets of Bones into layers.

Octahedral Bone : This is the default visualization, well suited formost of editing tasks.
Stick Bone . This is the simplest and most non-intrusivevisualization.
B-Bone Bone . This visualization shows the curves of “smooth” multi-segmented

Bones; see the Bendy Bones for details.

Envelope Bone . This visualization materializes the Bone deformation
influence.
Pose Library : The Pose Library panel is used to save, apply,and manage different
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Armature poses.

Ghost . In traditional cartoon creation animators use tracing paper, to see
several frames preceding the one they are working.

Shadow . Controls how objects using this Material castand receive shadows.

Structure . Armatures mimic real skeletons. They are made from Bones, which are
(by default) rigid elements.

Chains of Bones . Bone can be the parent of several children, andhence be part of
several chains at the same
time.

Working with Armature
First, let us try to add the default Armature in Blender.
e Step 1: Open a default scene.
o Step 2: Delete all Objects in the scene.
o Step 3: Make sure the cursor is in the world originwith Shift-C.
e Step 4: Press Numpadl to see the world in Frontview.
e Step 5: Add a Single Bone (Add » Armature > SingleBone).
e Step 6: Press Numpad Delete to see the Armatureat maximum zoom.

User Persp

(1) Amature

Title-Img 2. 1 The default Armature.
Source- blender.org

Link- https://docs.blender.org/manual/en/dev/rigging/armatures/intro duction.html

Armature Object
As you can see, an Armature is like any other Object type inBlender:

e It has a center, a position, a rotation and a scale factor.

227


https://docs.blender.org/manual/en/dev/rigging/armatures/introduction.html
https://docs.blender.org/manual/en/dev/rigging/armatures/introduction.html

« It has an Object Data data-block that can be edited in Edit Mode.

« It can be linked to other scenes, and the same Armature data can be reused on multiple
Objects.

« All animation you do in Object Mode is only working on thewhole Object, not the
Armature’s Bones (use the PoseMode to do this).

o As Armatures are designed to be posed, either for a static or animated scene, they have
a specific state, called “rest position”. This is the Armature’s default “shape”, the
default position/rotation/scale of its Bones, as set in Edit Mode.

« In Edit Mode, you will always see your Armature in rest position, whereas in Object
Mode and Pose Mode, you usually get the current “pose” of the Armature (unless you

enable the Rest Position button of the Armature panel).

Bones Structure

Title-Img 2. 2 The elements of a Bone.
Source- blender.org
Link- https://docs.blender.org/manual/en/dev/rigging/armatures/bones/stru cture.html

They have three elements:

1. “Start joint” named Root or Head,
2. “Body” itself,

3. “End joint” named Tip or Tail.

With the default Armature in edit-mode, you can select the root and the tip, and move them as you
do with mesh vertices. Both root and tip (the “joints™) define the Bone by their respective position.

They also have a radius property, only useful for the envelope deformation method.
Roll

Activating Axes checkbox on the Armature tab » Display panel, will show local axes for each
Bone’s tip. The Y axis is always aligned along the Bone, oriented from root to tip. So, this is the
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“roll” axis of the Bones.

Bones Influence

: Tip radius

Influence area
BN UCTILE aiea

Root radius

Title-Img 2. 3 A Bone in Envelope visualization, in Edit Mode.
Source-blender.org

Link- https://docs.blender.org/manual/en/dev/rigging/armatures/bones/stru cture.html

Basically, a Bone controls geometry when vertices “follow” the Bone. This is like how the
muscles and skin of your finger follow your finger-Bone when you move a finger.

To do this, you must define the strength of influences a Bone has on a certain vertex.

The simplest way is to have each Bone affecting those parts of the geometry that are within a given
range from it. This is called the Envelope Technique, because each Bone can control only the
geometry “enveloped” by its own influence area.

If a Bone is visualized as Envelope, in Edit Mode and in Pose Mode you can see the area of
influence, which depends on:

e The Distance Property and
e The Root’s Radius and the Tip’s Radius.

Title-Img 2. 4 Our Armature in Envelope visualization, in Pose Mode.
Source- blender.org

Linkhttps://docs.blender.org/manual/en/dev/rigging/armatures/bones/st ructure.html
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Selection of Bones

You can select and edit Bones of Armatures in Edit Mode and in Pose Mode. Here, we will see
how to select Bones in Edit Mode. Selecting Bones in Pose Mode is similar to selecting in Edit
Mode with a few specific differences that will be detailed in the posing part.

Similar to vertices/edges selection in meshes, there are two ways to select whole Bones in Edit
Mode:

e Directly, by selecting the Bone’s body.
o Selecting both of its joints (roots and tip).
This is an important point to understand, because selecting Bones’joints only might lead to non-
obvious behavior, with respect to which Bone you actually select.
Selecting Bone Joints
To select Bones’ joints, you have the standard selectionmethods.

e Inverse selection

As stated above, you must remember that these selection tools are for Bones’ joints only, not the
Bones’ bodies.

For example, the Inverse selection option Ctrl-1 inverts the selection of Bones’ joints, not of
Bones.

Remember that a Bone is selected only if both its joints areselected. So, when the selection status
of Bones’ joints is inverted, a new set of Bones is selected.

Title-Img 2. 5 Two Bones selected.
Source- blender.org

Link- https://docs.blender.org/manual/en/dev/rigging/armatures/bones/se lecting.html
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Title-Img 2. 6 The result of the inverse selection Ctrl-1 the Bones
joints selection has been inverted, and not the Bones selection.
Source- blender.org

Linkhttps://docs.blender.org/manual/en/dev/rigging/armatures/bones/se lecting.html

Selecting connected Bone Joints

Another Example: when you select the root of a Boneconnected to its parent, you also implicitly
select the tip ofits parent (and vice versa).

Selecting Bones

By RMB clicking on a Bone’s body, you will select it (and hence you will implicitly select its root

and tip).
Using Shift-RMB, you can add to/remove from the selection.
You also have some Advanced Selection options, based on their relations.

You can select at once all the Bones in the chain which the active (last selected) Bone belongs to

by using the linked selection tool, L.

Linked Bones selection

Title-Img 2. 7 A single selected Bone.
Source- blender.org
Link:https://docs.blender.org/manual/en/dev/rigging/armatures/bones/sele cting.html
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4

Title-Img 2. 8 Its whole chain selected with L.
Source- blender.org

Link- https://docs.blender.org/manual/en/dev/rigging/armatures/bone s/selecting.html

e Mirror Shift-Ctrl-M
e Flip the selection from one side to another.
e Pick Shortest Path Ctrl-RMB
e Selects the path from the active Bone to the Boneunder the mouse
e Deselecting connected Bones
There is a subtlety regarding connected Bones.

When you have several connected Bones selected, if you deselect one Bone, its tip will be deselected,
however, not its root, if it is also the tip of another selected Bone.

To understand this, look at Img 2.9 Bone deselection in a selected chain.

Bone deselection in a selected chain.

Bone.001 _lfP0e.002

Title-Img 2. 9 A selected chain.
Source- blender.org

Link- https://docs.blender.org/manual/en/dev/rigging/armatures/bones/sele cting.html
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Title-Img 2. 10 Two selected Bones.

Source- blender.org

Link- https://docs.blender.org/manual/en/dev/rigging/armatures/bones/sele cting.html

o After Shift-RMB -clicking “Bone.003”:
e “Bone.003” ‘s tip (which is same as “Bone.004” ‘s root) is deselected.

e “Bone” is “Bone.003” ‘s parent. Therefore “Bone.003” ‘s root is same as the tip of
“Bone”. Since “Bone” is still selected, its tip is selected. Thus, the root of “Bone.003”

remains selected.
e Mouse Clicks
e Reference
« Mode: Edit Mode
e Hotkey: Ctrl-LMB

If at least one Bone is selected, Ctrl-LMB -clicking adds a new Bone.
About the new Bone’s tip:

After you Ctrl-LMB -clicked it becomes the Active Element in the Armature,

It appears to be right where you clicked, however, (As in mesh editing) it will be on the plane

parallel to the viewand passing through the 3D cursor.

The position of the Root and the parenting of the newBone depends on the Active Element.

Active Element

If the Active Element is a Bone
The new Bone’s Root is placed on the Active Bone’s tip

The new Bone is parented and connected to the Active Bone (check the Outliner in Img 2.11 Ctrl-

clicking when the Active Element is a Bone.).
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Bone.001

Title-Img 2. 11 Ctrl-clicking when the Active Element is a Bone.
Source- blender.org

Linkhttps://docs.blender.org/manual/en/dev/rigging/armatures/bones/editi ng/bones.html

If the Active Elementis a Tip

The new Bone’s root is placed on the Active Tip

The new Bone is parented and connected to the Bone owning the Active Tip (check the Outliner

in Img 2.12 Ctrl- clicking when the Active Element is a tip.).

Title-Img 2. 12 Ctrl-clicking when the Active Element is a tip.
Source- blender.org
Link- https://docs.blender.org/manual/en/dev/rigging/armatures/bones/editi ng/bones.html

If the Active Element is a Disconnected Root:

The new Bone’s root is placed on the Active Root
The new Bone is not parented to the Bone owning the Active Root (check the Outliner in Img 2.13 Ctrl-
clicking when the Active Element is a disconnected root.).

And hence the new Bone will not be connected to any Bone
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Title-Img 2. 13 Ctrl-clicking when the Active Element is a disconnected root.
Source-blender.org

Link-https://docs.blender.org/manual/en/dev/rigging/armatures/bone s/editing/bones.html

If the Active Element is a Connected Root:

The new Bone’s root is placed on the Active Root

The new Bone is parented and connected to the parent of the Bone owning the Active Root (check

the Outliner in Img 2.14 Ctrl-clicking when the Active Element is a connected root.).

This should be obvious because if the Active Element is a connected root then the Active Element

is also the tip of the parent Bone, so it is the same as the second case.

As the tip of the new Bone becomes the Active Element, you can repeat these Ctrl-RMB several

times, to consecutively add several Bones to the end of the same chain.

Selected

Title-Img 2. 14 Ctrl-clicking when the Active Element is a connected root.
Source-blender.org

Link-https://docs.blender.org/manual/en/dev/rigging/armatures/bones/editi ng/bones.html

Delete Selected Bone(s)

X
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Hotkey:

This tool deletes selected Bones, selected joints are ignored.

If you delete a Bone in a chain, its child(ren) will be automatically re-parented to its own

parent, however, not connected, to avoid deforming the whole Armature.

Merge Bones

Hotkey: Alt-M

You can merge together several selected Bones, as long as they form a chain. Each sub-chain
formed by the selected Bones will give one Bone, whose root will be the root ofthe root Bone,

and whose tip will be the tip of the tip Bone.

Subdivide Bones

You can subdivide Bones, to get two or more Bones where there was just one Bone. The tool will
subdivide all selected Bones, preserving the existing relationships: the Bones created from a

subdivision always form a connected chain of Bones.

Naming Conventions

Naming conventions in Blender are not only useful for you in finding the right Bone, however,

also to tell Blenderwhen any two of them are counterparts.

In case your Armature can be mirrored in half (i.e. it is bilaterally symmetrical), it is worthwhile
to stick to a left/right naming convention. This will enable you to use some tools that will

probably save your time and effort(like the X-Axis Mirror editing tool we saw above...).

‘ Neck

Shoulder R — Shoulder L

" AA ¢ -
f 4

Title-Img 2. 15 An example of left/right Bone naming in a simple rig.
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Source-blender.org

Link-https://docs.blender.org/manual/en/dev/rigging/armatures/bones/editi ng/naming.htmil

Structure

Armatures mimic real skeletons. They are made out of Bones, which are (by default) rigid
elements. However, you have more possibilities than with real skeletons: In addition to the
“natural” rotation of Bones, you can also translate and even scale them! And your Bones do not
have to be connected to each other; they can be completely free if you want. However, the most

natural and useful setups imply that some Bones are related to others, forming so-called “chains of

Bones”.

Title-Img 2. 16 Example of a very basic Armature.
Source-

Link- http://blender-manual- i18n.readthedocs.io/ja/latest/rigging/armatures/structure.html

Chains of Bones

The Bones inside an Armature can be completely independent from each other (i.e. the
modification of one Bone does not affect the others). However, this is not oftena useful set up: To
create a leg, all Bones “after” the thigh Bone should move “with” it in a well-coordinated manner.
This is exactly what happens in Armatures by parenting a Bone to the next one in the limb, you

create a “chains of Bones”. These chains can be ramified. For example, five fingers attached to a

single “hand” Bone.
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Skinning
In Blender, you have two main skinning types:

1. You can Parent/Constrain Objects to Bones - then, when you transform the Bones in
Pose Mode, their “children” Objects are also transformed, exactly as witha standard
parent/children relationship... The “children” are never deformed when using this method.

2. You can Using the Armature Modifier on entire Mesh, and then, some parts of this Object
to some Bonesinside this Armature. This is the more complex and powerful method, and
the only way to really deform the geometry of the Object, i.e. to modify its vertices/control
points relative positions.

Armature Deform Parent
Hotkey: Ctrl-P

Armature Deform Parenting is a way of creating and setting up an Armature Modifier.
To use Armature Deform Parenting, you must
e Step 1: First select all the child Objects that will beinfluenced by the Armature
e Step 2: Lastly, select the Armature Object itself.
e Step 3: Once all the child Objects and the Armatureare selected press Ctrl-P

e Step 4: Select Armature Deform in the Set ParentTo pop-up menu.

The Armature will be the parent Object of all the other child Objects and each child Object will
have an Armature Modifier with the Armature associated (Object field).

Front Ortho

(1) Amature

Title-Img 2. 17 Bone associated with Mesh Object.
Source-

Link- https://docs.blender.org/manual/en/dev/rigging/armatures/skinning/pa renting.html
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With Empty Groups

When parenting, it will create empty vertex groups on the child Objects (if they do not already
exist) for and named after each deforming Bone in the Armature. The newly created vertex groups
will be empty this means they will not have any weights assigned. Vertex groups will only be
created for Bones which are setup as deforming (Properties Editor » Bone » Deform Panel).
You can then manually select the vertices and assign them to a particular vertex group that you are

choosing to have Bones in the Armature influence.

Choose this option if you have already created (and weighted) allthe vertex groups the mesh

requires.
Example

For example, if you have an Armature which consists of three Bones named “Bone A”, “Bone B”
and “Bone C” and cube mesh called “Cube”. If you parent the cube to the Armature the cube

will get three new vertex groups created on it called “Bone A”, “Bone B” and “Bone C”. Notice

that each vertex group is empty.

Title-Img 2. 18 Cube in Edit Mode using Armature Deform with empty groups.
Source

Link- https://docs.blender.org/manual/en/dev/rigging/armatures/skinning/pa renting.htmil

With Automatic Weights

With Automatic Weights, parenting works similar to With Empty Groups, however, it will not
leave the vertex groups empty. It calculates how much influence a particular Bone would have on
vertices based on the distance from those vertices to a particular Bone (“Bone heat” algorithm).

This influence will be assigned as weights in the vertex groups.
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This method of parenting is certainly easier setup; however, it can often lead to Armatures which
do not deform child Objects in ways you would want. Overlaps can occur when it comes to
determining which Bones should influence certain vertices when calculating influences for more
complex Armatures and child Objects. Symptoms of this confusion are that when transforming
the Armature in Pose Mode parts of the child Objects do not deform as you expect; If Blender
does not give you the results you require you will have to manually alter the weights of vertices in

relation to the vertex groups they belong to and have influence in.

With Envelope Weights

With Envelope Weights, parenting works in a similar way like Automatic Weights. The difference
is that the influences are calculated based on the Bone Envelopes settings. It will assign to each
vertex groups the vertices that are inside its Bone’s influence volume, weighted depending on their

distance to this Bone.

This means newly included/excluded vertices or new envelope settings will not be taken into

account. You will have to apply Armature Deform with Envelope Weights parenting again.

Front Ortho

(1) Amature

Title-Img 2. 19 Two sets of Armatures each with three Bones.
Source-

Link-https://docs.blender.org/manual/en/dev/rigging/armatures/skinning/parenting.html
Unit summary
In this Unit, you have learnt

e To Create and edit different types of Bones and apply it todifferent mesh
e Types of Armature structure
e To Edit an Armature

e To Arrange Linking Objects to Bone
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e To Set up Mesh and Armature using Skinning
e To Create Poses for the Rigged Character

e To Skin the mesh to the Bones

e To Add and remove influence for a Bone

e After learning this Unit, you can download the Open Source Software available on

the internet for free of cost topractice the possibilities of creating 3D Objects.

Assignment

Create a Basic Primitive Human Rig referring to the Youtube video link
Assessment

e Explain Armature in Blender

e Describe the Deforming Bones

e Write a brief note on Bone influence

e Explain five different Processes of Editing Bones
e Write a brief note on Bone structure

e Explain the process of skinning with examples

Fill in the Blanks

1. are directly involved in altering the positions of vertices associated with
their Bones.

2. can be seen when the Bone is in edit mode.

3. Using command on the keyboard, you can add to/remove from the
selection.

4. If at least one Bone is selected, clicking adds a new Bone.

5. In 3D View, clicking will add a new Bone to your
Armature.

Resources

While studying this Unit, you can browse the internet links for online video tutorials and several

books and training DVDs available in the Blender Store and on the Blender Cloud.
e wiki.blender.org
e archive.org
e www.blender.org

e docs.blender.org
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Unit-3 3D Animation

ntroduction

In 3D Animation and other forms of Computer Animation, the frames are generated by

interpolating between the numerical values that are defined in any two consecutive key frames.

Typically, in 3D Animation, this interpolation takes the form of 3D Beziers curves (paths) which

are constructed as a series of control points, allowing for the interactive manipulation of smooth

3

D curves.

In this Unit, you will learn about 3D Animation and how animation is making an object move or

change shape over time. This will be done through different tools and techniques in Blender.

Outcomes

Upon completion of this unit you will be able to:

Describe Key frame Animation
Work with Timeline

Work with F — Curves

Design the Dope Sheet

Create Animation on a Motion Path

Work with Interpolation and Extrapolation

Terminology

Keyframe :  Normal keyframe for Animation.
Breakdown : Breakdown state. e.g. for transitions between key poses.
Moving Hold : A keyframe that adds a small amount of motion around a holding

pose. In the Dope Sheet, it will also draw a bar between them..

Timeline Editor . The Timeline editor, identified by a clock icon, is shown by default
at the bottomof the screen.

Time Cursor . The Time Cursor is the green line, it isused to set and display the
current timeframe.

F Curve Editor . After animating some property in Blender using keyframes you can
edit their corresponding curves in F-Curve editor

Constant . There is no interpolation at all. The curve holds the value of its last
keyframe,giving a discrete (stairway) “curve”.

Pose Library : The Pose Library panel is used to save, apply, and manage
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different armatureposes.

Linear . This simple interpolation creates a straight segment, giving anon-
continuous line.

Beziers : The more powerful and useful interpolation, and the default one. It

gives nicely smoothed curves, i.e. smoothanimations!

Introduction to KeyFrame

Keyframe

A Keyframe is a marker of time which stores the value of aproperty.

For example, a Keyframe might define that the horizontalposition of a cube is at 3m on frame 1.

The purpose of a Keyframe is to allow for interpolated animation, meaning, for example, that
the user could then add another keyon frame 10, specifying the cube’s horizontal position at 20m,
and Blender will automatically determine the correct position of the cube for all the frames
between frame 1 and 10 depending on the chosen interpolation method (e.g. Linear, Bézier,

Quadratic, etc).
Visualization

There are some important visualization features in 3D Views that can help animation.

When the current frame is a keyframe for the current active object, the name of this object (shown

in Img 3.1 the bottom left corner of 3D Views) turns yellow.

User Persp

@ ObjectMode \ @

User Persp

(1) Cube

@ Object Mode | ©F

Title- Img 3. 1 Bottom: Current frame at 0. Top: Current frame is a keyframe for Cube.
Source- blender.org
Link-https://docs.blender.org/manual/en/dev/animation/keyframes/introduction.html

Keyframe Types
For visually distinguish regular keyframes from differentanimation events or states (extremes,
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breakdowns, or other in between), there is the possibility of applying different colors on them for

visualization.
e Keyframe (yellow diamond)

Normal keyframe.

e Breakdown (cyan small diamond)
Breakdown state. e.g. for transitions between key poses.

e Moving Hold (slight orange diamond)

A keyframe that adds a small amount of motion around a holding pose. In the Dope Sheet,
it will also draw a bar between them.

e Extreme (red big diamond)
An ‘extreme’ state or some other purpose as needed.

e Jitter (green tiny diamond)
A filler or baked keyframe for keying on ones, or some other purpose as needed.

Insert Keyframe
e Mode: Object Mode
e Panel: Tool Shelf » Animation > Animation * Keyframes: Insert
e Menu: Object » Animation » Insert Keyframe...
e Hotkey: I

There are several methods of adding new keys, namely:
e In 3D View, pressing “I” will bring up a menu to choose what to add a keyframe to.

e Hovering over a property and pressing “I” or with the context menu by RMB a
property and choose Insert Keyframe from the menu.

Auto Keyframe

Auto Keyframe is the red record button in the Timeline header. Auto Keyframe adds keyframes

automatically to the set frame if the value for transform type properties changes.

Title- Img 3. 2 Timeline Auto Keyframe.

Source-blender.org
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Delete Keyframe

Reference

Mode: Object Mode

Panel: Tool Shelf » Animation > Animation > Keyframes: Remove
Menu: Object » Animation » Delete Keyframes..

Hotkey: Alt-1

There are several methods of removing keyframes:

In 3D View, Press Alt-1 to remove keys on thecurrent frame for selected objects.

When the mouse is over a value press Alt-1.

RMB a value and choose Delete Keyframe from themenu.

Clear Keyframe

Reference

Mode: Object Mode
Menu: Object » Animation » Clear Keyframes.

KeyFrame Animation
This example shows you how to animate a cubes location, rotation, and scale.(Refer Img 3.3)

Step 1: First, in the Timeline, or other animation editors, set the frame to 1.
Step 2: With the Cube selected in Object Mode, press | in 3D View.

Step 3: From the Insert Keyframe Menu select LocRotScale. This will record the location,
rotation, and scale, for the Cube on frame 1.

Step 4: Set the frame to 100.
Step 5: Use Grab/Move G, Rotate R, Scale S, to transform the cube.

Step 6: Press I in 3D View. From the InsertKeyframe Menu, select LocRotScale.
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(1) Cube

Visual LocRotScale

Visual RotScale

Delta Location

Title- Img 3. 3 Insert Keyframes.
Source-blender.org

Link- https://docs.blender.org/manual/en/dev/animation/keyframes/editing.html

To test the animation, press Alt-A Pla

(50) Cude

[

6 G (B
Title- Img 3. 4 The animation on frames 1, 50, 100.
Source-blender.org

Link- https://docs.blender.org/manual/en/dev/animation/keyframes/editing.html

Timeline Editor

The Timeline editor, identified by a clock icon, is shown by defaultat the bottom of the screen.

Title- Img 3. 5 The Timeline.

Source-blender.org

Link- https://docs.blender.org/manual/en/dev/editors/timeline.html?highlight=timeline

The Timeline is not much of an editor, but more of an informationand control.
Here, you can have an overview of the animation part of yourscene.

e \What is the current time frame, either in frames or in seconds?
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e Where are the keyframes of the active object, the start and end frames of your animation,
markers, etc.

The Timeline has Player Controls, to play, pause the animation, and to skip though parts of the scene. It
also has some tools for Keyframes, Keying Sets, and Markers.

Main View

The Main Timeline region displays the animation frames over time.

Animation Start Frame Keyframes Time Cursor Animation End Frame
| rmm——— | |

- 4——Time —» +

Title- Img 3. 6Timeline Main Area.
Source-blender.org

Link-https://docs.blender.org/manual/en/dev/editors/timeline.html

Adjusting the View
The Timeline can be panned by holding MMB, then dragging thearea left or right.

You can zoom the Timeline by using Ctrl-MMB, the mouse Wheel,or pressing Numpad Minus
and Numpad Plus.

Time Cursor

Time Cursor is the green line, it is used to set and display thecurrent time frame.

Source-blender.org

Link-https://docs.blender.org/manual/en/dev/editors/timeline.html
Time Cursor can be set or moved to a new position by pressing or holding LMB in the Timeline
editor.

The current frame or second can be displayed on the Time Cursor, check the View menu for
settings. The Time Cursor can be moved in steps by pressing Left or Right, or in steps of 10 frames
by pressing Shift-Up or Shift-Down.

Using F Curve in Animation

After animating some property in Blender using keyframes, youcan edit their corresponding
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curves. When something is “animated,” it changes over time. This curve is shown as something
called an F-Curve. Basically, what an F-Curve does is an interpolation between two animated
properties. In Blender, animating an object means changing one of its properties, such as the

object’s location, or its scale.

As mentioned, Blender’s fundamental Unit of time is the “frame”, which usually lasts just a
fraction of a second, depending on the frame rate of the scene. As animation is composed of
incremental changes spanning multiple frames, usually these properties are not manually modified

frame by frame, because:
e It would take ages!

e It would be very difficult to get smooth variations of the property (unless you compute

mathematical functions and type a precise value for each frame, which would be crazy).

Therefore, nearly all direct animation is done using interpolation.

The idea is simple: you define a few Keyframes, which are multipleframes apart. Between these
keyframes, the properties’ values arecomputed (interpolated) by Blender and filled in. Thus, the

animators’ workload is significantly reduced.

Title- Img 3. 8Example of interpolation.
Source-blender.org
Link- https://docs.blender.org/manual/en/dev/editors/graph_editor/fcurves/introduction.html

For example, if you have:
e A control point of value 0 at frame 0,
e Another one of value 10 at frame 25,
e And you use linear interpolation,
e Then, at frame 5 we get a value of 2.

The same goes for all intermediate frames: with just two points, you get a smooth growth from (0
to 10) along the 25 frames. Obviously, if you would like the frame 15 to have a value of 9, you

would have to add another control point (or keyframe)
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Settings

F-Curves have three additional properties, which control the interpolation between points,
extension behaviour, and the typeof handles.

Interpolation Mode

Reference

e Menu: Key > Interpolation Mode
e Hotkey: T
e Mode: for the Interpolation between the currentand next keyframe.

Interpolation

Constant

There is no interpolation at all. The curved holds the value of its last keyframe, giving a
discrete(stairway) “curve”. Usually only used during the initial “blocking” stage in pose-to-pose

animation workflow.

Title- Img 3. 9Example of Constant.

Source-blender.org

Link -https://docs.blender.org/manual/en/dev/editors/graph_editor/fcurves/introdu ction.html

Linear

This simple interpolation creates a straight segment, giving a non- continuous line. It can be
useful when using only two keyframes and the Extrapolation extend mode, to easily get an infinite
straight line (i.e. a linear curve).
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Title- Img 3. 10Example of Linear.

Source-blender.org

Link- https://docs.blender.org/manual/en/dev/editors/graph_editor/fcurves/introduction.html
Bezier

The more powerful and useful interpolation, and the default one. It gives nicely smoothed

curves, i.e. smooth animations!

Title- Img 3. 11Example of Bezier.

Source-blender.org

Link https://docs.blender.org/manual/en/dev/editors/graph_editor/fcurves/introduction.html

Easing Interpolation (by strength)

There are different methods of easing interpolations for F-Curve segment. The “Robert Penner
easing equations” (basically, equations which define some preset ways that one keyframe
transitions to another) which reduce the amount of manual work (inserting and tweaking
keyframes) to achieve certain common effects. For example, snappy movements.

e Linear
e Sinusoidal
e Quadratic
e Cubic
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e Quartic
e Quintic
e Exponential

e Circular
Dynamic Effects

These additional easing types imitate (fake) physics-based effects like bouncing/springing
effects. The corresponding settings can be found in the Properties region » Active Keyframe

panel.

Elastic

Exponentially decaying sine wave, like an elastic band. This is like bending a stiff pole stuck
to some surface, and watching it rebound and settle back to its original state.

Amplitude

The amplitude property controls how strongly the oscillation diverges from the basic curve. At
0.0, there is nooscillation (i.e. it just snaps to the B-value like an extreme exponential
transition), and at 1.0 a profile similar to the one shown in the icon occurs.

Period

The period property controls the frequency with which oscillations occur. Higher values result

in denser oscillations.

Bounce

Exponentially decaying parabolic bounce, like when objectscollide. e.g. for Bouncing balls,
etc.

Back

Cubic easing with overshoot and settle. Use this one when you want a bit of an overshoot
coming into the next keyframe, or perhaps for some wind-up anticipation.

Back

The back property controls the size and direction (i.e. above/below the curve) of the overshoot.

Easing Type

Reference

e Menu: Key » Easing Type
e Hotkey: Ctrl-E

The Easing Type controls which end of the segment between the two keyframes that the easing
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effects apply to.
Automatic Easing

The most commonly expected of the below behaviours is used.For the transitional effects, this is

basically ease in, while for the physics effects it is ease out.

e Easeln
Effect builds up to the second keyframe.

e FEase Out

Effect fades out from the first keyframe.

e Ease In Out
Effect occurs on both ends of the segment.

Extrapolation
Reference

e Menu: Channel » Extrapolation Mode
e Hotkey: Shift-E

Extrapolation defines the behaviour of a curve before the first andafter the last keyframes.
There are two basic extrapolation modes:
Constant

The default one, curves before their first keyframe and after their last one has a constant value (the one of

these first and last keyframes)

Title- Img 3. 12Constant extrapolation.
Source-blender.org

Link-https://docs.blender.org/manual/en/dev/editors/graph_editor/fcurves/introduction.html
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Linear

Curves ends are straight lines (linear), as defined by their first twokeyframes (respectively their

last two keyframes).

Title- Img 3. 13Linear extrapolation.
Source-blender.org
Link- https://docs.blender.org/manual/en/dev/editors/graph_editor/fcurves/introduction.html

Handle Types

There is another curve option quite useful for Bézier-interpolated curves. You can set the type

of handle to use for the curve pointsV
e Automatic

Keyframes are automatically interpolated.

Title- Img 3. 14Auto handles.

Source-blender.org

Link- https://docs.blender.org/manual/en/dev/editors/graph_editor/fcurves/introduction.html
e Vector

Creates linear interpolation between keyframes. The linear segments remain if keyframe
centres are moved. If handlesare moved, the handle becomes Free.
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Title- Img 3. 15Vector handles.
Source-blender.org
Link- https://docs.blender.org/manual/en/dev/editors/graph_editor/fcurves/introduction.html

e Aligned

Handle maintain rotation when moved, and curve tangentis maintained.

Title- Img 3. 16Aligned handles.
Source-blender.org

Link- https://docs.blender.org/manual/en/dev/editors/graph_editor/fcurves/introduction.html

e Free
Breaks handles tangents.

Title- Img 3. 17Free handles.
Source-blender.org

Link- https://docs.blender.org/manual/en/dev/editors/graph_editor/fcurves/introduction.html

e Auto Clamped
Auto handles clamped to not overshoot.

Title- Img 3. 18 Auto clamped handles.
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Source-blender.org

Link-https://docs.blender.org/manual/en/dev/editors/graph_editor/fcurves/introduction.html

Using Dope Sheet in Animation
The Dope Sheet

Classical hand-drawn animators often made a chart, showing exactly when each drawing, sound
and camera move would occur, and for how long. They nicknamed this the “dope sheet”. While
CG foundations dramatically differ from classical hand-drawn animation, Blender’s Dope Sheet
inherits a similar directive. Itgives the animator a “birds-eye-view” of everything occurring within

a Scene.
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Title- Img 3. 19The Dope Sheet.
Source-blender.org

Link- https://docs.blender.org/manual/en/dev/editors/dope_sheet/introduction.html
Dope Sheet Modes

Grease Pencil
ShapeKey Editor
Action Editor

DopeSheet

DopeSheet :

Title- Img 3. 20Dope Sheet Modes.
Source-blender.org

Link- https://docs.blender.org/manual/en/dev/editors/dope_sheet/introduction.html
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e Dope Sheet
The Dope Sheet Mode allow you to edit multiple actions atonce.

e Action Editor
Action Editor is where you can define and control actions.

e Shape Key Editor
ShapeKey Editor is dedicated to the shape key data-blocks.

e Grease Pencil
Grease Pencil Mode is dedicated to the grease pencil tool’s keyframes for each grease pencil
layer, you have a strip along which you can grab its keys, and hence easily re-time your
animated sketches.

e Mask
Mask Mode is dedicated to the mask data-blocks.

e CacheFile
To do.

e Interface

The Dope Sheet Editor interface is somewhat similar to theGraph Editor one, it is divided in three

regions:

€ actionEdtor 4 22 summary 1B 18 [T vewedt fame  § EED
Title- Img 3. 21The Action Editor with object channels.
Source-blender.org

Link- https://docs.blender.org/manual/en/dev/editors/dope_sheet/introduction.html

Motion Paths

Reference

e Mode:Object Mode
e Panel: Tool Shelf » Animation » Animation » MotionPaths: Calculate

e Panel: Properties editor » Object » Motion Paths

Reference
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e Mode:Pose Mode
e Panel: Tool Shelf » Tools » Pose Tools » MotionPaths: Calculate
e Panel: Properties editor - Armature »Motion Paths

e Menu: Pose » Motion Paths

Title- Img 3. 22 An animated cube with its motion path displayed.

Source-blender.org

Link-http://blender-manual.readthedocs.io/en/latest/animation/motion_paths.html

This feature allows you to visualize the motion of points as pathsover a series of frames.

These points can be object origins and bone joints.

Before we look at its options, let us first see how to display/hide these paths. Unlike Ghost, you
must do it manually and you have to first select the bones you want to show/hide the motion
paths. Then,

e To show the paths (or update them, if needed), click on theCalculate Path button.

e To hide the paths, click on the Clear Paths button.
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Options

Around Frame

v Keyframes

V" Keyframe Numbers

Title- Img 3. 23The Motion Paths Panel in the Armature tab.

Source-blender.org

Link-http://blender- manual.readthedocs.io/en/latest/animation/motion_paths.html

Type

Around Frame
Display paths of points within a fixed number of frames around the current frame. When
you enable this button, you get paths for a given number of frames before and after the

current one (again, as with ghosts).

In Range
Display paths of points within specified range.

Display Range

Before, After
Number of frames to show before and after the current frame (only for Around Current

Frame Onion-skinning method).
Start, End

Starting and Ending frame of range of paths to display/calculate (not for Around Current
Frame Onion- skinning method).

Step

This is the same as the Step for ghosts. It allows you to onlydisplay on the path one frame
for each n ones. Mostly useful when you enable the frame number display (see below), to
avoid cluttering 3D Views.
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Cache/Cache for Bone

Show

From, To
These are the start/end frames of the range in which motion pathsare drawn. You cannot

modify this range without deleting themotion path first.
Calculate/Update Paths
If no paths have been calculated, Calculate Paths will create a new motion path in cache

based on the options specified in the pop-up menu or Operator panel.

If a path has already been calculated, Update Paths will update the path shape to the current
animation. To changethe frame range of the calculated path, you need to delete the path and

calculate it again.

Start, End

These are the start/end frames of the range in which motion paths are drawn. You must
Calculate Paths again if you modify this setting, to update the paths in 3D Views. Note that
unlike with ghosts, the start frame is inclusive (i.e. if you set Start to 1, you will really see
the frame 1 as starting point of the paths...).

Bake Location

Bones only — By default, you get the tips’ paths. By changing this setting to Tails, you will
get the paths of the bone’s roots (remember that in Blender Ul, bones’ rootsare called
“heads”). You must Calculate Paths again if you modify this setting, to update the paths in
3D Views.

Clear Paths X
Clears paths on all objects/bones or just the selected ones when holding Shift.

Frame Numbers

When enabled, a small number appears next to each frame dot on the path, which is of

course the number of the corresponding frame.
Keyframes

When enabled, big yellow square dots are drawn on motion paths, showing the keyframes
of their bones (i.e. only the paths of keyed bones at a given frame get a yellowdot at this

frame).
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e + Non-Grouped Keyframes

For bone motion paths, it searches the whole Action for keyframes instead of in groups with

matching name only (this is slower).

o Keyframe Numbers

When enabled, you will see the numbers of the displayed keyframes, so this option is
obviously only valid when Show Keys is enabled.

Example

Title- Img 3. 24An example of a motion path of an armature.
Source-blender.org

Link-http://blender- manual.readthedocs.io/en/latest/animation/motion_paths.html

Unit summary

In this Unit, you have learnt how to

e Create and edit Animation and Keyframes using key editor

o Work effectively with F curve to change the timing of animation
e Edit the Animation curve using different Interpolation method
e Use Motion Path for animating objects

e Work on Dope Sheet to make your animation more precise andaccurate

After learning this Unit, you can download the Open Source Software available on the internet

for free of cost to practice the possibilities of creating 3D Objects.
Assignment
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Create a Logo or Title Animation for an existing popular brand like Amazon, Flipkart,

Zee Tv etc. Students need to submit the assignment in MP4 format with 1920 X 1080

Resolution.

Assessment

Explain Keyframe Animation

Describe five types of Keyframes

Examine the key Interpolation and its types

Explain the importance of F curve in Animation

Differentiate between Ease in and Ease out

Write a note on the uses of Motion Path

Fill in the Blanks

1.

The is identified by a clock iconat the bottom of the screen.

Pose-to-pose animation workflows can be achieved by

Interpolation.

3. defines the behaviour of a curve before the first and after the
last keyframe.
4. Press to test the animation.
5. The is the green line, it is used to set and display thecurrent
time frame.
Resources

While studying this Unit, you can browse the internet links for online video tutorials and several

books and training DVDs available in the Blender Store and on the Blender Cloud.

wiki.blender.org

archive.org

www.blender.org

docs.blender.org
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Unit-4 Textures and Mapping

Introduction

In this Unit, you will be learning the process of production ofvideos using Tracking, such

as 2D Tracking, 3D Motion Tracking, Camera Tracking and Object Tracking. Tracking

allows you to import raw footage, track the footage, and mask areas using Camera movements in

your 3D scene. You will also learn about Stabilizing, Rotoscoping, Mask Editor, Mask Data

block, Shape Keyframe and Layers.

Outcomes

Upon completion of this unit you will be able to:

e Use the Masking

e Describe the Process of Motion Tracking

e Explain the Process of Stabilizing a Clip

e Use the Movie Clip Editor

e Brief the process of Rotoscoping

Terminology

Motion
Tracking

Speed

Frames Limit

Margin
Sensor Width

Pixel Aspect
Ratio

Track Path
Display
Stabilization
R,G,B

To Track the motion of Objects and applying that data to 3D
Object through the compositor.

To control the speed of sequence Tracking.

Controls how many frames can be Tracked whenthe Track Sequence
operator is called.

To disable Tracks when they become too closeto the image boundary.
Width of the CCD sensor in the Camera.

Is the pixel aspect of the CCD Sensor.

It helps to determine if a Track jumps from itsposition or not.

This option makes the displayed frame beaffected by 2D stabilization
settings.

RGB And B/W buttons at the top of this panel are used to control color

channels used for frame preview and to make the whole framegray
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scale.

Clip Panel . This panel currently contains the single operatorSet as background
which sets the clip currently being edited as the Camera background for
all visible 3D Views.

Solve Panel . Camera Motion operator solves the motion of Camera using all Tracks
placed on the footage and two keyframes specified on this panel.

Cleanup Panel This panel contains a single operator and its settings. This operator

cleans up bad Tracks: Tracks which are not Tracked long enough
or which failed to reconstruct accurately

Introduction to Motion Tracking

Motion Tracking is used to Track the motion of Objects and applying that data to 3D Object
through the compositor. Blender’s motion Tracker supports a couple of very powerful tools for
2D Tracking and 3D Motion Tracking, including Camera Tracking and Object Tracking, as
well as some specific featureslike the Plane Track for compositing. Tracks can also be used to
move and deform masks for Rotoscoping in the Mask Editor, which is available as a special mode
in the Movie Clip Editor.

Manual Lens Calibration

All Cameras record distorted video. Nothing can be done about this because of the way optical
lenses work. For accurate Camera

motion, the exact value of the focal length and the “strength” of distortion are needed.

Currently, focal length can be automatically obtained only from the Camera’s settings or from
the EXIF information. There are some tools which can help to find approximate values to
compensate for distortion. There are also fully manual tools where you can use a grid which is

getting affected by distortion model and deformed cells define straight lines in the footage.

You can also use the grease pencil for this —just draw a line, whichshould be straight on the footage
using poly line brush and adjust the distortion values to make the grease pencil match lines on the

footage.
To calibrate your Camera more accurately, use the Grid Calibration Tool from OpenCV.

OpenCV is using the samedistortion model.

Camera and Object Motion Solving

Blender not only supports the solving of Camera motion, including tripod shots, however, also the

solving of Object motion in relation to the motion of the Camera. In addition to that there is the
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Plane Track, which solves the motion of all markers on one plane.
There are also plans to add more tools in the future, for example more Automatic Tracking and

solving, multi-Camera solving and constrained solutions.

Tools for Scene Orientation and Stabilization

After Camera solving, you need to orient the real scene in 3D scene for more convenient
compositing. There are tools to define the floor, the scene origin, and the X/Y axes to perform

scene orientation.

Sometimes, the video footage includes spurious jumps and tilting movements, e.g. hand-held
Camera. Based on some Tracked image elements, 2D Stabilization can detect and compensate

suchmovements to improve the quality of the final result.
Clip View

The Clip View is used in the main part of the Movie Clip Editor. Almost all Motion Tracking

tools are concentrated in the Movie Clip Editor.

It should be mentioned that the Camera solver consists of threequite separate steps:
2D Tracking of footage

e Camera intrinsic (focal length, distortion coefficients)specification/estimation/calibration.

e Solving Camera, scene orientation, and scenereconstruction.

Tools in the clip editor are split depending on which step they are used in, so the interface is not
cluttered up with scene orientation tools when only 2D Tracking can be done. The currently
displayed tool category can be changed using the Mode menu, which is in the editor header.

tt Distortion

N Reconstruction

e Tracking
© Trac king

Title-Img 4. 1Movie Clip Editor Mode Menu.
Source-blender.org

Link-http://blender-manual-i18n.readthedocs.io/ja/latest/motion_tracking/

However, almost all operators can be called from menus, so it is not necessary to change the mode
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every time you want to use a tool which is associated with a different editor mode.

In Tracking mode, only tools related to Tracking and Camera solving are displayed. Camera
solving tools are included here; because, after solving, you will most probably want to re-
track existing Tracks or place new Tracks to make solving more accurate.

Tracking Settings Panel

This panel contains all settings for 2D tracking algorithms. Depending on which algorithm is
used, different settings are displayed, however, there are a few that are common for all Tracker

settings:

e Adjust Frames’ controls which patterns get Tracked; to be more precise, the pattern from

which frame is getting Tracked. Here is an example which should make thingsclearer.

e The Tracker algorithm receives two images inside the search area and the position of a point
to be Tracked in thefirst image. The Tracker tries to find the position of that point from the
first image in the second image.

Now, this is how Tracking of the sequence happens. The second image is always from a frame at
which the position of marker isnot known (next Tracking frame). However, a different first image
(instead of the one that immediately precedes the second imagein the footage) can be sent to the

Tracker.
Most commonly used combinations:

e An image created from a frame on which the Track was keyframed. This configuration
prevents sliding from the original position (because the position which best corresponds
to the original pattern is returned by the Tracker), however, it can lead to small jumps and
can lead to failures when the feature point is deformed due to Camera motion (perspective

transformation, for example). Such a configuration is used if Adjust Frames is set to 0.

e An image created from the current frame is sent as first image to the Tracker. In this
configuration, the pattern is Tracking between two neighbouringframes. It allows dealing
with cases of large transformations of the feature point however, can lead to sliding from
the original position, so it should be controlled. Such a configuration is used if Adjust

Frames is set to 1.

e If Adjust Frames is greater than 1, the behaviour of Tracker is: keyframes for Tracks are
creating every Adjust Frame, and Tracking between keyframed image and next image is

used.

Movie Clip Properties
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Objects Panel

Title-Img 4. 20bjects panel in clip editor
Source-blender.org

Link-http://blender-manual-il8n.readthedocs.io/ja/latest/motion tracking/

This panel contains a list of all Objects which can be used for Tracking, Camera or Object
solving. By default, there is only one Object in this list, which is used for Camera solving. It
cannot be deleted and other Objects cannot be used for Camera solving; all added Objects are used
for Object Tracking and solving only. These Objects can be referenced from Follow Track and

Object Solver constraints.
e Follow Track uses the Camera Object by default.

e New Objects can be added using Plus and the activeObject can be deleted with the Minus

button. Text field at the bottom of this panel is used to rename the active Object.

e If some Tracks were added and Tracked to the wrong Object, they can be copied to another

Objectusing Track » Copy Tracks and Track > Paste Tracks.

The usage for all kind of Objects (used for Camera and Object Tracking) is the same: Track
features, set Camera data, solve motion. Camera data is sharing between all Objects and refining

ofCamera intrinsic happens when solving Camera motion only.

Track Panel

First of all, Track name can be changed in this panel. Track names are used for linking Tracking

data to other areas, like a Follow Track constraint.

e The next thing that can be controlled here is the marker’s enabled flag (using the button
with the eye icon). If a marker is disabled, its position is not used either by solver nor by

constraints.

266


http://blender-manual-i18n.readthedocs.io/ja/latest/motion_tracking/

ColorPr %

v Custom

Title-Img 4. 3Track panel in clip editor
Source-blender.org

Link-http://blender-manual-i18n.readthedocs.io/ja/latest/motion tracking/

The button with the lock icon to the right of the button with the eye controls whether the Track is
locked. Locked Tracks cannot be edited at all. This helps to prevent accidental changes to Tracks

which are “finished” (Tracked accurate along the whole footage).

e The next widget in this panel is called “Track Preview” and it displays the content of the
pattern area. This helps to check how accurately the feature is being Tracked (controlling
that there is no sliding off original position) andhelps to move the Track back to the correct
position. The Track can be moved directly using this widget by mouse dragging.

If an anchor is used (the position in the image which is Tracking is different from the position
which is used for Parenting), a preview widget will display the area around the anchor position.
This configuration helps in masking some things when there is no good feature at position where

the mask corner should be placed. Details of this technique will be written later.

There is small area below the preview widget which can be usedto enlarge the vertical size of

preview widget (the area is highlighted with two horizontal lines).

e The next setting is channels control. Tracking happens in gray-scale space, so a high
contrast between the feature and its background yields more accurate Tracking. In such

cases disabling some color channels can help.

When several Tracks are used for 3D Camera reconstruction or for 2D stabilization, it is possible
to assign a reduced weight to some Tracks to control their influence on the solution result. The
Weightparameter is used for 3D reconstruction, while the Stab Weight parameter is used to control
2D stabilization. This parameter can (and often need to be) animated.
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e Thelastthing is custom color, and the preset for it. This setting overrides the default marker
color used in the clip editor and 3D View, and it helps to distinguish different type of
features (for example, features in the background vs. foreground and so on). Color also can
be used for “grouping” Tracks so a whole group of Tracks can be selected by color using

the Select Grouped operator.

2D Stabilization

2D video stabilization is a feature built on top of Blender’s image feature Tracking abilities: we
use some Tracking points to remove shakiness, bumps and jerks from video footage. Typically,
image stabilization is part of a 2D workflow to prepare and improve footage prior to further
processing or modeling steps. This page helps to understand how it works, introduces related terms
and concepts, describes the available interface controls in detail and finally gives some hints about

usage in practice.
Typical usage scenarios of the Stabilizer

¢ fixing minor deficiencies (shaky tripod, jerk in Camera movement)

e “poor man’s steadycam” (when a real steadycam was not available, affordable or

applicable)

e preparing for masking, matching and Rotoscoping It is not uncommon for 2D stabilization

to have to deal with somewhat imperfect and flawed footage

How it works

To detect spurious movement in the given shot, we’ll assume a simplified model about this
movement. We then try to fit themovement of Tracked features with this simplified model to derive
a compensation. Of course, this works only to the degree ourmodel is adequate — yet in practice,
this simplified approach workssurprisingly well even with rather complicated shots, where our

basic assumption was just an approximation of much more elaborate movements.

This simplified model underlying 2D stabilization as implemented here assumes movement by an

Affine-Linear Transform:
e the Camera is pushed up/down/sideways by some translation component

o the image is then tilted and scaled around a Pivot Point (rotation center)

To compensate movement according to this simplified model, 2D stabilizer proceeds in two steps.
First, we try to detect the translation offset from the weighted average of all translation Tracking
points. After compensating this translation component, we then use additional rotation/scale
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Tracking points to detect rotation around a given pivot point. Again, we detect rotation and scale

changes through a weighted average of all the rotation/scale Tracking points given.

In the current version, the Pivot Point is anchored to the weight center of the translation Tracking
points. So effectively the detected translation is already factored out. In some cases, this is not
optimal, especially when Tracks have gaps or do not cover the whole duration of the footage — we

plan further options to better control the Pivot Point in future releases.

Stabilization Tracks

Thus, as foundation for any image stabilization, we need Tracked image features to derive the
movements. These Tracking points or<“Tracks” can be established with Blender’s image feature
Tracking component the right choice of points to Track is somewhat tricky, yet crucial for
successful image stabilization. Often, we’re here because we’ll have to deal with imperfect
footage. In such cases, the averaging of Tracks helps to work around image or Tracking errors
at some point. Moreover, when the footage contains perspective induced movements,
symmetrically placed Trackingpoints above and below the horizon can be used to cancel out

spurious movement and get stabilization to the focal area in between.

Title-Img 4. 2Diverging movements caused by perspective.

Source-blender.org

Link-
https://docs.blender.org/manual/en/dev/editors/movie clip editor/tracking/clip/properties/stabilizatio
n/introduction.html

Footage, image and canvas

When talking about the movement stabilization video, we must distinguish several frames of
reference. The image elements featured by the footage move around irregularly within the footage’s
original image boundaries — this is the very reason why we are using the stabilizer. When our

attempt at stabilization was successful, the image elements can be considered stable now,while in
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exchange the footage’s image boundaries have taken on irregular movement and jump around in

the opposite way. This is the immediate consequence of the stabilizer’s activity.

However, when the Camera was moved intentionally, we must consider yet another frame of
reference beyond the canvas: namely the frame (or “cadre”) of the final image we want tocreate.
To understand this distinction, let’s consider a hand-held, panning shot to the right: Since our
Camera was turned towards the right side, the actual image contents move towards the left side
within the original image frame. However, let’s assume the stabilizer was successful with “fixing”
any image contents relative to the canvas — which in turn means, that the original image boundaries
start to move irregularly towards the right side, andthe contents of the image will begin to
disappear gradually behind the left boundary of the original image. After some amount of
panning, we’ll have lost all our original contents and just see an empty black image backdrop. The
only solution to deal with that problem is to move the final image frame along to the right, thus
following the originally intended panning movement. Of course, this time, we do want to perform

this newly added panning movement in a smooth and clean way.

=
Alley disabled

L4 s
Steeple: tracked|

Steeple: tracked h

Title-Img 4. 3 Stabilizing a panning shot.

Source-blender.org
Link- https://docs.blender.org/manual/en/dev/editors/movie clip editor/tracking/cl
ip/properties/stabilization/introduction.html
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Title-Img 4. 4Restoring the expected Camera movement.

Source-blender.org

Link
https://docs.blender.org/manual/en/dev/editors/movie_clip_editor/tracking/clip/properties/stabilizatio
n/introduction.html

To allow for such compensation and to reintroduce deliberatepanning, or tilting and zoom of the

resulting image, the stabilizer offers a dedicated set of controls:
e Expected position,
e Expected rotation and

e Expected scale

These act like the controls of a virtual Camera filming the contents we have fixed onto the canvas.
By animating those parameters, we’re able to perform all kinds of deliberate Camera movements

in a smooth fashion.

The “dancing” black borders

As explained above, when we succeed with stabilizing the image contents, the boundaries of the
original footage start to jump around in the opposite direction of the movements compensated.
This is inevitable — yet very annoying, since due to the irregular nature of these movements, these
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“dancing black borders” tendto draw away attention from the actual subject and introduce an
annoying restlessness. Thus, our goal must be to hide those dancing borders as good as possible. A
simple solution is to add a small amount of zoom. Sometimes we’ll also need to animate the
parameter Expected position in order to keep the image centered as good as we can — this helps to

reduce the amount of zoom necessary to remove those annoying borders.

The Autoscale function can be used to find the minimal amountof zoom just sufficient to
remove those black borders completely. However, if the Camera jumps a lot, the autoscale function
often zooms in too much, especially since this calculation aims at findinga single, static zoom factor
for the whole duration of the footage. When this happens, you’ll typically get overall better results

with animating both the zoom factor and the expected position manually.

Rotation

Bilinear

Title-Img 4. 5UI of 2D Stabilizer.

Source-blender.org
Link https://docs.blender.org/manual/en/dev/editors/movie clip editor/tracking/cl
ip/properties/stabilization/panel.html

Mask Editor

Previously there was no simple workflow for masks in Blender, compositing a rendered scene with
real footage was possible, however, when it came to mask out Objects, defining areas of influence
and other scenarios, the workflow was cumbersome.Masks are now natively supported, which

allow you to draw masksusing splines, and then have them rasterized for use in the compositor or

272


https://docs.blender.org/manual/en/dev/editors/movie_clip_editor/tracking/clip/properties/stabilization/panel.html
https://docs.blender.org/manual/en/dev/editors/movie_clip_editor/tracking/clip/properties/stabilization/panel.html

sequencer.
This feature consists of different parts:

o Mask data block containing multiple Mask Layers and splines.
o Mask editing in the image and Movie Clip Editor space using various tools.

o Animation of masks with keyframes, drivers and Tracking data.

Compositing Node and sequencer strip to use mask.

Mask Datablock: Points, Splines and Layers
Point

A Point is the most low-level entity used to define mask. It's a simple point with it a coordinate,

handles and set of feather points. Points can be parented to markers from Motion Tracking.

Spline

Sets of points define a Spline. Currently only Bezier splines are supported. They create a smooth
curve from the first to the last point in the spline. Splines, by default, will create a filled area,
however, can also create non-closed curves with a thickness to mask out Objects such as wires

or hair. (Refer Img 4.8)

Title-Img 4. 6Two splines with feathering.Attribution-Brecht
Source-

Link-https://wiki.blender.org/index.php/File:Blender2.64 mask.png

One or several splines can belong to the same Layer. Splines belonging to the same layer can be
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animated together, for example by an item from motion Tracker footage. By creating overlapping
splines holes can be created, and it's the layer membership that defines which splines interact to

create holes.

Mask datablocks are the most high-level entity used for masking purposes. They can be reused

in various places, and hold global parameters for all the entities they consist of.

Understanding Layers

The purpose of Mask Layers can be explained with an example.

Suppose there are two unwanted people in the footage, and oneof them goes from left to right,
and the other in the opposite direction. Two Mask Layers can then be used to mask them separately
using a Single Mask Data block. At the point of intersection of these shapes they will be added
together rather than creating a hole, as would happen if they were on the same layer. If the motion
is simple enough, a single motion Tracked point can be used to drive the location of the entire
Mask Layer. Each Mask Layer can consist of multiple splines to fit more complex shapes.

Editing Masks

Masks can be created in the image and Movie Clip Editors, by changing the mode from View to
Mask in the header. This will addvarious tools and properties to the editor panels, while hiding
others that are not needed for interacting with masks. The tools and panels available to edit masks

are the same in both editors, with the exception that linking masks to Motion Tracking data is only

possible in the Movie Clip Editor.

itIe-Img . 7Makediing inimage dior.
Source-Brecht
Link- https://wiki.blender.org/index.php/File:Blender2.64 mask editor overview.png

Once set to Mask mode, a Mask datablock can be added. Any image, movie clip, render or
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compositing result can be used as a backdrop to draw masks over. To get interactive feedback on

the resulting mask, a Mask Node can be connected directly to a Viewer Node in the compositor,

which will then keep updating the compositing result while editing.

Control Points

Editing of mask splines happens in the same way of editing Bezier curves or paths in GIMP or

other curve editors: control points are added to define the spline itself, and handles of several types

are used to create smooth bends. This makes it possible to define a mask with few points to easily

follow an Object in footage.

Selection

Ctrl + LMB is used to place new control points and define handle orientations
(click to place controlpoint, click followed with slide to place new control point

and set smoothness for it).
Alt + C: to close the mask by joining the last control point to the first.

Existing control points can be translated, scaled androtated with the usual G, S,

R shortcuts.

X or Delete removes control points

The usual Selection and Hide/Reveal tools are available:

A: toggle select all
B, C: border and circle Select
Ctrl + L select linked from selection, L: select linked with mouse

Ctrl + Alt + LMB: lasso select

H hide selected, 1t Shift + H hide unselected, Alt + H
Reveal

Curve Handles

Feather

Alt + C: cycle toggle spline, to create a close curveor open it again

V: set handle type for selected spline points
Ctrl + N: make normals (handle directions) consistent

Switch Direction handle directions in/out.

It's possible to control feather of mask, including a way to define non-linear feather. Linear feather
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is controlled by a slider, non- linear feather is controlled in the same curve-based way to define
feather falloff.

e f Shift + LMB Template-LMB.png is used to define a feathering outline curve. To create an
initial feather, sliding from a spline control point outside or inside will create and position feather
points.After this Tt Shift + LMB Template-LMB.png will insert new feather point and mouse sliding
can be used to move them around.

e Alt + S will scale the feather size

Using Masks

Masks have many purposes. They can be used in a Motion Tracking workflow to mask out, or influence
a particular Object in the footage. They can be used for manual Rotoscoping to pull a particular Object out
of the footage, or as a rough matte for green screen keying. Masks are independent from a particular image

of movie clip, and so they can just as well be used for creating motion graphics or other effects in the

compositor

Title-Img 4. 8Using the Mask Node to isolate an Object in compositing.

Source-Brecht
Link-https://wiki.blender.org/index.php/File:Blender2.64_mask_compositor _node.png
Compositing Node

In the compositing Nodes, the Mask Input Node can be used to select a mask datablock, with

as output the raster mask image. This image can be used with other Nodes, for example to Invert,

Multiply or Mix, or use as a factor input. The Node options are:
e Anti-Alias

Create smooth mask edges rather than hard ones.
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e Feather

Use or ignore feather points defined for splines.

o Size
Scene Size will give an image the size of the render resolution for the scene, scaling

along when rendering withdifferent resolutions. Fixed gives a fixed size in pixels.

Fixed/Scene gives a size in pixels that still scales along when changing the render
resolution percentage in thescene.

e Motion Blur

For animated masks, creating a motion blurred mask from the surrounding frames, with a
given number of samples (higher gives better quality), and a Camera shutter time in

seconds.

Animating Masks

Masks can be driven over the time so that they follow some Object from the footage, e.g. a running

actor. This animation can be done in several ways:

e Control points can be parented to motion Tracks. This way is the main way to interact with

masks in aMotion Tracking workflow.

e Keyframe Animation of control points using a shape keying system. This can be useful
when thereare not enough good feature points to Track in the footage, or the mask is not

based on footage.

e For animation, more complex mask shapes, it isalso possible to do more high-level

animation:
e Splines and Mask Layers can be animated as whole,instead of individual control points.

e Masks can be parented to Motion Tracking data. Works for both individual mask point
parenting andfor overall spline. To select motion Track to be parented to use Ctrl + RMB
to parent selected maskpoints to active motion Track use Ctrl + P.

« Mask Animation timing can be edited from the Dope Sheet where there is a mask mode

wheremask keyframes can be selected and edited.
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Title-Img 4. 9Complex masking setup in Movie Clip Editor, from the Mango opn movie project.

https://wiki.blender.org/index.php/File:Blender2.64 mask mango.png

Shape Keyframe
Masks can be animated with Shape Keyframing. This works on thelevel of Mask Layers, so
inserting a shape key will keyframe all the splines and points contained in it.

e Step 1: Insert a shape key for the active Mask Layer at the current frame.
e Step 2: Alt + | will clear the shape key for the active Mask Layer at the current frame.

Feather Reset Animation: Resets the feather offset across all animated frames useful if you

animate first then add feather after.

Re-Key Points of Selected Shapes: Re-interpolate selected points on across the range of keys
selected in the dope sheet. This hasthe same effect of removing and re-inserting keys - however
it can be applied selectively to the points you need.

Parenting to Motion Tracks

In the Movie Clip Editor, it's possible to parent spline points to motion Tracks.
e Ctrl + P parents one or more selected spline pointsto the active motion Tracker

e Alt + P clears any parenting relationship for theselected spline points.

e S-Curves
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Title-Img 4. 10S-curves

Source-Brecht

Link- https://docs.blender.org/manual/en/dev/editors/movie clip editor/masking/scurve.html

The curve type used for creating mask splines is almost a Bezier curve, however, with some
differences. The curve needed to support feathering in a way that stuck to the curve as you edited

it, for ease of editing an animation. We call these S-Curves.

Besides the handles, every control point also has points that define the feather between the current
point and the next pointon the spline. Each feather point is stored in UV space, where U means

position across spline segment, and V means distance between main spline and feather points.

This allows for deforming the main spline in almost any way, and the feather will be updated
automatically to reflect that change. For example, if there's just rotation of the spline, feather
would stay completely unchanged. If one point's feather is moved, the other feathers will be
automatically stretched uniformly along thatsegment and the overall shape will be almost the same

as artists would want it to be.

Unit summary

In this Unit, you have learnt how to
e Work effectively with Motion Tracking
e Create scenes for production
e Work with 2D Stabilization in Blender
e Use Rotoscoping in Blender
e Useof S curve
e Animate the mask

e Work with videos of Tracking using 3D virtual Camera andCamera Tracking

After learning this Unit, you can download the Open Source Software available on the internet for
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free of cost to practice thepossibilities of creating 3D Objects.

Assignment

e Create a Camera Tracking Shot in Blender watching the video

e Submit the assignment in MP4 format with 1920 X 1080Resolution

Assessment
1. Explain Motion Tracking in Blender
2. Describe the process of 2D Stabilizing
3. Write a brief note on Mask Editing and Animation
4. Explain the importance of S curve
5. Write a brief note on Track Panel

6. Write a note on Clip view

Fill in the Blanks

1. The is identified by a clock iconat the bottom ofthe screen.

2. Pose-to-pose  animation  workflows can be  achievedby _
Interpolation.

3. defines the behaviour of a curve before the firstand after the last
keyframe.
4. Press to test the animation.
5. The is the green line, it is used to set anddisplay the current time
frame.
Resources

While studying the Unit, you can browse the internet links for online video tutorials and several
books and training DVDs available in the Blender Store and Blender Cloud.

e wiki.blender.org

e archive.org

e www.blender.org

e docs.blender.org
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3D Animation

Block — IV: 3D Lighting & Rendering (Practical)
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Unit-1 Introduction to 3D Lighting
Introduction

Lighting is a very important topic in Rendering, standing equal to modelling, materials
and textures. The most accurately modelled and textured scene will yield poor results without a

proper lightingscheme, while a simple model can become very realistic if skilfully lit.

Lighting plays key role in 3D Animation, because it convinces the audience that the story is
believable psychological and physical of lighting emphasizes the role of lighting on the audience
“light dictates activities, influences our frame of mind and affects the way we perceive all manner

of things”.

Outcomes

Upon completion of this unit you will be able to:

e Plan your 3D Scene for Lighting

o |dentify the restrictions between the color of an object andthe lighting of your scene
e Design global influences affecting the lighting in the scene

e Practice setting up the lights

e Apply texture maps to lamp color channels

Terminology

Ambient Light - Ambient light means the light that is already present in a scene, before
any additional lighting is added. It usually refers to natural light, either
outdoors or coming through windows etc. It can also mean artificial
lights such as normal room lights.

Ambient : Ambient occlusion is a method to approximatehow bright light should

be shining on any.

Occlusion: . specific part of a surface, based on the light and its environment.
This is used to addrealism.
Indirect Lighting  : Lighting provided by reflection usually from wall or ceiling surfaces.

In day lighting, thismeans that the light coming from the sky or the sun
is reflected on a surface of high reflectivity like a wall, a window sill
or a special redirecting device. In electrical lighting,the luminaries are
suspended from the ceiling or wall mounted and distribute light mainly

upwards so it gets reflected off the ceiling or the walls.
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Direct Lighting . Direct sunlight is when you (or the plant) get the rays directly on it. It
is like sitting outside, without a hat, and nothing is between you andthe

sun.

Viewing Restrictions
The Color of an object and the lighting of your scene are affectedby:

e Your ability to see different colors (partial color blindnessis common).

e The medium in which you are viewing the image (e.g. an LCD panel versus printed glossy
paper).

e The quality of the image (e.g. a jpeg at 0.4 compression versus 1.0).

e The environment in which you are viewing the image (e.g.a CRT monitor with glare
versus in a dark room, or in a sunshiny blue room).

Your brain’s perception of the color and intensity relative to those objects around it and the world
background color, which can be changed using color manipulation techniques using Blender

Composite Nodes.

Global Influences

In Blender, the elements under your control which affect lighting are:

e The color of the world ambient light.

e The use of Ambient Occlusion to cast that ambient light onto the object.

e The degree to which the ambient light colors the material of the object.

e The use of Indirect lighting, where the color of one object radiates onto another.
e The lamps in your scene.

e The physics of light bouncing around in the real world is simulated by Ambient
Occlusion (a world setting), buffer shadows (which approximate shadows being cast by
objects), ray tracing (which traces the path of photons from a light source).

Also, within Blender you can use Indirect lighting. Ray tracing, Ambient Occlusion, and Indirect Lighting
are computer-intensive processes. Blender can perform much faster rendering with its internal scan line
renderer, which is a very good scan line rendererindeed. This kind of rendering engine is much faster since

it does not try to simulate the real behavior of light, assuming many simplifying hypotheses.
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Lighting Settings
Only after the above global influences have been considered, do you start adding light from lamps

in your scene. The main things under your control are the:

e Type of light used (Sun, Spot, Lamp, Hemi, etc.).
e Color of the light.
e Position of the light and its direction.

e Settings for the light, including energy and falloff.
Then you are back to how that material’s Shader reacts to the light.

This Unit attempts to address the above, including how lights can work together in rigs to light
your scene. In this Unit, we willanalyze the different type of lights in Blender and their behavior;
we will discuss their strong and weak points. We will also describemany lighting rigs, including

the ever-popular three-point lightmethod.

Lighting in the Workflow

In this Unit, you should set up your lighting before assigning materials to your meshes. Since the
material Shaders react tolight, without proper lighting, the material Shaders will not look right,
and you will end up fighting the Shaders, when it is really thebad lighting that is causing you grief.
All the example images in thisUnit do not use any material setting at all on the ball, cube or

background.

Overriding Materialsto Reset Lighting

If you have started down the road of assigning materials, and arenow fiddling with the lighting, we

suggest that you

Step 1: create a default, generic gray material — no Vertex Color, no Face Texture, no
Shadeless, justplain old middle gray with RGB (0.8, 0.8, 0.8).

Step 2: Name this “Gray”.

Step 3: Next go to the Render Layer tab.

Step 4: In the Layer panel, select your new “Gray” material in the Material field. This
will override anymaterials you may have set, and render everythingwith this color. Using

this material, you can now goabout adjusting the lighting.

Step 5: Just empty this field to get back to your originalmaterials.
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Title-Img 1. 1Material field in the Render Layers panel.
Attribution-

Source-

Link-https://docs.blender.org/manual/en/dev/render/blender render/lighting/introduct
ion.html?highlight=overriding%20materials%20reset%20lighting

Lamp Panel

Sun Spot Hemi Area

1.000 * )

Title-Img 1. 2Lamp tab.
Link- https://docs.blender.org/manual/en/dev/render/blender render/lighting/lights/la mp _panel.html
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Lamp
A Data-Block Menu. Its list shows all light settings used inthe current scene.

e Texture Count

Shows the count of textures in the lamp texture stack.

e Preview

A quick preview of the light settings

Lamp Type

Types of lamps available in Blender Internal. They share all orsome of the options listed here:

e Color
The color of the light source’s illumination

e Energy

The intensity of the light source’s illumination from (0.0 to 10.0).

e Distance

The Distance number button indicates the number of Blender Units (BU) at which the
intensity of the current light source will be half of its intensity. Objects less thanthe
number of BU away from the lamp will get more light, while objects further away will
receive less light. Certain settings and lamp falloff types affect how the Distance is
interpreted, meaning that it will not always react the same.

The Sun and Hemi Lamps are another class of Lamps whichuses a constant falloff.
Those lamps do not have a Distance parameter, and are often called “Base Lighting

Lamps”.

e Influence

Every lamp has a set of switches that control which objects receive its light, and how it interacts

with materials.
e Negative

Let the lamp cast negative light. The light produced by the lamp is subtracted from the
irradiance on the surfaces it hits, which darkens these surfaces instead of brightening them.

e This Layer Only
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The Lamp only illuminates objects on the same layer the lamp is on. Causes the lamp to only
light objects on the same layer.

e Specular

The Lamp creates specular highlights.
e Diffuse

The Lamp affects diffuse shading.
Light Attenuation

Sun Spot Hemi Area

Title-Img 1. 3Lamp panel, falloff options highlighted.
Link- https://docs.blender.org/manual/en/dev/render/blender render/lighting/lights/att enuation.html

There are two main controls for light falloff for Point and Spot lamps:
1. The lamp Fallofftype selector
2. The Spherecheckbox

Falloff Types
Lin/Quad Weighted

Sun Spot Hemi Area

Energy: 1.000 »
v’ Specular

2

LinQuad Weighted ¥ v Diffuse

Title-Img 1. 4 Lamp panel with Lin/Quad Weighted Falloff optionshighlighted.
Attribution-

Source-blender.org
Link https://docs.blender.org/manual/en/dev/render/blender render/lighting/lights/attenuation.html
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When this setting is chosen, two sliders are shown, Linearand Quadratic, which control
respectively the “linearness” and “quadraticness” of the falloff curve.

This lamp falloff type is in effect allowing the mixing of the two light attenuation profiles (linear
and quadratic attenuation types).

Quadratic Attenuation

Title-Img 1. 5 Lamp with Lin/Quad Weighted falloff default settings.

Attribution-

Source-blender.org

Link-https://docs.blender.org/manual/en/dev/render/blender render/lighting/lights/att enuation.html

This slider input field can have a value between (0.0 to 1.0). A value of 1.0 in the Quadratic field

and 0.0 in the Linear field means that the light from this source is completely quadratic.

Quadratic Attenuation type lighting is considered a more accuraterepresentation of how light
attenuates (in the real world). In fact, fully quadratic attenuation is selected by default. For
Lin/Quad Weighted lamp fallout. Here again, the light intensity is half when it reaches the
Distance value from the lamp. Comparing the quadratic falloff to the linear falloff, the intensity
decays much slower at distances lower than the set Distance, however, it attenuates much quicker

after Distance is reached.

Zeroing both “Linear” and “Quad”

If both the Linear and Quadratic sliders have 0.0 as their values, the light intensity will not
attenuate with distance. This does not mean that the light will not get darker, rather it will, however,
onlybecause the energy the light has is spread out over a wider and wider distance. The total amount
of energy in the spread-out light will remain the same, though. The light angle also affects the

amount of light you see. It is in fact the behavior of light in the deep space vacuum.

If you want a light source that does not attenuate and gives the same amount of light intensity to
each area it hits, you need a lightwith properties like the Constant lamp Falloff type.

Also, when the Linear and Quad sliders are both 0.0 values the Distance field ceases to have any

influence on the light attenuation, as shown by the equation above.
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Graphical Summary

Below is a Graph Summarizing the lin/quad attenuation type, showing attenuation with or without

the Sphere option (described later).

Light Intensity, /
0O 0o O o o o o
wy £ L] o -4 =] w

o
b

01F

- L L L L L
1] 10 2 30 40 50 B0 70 80 a0 100
Distance from light source, r

Title-Img 1. 6 Lin/quad attenuation type

Source-blender.org
Linkhttps://docs.blender.org/manual/en/dev/render/blender render/lighting/lights/attenuation.html

Light Attenuation:
Linear (Linear=1.0, Quad=0.0);

Quadratic (Linear=0.0, Quad=1.0);
Linear and quadratic (Linear=Quad=0.5);

Null (Linear=Quad=0.0);

Also, shown in the graph the “same” curves, in the same colors,however, with the Sphere
button turned on.

Custom Curve

The Custom Curve Lamp Falloff type is very flexible.
Most other lamp falloff types work by having their light intensity start at its maximum (when
nearest to the light source) and then with some predetermined pattern decrease their light intensity

when the distance from the light source increases.

When using the Custom Curve Lamp Falloff type, a new panel is created called Falloff Curve. This
Falloff Curve profile graph allows the user to alter how intense light is at a particular point along a

light’s attenuation profile (i.e. at a specific distance from the light source).

The Falloff Curve profile graph has two axes, the Distance-axis andthe Intensity-axis.
1. Distance axis
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It represents the position at a particular point along a light source’s attenuation path. The
far left is at the position of the light source and the far right is the place where thelight
source’s influence would normally be completely attenuated.
2. Intensity axis
It represents the intensity at a particular point along a lightsource’s attenuation path. Higher
intensity is represented by being higher up the intensity axis, while lower intensity light is
represented by being lower down on the intensity axis.
Altering the Falloff Curve profile graph is easy. Just LMB click on a part of the graph you want to
alter and drag it where you want it to be. If you click over or near one of the tiny black square handles, it
will turn white, indicating that this handle is now selected, and you will be able to drag it to a new position.
If when you click on the graph you are not near a handle, one will be created at the point that you clicked,
which you can then drag where you wish. You can also create handles at specific parts of
the graph, clicking with LMB while holding Ctrl ; it will create a new handle at the point you

have checked.

In the example below (the default for the Falloff Curve Profile Graph), the graph shows that the
intensity of the light starts off at its maximum (when near the light), and linearly attenuates as it

moves to the right (further away from the light source).

Default Falloff Curve panel
graph.

Render showing the Custom Curve lamp
falloff type effect with default settings.

Title-Img 1. 7 Falloff Curve Profile Graph
Source-blender.org
Link-https://docs.blender.org/manual/en/dev/render/blender render/lighting/lights/att enuation.html

If you want to have a light attenuation profile that gets more intense as it moves away from the
light source, you could alter thegraph as below:
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Falloff Curve for reversed
attenuation.

Falloff Curve for reversed attenuation
rendered.

Title-Img 1. 8Falloff Curve Profile Graph
Source-blender.org

Link- https://docs.blender.org/manual/en/dev/render/blender render/lighting/lights/att enuation.html

You are obviously not just limited to simple changes such as reversing the attenuation profile, you
can have almost any profile you desire.

Here is another example of a different Falloff Curve profile graph, along with its resultant render
output:

Oscillating attenuation profile.

Render showing the effects of a “wavelet”
profile graph on the light attenuation.

Title-Img 1. 9 Falloff Curve Profile Graph
Source-blender.org

Link https://docs.blender.org/manual/en/dev/render/blender render/lighting/lights/att enuation.html

Inverse Square
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Title-Img 1. 10 Render showing the Inverse Square lamp falloff type effect withdefault settings.
Source-blender.org

Link-https://docs.blender.org/manual/en/dev/render/blender render/lighting/lights/att enuation.html

This lamp falloff type attenuates its intensity according to inverse square law, scaled by the Distance
value. Inverse square is a sharper, realistic decay, useful for lighting such as desk lamps and street lights.
This is similar to the old Quad option (and consequently, to the new Lin/Quad Weighted option with
Linear to 0.0 and Quad to 1.0), with slight changes.

Inverse Linear

Title-Img 1.11Render showing the Inverse Linear lamp falloff type effect withdefault settings.
Source-blender.org

Link-https://docs.blender.org/manual/en/dev/render/blender render/lighting/lights/attenuation.html

This lamp falloff type attenuates its intensity linearly, scaled by theDistance value. This is the
default setting, behaving the same asthe default in previous Blender versions without Quad
switched on, and consequently, like the new Lin/Quad Weighted optionwith Linear to 1.0 and

Quad to 0.0. This is not physically accurate, however, can be easier to light with.

Constant
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Title-Img 1.12Render showing the Constant lamp falloff type effect withdefault settings.

Source-blender.org

Link-https://docs.blender.org/manual/en/dev/render/blender render/lighting/lights/att enuation.html

This lamp falloff type does not attenuate its intensity with distance. This is useful for distant light
sources like the sun or sky, which are so far away that their falloff is not noticeable. Sun and Hemi

lamps always have constant falloff.

Such a falloff model is commonly used in real-time rendering applications via a shading language like
GLSL.

Sphere

Title-Img 1. 6Screenshot of the 3D View editor, showing the Sphere light clippingcircle.

Source-blender.org

Link-https://docs.blender.org/manual/en/dev/render/blender render/lighting/lights/attenuation.html

The Sphere option restricts the light illumination range of a Lamp or Spot lamp, so that it will
completely stop illuminating an area once it reaches the number of Blender Units away from the
Lamp, as specified in the Distance field.
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When the Sphere option is active, a dotted sphere will appear around the light source, indicating

the demarcation point at which this light intensity will be null.

Render showing the light attenuation of  Render showing the light attenuation of
a Constant falloff light type with the a Constant falloff light type with the
Sphere option active. Sphere option deactivated.

Title-Img 1. 7Lin/Quad Weighted attenuation option.
Source-blender.org
Link-https://docs.blender.org/manual/en/dev/render/blender render/lighting/lights/att enuation.html

Examples

Distance Example

In this example, the Lamp has been set pretty close to the groupof planes. This causes the light
to affect the front, middle and rear planes more dramatically. Looking at Img 1.15 below, you can
see that as the Distance is increased, more and more objects become progressively brighter.

Distance: 10. Distance: 100. Distance: 1000.

Title-Img 1. 8 Various Distance settings (shadows disabled).
Source-blender.org

Link-https://docs.blender.org/manual/en/dev/render/blender render/lighting/lights/attenuation.html

The Distance parameter is controlling where the light is falling — at a linear rate by default — to half
its original value from the light’s origin. As you increase or decrease this value, you are changing
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where this half falloff occurs. You could think of Distance as the surface of a sphere and the surface
is where the light’s intensity has fallen to half its strength in all directions. Note that the light’s
intensity continues to fall even after Distance. Distance just specifies the distance where half of
the light’s energy has weakened.

Notice in Img 1.15 Distance: 1000., that the farthest objects are very bright. This is because the
falloff has been extended far into the distance, which means the light is very strong when it hits the
last few objects. It is not until 1000 Units that the light’s intensity has fallen to half of its original
intensity.

Contrast this with Img 1.15 Distance: 100., where the falloff occursso soon that the farther objects
are barely lit. The light’s intensity has fallen by a half by time it even reaches the tenth object.
You may be wondering why the first few planes appear to be dimmer? This is because the surface angle
between the light and the object’s surface normal is getting close to oblique. That is the nature of a Lamp
light object. By moving the light infinitely far away you would begin to approach the characteristics of the
Sun lamp type.

Inverse Square Example

Inverse Square makes the light’s intensity falloff with a non-linear rate, or specifically, a quadratic rate.
The characteristic feature of using Inverse Square is that the light’s intensity begins to fall off very slowly

however, then starts falling off very rapidly. We can see this inImg. 1.16 Inverse Square selected.

Inverse Square with
1000.

(with the specified distances). images.

==

Inverse Square with 10. Inverse Square with 100.

Title-Img 1. 9 Inverse Square selected. (with the specified distances).
Source-blender.org

Link-https://docs.blender.org/manual/en/dev/render/blender render/lighting/lights/att enuation.html

With Inverse Square selected, the Distance field specifies where the light begins to fall off faster,
roughly speaking; see the light attenuation description in Falloff types for more info.

In Img. 1.16 Inverse Square with 10., the light’s intensity has fallen so quickly that the last few
objects are not even lit.

Both Img. 1.16 Inverse Square with 100. and Img. 1.16 Inverse Square with 1000. appear to be
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almost identical and that is because the Distance is set beyond the farthest object’s distance which

is at about 40 BU out. Hence, all the objects get almost the full intensity of the light.

As above, the first few objects are dimmer than farther objects because they are very close to the
light. Remember, the brightness of an object’s surface is also based on the angle between the

surface normal of an object and the ray of light coming from the lamp.

This means there are at least two things that are controlling the surface’s brightness: intensity and
the angle between the lightsource and the surface’s normal.

Sphere Example

Title-Img 1. 10Clipping Sphere.

Source-blender.org
Link-https://docs.blender.org/manual/en/dev/render/blender render/lighting/lights/attenuation.html

Sphere indicates that the light’s intensity is null at the Distanceand beyond, regardless of the chosen
light’s falloff. In Img 1.17 Clipping Sphere. you can see a side view example of the setup with Sphere
enabled and a distance of 10.

Any object beyond the sphere receive no light from the lamp.

Sphere with 10. Sphere with 20. Sphere with 40.

Title-Img 1. 11 Sphere enabled with the specified distances, Inverse Linear lightfalloff.
Source-blender.org

Link- https://docs.blender.org/manual/en/dev/render/blender render/lighting/lights/att enuation.html
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The Distance field is now specifying both where the light’s rays become null, and the intensity’s
ratio falloff setting. Note that there is no abrupt transition at the sphere: the light attenuation is
progressive (for more details, see the descriptions of the Sphere and Falloff types above).

In Img 1.18 Sphere with 10., the clipping sphere’s radius is 10 Units, which means the light’s
intensity is also being controlled by 10 Units of distance. With a linear attenuation, the light’s

intensityhas fallen very low even before it gets to the first object.

In Img 1.18 Sphere with 20., the clipping sphere’s radius is now 20 BU and some light is reaching
the middle objects.

In Img 1.18 Sphere with 40., the clipping sphere’s radius is now 40 Units, which is beyond the last
object. However, the light does not make it to the last few objects because the intensity has fallen

to nearly 0.

Lamps Textures

3 image or Movie

Global

Title-Img 1. 12Lamp Texture panels.

Source-blender.org
Link-https://docs.blender.org/manual/en/dev/render/blender render/lighting/lights/te xtures.html

When a new lamp is added, it produces light in a uniform, flat color. While this might be sufficient in
simple renderings, more sophisticated effects can be accomplished through the use of textures. Subtle
textures can add visual nuance to a lamp, while hard textures can be used to simulate more pronounced

effects, such as a disco ball, dappled sunlight breaking through treetops, or even a projector. These textures
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are assigned to one of ten channels, and behave exactly like material textures, except that they affect a

lamp’s color and intensity, rather than a material’s surface characteristics.
Options

The lamp textures settings are grouped into two panels. Here we will only talk about the few things
that differ from object material textures.

The Texture-specific and the Mapping panels remain the same. However, you will note there are
much fewer Mapping options. You can only choose between Global, View or another Object ‘s
texture coordinates (since a lamp has no texture coordinates by itself), and you can scale or offset
the texture.

The Mapping panel is also a subset of its regular material’s counterpart. You can only map a lamp
texture to its regular, basic Color and/or to its Shadow color. As you can only affect colors,and a
lamp has no texture coordinates on its own, the Diffuse, Specular, Shading, and Geometry options

have disappeared.

Lamps Related Settings
Here are some options closely related to light sources, withoutbeing lamps settings.
Lighting Groups:

Materials

Title-Img 1. 13Light Group options for Materials.
Source-blender.org

Link-https://docs.blender.org/manual/en/dev/render/blender render/lighting/lights/in
other contexts.html

By default, materials are lit by all lamps in all visible layers, however, a material (and thus all
objects using that material) can be limited to a single group of lamps. This sort of control can be
incredibly useful, especially in scenes with complex lighting setups.To enable this, navigate to the
Material menu’s Options panel andselect a group of lamps in the Light Group field. Note that a
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light group must be created first.

If the Exclusive button is enabled, lights in the specified group will only affect objects with this material.

Render Layers

Title-Img 1. 14Light Group options for Render Layers.
Source-blender.org
Link-https://docs.blender.org/manual/en/dev/render/blender render/lighting/lights/in

othercontexts.html

There is a similar control located in the Layer panel of the Render Layers tab. If a light group

name is selected in this Light field, the scene will be lit exclusively by lamps in the specified group.

Unit summary
In this Unit, you have learnt what is 3D Lighting and how to
e Plan your 3D scene for lighting

e View limitations and global influences to setup a perfectlighting angle for your
3D Assets

e Set up the lights using Lamp Panel controlling light intensitywith the help of curve,
attenuation.

e Produce subtle visual nuance using texture connecting withchannels
After learning this Unit, you can download the Open Source Software available on the internet for

free of cost to practice the possibilities of creating 3D Interface.

Assignment

e Students are expected to experiment the lighting setups andparameters available in the
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panel.

Assessment

1. Define Indirect Lighting

2. Write a note on Lamp Panel

3. Describe Light Attenuation

4. Describe Sphere Option in Lighting

Write down the steps to create Lamp Texturing

Fill in the Blanks

1. means the light that is already present ina scene.
2. Direct lighting is equal to Light.
3. Lamp only illuminates objects on the when thelamp is on.

4. There are two main controls for light falloff - Pointand

5. The option restricts the lightillumination range of a Lamp or Spot lamp

Resources

While studying this Unit, you can browse the internet links for online video tutorials and several
books and training DVDs available in the Blender Store and on the Blender Cloud.

e wiki.blender.org

e ia600207.us.archive.org

e archive.org

e www.blender.org

e docs.blender.org

300


https://store.blender.org/
https://cloud.blender.org/
http://www.blender.org/

Unit-2 Introduction Understanding Shadows

Introduction

Light would not even exist without its counterpart: Shadows. Shadows are a darkening of

a portion of an object, because light is being partially or totally blocked from illuminating the

object. Theyadd contrast and volume to a scene; there is nearly no place in thereal world without

shadows, so to get realistic renders, you will need them. Blender supports the following kinds of

shadows:

Lamps: Ray-traced Shadows

Lamps: Buffered Shadows

1
2
3. Ambient Occlusion
4

Indirect Lighting

In this Unit, you will learn about Shadows and the various kinds of Shadows.

Outcomes

Upon completion of this unit you will be able to:

e Compose lighting with relevant shadow type
e Differentiate the types of shadows
e Apply shadow options for the available light setup inBlender software

Terminology

Raytrace

Ambient
Occlusion

Attenuation

Chains of Bones

In computer graphics, ray tracing is a technique for generating an
image by tracing the path of light through pixels in an image plane and
simulating the effects of its encounters with virtual objects, such as
reflection and refraction,scattering, and dispersion phenomena
Ambient occlusion is a method to approximate how bright light should
be shining on any specific part of a surface, based on the light and its
environment. This is used to add realism.

Length of rays defines how far away other faces may be and still have
an occlusion effect. The longer this distance, the greater impact that far-
away geometry will have on the occlusioneffect.

Bone can be the parent of several children, and hence be part of several
chains at the same time.

Lamps: Ray-traced Shadows

Ambient Occlusion really is not a shadow based on light per se, however, based on geometry.

However, it does mimic an effect where light is prevented from fully and uniformly illuminating

an object, so it is mentioned here. Also, it is important to mention Ambient Lighting, since
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increasing Ambient decreases the effectof a shadow.

You can use a combination of ray-traced and Buffer Shadows to achieve different results. Even
within ray-traced shadows, different lamps cast different patterns and intensities of shadow.
Depending on how you arrange your lamps, one lamp may wipe out or override the shadow cast

by another lamp.

Shadows are one of those trifectas in Blender, where multiple things must be set up in different

areas to get results:

e The Lamp must cast shadows (ability and direction).
e An Opaque object must block light on its way (position and layer).

e Another object’s material must receive shadows (Shadow and Receive Transparent
enabled).

e The render engine must calculate shadows (Shadow forbuffered shadows, Shadow and Ray
for ray-traced shadows).

For example, the simple Lamp, Area, and Sun light have the ability to cast ray shadows, however,
not Buffer Shadows. The Spot light can cast both, whereas the Hemi light does not cast any. If a
Sun lamp is pointing sideways, it will not cast a shadow from a sphere above a plane onto the
plane, since the light is not traveling that way. All lamps able to cast shadows share some common

options, described in the Shadow Panel.

Just to give you more shadow options (and further confuse the issue), lamps and materials can be
set to respectively only castand receive shadows, and not light the diffuse/specular aspects of the
object. Also, render layers can turn on/off the shadow pass, and their output may or may not contain

shadow information.

No Shadow Buffer Shadow

Title-Img 2. 1Ray Shadow enabled for a lamp.
Source-blender.org

Link-https://docs.blender.org/manual/en/dev/render/blender render/lighting/shadow
s/introduction.html?highlight=ray%?20shadow%20enabled%20lamp
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Ray-traced shadows produce very precise shadows with very low memory use, however, at the

cost of processing time. This type of shadowing is available to all lamp types except Hemi.

As opposed to buffered shadows (Lamps: Buffered Shadows), ray- traced shadows are obtained by
casting rays from a regular light source, uniformly and in all directions. The ray-tracer then
records which pixel of the final image is hit by a ray light, and which is not. Those that are not are

obviously obscured by a shadow.

Each light casts rays in a different way. For example, a Spot light casts rays uniformly in all
directions within a cone. The Sun light casts rays from an infinitely distant point, with all ray’s

parallel to the direction of the Sun light.

For each additional light added to the scene, with ray-tracing enabled, the rendering time increases.
Ray-traced shadows require more computation than buffered shadows however, produce sharp

shadow borders with very less memory resource usage.

To enable Ray-traced shadows, three actions are required:
e Step 1: Enable Shadows globally in the Render Menu’s Shading panel.
e Step 2: Enable Ray tracing globally from the same panel.

e Step 3: Enable ray-traced shadows for the light using the Ray Shadow button in the Light
menu’s Shadow panel. This panel varies depending on the type of light.

All lamps able to cast ray-traced shadows share some commonoptions, described in Ray-traced

Properties.

Ray-traced shadows can be cast by the following types of lamp:
1. Point lamp
2. Spot lamp
3. Arealamp

4. Sun lamp

Lamps: Buffered Shadows
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No Shadow Ray Shadow

Classical Irregular Deep

Title-Img 2. 2Buffer Shadow enabled for a Spot lamp.
Source- blender.org

Link-https://docs.blender.org/manual/en/dev/render/blender render/lighting/shadow
s/introduction.html?highlight=ray%20shadow%20enabled%20lamp

v Auto Ray Bias

v Cast Approximate

Title-Img 2. 3Cast Buffer Shadows enabled for a material.

Source- blender.org
Linkhttps://docs.blender.org/manual/en/dev/render/blender render/lighting/shadow
s/introduction.html?highlight=ray%20shadow%?20enabled%20lamp

Buffered shadows provide fast-rendered shadows at the expense of precision and/or quality.
Buffered shadows also require more memory resources as compared to ray tracing. You must use
buffered shadows depending on your requirements. If you arerendering animations or cannot wait
hours to render a complex scene with soft shadows, Buffer Shadows are a good choice.

For a scanline renderer — and Blender’s built-in engine is, among other things, a scanline renderer
— shadows can be computedusing a shadow buffer. This implies that an “image”, as seen from
the spot lamp’s point of view, is “rendered” and that the distance - in the image — for each point
from the spot light is saved. Any point in the “rendered” image that is farther away than any of
those points in the spot light’s image is then considered to be in shadow. The shadow buffer stores
this image data.
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To enable buffered shadows these actions are required:

e Step 1: Enable shadows globally from the Scene Menu’s Gather panel by selecting
Approximate.

e Step 2: Enable shadows for the light using the BufferShadow button in the Lamp

menu’s Shadow panel.

e Step 3: Make sure the Cast Buffer Shadows options isenabled in each Material ‘s

Shadow panel.

The Spot lamp is the only lamp able to cast buffered shadows.

Indirect Lighting
Indirect Lighting adds indirect light bouncing of surrounding objects. It models the light that is reflected
from other surfaces to the current surface. It is more comprehensive, more physically correct, and

produces more realistic images. It is also more computationally expensive.

Title-Img 2. 4Indirect Lighting parameters
Source- blender.org

Link- https://docs.blender.org/manual/en/dev/render/blender render/lighting/shadow
s/introduction.html?highlight=ray%20shadow%20enabled%20lamp

Options
Indirect Lighting Panel contains two options:
1. Factor

Defines how much surrounding objects contribute to light.
2. Bounces
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Number of indirect diffuse light bounces.
Gather Panel contains settings for the indirect lighting quality. Note that these settings also apply

to Environment Lighting and Ambient Occlusion.

Approximate

Raytrace

Title-Img 2. 5 The Indirect Lighting panel, Approximate method.
Source- blender.org

Link-https://docs.blender.org/manual/en/dev/render/blender render/world/indirectlighting.html

The Approximate method gives a much smoother result for the same amount of render time,
however, as its name states, it isonly an approximation of the Raytrace method, which implies

it might produce some artifacts and it cannot use the sky’s textureas the base color.
This method seems to tend to “over-occlude” the results. Youhave two complementary options to
reduce this problem:
e Passes
Set the number of pre-processing passes, between (0 to10) passes. Keeping the pre-
processing passes high will increase render time, however, will also clear someartifacts
and over-occlusions.

e Error

This is the tolerance factor for approximation error (i.e. themax allowed difference between
approximated result and fully computed result). The lower, the slower the render, however,
the more accurate the results... Ranges between (0.0 to 10.0), defaults to 0.250.

e Pixel Cache

When enabled, it will keep values of computed pixels to interpolate it with its neighbors.

These further speeds up the render, generally without visible loss in quality...
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e Correction

A correction factor is to reduce over-occlusion. Ranges between (0.0 to 1.0) correction.

Ambient Occlusion (AO)

Ambient Occlusion is a sophisticated ray-tracing calculation which simulates soft global
illumination shadows by faking darkness perceived in corners and at mesh intersections, creases,

and cracks, where ambient light is occluded, or blocked.

There is no such thing as AO in real life; AO is a specific not- physically-accurate (but generally
nice-looking) rendering trick. It basically samples a hemisphere around each point on the face, sees
what proportion of that hemisphere is occluded by other geometry, and shades the pixel

accordingly.

It has got nothing to do with light at all; it is purely a renderingtrick that tends to look nice
because generally in real life surfaces that are close together (like small cracks) will be darker than

surfaces that do not have anything in front of them, because of shadows, dirt, etc.

The AO process, though, approximates this result; it is not simulating light bouncing around or
going through things. That is why AO still works when you do not have any lights in the scene,

and it is why just switching on AO alone is a very bad way of “lighting” a scene.

You must have ray tracing enabled as a Render panel option in the Shading section for this to

work.

You must have an ambient light color set as you desire. By default,the ambient light color (world)
is black, simulating midnight in the basement during a power outage. Applying that color as
ambient will actually darken all colors. A good outdoor mid-day color is RGB(0.9, 0.9, 0.8) which
is a whitish yellow sunny kind of color on a bright-but-not-harshly-bright day.

Options

Multiply

Title-Img 2. 6 The World panel with ambient color sliders highlighted.
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Link-https://docs.blender.org/manual/en/dev/render/blender render/world/ambient
occlusion.html?highlight=world%20panel%20ambient%20color%20sliders%20highlighted

e Factor
The strength of the AO effect, a multiplier for addition.

Ambient Occlusion is composited during the render. Twoblending modes are available:
I. Add

The pixel receives light according to the number of non- obstructed rays. The scene is

lighter. This simulates global illumination.

Il.  Multiply

Ambient occlusion is multiplied over the shading, making things darker.
Ambient occlusion has two main methods of calculation:
. Raytrace and

Il.  Approximate

Gather

Gather Panel contains settings for the Ambient occlusion quality. Note that these settings also

apply to Environment Lighting and Ambient Occlusion.

Raytrace

Approximate

Constant QMC

SOl

Title-Img 2. 7 The Amb Occ panel, Raytrace method.
Source- blender.org

Link-https://docs.blender.org/manual/en/dev/render/blender render/world/ambient
occlusion.html?highlight=world%20panel%20ambient%20color%20sliders%20highlighted

The Raytrace method gives the more accurate, however, also the more noisy results. You can get
a nearly noiseless image, however,at the cost of render time... It is the only option if you want to

use the colors of your sky’s texture.
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Attenuation

Length of rays defines how far away other faces may be and still have an occlusion effect. The
longer this distance, the greaterimpact that far-away geometry will have on the occlusion effect. A
high Distance value also means that the renderer must search a greater area for geometry that
occludes, so render time can be optimized by making this distance as short as possible for the visual

effect that you want.

Sampling Method

e Constant QMC

The base Quasi-Monte Carlo, gives evenly and randomly distributed rays.

e Adaptive QMC
An improved method of QMC, that tries to determine when the sample rate can be lowered
or the sample skipped, based on its two settings:

e Threshold
The limit below which the sample is considered fully occluded (“black™) or un-occluded
(“white”), and skipped.

e Adapt to Speed

A factor to reduce AO sampling on fast-moving pixels. As it uses the Vector render pass,
that must also be enabled.

e Constant Jittered

The historical sample method, more prone to “bias” artifacts...

e Bias

The angle (in radians) the hemisphere will be made narrower (i.e. the hemisphere will no
longer be a real hemisphere: its section will no longer be a semicircle, however, an arc of a

circle of: pi - bias radians).

The bias setting allows you to control how smooth“smooth” faces will appear in AO

rendering. Since AO occurs on the original faceted mesh, it is possible that the AO light
309



makes faces visible even on objects with “smooth”on. This is due to the way AO rays are
shot, and can be controlled with the Bias slider. Note that while it might even happen with
QMC sampling methods, it is much morevisible with the Constant Jittered one and anyway,
you have no Bias option for QMC.

24x24 UV Sphere with Bias: 0.05 Raising the Bias to 0.15 removes
(default). Note the facets on the the faceted artifacts.
sphere’s surface even though it is
set to smooth.

Title-Img 2.8 Bias

Source- blender.org
Linkhttps://docs.blender.org/manual/en/dev/render/blender_render/world/ambient
occlusion.htmlI?highlight=world%20panel%20ambient%20color%20sliders%20highlighted

Samples

The number of rays used to detect if an object is occluded. Higher numbers of samples give
smoother and more accurate results, at the expense of slower render times. The default value of 5
isusually good for previews. The actual number of rays shot out is the square of this number (i.e.
Samples at 5 means 25 rays). Rays are shot at the hemisphere according to a random pattern
(determined by the sample methods described above); this causes differences in the occlusion
pattern of neighboring pixels unless the number of shot rays is big enough to produce good
statistical data.

Ambient Occlusion Ambient Occlusion Ambient Occlusion
with 3 Samples. with 6 Samples. with 12 Samples.

Title-Img 2.9 Ambient Occlusion samples
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Source- blender.org
Link-https://docs.blender.org/manual/en/dev/render/blender render/world/ambient
occlusion.html?highlight=world%20panel%20ambient%20color%20sliders%20highighted

Approximate

Title-Img 2.10 Ambient Occlusion panels, approximate method

Source- blender.org
Link-https://docs.blender.org/manual/en/dev/render/blender_render/world/ambient
occlusion.html?highlight=world%20panel%20ambient%20color%20sliders%20highlighted

The Approximate method gives a much smoother result for the same amount of render time,
however, as its name states, it isonly an approximation of the Raytrace method, which implies it
might produce some artifacts and it cannot use the sky’s textureas the base color.

This method seems to tend to “over-occlude” the results. Youhave two complementary options to
reduce this problem:

e Passes

Set the number of pre-processing passes, between (0 t010) passes. Keeping the pre-
processing passes high will increase render time however, will also clear some artifactsand
over-occlusions.

e Error

This is the tolerance factor for approximation error (i.e. themax allowed difference between
approximated result and fully computed result). The lower, the slower the render, however,
the more accurate the results... Ranges between (0.0 to 10.0), defaults to 0.250.

e Pixel Cache

When enabled, it will keep values of computed pixels to interpolate it with its neighbours.
This further speed up the render, generally without visible loss in quality...

e Correction
A correction factor to reduce over-occlusion. Rangesbetween (0.0 to 1.0) correction.

Common Settings

e Falloff
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When activated, the distance to the occluding objects will influence the “depth” of the
shadow. This means that the further away the occluding geometry is, the lighter its
“shadow” will be. This effect only occurs when theStrength factor is higher than 0.0. It
mimics light dispersionin the atmosphere...

e Strength

Controls the attenuation of the shadows enabled with Use Falloff. Higher values give a
shorter shadow, as it falls off more quickly (corresponding to a more foggy/dusty
atmosphere). Ranges from (0.0 to 10.0), default is 0.0, which means no falloff.

e Technical Details

Ambient occlusion is calculated by casting rays from each visible point, and by counting
how many of them actually reach the sky, and how many, on the other hand, are obstructed
by objects.

The amount of light on the point is then proportional tothe number of rays which have
“escaped” and have reached the sky. This is done by firing a hemisphere of shadow rays
around. If a ray hits another face (it is occluded) then that ray is considered “shadow”,
otherwise it is considered “light”. The ratio between “shadow” and “light” rays defines how
bright a given pixel is.

Shadow Panel

No Shadow Ray Shadow

|:||:|

No Shadow Buffer Shadow

:D

Title-Img 2.11 Common shadowing options for lamps.

Source- blender.org
Link-https://docs.blender.org/manual/en/dev/render/blender_render/lighting/shadow
s/shadow_panel.html?highlight=common%?20shadowing%20options%20lamps

All lamps able to cast shadows. Share some options, describedbelow:
Shadow Method
e No Shadow

The lamp casts no shadow.
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e Buffered Shadow
The Spot lamp is the only lamp able to cast buffered shadows.
e Raytraced Shadows

Ray-traced Properties.

e This Layer Only

When this option is enabled, only the objects on the same layer as the light source will cast

shadows.

e Only Shadow

The light source will not illuminate an object however, will generate the shadows that would
normally appear. This feature is often used to control how and where shadows fall by having
a light which illuminates however, has no shadow, combined with a second light which
does not illuminate however, has Only Shadow enabled, allowingthe user to control shadow

placement by moving the “Shadow Only” light around.

e Shadow color

This color picker control allows you to choose the color of your cast shadows (black by
default). The images below were all rendered with a white light and the shadow color was

selected independently.

Red colored shadow Green colored Blue colored shadow
example. shadow example. example.

Title-Img 2.12 Shadow color
Source- blender.org

Link-https://docs.blender.org/manual/en/dev/render/blender render/lighting/shadow

s/shadow panel.html?highlight=common%?20shadowing%200options%20lamps

Although you can select a pure white color for a shadow color, itappears to make a shadow
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disappear.

Raytraced Shadows

No Shadow Buffer Shadow

Title-Img 2.13 Ray shadowing options for lamps.
Source-blender.org

Link-https://docs.blender.org/manual/en/dev/render/blender render/lighting/shadow
s/raytraced properties.html

Most lamp types (Lamp, Spot and Sun) share the same options for the ray-traced shadows generation,
which are described below. Note that the Area lamp, even though using most of these options, have
some specifics described in its own ray-traced shadows page.

Ray Shadow

The Ray Shadow button enables the light source to generate ray- traced shadows. When the Ray
Shadow button is selected, another set of options is made available, those options being:

Shadow sample generator type

Method for generating shadow samples:
» Adaptive QMC is fastest,

» Constant QMC is less noisy however, slower. This allows you to choose which algorithm is
to be used to generate the samples that will serve to compute the ray-traced shadows

e Constant QMC

The Constant QMC method is used to calculate shadow values in a very uniform, evenly
distributed way. This method results in very good calculation of shadow value however,
it is not as fast as using the Adaptive QMC method; however, Constant QMC is more
accurate.

e Adaptive QMC

The Adaptive QMC method is used to calculate shadow values in a slightly less uniform
and distributed way. This method results in good calculation of shadow valuehowever, not
as good as Constant QMC. The advantage of using Adaptive QMC is that it is in general
much quicker while being not much worse than Constant QMC in termsof overall results.

e Samples
Number of extra samples taken (samples x samples). This slider sets the maximum number
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of samples that both Constant QMC and Adaptive QMC will use to do their shadow
calculations. The maximum value is 16: the real number of samples is actually the square
of it, so setting a sample value of 3 really means 32 = 9 samples will be taken.

e Soft Size

Light size for ray shadow sampling. This slider determines the size of the
fuzzy/diffuse/penumbra area around the edge of a shadow. Soft Size only determines the
width of the soft shadow size, not how graded and smooth the shadow is. If you want a
wide shadow which is also soft and finely graded, you must also set the number of samples
in the Samples field higher than 1; otherwise this field has no visible effect and the shadows
generated will not have a soft edge. The maximum value for Soft Size is 100.0.

Below is a table of renders with different Soft Size and Samples settings showing the effect of
various values on the softness of shadow edges:

Soft Size: 1.0, Soft Size: 1.0, Soft Size: 1.0,
Samples: 2. Samples: 4. Samples: 6.

Soft Size: 2.0, ‘ Soft Size: 2.0, Soft Size: 2.0,
Samples: 2. Samples: 4. Samples: 6.

Soft Size: 3.0, ‘ Soft Size: 3.0, Soft Size: 3.0,
Samples: 2. Samples: 4. Samples: 6.

Title-Img 2.14 Different soft size and samples
Source-blender.org

Link-https://docs.blender.org/manual/en/dev/render/blender render/lighting/shadow

s/raytraced properties.html

Below is an animated version of the above table of imagesshowing the effects.
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Title-Img 2.15 Animated version renders with different Soft Size and Samples settings showing the effect of various
values on the softness of shadow edges.
Source-blender.org

Link-https://docs.blender.org/manual/en/dev/render/blender render/lighting/shadow
s/raytraced properties.html

Threshold

Threshold is for Adaptive Sampling. This field is used with the Adaptive QMC shadow calculation
method. The value is used to determine if the Adaptive QMC shadow sample calculation can be
skipped based on a threshold of how shadowed an area is already. The maximum Threshold value
is 1.0.

Quasi-Monte Carlo method

The Monte Carlo method is a method of taking a series of samples/readings of values (any kind
of values, such as light values, color values, reflective states) in or around an area at random, so
as to determine the correct actions to take in certain calculations which usually require multiple
sample values to determine overall accuracy of those calculations. The Monte Carlo method tries
to be as random as possible; this can often cause areas that are being sampled to have large irregular
gaps in them (places that are not sampled/read). This in turn can cause problems for certain

calculations (such as shadow calculation).
The solution to this was the Quasi-Monte Carlo method.

The Quasi-Monte Carlo method is also random, however, tries to make sure that the
samples/readings it takes are also better distributed (leaving less irregular gaps in its sample areas)
and more evenly spread across an area. This has the advantage of sometimes leading to more

accurate calculations based onsamples/reading.

Volumetric Lighting
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Volumetric lighting is a technique used in 3D computer graphics toadd lighting effects to a
rendered scene. It allows the viewer tosee beams of light shining through the environment; seeing
sunbeams streaming through an open window is an example of volumetric lighting, also known as
God rays. The term seems to have been introduced from cinematography and is now widely
applied to 3D modeling and rendering especially in the field of 3D gaming. In volumetric
lighting, the light cone emitted by a light source is modeled as a transparent object and considered
as a container of a “volume: as a result, light has the capability to give the effect of passing through
an actual three dimensional medium (such as fog, dust, smoke, or steam) that is inside its volume,

just like in the real world.”

—According to Wikipedia, Volumetric Lighting.

A classic example is the search light with a visible halo/shaft oflight being emitted from it as

the search light sweeps around.

By default, Blender does not model this aspect of light. For example, when Blender lights
something with a Spot light, you see the objects and area on the floor lit however, not the shaft/halo

oflight coming from the spotlight as it progresses to its target and would get scattered on the way.

The halo/shaft of light is caused in the real world by light being scattered by particles in the air,
some of which get diverted into your eye and that you perceive as a halo/shaft of light. The
scattering of light from a source can be simulated in Blender using various options, however, by

default is not activated.

The only lamp able to create volumetric effects is the Spot lamp (even thought you might consider

some of the “Sky & Atmosphere” effects of the Sun lamp as volumetric as well).

Unit summary

In this Unit, you have learnt
e Create depth using Shadows and lights
e Work on different types of shadows based on needs of your 3D Scene
e Work on Direct and Indirect Lighting
e Work on Shadows using ambient occlusion and shadow passes.
After learning this Unit, you can download the Open Source Software available on the internet for

free of cost to practice the possibilities of creating 3D Objects.

Assignment
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Use the same Living Room scene created for Block 02, Unit — 01 Assignment to light
with Blender

Use this key word “photo frame on wall” onwww.google.com to
collect the reference image to build yourlighting reference

Assessment

5.

Describe Ambient Occlusion
Write a note on Indirect Lighting
Define Volumetric Lighting

Write few lines about Raytracing

List the types of Shadow Settings available inBlender

Fill in the Blanks

1. Ray-traced shadows produce very precise with very low memory.
2. shadows provide fast-rendered shadows.
3. Indirect Lighting adds light of surrounding objects.
4, simulates soft global illumination shadows.
5. is also known as God rays.
Resources

While studying this Unit, you can browse the internet links for online video tutorials and several

books and training DVDs available in theBlender Storeand on theBlenderCloud.

Links to download 3D Files for practice - Copyright Notice Attribution-Non Commercial —
Share Alike CC BY-NC-SA

1.

https://wiki.blender.org/index.php/Doc:2.4/Tutorials/Lighting/BSoD

https://cloud.blender.org/p/hdri

wiki.blender.org

ia600207.us.archive.org

archive.org
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6. www.blender.org

7. docs.blender.org

Books to refer
8. Blender 2.5 Lighting and Rendering

9. https://www.lifewire.com/quick-tips-for-interesting-cg- lighting-2119
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Unit-3 Using Lamps in Blender
Introduction

In this Unit, you will learn about Lighting using Lamps in Blender. AShading model is used
to describe how surfaces respond to light.
Lighting refers to the simulation of light in computer graphics using Blender. This simulation can
either be extremely accurate, as is the case in an application like Radiance which attempts to track
the energy flow of light interacting with materials using Radiosity computational techniques.
Alternatively, the simulation can simply be inspired by light physics, as is the case with non-
photorealistic rendering. Between these two extremes, there are many different lighting approaches

which can be employed to achieve almost on any desired visual result.
Outcomes

Upon completion of this unit, you will be able to:

e Design lighting with relevant Lamp type
e Differentiate the Lamp types with its Options
e Apply Lamp options for the available light setup andshadow parameters in Blender

software

Terminology

Turbidity . Turbidity is the cloudiness or haziness of a fluid caused by large
numbers of individual particles that are generallyinvisible to the naked
eye, similar to smoke in air. The measurement of turbidity is a key test
of water quality.

Light Falloff . Acandle across the room illuminates your book less well than a candle
at your shoulder. The decline in illumination withdistance is called
falloff or attenuationand in a physics

Volumetric - Volumetric lighting is a technique used in3D computer graphics to

Lighting add lighting effects to a rendered scene.
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Lamp Point

Title-Img 3. 1Point lamp
Source- docs.blender.org

Link-https://docs.blender.org/manual/en/dev/render/blender render/lighting/lamps/p oint.html

The Point lamp is an omni-directional point of light, that is, a point radiating the same amount
of light in all directions. It’s visualized by a plain, circled dot. Being a point light source, the
direction of the light hitting an object’s surface is determined by the line joining the lamp and the
point on the surface of the objectitself.

Light intensity/energy decays based on (among other variables) distance from the Point lamp to
the object. In other words, surfaces that are further away are rendered darker.

Shadows

Ray Shadow

Title-Img 3. 2Without ray shadows.
Source- docs.blender.org

Link-https://docs.blender.org/manual/en/dev/render/blender render/lighting/lamps/point.html
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No Shadow

Title-Img 3. 3 Point lamp with ray shadows and Adaptive QMC samplegenerator enabled.
Source- docs.blender.org

Link-https://docs.blender.org/manual/en/dev/render/blender render/lighting/lamps/p oint.html

The Point light source can only cast ray-traced shadows. It shares with other lamp types the
common shadow options described in Shadow Panel.

The ray-traced shadows settings of this lamp are shared with other lamps, and are described
Raytraced Properties.

Lamp: Sun

A Sun lamp provides light of constant intensity emitted in a single direction. A Sun lamp can be
very handy for a uniform clear daylight open-space illumination. In the 3D View, the Sun light is
represented by an encircled black dot with rays emitting from it, plus a dashed line indicating the

direction of the light.

This direction can be changed by rotating the Sun lamp, like any other object, but because the light
is emitted in a constant direction, the location of a Sun lamp does not affect the rendered result

(unless you use the “sky & atmosphere” option).

Title-Img 3. 4Sun lamp panel.

Atribution-
Source- docs.blender.org

Link-https://docs.blender.org/manual/en/dev/render/blender render/lighting/lamps/s
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Lamp options
e Energy and Color

These settings are common to most types of lamps, andare described in Light

Properties.

e Negative, This Layer Only, Specular, and Diffuse

These settings control what the lamp affects, as describedin What Light Affects.

The Sun lamp has no light falloff settings: it always uses a constant attenuation (i.e.

no attenuation!).

Sky & Atmosphere

REC709 CIE

1.000

Title-Img 3. 5Sky & Atmosphere panel.
Source- docs.blender.org
Link-https://docs.blender.org/manual/en/dev/render/blender render/lighting/lamps/s

un/introduction.html

Various settings for the appearance of the sun in the sky, and theatmosphere through which it

shines, are available.
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Shadow

No Shadow

Title-Img 3. 6Shadow panel.

Link- https://docs.blender.org/manual/en/dev/render/blender render/lighting/lamps/s un/introduction.html

The Sun light source can only cast ray-traced shadows. It shares with other lamp types the same

common shadowing options, described in Shadow Panel.

The ray-traced shadows settings of this lamp are shared with other lamps, and are described in

Raytraced Properties.

Lamp: Sky & Atmosphere

Title-Img 3. 7Sky & Atmosphere panel.

Atribution-
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Source-

Link-https://docs.blender.org/manual/en/dev/render/blender render/lighting/lamps/s un/introduction.html

This panel allows you to enable an effect that simulates various properties of real sky and
atmosphere: the scattering of sunlight as it crosses the kilometers of air overhead. For example,
whenthe Sun is high, the sky is blue (and the horizon, somewhat whitish). When the Sun is near
the horizon, the sky is dark blue/purple, and the horizon turns orange. The dispersion of the
atmosphere is also more visible when it is a bit foggy: the farther away an object is, the more

“faded” in light gray it is... Go out into the countryside on a nice hot day, and you will see it.

To enable this effect, you have to use a Sun light source. If, as usual, the position of the lamp has
no importance, its rotation is crucial: it determines which hour it is. As a starting point, you should
reset rotation of your Sun (with Alt-R, or typing 0 in each ofthe three Rotation Fields X, Y, Z in
the Transform panel). This way, you will have a nice mid-day sun (in the tropics).

Now, there are two important angles for the Sky/Atmosphere effect: the “incidence” angle
(between the light direction and the X-Y plane), which determines the “hour” of the day (as you
might expect, the default rotation — straight down — is “mid-day”, a light pointing straight up is
“midnight”, and so on...). And the rotation around the Z axis determines the position of the sun

around the camera.

Title-Img 3. 8 The dashed “light line” of the Sun lamp crossing the camerafocal point.

Source- docs.blender.org\

Link-https://docs.blender.org/manual/en/dev/render/blender render/lighting/lamps/s

un/sky atmosphere.html

In fact, to have a good idea of where the sun is in your world, relative to the camera in your 3D
View, you should always try to have the dashed “light line” of the lamp crossing the center of the
camera (its “focal” point), as shown in Img 3. 8(The dashed “light line” of the Sun lamp crossing
the camera focal point). This way, in camera view (NumpadO, center area in the example picture),

you will see where the “virtual” sun created by this effect will be.
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It is important to understand that the position of the sun has no importance for the effect: only its

orientation is relevant. The position just might help you in your scene design.

= .

N Y, :
2 M 4 . - : -t

Di'stancé? 30 Distance: 4.0.

Title-Img 3. 9 Variations in Distance parameter, all other settings to default.
Source- docs.blender.org

Link-https://docs.blender.org/manual/en/dev/render/blender render/lighting/lamps/s

un/sky atmosphere.html

Hints and limitations

To always have the Sun pointing at the camera center, you can usea Track To constraint on the
sun object, with the camera as target,and -Z as the “To” axis (use either X or Y as “Up” axis). This
way, to modify height/position of the sun in the rendered picture, you justhave to move it;
orientation is automatically handled by the constraint. Of course, if your camera itself is moving,
you should also add e.g. a Copy Location constraint to your Sun lamp, with the camera as target
and the Offset option activated... This way, the sun light will not change as the camera moves

around.

If you use the default Add mixing type, you should use a very dark-blue world color, to get correct

“nights”...

This effect works quite well with a Hemi lamp, or some ambient occlusion, to fill in the Sun
shadows.
Atmosphere shading currently works incorrectly in reflections andrefractions and is only supported for

solid shaded surfaces. This will be addressed in a later release.

Lamps: Spot

A Spot lamp emits a cone-shaped beam of light from the tip of thecone, in a given direction.

The Spot light is the most complex of the light objects and indeed, for a long time, among the most
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used thanks to the fact that it was the only one able to cast shadows. Nowadays, with a ray tracer
integrated into Blender’s internal render engine, all lamps can cast shadows (except Hemi). Even
so0, Spot lamps’ shadow buffers are much faster to render than ray-traced shadows, especially when

blurred/softened, and spot lamps also provide other functionality such as “volumetric” halos.

Lamp options

Hemi

Title-Img 3. 9Common Lamp options of a Spot.
Source- docs.blender.org

Link-https://docs.blender.org/manual/en/dev/render/blender render/lighting/lamps/s

pot/introduction.htm|?highlight=common%?20lamp%20options%20spot

e Distance, Energy and Color

These settings are common to most types of lamps, andare described in Light

Properties.

e This Layer Only, Negative, Diffuse and Specular

These settings control what the lamp affects, as describedin What Light Affects.

e Light Falloff and Sphere

These settings control how the light of the Spot decayswith distance.
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Distance

Clip Start

Title-Img 3. 10 Changing the Spot options also changes the appearance ofthe spotlight as displayed in
the 3D View.
Source- docs.blender.org

Link-https://docs.blender.org/manual/en/dev/render/blender render/lighting/lamps/s

pot/introduction.html?highlight=common%?20lamp%20options%20spot

Shadows

No Shadow Buffer Shadow

Title-Img 3. 11Shadow panel set to Ray Shadow.

Source- docs.blender.org

Link-https://docs.blender.org/manual/en/dev/render/blender render/lighting/lamps/s

pot/introduction.html?highlight=common%?20lamp%20options%20spot

Spotlights can use either ray-traced shadows or buffered shadows. Either of the two can provide
various extra options. Ray-traced shadows are generally more accurate, with extra capabilities

such as transparent shadows, although they are quiteslower to render.
e No Shadow

Choose this to turn shadows off for this spot lamp. This canbe useful to add some discreet
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directed light to a scene.

e Buffer Shadow

Buffered Shadows are also known as depth map shadows. Shadows are created by
calculating differences in the distance from the light to scene objects. Buffered shadows are
more complex to set up and involve more faking, but the speed of rendering is a definite
advantage. Nevertheless, it shares with other lamp types common shadow options described
in Shadow Panel.

e Ray Shadow

The ray-traced shadows settings of this lamp are shared with other lamps, and are described

in Raytraced Properties.

Spot Shape

Size

The size of the outer cone of a Spot, which largely controls the circular area a Spot light covers.
This slider in fact controls the angle at the top of the lighting cone, and can be between (1.0 to
180.0).

Title-Img 3. 12Changing the spot size option

Source- docs.blender.org

Link- https://docs.blender.org/manual/en/dev/render/blender render/lighting/lamps/s

pot/introduction.html?highlight=common%20lamp%20options%20spot
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Blend

The Blend slider controls the inner cone of the Spot. The Blend value can be between (0.0 to 1.0).
The value is proportional and represents that amount of space that the inner cone should occupy

inside the outer cone Size.

The inner cone boundary line indicates the point at which light from the Spot will start to
blur/soften; before this point its lightwill mostly be full strength. The larger the value of Blend
the more blurred/soft the edges of the spotlight will be, and the smaller the inner cone’s circular

area will be (as it starts to blur/soften earlier).

To make the Spot have a sharper falloff rate and therefore less blurred/soft edges, decrease the
value of Blend. Setting Blend to 0.0 results in very sharp spotlight edges, without any transition between
light and shadow.

The falloff rate of the Spot lamp light is a ratio between the Blend and Size values; the larger the
circular gap between the two, the more gradual the light fades between Blend and Size.

Blend and Size only control the Spot light cone’s aperture and softness (“radial” falloff); they do

not control the shadow’s softness as shown below (Img 3.14)

Spotlight Soft Edge

Object Hard Shadow

Title-Img 3. 13 Render showing the soft edge spotlighted area and the sharp/hardobject shadow.

Link- https://docs.blender.org/manual/en/dev/render/blender render/lighting/lamps/s

pot/introduction.html?highlight=common%20lamp%200ptions%20spot

Notice in the picture above Img 3. 14that the object’s shadow is sharp as a result of the ray tracing,
whereas the spotlight edges are soft. If you want other items to cast soft shadows within the Spot
area, you will need to alter other shadow settings.

e Square
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The Square button makes a Spot light cast a square lightarea, rather than the default
circular one.

e Show Cone
Draw a transparent cone in 3D View to visualize whichobjects are contained in it.
e Halo

Adds a volumetric effect to the spot lamp.

Spot Buffered Shadows

When the Buffer Shadow button is activated, the currently selected Spot light generates shadows,
using a “shadow buffer” rather than using raytracing, and various extra options and buttons

appear in the Shadow panel.
Buffer Type

There more than one way to generate buffered shadows. The shadow buffer generation type

controls which generator to use.

There are four shadow generation types, those being:
1. Classical
2. Classic-Halfway
3. lrregular

4. Deep

No Shadow Ray Shadow

Classical Irregular Deep

Title-Img 3. 14Buffer Shadow set to Classic-Halfway.
Link- https://docs.blender.org/manual/en/dev/render/blender render/lighting/lamps/s
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Classical

A Classical shadow generation method, which is used to be the Blender default and unique
method for generation of buffered shadows. It used an older way of generating buffered shadows,
but it could have some problems with accuracy of the generated shadows and can be very sensitive
to the resolution of the shadowbuffer Shadow Buffer > Size, different Bias values, and all the self-

shadowing issues that brings up.

The Classical method of generating shadows is obsolete and is really only still present to allow for
backward compatibility with older versions of Blender. In most other cases, you will want to

use Classic-Halfway instead.
Classic-Halfway

This shadow buffer type is an improved shadow buffering method and is the default option selected
in Blender. It works by taking an averaged reading of the first and second nearest Z depth values

allowing the Bias value to be lowered and yet not suffer as much from self-shadowing issues.
Not having to increase Bias values helps with shadow accuracy, because large Bias values can
mean small faces can lose theirshadows, as well as preventing shadows being overly offset from

the larger Bias value.
Classic-Halfway does not work very well when faces overlap, and biasing problems can happen.
Options
Here are now the options specific to these generation methods:
o Size

The Size number button can have a value from (512 to 10240).Size represents the resolution used
to create a shadow map. This shadow map is then used to determine where shadows lay withina

Scene.

As an example, if you have a Size with a value of 1024, you are indicating that the shadow data
will be written to a buffer which will have a square resolution of 1024x1024 pixels/samples from

the selected spotlight.

The higher the value of Size, the higher resolution and accuracy of the resultant shadows,

assuming all other properties of the light and scene are the same, although more memory and
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processing time would be used. The reverse is also true — if the Size value is lowered, the resultant
shadows can be of lower quality, but would use less memory and take less processing time to

calculate.

As well as the Size value affecting the quality of generated shadows, another property of Spot
lamps that affects the quality of their buffered shadows is the angle of the spotlights lighted area
(given in the Spot Shape Panel’s Size field).

As the spot shape Size value is increased, the quality of the cast shadows degrades. This happens
because when the Spot lighted area is made larger (by increasing spot shape Size), the shadow

buffer area must be stretched and scaled to fit the size of the new lighted area.

The Size resolution is not altered to compensate for the change in size of the spotlight, so the quality
of the shadows degrades. If youwant to keep the generated shadows the same quality, as you
increase the spot shape Size value, you also need to increase the buffer Size value.

Filter Type

The Box, Tent, and Gauss filter types control what filtering algorithm to use to anti-alias the

buffered shadows.

They are closely related to the Samples number button, as when this setting is set to 1, shadow

filtering is disabled, so none of these buttons will have any effect whatsoever.
e Box

The buffered shadows will be anti-aliased using the “box” filtering method. This is the original
filter used in Blender. It is relativelylow quality and is used for low resolution renders, as it
produces very sharp anti-aliasing. When this filter is used, it only takes into account oversampling
data which falls within a single pixel, and does not take into account surrounding pixel samples. It

is often useful for images which have sharply angled elements and horizontal/vertical lines.
o Tent

The buffered shadows will be anti-aliased using the “tent” filtering method. It is a simple filter that
gives sharp results, an excellent general-purpose filtering method. This filter also takes intoaccount

the sample values of neighboring pixels when calculating its final filtering value.
e Gauss

The buffered shadows will be anti-aliased using the “Gaussian” filtering method. It produces a very

soft/blurry anti-aliasing. As result, this filter is excellent with high resolution renders.
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Samples

The Samples number button can have a value between (1 and 16). It controls the number of samples
taken per pixel when calculatingshadow maps.

The higher this value, the more filtered, smoothed and anti-aliasedthe shadows cast by the current
lamp will be, but the longer they will take to calculate and the more memory they will use. The
anti-aliasing method used is determined by having one of the Box,Tent or Gauss buttons

activated.
Having a Samples value of 1 is similar to turning off anti-aliasingfor buffered shadows.
Soft

The Soft number button can have a value between (1.0 to 100.0).It indicates how wide an area is
sampled when doing anti-aliasing on buffered shadows. The larger the Soft value, the more

graduated/soft the area that is anti-aliased/softened on the edge of generated shadows.
Sample Buffers

The Sample Buffers setting can be set to values (1, 4 or 9), and represents the number of shadow

buffers that will be used when doing anti-aliasing on buffered shadows.

This option is used in special cases, like very small objects which move and need to generate really
small shadows (such as strands).It appears that normally, pixel width shadows do not anti-alias

properly, and that increasing Buffer Size does not help much.

So, this option allows you to have a sort of extra sample pass,done above the regular one (the

one controlled by the Box / Tent /Gauss, Samples and Soft settings).
The default 1 value will disable this option.

Higher values will produce a smoother anti-aliasing — but be careful: using a Sample Buffers of 4
will require four times as muchmemory and process time, and so on, as Blender will have to

compute that number of sample buffers.

Irregular
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No Shadow Ray Shadow

Classical lassic-Halfwa

Title-Img 3. 15Buffer Shadow set to Irregular.
Source- docs.blender.org

Link-https://docs.blender.org/manual/en/dev/render/blender render/lighting/lamps/s

pot/buffered shadow.html

Irregular shadow method is used to generate sharp/hard shadowsthat are placed as accurately as
raytraced shadows. This method offers very good performance because it can be done as a multi-

threaded process.

This method supports transparent shadows. To do so, you will firstneed to setup the shadow setting
for the object which will receive the transparent shadow Material » Shadow > Cat Buffer Shadows

and Buffer Bias.

Deep Generation Method

No Shadow Ray Shadow

Classical lassic-Halfwa Irregular

Title-Img 3. 16Buffer Shadow set to Deep.

Source- docs.blender.org
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Link-https://docs.blender.org/manual/en/dev/render/blender render/lighting/lamps/s

pot/buffered shadow.html

Deep Shadow buffer supports transparency and better filtering,at the cost of more memory

usage and processing time.

Compress

Deep shadow map compression threshold.

Common options

The following settings are common to all buffered shadowgeneration method.

Bias

The Bias number button can have a value between (0.001 to 5.0).Bias is used to add a slight
offset distance between an object and the shadows cast by it. This is sometimes required
because of inaccuracies in the calculation which determines whether an area of an object is

in shadow or not.

Making the Bias value smaller results in the distance between the object and its shadow
being smaller. If the Bias value is too small, an object can get artifacts, which can appear
as lines and interference patterns on objects. This problem is usually called “self-
shadowing”, and can usually be fixed by increasing the Bias value, which exists for that

purpose!

Other methods for correcting self-shadowing include increasing the size of the Shadow
Buffer Size or using a different buffer shadow calculation method such as Classic-Halfway

or Irregular.

Self-shadowing interference tends to affect curvedsurfaces more than flat ones, meaning
that if your scene has a lot of curved surfaces it may be necessary to increasethe Bias value

or Shadow Buffer Size value.

Having overly large Bias values not only places shadows further away from their casting
objects, but can also cause objects that are very small to not cast any shadow at all. At that
point altering Bias, Shadow Buffer Size or Spot Size values, among other things, may be

required to fix theproblem.

336


https://docs.blender.org/manual/en/dev/render/blender_render/lighting/lamps/spot/buffered_shadow.html
https://docs.blender.org/manual/en/dev/render/blender_render/lighting/lamps/spot/buffered_shadow.html

Clip Start & Clip End

When a Spot light with buffered shadows is added to a scene, an extra line appears on the

Spot 3D View representation.

The start point of the line represents Clip Start ‘s value and the end of the line represents
Clip End ‘s value. Clip Start can have a value between (0.1 to 1000.0), and Clip End,
between (1.0 to 5000.0). Both values are represented in Blender Units.

Clip Start indicates the point after which buffered shadows can be present within the Spot
light area. Any shadow which could be present before this point is ignored and no shadow

will be generated.

Clip End indicates the point after which buffered shadows will not be generated within the
Spotlight area. Any shadow which could be present after this point is ignored and no

shadow will be generated.

The area between Clip Start and Clip End will be capable of having buffered shadows
generated.

Altering the Clip Start and Clip End values helps in controlling where shadows can be
generated. Altering the range between Clip Start and Clip End can help speed up rendering,

save memory and make the resultant shadows more accurate.

When using a Spot lamp with buffered shadows, to maintain or increase quality of generated
shadows, it is helpful to adjust the Clip Start and Clip End such that their values closely
bound around the areas which they want to have shadows generated at. Minimizing the
range betweenClip Start and Clip End, minimizes the area shadows are computed in and

therefore helps increase shadow quality in the more restricted area.
Autoclip Start & Autoclip End

As well as manually setting Clip Start and Clip Endfields to control when buffered
shadows start and end, it is also possible to have Blender pick the best value independently
for each Clip Start and Clip End field.

Blender does this by looking at where the visible vertices are when viewed from the Spot

lamp position.
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Hints

Any object in Blender can act as a camera in the 3D View. Hence you can select the Spot light and

switch to a view from its perspective by pressing Ctrl-Numpado0.

Spot Volumetric Effects

Title-Img 3. 17Spot lamps’s Halo options.

Source- docs.blender.org

Link-https://docs.blender.org/manual/en/dev/render/blender render/lighting/lamps/s pot/halo.html

Spot lights also can produce “volumetric” effects.

Halo

The Halo button allows a Spot lamp to have a volumetric effect applied to it. This button
must be active if the volumetric effect is to be visible. Note that if you are using buffered

shadows.

Intensity

The Intensity slider controls how intense/dense the volumetric effect is that is generated
from the light source. The lower the value of the Intensity slider, the less visible the
volumetric effect is, while higher Intensity values give amuch more noticeable and dense
volumetric effect.

Step

This field can have a value between (0 to 12). It is used to determine whether this Spot will
cast volumetric shadows, and what quality those volumetric shadows will have. If Step is
set to a value of 0, then no volumetric shadow will be generated. Unlike most other controls,
asthe Step value increases, the quality of volumetric shadows decreases (but take less time
to render), and vice versa.
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e Tip

Step values

A value of 8 for Halo Step is usually a good compromise between speed and accuracy.

Blender only simulates volumetric lighting in Spot lamps whenusing its internal renderer. This can lead to
some strange resultsfor certain combinations of settings for the light’s Energy and the halo’s Intensity. For
example, having a Spot light with null or very low light Energy settings but a very high halo Intensity setting
can result in a dark/black halo, which would not happen in the real world. Just be aware of this possibility when

using halos with the internal renderer.

Lamp: Hemi

RN
[

T ®

— I

Title-Img 3. 18Hemi light conceptual scheme.

Source- docs.blender.org
Link-https://docs.blender.org/manual/en/dev/render/blender_render/lighting/lamps/h
emi.html?highlight=hemi%?20light%20conceptual%20scheme

The Hemi lamp provides light from the direction of a 180- hemisphere, designed to simulate the
light coming from a heavily clouded or otherwise uniform sky. In other words, it is a light which
is shed, uniformly, by a glowing dome surrounding the scene.

Similar to the Sun lamp, the Hemi s location is unimportant, whileits orientation is key.

The Hemi lamp is represented with four arcs, visualizing the orientation of the hemispherical
dome, and a dashed line representing the direction in which the maximum energy is radiated, the
inside of the hemisphere.

339


https://docs.blender.org/manual/en/dev/render/blender_render/lighting/lamps/hemi.html?highlight=hemi%20light%20conceptual%20scheme
https://docs.blender.org/manual/en/dev/render/blender_render/lighting/lamps/hemi.html?highlight=hemi%20light%20conceptual%20scheme

Options

Point Sun
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Title-Img 3. 19Hemi lamp’s panel.

Source- docs.blender.org
Link-https://docs.blender.org/manual/en/dev/render/blender_render/lighting/lamps/h
emi.html?highlight=hemi%20light%20conceptual %20scheme

e Energy and Color

These settings are common to most types of lamps.

e Layer, Negative, Specular, and Diffuse

These settings control what the lamp affects, as describedin What Light Affects.

The Hemi lamp has no light falloff settings: it always uses aconstant attenuation (i.e.

no attenuation).

Since this lamp is the only lamp which cannot cast any shadow,the Shadow panel is absent.
Lamp: Area

The Area lamp simulates light originating from a surface (or surface-like) emitter. For example, a
TV screen, your supermarket’s neon lamps, a window, or a cloudy sky are just afew types of
area lamp. The area lamp produces shadows with soft borders by sampling a lamp along a grid
the size of which is defined by the user. This is in direct contrast to point-like artificial lights which

produce sharp borders.

Point Sun Spot Hemi

Title-Img 3. 20Commons Options.
Link-http://blender-manual-
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Lamp Options

e Distance, Energy and Color
These settings are common to most types of lamps, andare described in Light
Properties.

e Gamma

Amount to gamma correct the brightness of illumination.Higher values give more

contrast and shorter falloff.

The Area lamp does not have light falloff settings. It usesan “inverse quadratic”
attenuation law. The only way to control its falloff is to use the Distance and/or Gamma
settings.

e This Layer Only, Negative, Specular and Diffuse

These settings control what the lamp affects.

Shadows

When an Area light source is selected, the Shadow panel has thefollowing default layout:

Adaptive OMC settings. Constant Jittered settings.

Title-Img 3. 21 The shadow panel when area light source is selected.

Link-http://blender-manual- i18n.readthedocs.io/ja/latest/render/blender render/lighting/lamps/area.html

Area Shape

The shape of the area light can be set to Square or Rectangle.
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;

Square options. Rectangle options.

Title-Img 3. 22Area shape

Link-http://blender-manual- i18n.readthedocs.io/ja/latest/render/blender render/lighting/lamps/area.html

Square / Rectangular

Emit light from either a square or a rectangular area

e Size/Size X/SizeY

Dimensions for the Square or Rectangle

Area Raytraced Shadows

No Shadow

Constant QMC Constant Jittered

Title-Img 3. 23Adaptive QMC settings.

Link-http://blender-manual- i18n.readthedocs.io/ja/latest/render/blender render/lighting/lamps/area.html

The Area light source can only cast ray-traced shadows. The ray- traced shadows settings of this
lamp are mostly shared with other lamps. However, there are some specifics with this lamp, which
are detailed below:

Shadow Samples

Samples

This has the same role as with other lamps, but when using a Rectangle Area lamp, you have two
samples settings: Samples X and Samples Y, for the two axes of the area plane. Note also that
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when using the Constant Jittered sample generator method, thisis more or less equivalent to
the number of virtual lamps in the area. With QMC sample generator methods, it behaves similarly to

with Lamp or Spot lamps.
Sample Generator Types
e Adaptive QMC / Constant QMC

These common setting are described in Shadow Panel.

e Constant Jittered

The Area lamp has a third sample generator method, Constant Jittered, which is more like
simulating an array of lights. It has the same options as the old one: Umbra, Dither and
Jitter.

No Shadow

Adaptive QMC Constant QMC

Title-Img 3. 24Constant Jittered settings.
Link-http://blender-manual- i18n.readthedocs.io/ja/latest/render/blender render/lighting/lamps/area.html

The following three parameters are only available when using the Constant Jittered sample
generator method, and are intended to artificially boost the “soft” shadow effect, with possible loss
in quality:

e Umbra

Umbra, emphasizes the intensity of shadows in the area fully within the shadow rays. The
light transition between fully shadowed areas and fully lit areas changes more quickly (i.e.
a sharp shadow gradient). You need Samples values equal to or greater than 2 to see any
influence of this button.

e Dither

Applies a sampling over the borders of the shadows, similar to the way anti-aliasing is
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applied by the OSA buttonon the borders of an object. It artificially softens the borders of
shadows; when Samples is set very low, you can expect poor results, so Dither is better
used with medium Samples values. It is not useful at all with high Samples values, as the
borders will already appear soft.

e Jitter

Jitter adds noise to break up the edges of solid shadow samples, offsetting them from each
other in a pseudo- random way. Once again, this option is not very usefulwhen you use
high Samples values where the drawback is that noise generates quite visible graininess.

Hints

You will note that changing the Size parameter of your area lamp does not affect the lighting
intensity of your scene. On the other hand,  rescaling the lamp using the S in
the 3D View could dramatically increase or decrease the lighting intensity of the scene. This
behavior has been coded this way so that you can fine tune all your light settings and then decide
to scale up (or down) the whole scene without suffering from a drastic change in the lighting
intensity. If you only want to change the dimensions of your Area lamp, without messing with its

lighting intensity, you are strongly encouraged to use the Size button(s) instead.

If your computer is not very fast, when using the Constant Jitteredsample generator method, you
could find it useful to set a low Samples value (like 2) and activate Umbra, Dither, and/or Jitterin
order to simulate slightly softer shadows. However, these results will never be better than the same

lighting with high Samplesvalues.

Unit summary
In this Unit, you have learnt how to
e Create illumination using Lamps in Blender.
e Use lights allowing various shadow option types.

e Work on different setups created for diverse needs of your 3D Scene.

e Work on Dome type of lighting called Hemi and Area Lighting to create the desired
effects on the objects using Lamps in Blender.

After learning this Unit, you can download the Open Source Software available on the internet for
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free of cost to practice the possibilities of creating 3D Objects.
Assignment

e Use the same Living Room scene created for Block 02, Unit — 01 Assignment to light

with Blender, improvise the sameusing Lamps as required.

e Use these key words “photo frame on wall” on www.google.com to collect the reference

image to build your lighting references.

Assessment

1. Explain Light Falloff

2. Write a note on Point Lamp

3. Write short note on the following
a. Sun
b. Sky & Atmosphere

Explain Buffer Shadow with Illustrations
Draw Soft Shadow Edge and Hard Shadow edge using “Sphere”as a reference point

ok~

Fill in the Blanks

1. is an omni-directional source of light
2. Spotisa source of light.
3. is a source simulating light, as windows, neon, TV screens.

4. Hemi simulates a very wide and far away light source, like the

5. simulates a very far away and punctual light source, like the sun.

Resources

While studying this Unit, you can browse the following internet links for online video tutorials
and several books and training DVDs available in the Blender Store and on the Blender Cloud.

Links to download 3D Files for practice - Copyright Notice
Attribution-Non Commercial-Share Alike CC BY-NC-SA
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1. https://wiki.blender.org/index.php/Doc:2.4/Tutorials/Lighting/ BSoD

2. https://cloud.blender.org/p/hdri\

wiki.blender.org

ia600207.us.archive.org

archive.org
www.blender.org

N o g B~ ow

docs.blender.org

Books to refer

8. Blender 2.5 Lighting and Rendering by Aaron W. Powell

9. Read Chapter 7 of the John Blain "Complete Guide to BlenderGraphics" - Lighting
and Cameras (pages 131-136)

10. https://www.lifewire.com/quick-tips-for-interesting-cg-lighting-2119
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Unit-4 Using Light Rigs

Introduction

In this Unit, you will learn about Light Rigs and how it is used. A rigis a standard setup and

combination of objects; there can be lighting rigs, or armature rigs, etc. A rig provides a basic

setup andallows you to start from a known point and go from there.

Different rigs are used for different purposes and emulate different conditions; the rig you start

with depends on what you want to convey in your scene. Lighting can be very confusing, and the

defaults do not give good results. Further, very small changes can have a dramatic effect on the

mood and colors.

Outcomes

Upon completion of this unit you will be able to:

e Design One-point, Two-point and Three-point light rigs

e Utilize Camera Setup for Final rendering

e Recall all the lighting parameters to create one final LightRig

e Practice Lighting for different light setups Home, Factory, Office, Indoor, outdoor etc.,

Terminology
Light Rigs

Lens

Depth of Field

It is a collection of lights used to set up a simple light to effectively
highlight and show off your modeled assets. This series of lessons will
walk through the absolute basics of lighting for presentation.
Showcasing your work is an essential part of being a Computer Graphic
artist, and lighting is essential to showing off.

A lens is a transmissive optical device that focuses or disperses a light
beam by means of refraction. A simple lens consists of a single piece
of transparent material, while acompound lens consists of
several simple lenses (elements), usually arranged along a common
axis.

In optics, particularly as it relates to film and photography, depth of

field (DOF), also called focus range or effective focus range.
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Lighting Rigs

In all the lighting rigs, the default camera is always positioned nearly =~ 15 degrees offdead-on, about 25
BU (Blender Units) back and 9 BU to the side ofthe subject, at eye level, and uses a long lens of 80 mm.
Up close,a 35 mm lens will distort the image. A long lens takes in more of the scene. A dead-on camera
angle is too dramatic and frames toowide a scene to take in. So now you know; next time you go to a play,
sit off-center and you will not miss the action happening on the sidelines and will have a greater appreciation
for the depth of the set. Anyway, enough about camera angles; this is about lighting.

Environment or Ambient Light Only

Frame:1 | Time:00:00.19 | Ve:490 Fa:518 | Mem:62.07M (0.00M, Peak 66.57M)

Title-Img. 4. 1Environment (Ambient) lighting only.

Link-https://docs.blender.org/manual/en/dev/render/blender render/lighting/lightingrigs.html

In the World tab, there is a panel Environment Lighting, where you enable environment or ambient
lighting of your scene. Ambient light is the scattered light that comes from sunlight being reflected

off every surface it hits, hitting your object, and traveling to camera.
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Title-Img. 4. 2Ambient occlusion.

Link- https://docs.blender.org/manual/en/dev/render/blender render/lighting/lighting rigs.html

Ambient light illuminates, in a perfectly balanced, Shadeless way, without casting shadows. You
can vary the intensity of the ambient light across your scene via ambient occlusion. The ambient

color is a sunny white.

Single Rig

Title-Img. 4. 3Standard Spot light rig.
Link- https://docs.blender.org/manual/en/dev/render/blender render/lighting/lighting  rigs.html
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The sole, or key, spot light rig provides a dramatic, showy, yet effective illumination of one object
or a few objects close together. It is a single Spot light, usually with a hard edge. Halos are enabled
in this render to remind you of a smoky nightclub scene. It is placed above and directly in front of
the subject; in this case 10 BU in front and 10 BU high, just like a stage, it shinesdown at about

a 40 degrees angle. We use quadratic attenuation.

You can make the spot wider by increasing Size Spot Shape and softening the edge by increasing
Blend Spot Shape, and parent it to the main actor, so that the spot follows him as he moves around.

Obijects close to the main actor will naturally be more lit and your viewer will pay attention to them.

Moving this spot directly overhead and pointing down gives the interrogation effect. At the
opposite end of the show-off emotional spectrum is one soft candlelight (Point lamp, short falloff
Distance, yellow light) placed really up close to the subject, dramatizing the fearful “lost in the
darkness” effect.

Somewhere in the macabre spectrum is a hard spot on the floor shining upward. For fun, grab a
flashlight, head into the bathroom and close the door. Turn out the light and hold the flashlight
underyour chin, pointing up. Look in the mirror and turn it on. From this you can see that lighting,

even with a single light, varying theintensity, location and direction, changes everything in a scene.

e Use thisrig, with Environment Lighting (and props receiving and being lit by ambient light
in their material settings) for scenes that feature one main actor or a product being
spotlighted.

e Do not use this rig for big open spaces or to show all aspects of a model.

Two-Point Rig

Title-Img. 4. 4Standard two-point light rig.
Link- https://docs.blender.org/manual/en/dev/render/blender render/lighting/lighting rigs.html

The two-point lighting rig provides a balanced illumination of an object. Shown to the right are
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the views of the standard two-point lighting rig. It is called the two-point because there are two
pointsof light. The standard two-point lighting rig provides a balanced illumination of untextured
objects hanging out there in 3D space. This rig is used in real studios for lighting a product,
especially a glossy one.

Both lights are almost the same but do different things. Bothemulate very wide, soft light by being

Hemi. In real life, these lights bounce light off the inside of a silver umbrella.

Notice how we use low Energy to bring out the dimensionality of the sphere; I cannot stress that
enough. Hard, bright lights actuallyflatten it and make you squint. Soft lights allow your eye to

focus.

We disable specular for right Hemi, so we do not get that shiny forehead or nose.

The lamp on the left however, lets it be known that it is there by enabling specular; specular flare

is that bright spot that is off center above midline on the sphere.

e Use this rig to give even illumination of a scene, where there is no main focus.

The Hemi‘s will light up background objects and props, so Environment Lighting is not that
important. At the opposite end of the lighting spectrum, two narrow Spot lights at higher power
witha hard edge give a “This is the Police, come out with your hands up” kind of look, as if the

subject is caught in the crossfire.
Three-Point Rig

The standard three-point lighting rig is the most commonillumination of objects and scenes bar
none. If you want to show off your model, use this rig. As you can see, the untextured
unmaterialized sphere seems to come out at you. There are multiple thesis on this rig, and you will

use one of two:

1. Studio: Used in a real studio to film in front of a green screen or backdrop. Use this rig
when you are rendering your CG objects to alpha into the scene so that the lighting on

the actors and your CG objects is the same.

2. Standard: Used in real life to light actors on a set, and givessome backlighting to
highlight the sides of actors, making them stand out more and giving them depth.

Studio Rig
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Title-Img. 4. 5Studio three-point light rig.

Link- https://docs.blender.org/manual/en/dev/render/blender render/lighting/lighting rigs.html

Shown to the right are the “Studio” top, front, and side views of the standard three-point lighting
rig. It changes the dynamics of the scene, by making a brighter “key” light give some highlights to
the object, while two side “fill” lights soften the shadows created by the key light.

In the studio, use this rig to film a talking head (actor) in front of a green screen, or with multiple
people, keeping the key light on themain actor. This rig is also used to light products from all

angles, and the side fill lights light up the props.

The key light is the Area light placed slightly above and to the left of the camera. It allows the
specular to come out. It is about 30 BUback from the subject, and travels with the camera. A little
specular shine lets you know there is a light there, and that youare not looking at a ghost. In real

life, it is a spot with baffles, or blinders, that limit the area of the light.

The two sidelights are reduced to only fill; each of them are Hemi lights placed 20 BU to the side
and 5 BU in front of the subject, at ground level. They do not cause a spot shine on the surface by
disabling specular, and at ground level, light under the chin or any horizontal surfaces, countering

the shadows caused by the key light.

e Use this rig to give balanced soft lighting that alsohighlights your main actor or

object.

It combines the best of both the single rig and the two-point rig, providing balanced illumination
and frontal highlights. For a wide scene, you may have to pull the sidelights back to be more

positioned like the two-point rig.

Standard Rig
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Title-Img. 4. 6Standard three-point light rig.

Link- https://docs.blender.org/manual/en/dev/render/blenderrender/lighting/lightingrigs.html

Without a curtain in back of your main subject, you have depth to work with. The left fill light has
been moved behind the subject (soit is now called a backlight) and is just off-camera, while the
right- side fill light remains the same. The key light gives you specular reflection so you can play
with specularity and hardness in your object’s material settings. The key light gives that “in-the-
spotlight” feel, highlighting the subject, while the backlight gives a crisp edge to the subject against
the background. This helps them stand out.

In this rig, the key light is a fairly bright spot light. Use a slighter tinge of yellow because the
light is so bright; it is the only light for that side. The other sidelight has been moved in back and
raisedto eye (camera) level. You need to cut the energy of the backlight in half, or when it is added
to the remaining sidelight, it will lightup the side too much and call too much attention to itself.
You canvary the angle and height of the backlight to mimic sun lighting upthe objects.

e Use this rig in normal 3D animations to light the main actor.

e Use this rig especially if you have transparent objects (like glass) so that there is

plenty of light to shine through them to the camera.

The tricky part here is balancing the intensities of the lights so thatno one light competes with or

overpowers the others, while making sure all three works together as a team.

Four-point Rig
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Title-Img. 4. 7Four-point light rig.

Link- https://docs.blender.org/manual/en/dev/render/blender render/lighting/lighting  rigs.html

The four-point lighting rig provides a better simulation of outside lighting, by adding a Sun lamp
30 BU (Blender Unit) above, 10 to the side, and 15 BU behind the subject. This sunlight provides
backlighting and fills the top of the subject; even producing an intentional glare on the top of their
head, telling you there is a sunup there. Notice it is colored yellow, which balances out the blue
sidelights.

Changing the key light to a Spot, select Inverse Square, disable Specularand pure white light
combines with and softens the top sun flare while illuminating the face, resulting in a bright
sunshine effect. Two lights above mean sharper shadows as well, so you might want to adjust the
side fill lights. In this picture, they are stillHemi, disable Specular.

e Use this rig when the camera will be filming from behind the characters, looking over their

shoulder or whatnot, because the sun provides the backlight there.

e Also use this rig when you have transparent objects, so there is light to come through the

objects to the camera.

Another spot for the fill light is shining up onto the main actor’s face, illuminating the underside
of his chin and neck. This gets rid of a sometimes-ugly shadow under the chin, which if not
corrected, can make the actor look fat or like they have a double chin; otherwise distracting. It
evens out the lighting of the face.

Troubleshooting
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If you run into a problem with your render, where there are really bright areas, or really dark ones,

or strange shadows, or lines on your objects, here are some good steps to debugging what is wrong:

First, try deactivating all materials (create a default, gray one, and enter its name in the
Mat field, Layer panel, the Render Layer tab to get back all your normalmaterials, just
erase this text field!). See if you get those problems with just grayness objects. If you
donot have the problem anymore, that should tell you that you have got a materials-
interacting-with-light problem. Check the material settings, especially ambient, reflection
and all those little buttons and sliders in the Material tab. You can set some lights to affect
only certain materials, so if there is an issue with only a few objects being really bright, start

with those.

Then start “killing” lights (e.g. moving them to an unused layer); regress all the way back
to one light, make sure it is smooth, then add them in one by one.As they add together,
reduce power in the tested ones so they merge cleanly, or consider not adding it at all, or,

especially, reduce the energy of the lamp you just introduced.

You can also set lights to only light objects on a layer, so again, if some of the gray spheres
have weirdness, check for that as well. Again, you may have done some of this accidentally,
so sometimes deleting the light andre-adding it with defaults helps you reset to a known-

good situation.

Negative lights can be very tricky, and make your model blotchy, so pay special attention
to your use of those special lights. Shadow-only lights can throw off the look of the scene
as well. Overly textured lights can make your scene have random weird colors. Do not go
too far off a slight tinge of blue or yellow or shades of white, or your material may show
blue in the Material tab but render green, and you will be very confused.

Look at your Environment Settings World tab: Horizon, Zenith, and Environment Lighting.

Camera

A Camera is an object that provides a means of rendering images from Blender. It defines

which portion of a scene is visible in the rendered image. By default, a scene contains one

camera. However, a scene can contain more than one camera, but onlyone of them will be

used at a time.

Add a New Camera
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In Object mode simply press Shift-A and in the pop-up menu choose Add > Camera.

The default scene in Blender includes a camera, so you’ll probably only need to add a new one if

you have deleted the default one, orneed to animate a cut between two cameras.

Changing the Active Camera

Reference

e Mode: Object Mode

e Hotkey: Ctrl-NumpadO

Title-Img.4.8Active camera (left one).

Link- https://docs.blender.org/manual/en/dev/render/blender render/camera/introduction.html

The Active Camera is the camera that is currently being used forrendering and camera view

Numpado.
e Step 1: Select the camera you would like to makeactive
e Step 2: Press Ctrl-NumpadO

e Step 3: Switch the view to camera view.

In order to render, each scene must have an active camera.

The active camera can also be set in the Scene tab of the Properties Editor.

The camera with the solid triangle on top is the active camera.

Warning

The active camera, as well as the layers, can be specific to a givenview, or global (locked) to
the whole scene.

Render Border
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Reference
e Mode: All modes
e Menu: View » Render Border

e Hotkey: Ctrl-B

Render Presets

Title-Img. 4. 9Render Border toggle.

Link- https://docs.blender.org/manual/en/dev/render/blender render/camera/introduction.html

While in camera view, you can define a sub region to render by drawing out a rectangle within the
camera’s frame. Your renders will now be limited to the part of scene visible within the render

border. This can be very useful for reducing render times for quick previews on an area of interest.

The border can be disabled by disabling the Border option in the Dimensions panel in the Render

tab or by activating the option again.
Note

When Render Border is activated, Sampled Motion Blur willbecome available to view in the
3D View.

Title-Img. 4. 10 Render border and associated render
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Link- https://docs.blender.org/manual/en/dev/render/blender render/camera/introduc tion.html

Object Data

Cameras are invisible in renders, so they do not have any material or texture settings. However,
they do have Object and Editing setting panels available which are displayed when a camera is

the selected (active!) object.

Camera Lens

Orthographic Panoramic

wgth: 35.00 * BT s

Title-Img. 4. 10Camera Lens panel.
Link- https://docs.blender.org/manual/en/dev/render/blender render/camera/objectdata.html

The camera lens options control the way 3D objects arerepresented in a 2D image.
Lens Type
There are three different lens types:

1. Perspective
2. Orthographic

3. Panoramic

Perspective

This matches how you view things in the real-world. Objects in thedistance will appear smaller than objects
in the foreground, and parallel lines (such as the rails on a railroad) will appear to converge as they get

farther away.
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Title-Img. 4. 11 Render of a train track scene with a Perspective camera.

Link- https://docs.blender.org/manual/en/dev/render/blender render/camera/object data.html

Settings which adjust this projection include:

e Focal length
e Shift
e Sensor size
Focal length
The focal length setting controls the amount of zoom, i.e. the amount of the scene which is visible

all at once. Longer focallengths result in a smaller FOV (more zoom), while short focal lengths

allow you to see more of the scene at once (larger FOV, less zoom).

Title-Img. 4. 12 Render of the same scene as above, but with a focal lengthof 210mm instead of 35mm.

Link- https://docs.blender.org/manual/en/dev/render/blender render/camera/object data.html

Lens Unit

The focal length can be set either in terms of millimeters orthe actual Field of View as an angle.

Orthographic

With Orthographic perspective objects always appear at their actual size, regardless of distance.

This means that parallel lines appear parallel, and do not converge like they do with Perspective.
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Title-Img. 4. 13 Render from the same camera angle as the previousexamples, but with orthographic
perspective.

Link- https://docs.blender.org/manual/en/dev/render/blender render/camera/object data.html

Orthographic Scale

This controls the apparent size of objects in the camera.

Note that this is effectively the only setting which applies to orthographic perspective. Since
parallel lines do not converge in orthographic mode (no vanishing points), the lens shift settings

are equivalent to translating the camera in the 3D View.

Panoramic

Panoramic cameras are only supported in the Cycles renderengine.
Shift

The Shift setting allows for the adjustment of vanishing points. Vanishing points refer to the
positions to which parallel lines converge. In this example, the most obvious vanishing point is at

the end of the railroad.

To see how this works, take the following examples:

- -

Title- Img. 4. 14 Render of a train track scene with a horizontal lens shift 0f0.330.

Link- https://docs.blender.org/manual/en/dev/render/blender render/camera/object data.html
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Title-Img. 4. 15 Render of a train track scene with a rotation of the camera object instead of a lens shift.

Link- https://docs.blender.org/manual/en/dev/render/blender render/camera/object data.html

Notice how the horizontal lines remain perfectly horizontal when using the lens shift, but do get

skewed when rotating the camera object.
Using lens shift is equivalent to rendering an image with a larger FOV and cropping it off-center.

e Clipping

Set the clipping limits with the Start and End values.

Only objects within the limits are rendered.

For OpenGL display, setting clipping distances to limited values is important to ensure sufficient
rasterization precision. Ray tracing renders do not suffer from this issue so much, and as such more

extreme values can safely be set.

When Limits in the Display panel is enabled, the clip bounds will be visible as two yellow
connected dots on the camera line of sight.

Camera Preset

Options
Camera Presets

Camera Presets

< Size:

Title-Img.4. 16Camera Presets panel.

Link- https://docs.blender.org/manual/en/dev/render/blender render/camera/object data.html
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Sensor size

This setting is an alternative way to control the focal- length, it is useful to match the camera in

Blender to a physical camera & lens combination, e.g. for motion tracking.

Depth of Field

Title-Img. 4. 17Camera Depth of Field Panel.

Link- https://docs.blender.org/manual/en/dev/render/blender render/camera/object  data.html

Real world cameras transmit light through a lens that bends andfocuses it onto the sensor.
Because of this, objects that are a certain distance away are in focus, but objects in front and
behind that are blurred.

The area in focus is called the focal point and can be set using either an exact value, or by using

the distance between the camera and a chosen object:
e Focus Object

Choose an object which will determine the focal point. Linking an object will deactivate
the distance parameter. Typically, this is used to give precise control over the position of
the focal point, and also allows it to be animated or constrained to another object.

e Distance
Sets the distance to the focal point, when no Focus Obijectis specified. If Limits are
enabled, a yellow cross is shownon the camera line of sight at this distance.

e Hint
Hover the mouse over the Distance property and press E touse a special Depth Picker. Then
click on a point in the 3D View to sample the distance from that point to the camera.

¢ High Quality
In order for the viewport to offer an accurate representation of depth of field, like a render,

you must enable High Quality. Without it, you may notice a difference in shading.

e Viewport F-stop
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Controls the real-time focal blur effect used during sequencer or OpenGL rendering and,
when enabled,camera views in the 3D View. The amount of blur depends on this setting,
along with Focal Length and Sensor Size. Smaller Viewport F-stop values result in more
blur.

e Blades

Add a number of polygonal blades to the blur effect, in order to achieve a bokeh effect in

the viewport. To enable this feature, the blades must be set to at least 3 (3 sides, triangle)

Title-Img. 4. 18The viewport bokeh effect with the blades set to 3.
Link- https://docs.blender.org/manual/en/dev/render/blender render/camera/object data.html

Display

Composition Guides

Title-Img. 4. 19Camera Display Panel.

Link- https://docs.blender.org/manual/en/dev/render/blender render/camera/object data.html

e Limits
Shows a line which indicates Start and End Clipping values.

e Mist
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Toggles viewing of the mist limits on and off. The limits are shown as two connected white
dots on the camera line of sight. The mist limits and other options are set in the Worldpanel,

in the Mist section.

Camera Persp

Camera

Title-Img. 4. 20Camera view displaying safe areas, sensor and name.

Link- https://docs.blender.org/manual/en/dev/render/blender render/camera/object data.html

e Sensor

Displays a dotted frame in camera view.

e Name

Toggle name display on and off in camera view.

e Size

Refers to the size of the camera icon in the 3D View. This setting has no effect on the render
output of a camera, andis only a cosmetic setting. The camera icon can also be scaled using

the standard Scale S transform key.

e Passé partout, Alpha
This mode darkens the area outside of the camera’s field ofview, based on the Alpha setting.
e Composition Guides

Composition Guides are available from the menu, whichcan help when framing a shot.

There are eight types of guides available:
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Center

Adds lines dividing the frame in half vertically and horizontally.

Center Diagonal

Adds lines connecting opposite corners.

Thirds

Adds lines dividing the frame in thirds vertically and horizontally.

Golden

Divides the width and height into Golden proportions (About 0.618 of the size from all

sides of the frame).

Golden Triangle A

Draws a diagonal line from the lower-left to upper-right corners, then adds perpendicular
lines that pass through the top left and bottom right corners.

Golden Triangle B

Same as A, but with the opposite corners.

Harmonious Triangle A

Draws a diagonal line from the lower-left to upper-right corners, then lines from the top left
and bottom right corners to 0.618 the lengths of the opposite side.

Harmonious Triangle B

Same as A, but with the opposite corners.

Safe Areas

Safe areas are guides used to position elements to ensure that themost important parts of the content can

be seen across all screens.

Different screens have varying amounts of over scan (speciallyolder TV sets). That means that not

all content will be visible to all viewers, since parts of the image surrounding the edges are not

shown. To work around this problem TV producers defined, two areas where content is guaranteed
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to be shown: action safe and title safe.

Modern LCD/plasma screens with purely digital signals have no over scan, yet safe areas are still

considered best practice and maybe legally required for broadcast.
In Blender, safe areas can be set from the Camera and Sequencer views.

-,

Camera Presets s 51 v/ Center-Cut Safe Areas

Title-Img. 4. 21The Safe areas panel found in the camera properties, and the viewmode of the sequencer.

Link- https://docs.blender.org/manual/en/dev/render/blender render/camera/object data.html

Main Safe Areas

Title- Img. 4. 22Red line: Action safe. Green line: Title safe.

Link- https://docs.blender.org/manual/en/dev/render/blender render/camera/object data.html

Title Safe

Title safe is also known as Graphics Safe. Place all important information (graphics or text) inside
this area to ensure it can be seen by the majority of viewers.

Action Safe

Make sure any significant action or characters in the shot areinside this area. This zone also doubles
as a sort of “margin” for the screen which can be used to keep elements from piling up against the

edges.
Tip
Legal Standards
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Each country sets a legal standard for broadcasting. These include,among other things, specific
values for safe areas. Blender defaultsfor safe areas follow the EBU (European Union) standard.

Make sure you are using the correct values when working for broadcast to avoid any trouble.
Center-Cuts

Title- Img. 4. 23Cyan line: action center safe. Blue line: title center safe.

Link- https://docs.blender.org/manual/en/dev/render/blender render/camera/object data.html

Center-cuts are a second set of safe areas to ensure content is seen correctly on screens with a
different aspect ratio. Old TV sets receiving 16:9 or 21:9 video will cut off the sides. Position
content inside the center-cut areas to make sure the most important elements of your composition

can still be visible in these screens.

Blender defaults show a 4:3 (square) ratio inside 16:9 (wide- screen).
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Unit summary

In this Unit, you have learnt how to

e Use Lighting Rig to produce photorealistic results with itsphysically plausible shading and
lighting system.

e Work with lights realistically, with shape and falloff.

e Produce final quality results, resulting in faster setup andmore accurate results.

After learning this Unit, you can download the Open Source Software available on the

internet for free of cost to practice thepossibilities of creating 3D Objects.

Assignment

e Use the same Living Room scene created for Block 02, Unit — 01 Assignment to light
with Blender, improvise the same using Lamps as rigs and render using camera with
required DOF — Depth of Field

e Use this key word “photo frame on wall” on www.google.com to collect the reference

image to build your lighting reference.

Assessment

1. Describe the use of Light Rigs

2. Explain One-point light rig with appropriate example
3. Explain Two-point light rig with appropriate example
4. Explain Studio light rig with appropriate example

5. Describe Depth of Filed
Objective type Questions

1. You can make the spot wider by increasing spot

2. Studio Light rig is similar to Light Rig

3. You cannot set lights to only light objects on a layer (True / False)
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4. Hard, bright lights actually flatten it and make you squint. Softlights allow your
eye to focus (True / False)

5. Ambient light illuminates, in a perfectly balanced, Shadeless way,without casting
shadows (True / False)

Resources

While studying this Unit, you can browse the following internet

links for online video tutorials and several books and trainingDVDs available in the

Blender Store and on the Blender Cloud.

Links to download 3D Files for practice - Copyright Notice
Attribution-NonCommercial-ShareAlike CC BY-NC-SA

1. https://wiki.blender.org/index.php/Doc:2.4/Tutorials/Lig hting/BSoD

2. https://cloud.blender.org/p/hdri

3. wiki.blender.org

4. 1a600207.us.archive.org

5. archive.org
6. www.blender.org

7. docs.blender.org

Books to refer

8. Blender 2.5 Lighting and Rendering by Aaron W. Powell

9. Read Chapter 7 of the John Blain "Complete Guide to Blender Graphics" - Lighting
and Cameras (pages 131-136)

10. https://www.lifewire.com/quick-tips-for-interesting-cg- lighting-2119
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DMA-201
3D Animation

Block — V: 3D Dynamics (Practical)
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Unit-1 Introduction Dynamics
Introduction

All real world physical phenomena are the branches of Physics. The software Blender offers a
variety for different physics. For example you can use Blender to simulate to Smoke, Rain, Dust,
Cloth, Water, Jelly Etc.,

Particle Systems can be used to simulate many things: hair, grass, smoke, flocks. Hair is a subset of
the particle system, and can be used for strand-like objects, such as hair, fur, grass, quills, etc.

Soft Bodies are useful for everything that tends to bend, deform,in reaction to forces like gravity or
wind, or when colliding with other objects. It can be used for skin, rubber, and even clothes, even
though there is separate Cloth Simulation specific for cloth- like objects. Rigid Bodies can simulate

dynamic objects that are fairly rigid.

Fluids, which include liquids and gases, can be simulated, includingSmoke. Force Fields can modify
the behavior of simulations.

In this Unit, you will learn the physical simulation to 3D objectsand practice real world physical

simulation.

Outcomes

Upon completion of this unit you will be able to:
e Apply physical simulation to 3D Objects in your scene
e Demonstrate the utility of Force Fields
e Use Multiple field to create the required effects

e Practice real world physical simulation

Terminology

Baking Baking, in general, is the act of pre-computing something, in order to speed up
some otherprocess later down the line.

Cache : A collection of items of the same type stored
in a hidden or inaccessible place

Gravity Gravity is a global setting that is applied the same to all physics systems in a

scene, which can be found in the scene tab. This value is generally fine left at
its default value, at -9.810in the Z-Axis, which is the force of gravity in the
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real world. Lowering this value would simulate a lower or higher force of

gravity

Baking Physics Simulations

Baking refers to the act of storing or caching the results of a calculation.

It is generally recommended to bake your physics simulations before rendering. Aside from no
longer needing to go through the time-consuming process of simulating again, baking can help
prevent potential glitches and ensure that the outcome of the simulation remains exactly the same

every time.

Compression

Compression level for cache files. Some physics caches can be verylarge (such as smoke). Blender
can compress these caches in orderto save space.

e None
Do not compress the cache.
e Light
Compression optimizes speed ofcompressing/decompressing operations over file size.

e Heavy
Compression will result in smaller cache file more thanLight, however, requires more CPU
time to compress/decompress.

External
Read and write the cache to disk using a user-specified file path.

e [ndex Number

This number specifies which cache should be used when the specified cache directory
contains multiple caches. 0 refers to the top-most cache, 1 to the second from the top,2to
the third, and so on.

e Use Lib Path
Share the disk cache when the physics object is linked into another blend-file.

When this option is enabled, linked versions of the object will reference the same disk
cache. When disabled, linked versions of the object will use independent caches.

e Start
Frame on which to start the simulation.

e End
Frame on which to stop the simulation.

e Cache Step
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Interval for storing simulation data.

e Bake

Start baking. Blender will become unresponsive during most baking operations. The cursor
will display as a number representing the bakes’ progress.

e Free Bake

Mark the baked cache as temporary. The data will stillexist, However, will be removed
with the next object modification and frame change. This button is only available when the
physics system has been baked.

e Calculate to Frame

Bake only up to the current frame. Limited by End frame set in the cache settings.

e Current Cache to Bake
Store any temporarily cached simulation data as a bake. Note that playing the animation
will try to simulate any visible physics simulations. Depending on the physics type, this
data may be temporarily cached. Normally such temporary caches are cleared when an
object or setting is modified, However, converting it to a bake will “save” it.

e Bake All Dynamics
Bake all physics systems in the scene, even those of different types. This is useful for baking
complex setups involving interactions between different physics types.

e Free All Bakes
Free bakes of all physics systems in the scene, even thoseof different types.

e Update All to Frame
Bake all physics systems in the scene to the current frame.

Multiple Caches

Blender allows for storing and managing multiple caches at oncefor the same physics object.

Title-Img. 1. 1Two different caches stored simultaneously.

Attribution-Source-Link-
https://docs.blender.org/manual/en/dev/physics/baking.htmi?highlight=two%20different%20c
aches%20stored%20simultaneously
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Caches can be added and removed with the Plus and Minus buttons. Renaming a cache can be done by
either double clicking or pressing Ctrl-LMB on the desired cache.

Force Fields
Force Fields offer a way to add extra movement to dynamic systems. Particles, Soft Bodies,
Rigid Bodies and Cloth objects canall be affected by forces fields. Force Fields automatically

affect everything. To remove a simulation or particle system from their influence, simply turn down

the influence of that type of Force Field in its Field Weights panel.

e All types of objects and particles can generate fields, However, only curve object can bear
Curve Guides fields.

e Force Fields can also be generated from particles.

e The objects need to share at least one common layer to have effect.

You may limit the effect on particles to a group of objects.
Creating a Force Field

Force field types

Title-Img. 1. 2Creating a Force Field.

Attribution-Source- Link-

https://docs.blender.org/manual/en/dev/physics/force fields/introduction.h tml#creating-a-
force-field
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Reference

e Mode: Object Mode
e Panel: Physics > Fields

To create a single Force Field,
e Step 1: Select Add » Force Field and
e Step 2: Select the desired force field.

This method creates an Empty with the force field attached. To create a field from an existing
object,

e Select the object and change to the Physics tab.
e Select the field type in the Fields menu.

The fields have many options in common; these common optionsare explained for the Spherical
field.

Common Field Settings
Most Fields have the same settings, even though they act very differently. Settings unique to a field

type are described below. Curve Guide and Texture Fields have very different options.

e Shape

The field is either a Point, with omni-directional influence, or a Plane, constant in the XY -
plane, changes only in Zdirection.

e Strength:

The strength of the field effect can be positive or negative to change the direction that the
force operates in. A force field’s strength is scaled with the force object’s scale, allowing
you to scale up and down scene, keeping the same effects.

e Flow

Convert effector force into air flow velocity.

e Noise

Adds noise to the strength of the force.

e Seed
Changes the seed of the random noise.

e Effect Point
You can toggle the field’s effect on particle Location and Rotation

e Collision Absorption

Force gets absorbed by collision objects.

Falloff
Here you can specify the shape of the force field (if the Fall-off Power is greater than 0).
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e Sphere

Falloff is uniform in all directions, as in a sphere.
e Tube

Fall off results in a tube-shaped force field. The Field’s Radial falloff can be adjusted, as well
as the Minimum and Maximum distances of the field.

e Cone
Fall off results in a cone shaped force field. Additional options are the same as those of Tube
options.

e Z Direction
Fall-off can be set to apply only in the direction of the positive Z Axis, negative Z Axis, or
both.

e Power (Power)

How the power of the force field changes with the distancefrom the force field. If r is the
distance from the center of the object, the force changes with 1/ r**"*'. A Fall-off of 2 changes
the force field with 1/ r?, which is the falloff of gravitational pull.

e Max Distance
This makes the force field to take effect within a specified maximum radius (shown by an
additional circle around the object).

e Min Distance

The distance from the object center, up to where the force field is effective with full strength.
If you have a Fall-off of Othis parameter does nothing, because the field is effective with full

strength up to Max Distance (or the infinity).

Force
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Title-Img. 1. 3Force field.

Attribution-Source-Link-

https://docs.blender.org/manual/en/dev/physics/force fields/introduction.h tml#creating-a-
force-field

The Force field is the simplest of the fields. It gives a constantforce towards (positive strength) or away
from (negative strength) the object’s center. Newtonian particles are attracted to a field with negative
strength, and are blown away from a field withpositive strength.

"* Force

Point

v Location

' Rotation

Title-Img. 1. 4UlI for a Force field.
Attribution-Source- Link-

https://docs.blender.org/manual/en/dev/physics/force fields/types/force.html

For Boids Particles, a field with positive strength can be used as a Goal, a field with negative
strength can be used as Predator. Whether Boids seek or fly goals/predators depends on the Physics

settings of the Boids.

Wind
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Title-Img. 1. 5Wind force field.
Attribution-Source- Link-

https://docs.blender.org/manual/en/dev/physics/force fields/types/wind.html

The Wind force field gives a constant force in a single direction, along the force object’s local Z axis. The

strength of the force is visualized by the spacing of the circles shown.

0P wind

Plane

BothZ

Title-Img. 1. 6UI for a Wind force field.
Attribution-Source-

Link- https://docs.blender.org/manual/en/dev/physics/force fields/types/wind.html

Vortex

Title-Img. 1. 7VVortex force field.
Attribution-Source-Link-

https://docs.blender.org/manual/en/dev/physics/force fields/types/wind.ht ml

The Vortex force field gives a spiraling force that twists the direction of points around the force
object’s local Z axis. This can be useful for making a swirling sink, or tornado, or kinks in

particle hair.
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Title-Img. 1. 8UI for a Vortex force field.
Attribution-
Source-

Link- https://docs.blender.org/manual/en/dev/physics/force fields/types/vortex.html

Magnetic

Title-Img. 1. 9Magnetic force field.
Attribution-Source-Link-

https://docs.blender.org/manual/en/dev/physics/force fields/types/magneti c.html

This field depends on the speed of the particles. It simulates theforce of magnetism on
magnetized objects.
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‘ee Harmonic
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Title-Img. 1. 10UI for a Magnetic force field.

Attribution-Source-
Link- https://docs.blender.org/manual/en/dev/physics/force fields/types/magnetic.html

Harmonic

Title-Img. 1. 11Harmonic force field.
Attribution-Source-

Link-https://docs.blender.org/manual/en/dev/physics/force fields/types/harmon ic.html

In a Harmonic force field, the source of the force field is the zero point of a harmonic oscillator
(spring, pendulum). If you set the Damping parameter to 1, the movement is stopped in the
moment the object is reached. This force field is really special if you assign it to particles.
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‘ee Harmonic
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Title-Img. 1. 12UI for a Harmonic force field.
Attribution-Source-Link- https://docs.blender.org/manual/en/dev/physics/force fields/types/harmon ic.html

Options:

e Rest Length
Controls the rest length of the harmonic force.

e Multiple Springs
This causes every point to be affected by multiple springs. Normally every particle of the
field system influences everyparticle of the target system. Not with Harmonic ! Here every
target particle is assigned to a field particle. So particles will move to the place of other
particles, thusforming shapes.

Tutorial: https://en.wikibooks.org/wiki/Blender 3D: Noob to Pro/Particles for ming Shapes

Charge

Title-Img. 1. 13Charge force field.
Attribution-Source-

Link-https://docs.blender.org/manual/en/dev/physics/force fields/types/charge. html

A Charge force field is similar to spherical field except it changesbehavior (attract/repulse)
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based on the effected particles charge field (negative/positive), like real particles with a charge.
This means this field has only effect on particles that have also a Charge field (else, they have

no “charge”, and hence areunaffected)!

_r:° Charge

Point

v’ Rotation

Both Z

Title-Img. 1. 14UI for a Charge force field.
Attribution-Source-

Link-https://docs.blender.org/manual/en/dev/physics/force fields/types/charge. html

Lennard Jones

Title-Img. 1. 15Lennard Jones force field.
Attribution-Source-

Link-https://docs.blender.org/manual/en/dev/physics/force fields/types/lennard jones.html

The Lennard Jones force field is a very short range force with a behavior determined by the sizes
of the effector and effectedparticle. At a distance smaller than the combined sizes the field is very
repulsive and after that distance it is attractive. It tries to keep the particles at an equilibrium

distance from each other. Particles need to be at a close proximity to each other to be effected by
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this field at all.

Particles can have for example both a charge and a Lennard-Jones potential, which is probably
something for the nuclear physicists amongst us.

&e Lennard{ones

Point

Title-Img. 1. 16Ul for a Lennard Jones force field.
Attribution-Source-

Link-https://docs.blender.org/manual/en/dev/physics/force fields/types/lennard jones.html

Texture

Title-Img. 1. 17Texture force field.
Attribution-Source-

Link- https://docs.blender.org/manual/en/dev/physics/force fields/types/texture. html

You can use a Texture force field to create an arbitrarily complicated force field, which force in
the three directions is colorcoded. Red is coding for the X-axis, green for the Y-axis and blue for
the Z-axis (like the color of the coordinate axes in the 3D View).A value of 0.5 means no force, a
value larger than 0.5 acceleration in negative axis direction (like -Z), a value smaller than 0.5
acceleration in positive axis direction (like +Z).
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Title-Img. 1. 18UlI for a Texture force field.
Attribution-Source-

Link-https://docs.blender.org/manual/en/dev/physics/force fields/types/texture. html

Options

Texture mode

This sets the way a force vector is derived from the texture.
e RGB

Uses the color components directly as the force vector components in the color encoded directions.
You need an RGB texture for this, e.g. an image or a color band. So, a Blend texture without a
color band would not suffice.

e Gradient
Calculates the force vector as the 3D-gradient of the intensity(grayscale) of the texture. The gradient

vector always points to thedirection of increasing brightness.
e Curl

Calculates the force vector from the curl of the 3D-RGB texture (rotation of RGB vectors). This
also works only with a color texture. It can be used for example to create a nice-looking turbulence

force with a color clouds texture with Perlin noise.
e Nabla

It is the offset used to calculate the partial derivatives needed for Gradient and Curl texture modes.
e Use Object Coordinates

Uses the emitter object coordinates (and rotation & scale) as the texture space the particles use.
Allows for moving force fields that have their coordinates bound to the location coordinates of an
object.

e Root Texture Coordinates
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This is useful for hair as it uses the texture force calculated for theparticle root position for all
parts of the hair strand.

e 2D

The 2D button disregards the particles z-coordinate and only usesparticles x & y as the texture
coordinates.

Remember that only procedural texture is truly 3D.

Examples

A single colored texture (0.5, 0.0, 0.5) creates a force in thedirection of the positive Y-axis, e.g.

hair is orientated to the Y-axis.

A blend texture with color band can be used to create a force “plane”. E.g. on the left side (0.5, 0.5,
0.5), on the right side (1.0, 0.5, 0.5) you have a force plane perpendicular to XY (i.e. parallel toZ).

If you use an object for the coordinates, you can use the object to push particles around.

An animated wood texture can be used to create a wave likemotion.

Curve Guide

Title-Img. 1. 19Curve Guide force field.
Attribution-Source-

Link-https://docs.blender.org/manual/en/dev/physics/force fields/types/curve g uide.html

The Curve Guide is used to force particles to follow a certain path defined by a Curve Object. A
typical scenario would be to move a red blood cell inside a vein, or to animate the particle flow in

a motor. You can use Curve Guide s also to shape certain hair strands.

You can also use the Particle Edit Mode to define a path.
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Since you can animate curves as Soft Body or any other usual way, you may build very complex

animations while keeping great control and keeping the simulation time to a minimum.

The option Curve Follow does not work for particles. Instead you must set Angular Velocity

(Particle system tab) to Spin and leave the rotation constant (i.e. do not turn on Dynamic).

Curve Guideaffects all particles on the same layer, independently from their distance to the curve.
If you have several guides in a layer, their fields add up to each other (the way you may have
learned it in your physics course). However, you can limit theirinfluence radius by changing

their Minimum Distance.

Options

2 Curve Guide

Nothing

Title-Img. 1. 20U1 for a Curve Guide force field.
Attribution-

Source-
Link-https://docs.blender.org/manual/en/dev/physics/force fields/types/curve g uide.html

e Minimum Distance

It means the distance from the curve, up to where theforce field is effective with full
strength. If you have a Fall- off of 0 this parameter does nothing, because the field is effective
with full strength up to Max Distance (or the infinity). Min Distance is shown with a circle at
the endpoints of the curve in the 3D View.

e Free

Fraction of particle life time, which is not used for thecurve.

Fall-off

This setting governs the strength of the guide between Min Distance and Max Distance. A Fall-

off of 1 means a linear progression.

A particle follows a Curve Guide during its lifetime, the velocity depends on its lifetime and the
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length of the path.

e Additive
If you use Additive, the speed of the particles is alsoevaluated depending on the Fall-off.

e Weights
Use Curve weights to influence the particle influence alongthe curve.

e Maximum Distance / Use Max

This maximum distance value influence radius which isshown by an additional circle
around the curve object.

The other settings govern the form of the force field along the curve.
e  Clumping Amount
The particles come together at the end of the curve (1) or they drift apart (-1).
e Shape

Defines the form in which the particles come together.+0.99: the particles meet at the end
of the curve. O: linear progression along the curve. -0.99: the particles meet atthe beginning of
the curve.

e Kink
Changes the shape that the particles can take:

e Curl
The radius of the influence depends on the distance of the curve to the emitter.

e Radial
A three dimensional, standing wave.

e Wave

A two dimensional, standing wave.
e Braid

Pattern that follows along the curve.

e Roll
A one dimensional, standing wave.

It is not so easy to describe the resulting shapes, so have a look atthe example below.
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Title-Img. 1. 21 Kink options of a curve guide. From left to right:Radial, Wave, Braid, and Roll.
Attribution-Source-
Link-https://docs.blender.org/manual/en/dev/physics/force fields/types/curvequide.html

e Frequency
The frequency of the offset.

e Shape
Adjust the offset to the beginning/end.

e Amplitude
The Amplitude of the offset.

Boid

Title-Img. 1. 22Boid force field.

Attribution-Source-
Link- https://docs.blender.org/manual/en/dev/physics/force fields/types/boid.ht mil

Boid probably comes from theoretical works. Boids is an artificial life program, developed by
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Craig Reynolds (1986), which simulates the flocking behavior of birds. His paper on this topic
was published in 1987 in the proceedings of the ACM SIGGRAPH conference. The name refers to
a “bird-like object”, However, its pronunciation evokes that of “bird” in a stereotypical New York
accent. As with most artificial life simulations, Boids is an example of emergent behavior; that

is, the complexity of Boids arises from the interaction of individual agents (the Boids, in this case)

adhering to a set of simple rules.

Title-Img. 1. 23UlI for a Boid force field.
Attribution-

Source-
Link- https://docs.blender.org/manual/en/dev/physics/force fields/types/boid.ht ml

The rules applied in the simplest Boids world are as follows:
e Separation: steer to avoid crowding local flock mates
e Alignment: steer towards the average heading of localflock mates

e Cohesion: steer to move toward the average position(center of mass) of local

flock mates

More complex rules can be added, such as obstacle avoidance andgoal seeking.

Turbulence

Title-Img. 1. 24Turbulence force field.
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Attribution-
Source-
Link- https://docs.blender.org/manual/en/dev/physics/force fields/types/turbule nce.html

A Turbulence force field creates a random & chaotic 3D noise effect, similar to jets of water

or geysers under the ocean.
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Title-Img. 1. 25UI for a Turbulence force field.
Attribution-

Source-
Link https://docs.blender.org/manual/en/dev/physics/force fields/types/turbule nce.html

e Sjze

Indicates the scale of the noise.

e Global

Makes the size and strength of the noise relative to theworld, instead of the object it is
attached to.

Title-Img. 1. 26 Turbulence force field affecting a particle system.
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Attribution-Source-
Link-https://docs.blender.org/manual/en/dev/physics/force fields/types/turbulence.html

Drag

Title-Img. 1. 27Drag force field.
Attribution-Source-

Link-https://docs.blender.org/manual/en/dev/physics/force fields/types/drag.ht ml

A Drag force field resists particle motion by slowing it down.
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v Rotation

Title-Img. 1. 28Ul for a Drag force field.
Attribution-Source-

Link- https://docs.blender.org/manual/en/dev/physics/force fields/types/drag.ht ml

e Linear

Drag component proportional to velocity.

e Quadratic

Drag component proportional to the square of the velocity.

Smoke Flow
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Title-Img. 1. 29Smoke Flow force field.
Attribution-

Source-
Link-https://docs.blender.org/manual/en/dev/physics/force fields/types/smoke flow.html

A Smoke Flow force field directs the smoke within a smoke simulation.

Smoke Flow

Title-Img. 1. 30U1 for a Smoke Flow force field.
Attribution-

Source-

Link-https://docs.blender.org/manual/en/dev/physics/force fields/types/smoke flow.html

Unit summary

In this Unit, you have learnt what is Physical Simulation and Gravity and how to
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e Use the real-world simulation effects in your 3D Projects likeDust, Smoke, Rain, Fire,
Water etc.

e  Use the force fields in your 3D simulation project.

e Apply Gravity in 3D Simulation using Rigid Body and Soft Body.
After learning this Unit, you can download the Open Source Software available on the internet

for free of cost to practice the possibilities of creating 3D Interface.
Assignment

e Learners are expected to experiment the force fields options / setups and parameters
available in the panel and to experiment the way the physical simulation works for

different force fields from the links.
Assessment

e Describe Force Fields with examples.

e Define Magnetic Force Field.

e Explain Harmonic Force Field with examples.

e Define Charge Filed.

e Explain the Process of using curve as a guide in Force Field.
e Define Boid Field?

e List down the effects Turbulence filed can create.

Fill in the Blanks

1. Default value of Gravity in Blender is

2. Baking refers to the act of the results of acalculation

3. Force Fields can also be generated from

4. Field with positive strength can be used as a

5. A field with negative strength can be used as

Resources

While studying this Unit, you can browse the following internet links for online video
tutorials and several books and training DVDsavailable in the Blender Store and on the Blender

Cloud.
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e wiki.blender.org

e ja600207.us.archive.org

e archive.org

e www.blender.org

e docs.blender.org

Links to download 3D Files for practice

1. https://en.wikibooks.org/wiki/Blender 3D: Noob to Pro/P articles forming Shapes

2. https://cloud.blender.org/training
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Unit-2 Introduction to Rigid Body, Soft Body and
Constraints

Introduction

In this Unit, you will be introduced to a Rigid Body which is an idealization of a Solid Body in
which deformation is neglected. In other words, the distance between any two given points of a
Rigid Body remains constant in time regardless of external forces exerted on it and Soft-body
dynamics that it is a field of computer graphics that focuses on visually realistic physical

simulations of the motion and properties of deformable objects (or soft bodies).

You will also learn the different types of constraints available in Blender to control both Rigid
and Soft Body.

Outcomes

Upon completion of this unit you will be able to:
e Create Passive Body and Active Body
e Demonstrate the utility of Rigid Body
e Use Multiple constraints
e Practice Soft Body animation
e Use constraints to control dynamic animation

e Reuse simulation as cache

Terminology

Active . Object is directly controlled by simulation results. One can select
Active type with Add Active Button in the Physics tab of the Tool Shelf.

Passive . Enables/disables Rigid Body simulation for object.

Dynamic . Enables/disables Rigid Body simulation for object.

Animated . Allowsthe Rigid Body additionally to becontrolled by the animation
system.

Mass

Specifies how heavy the object is and “weights” irrespective of
gravity. There is predefined mass preset available with the Calculate
Mass Button in the Physics tab of the Tool Shelf..

Rigid Body
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The Rigid Body simulation can be used to simulate the motion of solid objects. It affects the

position and orientation of objects anddoes not deform them.

Unlike the other simulations in Blender, the Rigid Body simulation works closer with the animation
system. This means that rigidbodies can be used like regular objects and be part of parent-child

relationships, animation constraints and drivers.

Active

Title-Img. 2. 1Create Rigid Body.
Attribution-

Source-

Link-https://docs.blender.org/manual/en/dev/physics/rigid body/properties.html

Right now, only mesh objects can participate in the Rigid Bodysimulation.

To create Rigid Bodies,
e Step 1: Either click on Rigid Body Button in the Physics tabof the Properties editor

e Step 2: Or use Add Active/Add Passive buttons in the Physics tab of the Tool Shelf.

There are two types of Rigid Body:

1. Active 2. Passive

Active bodies are dynamically simulated, Passive bodies remain static. Both types can be driven
by the animation system when using the Animated option.

During the simulation, the Rigid Body system will override the position and orientation of dynamic
Rigid Body objects. Note however, that the location and rotation of the objects is not changed, so

the Rigid Body simulation acts similar to a constraint.

To apply the Rigid Body transformations, you can use the Apply Transformation Button in the
Physics tab of the Tool Shelf.

The scale of the Rigid Body object also influences the simulation, however, is always controlled

by the animation system.
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Rigid Body physics on the object can be removed with the Rigid Body Button in the Physics tab
or Remove Button in the Physics tab of the Tool Shelf.

Properties of Rigid Body

‘? Convex Hull

Deform

Title-Img. 2. 2 Default Rigid Body panel.
Attribution-
Source-

Link- https://docs.blender.org/manual/en/dev/physics/rigid body/properties.html

These are

e Type

Role of the Rigid Body in the simulation. Active objects can be simulated dynamically,
whereas Passive object remain static.

e Active
Obiject is directly controlled by simulation results. The possibility to select this type also
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available with Add Active Button in the Physics tab of the Tool Shelf.

e Passive

Obiject is directly controlled by animation system. Thus,this type is not available for Rigid Body
Dynamics. The possibility to select this type also available withAdd Passive Button in
the Physics tab of the Tool Shelf.

e Dynamic

Enables/disables Rigid Body simulation for object.

e Animated

Allows the Rigid Body additionally to be controlled by the animation system.

e Mass

Specifies how heavy the object is and “weights”irrespective of gravity. There is predefined

mass preset available with the Calculate Mass Button in the Physics tabof the Tool Shelf.

Calculate Mass

Automatically calculate mass values for Rigid Body Objects based on volume. There are
many useful presets available from the menu, patching real-world objects.
e Note

Also, you can have Custom mass material type, which is achieved by setting a custom
density value (kg/m?).

Rigid Body Collisions

Rigid Body Collisions panel.

Collision shapes

The Shape option determines the collision shape of the object. Thefollowing Collision Shapes are

available:

Primitive shapes

these are best in terms of memory/performance however, do not necessarily reflect the actual shape

of the object. They are calculated based on the object’s bounding box. The center of gravity is
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always in the middle for now.

e Box

Box-like shapes (i.e. cubes), including planes (i.e. ground planes). The size per axis is
calculated from the bounding box.

e Sphere

Sphere-like shapes. The radius is the largest axis of the bounding box.

e Capsule

This points up the Z-Axis.

e Cylinder

This points up the Z-Axis. The height is taken from the z- axis, while the radius is the larger
of the x/y-axes.

e Cone

This points up the Z-Axis. The height is taken from the z- axis, while the radius is the larger

of the x/y-axes.

Mesh based shapes

These are calculated based on the geometry of the object so they are a better representation of the

object. The center of gravity for these shapes is the object origin.
e Convex Hull
A mesh-like surface encompassing (i.e. shrink-wrap over)all vertices (best results with
fewer vertices). Convex approximation of the object, has good performance and stability.
e Mesh
Mesh consisting of triangles only, allowing for more detailed interactions than convex hulls.

Allows to simulate concave objects, however, is rather slow and unstable.

The changing collision shape is available also with Change Shape Button in the Physics tab of the Tool
Shelf.

Mesh source

Users can now specify the mesh Source for Mesh bases collisionshapes:
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e Base

The base mesh of the object.

e Deform

Includes any deformations added to the mesh (shape keys,deform modifiers).
Deforming
Rigid Body deforms during simulation.

e Final

Includes all modifiers.

General settings

e Surface Response

Friction

Resistance of object to movement. Specifies how muchvelocity is lost when objects

collide with each other.
Bounciness

Tendency of object to bounce after colliding with another (0 to 1) (rigid to perfectly elastic).

Specifies how much objects can bounce after collisions.

e Collision Groups

Allows Rigid Body collisions allocate on different groups (maximum 20).
Collision Margin

Margin

Threshold of distance near surface where collisions are stillconsidered (best results when

non-zero).

The collision margin is used to improve performance and stability of rigid bodies. Depending on
the shape, it behaves differently: some shapes embed it, while others have a visible gap around

them.
The margin is embedded for these shapes:

e Sphere
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e Box
e Capsule
e Cylinder
e Convex Hull: Only allows for uniform scale when embedded.
The margin is not embedded for these shapes:
e Cone
e Active Triangle Mesh

e Passive Triangle Mesh: Can be set to 0 most of the time.
Rigid Body Dynamics
Used to control the physics of the rigid body simulation. Rigid BodyDynamics panel.
This panel is available only for Active type of rigid bodies.
Deactivation

e Enable Deactivation

Enable deactivation of resting rigid bodies. Allows object tobe deactivated during the

simulation (improves performance and stability, however, can cause glitches).

e Start Deactivated

Starts objects deactivated. They are activated on collision with other objects.

e Linear Velocity

Specifies the linear deactivation velocity below which the Rigid Body is deactivated

and simulation stops simulating object.

e Angular Velocity

Specifies the angular deactivation velocity below which theRigid Body is deactivated

and simulation stops simulating object.
Damping
A reduction in the amplitude of an oscillation as a result of energy being drained from the system

to overcome frictional or other resistive forces
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e Translation

Amount of linear velocity that is lost over time.

e Rotation

Amount of angular velocity that is lost over time.

Rigid Body World

Rigid Body objects and constraints are only taken into account by the simulation if they are in the
groups specified in Group field of the Rigid Body World panel in the Scene tab.

e Rigid Body World

Enable/disable evaluation of the Rigid Body simulation based on the Rigid Body objects
participating in the specified group of Rigid Body World.

e Remove Rigid Body World

Remove Rigid Body simulation from the current scene.

e Group

Containing Rigid Body objects participating in this simulation.

e Constraints
Containing Rigid Body object constraints participating inthe simulation.
Simulation quality and timing settings:
e Speed

Can be used to speed up/slow down the simulation.

e Split Impulse

Enable/disable reducing extra velocity that can build up when objects collide (lowers
simulation stability a little so use only when necessary). Limits the force with which objects
are separated on collision, generally produces nicerresults, however, makes the simulation

less stable (especially when stacking many objects).

e Steps Per Second
Number of simulation steps made per second (higher values are more accurate however, slower). This only

influences the accuracy and not the speed of the simulation.

e Solver lterations
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Amount of constraint solver iterations made per simulationstep (higher values are more
accurate however, slower). Increasing this makes constraints and object stacking more

stable.

Rigid Body Cache

The Rigid Body Cache panel specifies the frame range in which thesimulation is active. Can be

used to bake the simulation.
e Start/End

First and last frame of the simulation.

e Bake

Calculates the simulation and protects the cache. You needto be in Object Mode to bake.

e Free Bake

Active after the baking of simulation. Clears the baked cache.

e Calculate to Frame

Bake physics to current frame.

e Current Cache to Bake

Bake from Cache.

e Bake All Dynamics

Bake all physics.

e Free All Bakes

Free all baked caches of all objects in the current scene.

e Update All to Frame
Update cache to current frame.

If you haven’t saved the blend-file, the cache is created in memory, so save your file first or the

cache may be lost.
Rigid Body Field Weights

As other physics dynamics systems, Rigid Body simulation are also influenced by external force
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effectors.

Rigid Body Constraints

Constraints (also known as Joints) for rigid bodies connect two Rigid Bodies.

The physics constraints available in the non-game modes are meant to be attached to an Empty
object. The constraint then hasfields which can be pointed at the two physics-enabled objectwhich
will be bound by the constraint. The Empty object providesa location and axis for the constraint
distinct from the two constrained objects. The location of the entity hosting the physics constraint
marks a location and set of axes on each of the two constrained objects. These two anchor points
are calculated at thebeginning of the animation and their position and orientation remain fixed in
the local coordinate system of the object for the duration of the animation. The objects can move
far from the constraint object; however, the constraint anchor moves with the object. If this feature
seems limiting, consider using multiple objects with a non-physics Child-of constraint and animate
the relative location of the child.

Connect

The quickest way to constrain two objects is to select both and click the Connect Button in the
Physics tab of the Tool Shelf. This creates a new Empty object (named “Constraint”) with a physics
constraint already attached and pointing at the two selected objects.

Physics Tab

Also, you can create Rigid Body Constraint on of the two constrained objects with Rigid Body
Constraint Button of the Physics tab in the Properties editor. This constraint is dependent on the
object location and rotation on which it was created. This way, there are no Empty object created
for the constraint. Therole of the Empty object is put on this object. The constrained object can be

then set as Passive type for better driving the constrain.

Additional parameters appear in the Rigid Body Constraint panel of the Physics tab in the
Properties editor for the selected Empty object or the one of the two constrained objects with the

created constraint.
Common Options
Rigid Body Constraint panel.
e Enabled
Specifies whether the constraint is active during the simulation.

e Disable Collisions
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Allows constrained objects to pass through one another.

e Objectl

First object to be constrained.

e Object 2

Second object to be constrained.

e Breakable

Allows constraint to break during simulation. Disabled forthe Motor constraint.
e Threshold

Impulse strength that needs to be reached beforeconstraint breaks.

e Override Iterations

Allows to make constraints stronger (more iterations) or weaker (less iterations) than

specified in the Rigid Body world.

e |terations
Number of constraint solver iterations made per simulationstep for this constraint.
e Limits

By using limits, you can constrain objects even more by specifying a translation/rotation
range on/around respectively axis (see below for each one individually). To lock one axis,
set both limits to 0

Soft Body

A Soft Body in general, is a simulation of a soft or rigid deformableobject. In Blender, this system

is best for simple cloth objects and closed meshes. There is dedicated Cloth Simulation physics

that use a different solver, and is better for cloth.

This simulation is done by applying forces to the vertices or control points of the object. There

are exterior forces like gravityor force fields and interior forces that hold the vertices together.

This way you can simulate the shapes that an object would take onin reality if it had volume, was

filled with something, and was acted on by real forces.

Soft Bodies can interact with other objects throughCollision. They can interact with themselves

through Self Collision.
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The result of the Soft Body simulation can be converted to a static object. You can also bake edit
the simulation, i.e. edit intermediate results and run the simulation from there.

Typical scenarios for using Soft Bodies

Title-Img. 2. 3 A wind cone. The cone is a Soft Body, as the suspension.

Attribution-

Source-

Link-

https://docs.blender.org/manual/en/dev/physics/soft body/introduction.html?
highlight=wind%20cone%20cone%20soft%20body%20suspension

Soft Bodies are well suited for:
e Elastic objects with or without collision.
e Flags, fabric reacting to forces.
e Certain modeling tasks, like a cushion or a table cloth overan object.

e Blender has another simulation system for clothing. However, you can sometimes use
Soft Bodies for certain parts of clothing, like wide sleeves.

e Hair (as long as you minimize collision).

e Animation of swinging ropes, chains and the like.
Creating Soft Body

Soft Body simulation works for all objects that have vertices or control points:

e Meshes.
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e Curves.
e Surfaces.

e Lattices.

To activate the Soft Body simulation for an object:

e Step 1: In the Properties editor, go to the Physics tab (itis all the way on the right, and

looks like a bouncing ball).
e Step 2: Activate the Soft Body button.
e Step 3: You start a Soft Body simulation with Alt-A.
e Step 4: You pause the simulation with Spacebar, continue with Alt-A.

e Step 5: You stop the simulation with Esc.

Simulation Quality

The settings in the Soft Body Solver panel determine the accuracy of the simulation.
e Min Step
Minimum simulation steps per frame. Increase this value, ifthe Soft Body misses fast
moving collision objects.
e Max Step

Maximum simulation steps per frame. Normally the number of simulation steps is set
dynamically (with the Error Limit) however, you have probably a good reason to change
it.

e Auto-Step

Use Velocities for automatic step sizes.

e Error Limit

Rules the overall quality of the solution delivered, default value is 0.1. The most critical
setting that says how precise the solver should check for collisions. Start with a valuethat
is 1/2 the average edge length. If there are visible errors, jitter, or over-exaggerated
responses, decrease the value. The solver keeps track of how “bad” it is doing and the Error

Limit causes the solver to do some “adaptive step sizing”.

o Fuzzy

Simulation is faster, however, less accurate.
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e Choke

Calms down (reduces the exit velocity of) a vertex or edge once it penetrates a collision

mesh.

Diagnostics
e Print Performance to Console

Prints on the console how the solver is doing.

e Estimate Matrix

Estimate matrix. Split to COM, ROT, SCALE

Cache and Bake

Soft Bodies and other physic simulations use a unified system for caching and baking.

The results of the simulation are automatically cached to disk when the animation is played, so
that the next time it runs, it can play again quickly by reading in the results from the disk. If you
Bake the simulation, the cache is protected and you will be asked when you are trying to change

a setting that will make a recalculating necessary.

Caching

e As animation is played, each physics system writes each frame to disk, between the
simulation start and end frames. These files are stored in folders with prefix blend cache,

next to the blend-file.

e The cache is cleared automatically on changes. However, not on all changes, so it may be
necessary to free it manually, e.g. if you change a force field. Note that for the cache to fill

up, one must start playback before or on the frame that the simulation starts.
e If you are not allowed to write to the required sub- directory caching will not take place.

e The cache can be freed per physics system with a Button in the panels, or with the Ctrl-B

shortcut key to free it for all selected objects.

e You may run into trouble if your blend-file path is very long and your operating system has
a limit on the path length that is supported.

Baking

e The system is protected against changes after baking.
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e The Bake result is cleared also with Ctrl-B for all selected objects or click on Free Bake for the
current Soft Body system.

e |If the mesh changes the simulation is not calculated anew.

e For render farms, it is best to bake all the physics systems, and then copy the blend cache to

the render farm as well.
Interaction in real time

To work with a Soft Body simulation, you will find it handy to use the Timeline editor. You can
change between frames and thesimulation will always be shown in the actual state. The option
Continue Physics in the Playback menu of the Timeline editor lets you interact in real time with
the simulation, e.g. by moving collision objects or shake a Soft Body object. If the objects have an

even vertex distribution then the Soft Bodieswork especially well. You need enough vertices for good
collisions.You change the deformation (the stiffness) if you add more vertices in a certain region.

The calculation of collisions may take a long time. If something is not visible, why calculate it?

To speed up the collision calculation it is often useful to collide with an additional, simpler,

invisible, somewhat larger object.

Use Soft Bodies only where it makes sense. If you try to cover a body mesh with a tight piece of
cloth and animate solely with Soft Body, you will have no success. Self-collision of Soft Body hair
may be activated, however, that is a path that you must wander alone. We will deal with Collisions

in detail later.

Try and use a Lattice or a Curve Guide Soft Body instead of the object itself. This may be

magnitudes faster.

Simple Example

Here are some simple examples showing the power of Soft Body physics.
Bouncing Cube

The Process

Title-Img. 2. 4 The timeline.
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Link-https://docs.blender.org/manual/en/dev/physics/soft body/examples.html?hig

hlight=bouncing%20cube

e Step 1: First, change your start and end frames to 1 and 150.

e Step 2: Then, add a plane, and scale it five times.

o Step 3: Next, go to the physics tab, and add a collision. Thedefault settings are fine for this example.
e Step 4: Now add a cube, or use the default cube.

e Step 5: Tab into edit mode and subdivide it three times.

o Step 6: Add a bevel modifier to it to smoothen the edges.

e Step 7: Add a little more, press r twice, and move yourcursor a bit.

When finished, your scene should look like this:

Title-Img. 2. 5 The scene, ready for Soft Body physics.
Attribution-

Source-
Link-
https://docs.blender.org/manual/en/dev/physics/soft body/examples.html? highlight=bouncing%20cube

Everything is ready to add the Soft Body physics.
e Step 1: Go to Properties > Physics and choose Soft Body.
e Step 2: Uncheck the Soft Body goal, and check Soft Body self-collision.
e Step 3: Also, under Soft Body edges, increase the bending to 10.

e Step 4: Playing the animation with Alt-A will now give a slow animation of a bouncing
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cube.
e Step 5: To speed things up, we need to bake the Soft Body physics.

e Step 6: Under Soft Body Cache, change the start and end values to your start and end
frames. In this case 1 and 150.

o Step 7: Now, to test if everything is working, you can take acache step of 5 or 10,
however, for the final animation it is better to reduce it to 1, to cache everything.

When finished, your physics panel should look like this:

Lift Force

Manual Minimal Maximal AvMinMa

Title-Img. 2. 6 The physics settings.
Attribution-

Source-

Link-https://docs.blender.org/manual/en/dev/physics/soft body/examples.html?

highlight=bouncing%?20cube

You can now bake the simulation, give the cube materials andtextures and render the animation.

The Result

The rendered bouncing cube:

Rigid Body Constraint Types

Fixed Constraint
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Title-Img. 2. 7 Options available to a Fixed constraint.
Attribution-

Source-

Link-
https://docs.blender.org/manual/en/dev/physics/rigid_body/constraints/types/fixed.html?highlight=options%20avail
able%20fixed%20constraint

This constraint causes the two objects to move as one. Since the physics system does have a tiny

bit of slop in it, the objects do not move as rigidly as they would if they were part of the same mesh.

Point Constraint

User Persp

(275) Constraint.006

@ ObjectMode v @ 57 % ¢

Title-Img. 2. 8 Options available to a Point constraint.

Attribution-
Source-

Link-https://docs.blender.org/manual/en/dev/physics/rigid body/constraints/types/point.html

The objects are linked by a point bearing allowing any kind of rotation around the location of the
constraint object, however, no relative translation is permitted. The physics engine will do its best

to make sure that the two points designated by the constraint object on the two constrained objects
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are coincident

Hinge

Title- Img. 2. 9 Options available to a Hinge constraint.

Attribution-
Source-

Link-https://docs.blender.org/manual/en/dev/physics/rigid body/constraints/types/hinge.html

The Hinge permits 1 degree of freedom between two objects. Translation is completely
constrained. Rotation is permitted about the Z axis of the object hosting the Physics constraint
(usually an Empty, distinct from the two objects that are being linked). Adjusting the position and

rotation of the object hosting the constraint allows you to control the anchor and axis of the hinge.

The Hinge is the only 1-axis rotational constraint that uses the Z axis instead of the X axis. If
something is wrong with your hinge, check your other constraints to see if this might be the

problem.
Options - Limits
e Z Angle
Enables/disables limit rotation around Z axis.

e Lower

Lower limit of Z axis rotation.

o Upper

Upper limit of Z axis rotation.
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Slider Constraint

The Slider constraint allows relative translation along the X axis of the constraint object, however,

permits no relative rotation, or relative translation along other axes.
Options - Limits
e X AXis

Enables/disables limit translation around X axis.

e Lower

Lower limit of X axis translation.

o Upper

Upper limit of X axis translation

Piston Constraint

A piston permits translation along the X axis of the constraint object. It also allows rotation around
the X axis of the constraint object. It is like a combination of the freedoms of a slider with the

freedoms of a hinge (neither of which is very free alone).

Options - Limits
e X Axis

Enables/disables limit translation around X axis.

e Lower

Lower limit of X axis translation.

e Upper

Upper limit of X axis translation.

e X Angle

Enables/disables limit rotation around X axis.

e |ower

Lower limit of X axis rotation.
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e Upper

Upper limit of X axis rotation

Generic Constraint

The generic constraint has a lot of available parameters.

The X, Y, and Z axis constraints can be used to limit the amount of translation between the objects.

Clamping the min/max to zero has the same effect as the Point constraint.

Clamping the relative rotation to zero keeps the objects in alignment. Combining an absolute

rotation and translation clamp would behave much like the Fixed constraint.

Using a non-zero spread on any parameter allows it to rattle around in that range throughout the

course of the simulation.
Options - Limits
e X Axis/Y Axis/Z axis

Enables/disables limit translation on X, Y or Z axisrespectively.

e Lower
Lower limit of translation for X, Y or Z axis respectively.

e Upper

Upper limit of translation for X, Y or Z axis respectively.

e X Angle/Y Angle/Z Angle

Enables/disables limit rotation around X, Y or Z axisrespectively.

e Lower

Lower limit of rotation for X, Y or Z axis respectively.

e Upper

Upper limit of rotation for X, Y or Z axis respectively.

Generic Spring Constraint
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' Disable Collisions

Title-Img. 2. 10 Options available to a Generic Spring constraint.
Attribution-

Source-

Link-

https://docs.blender.org/manual/en/dev/physics/rigid body/constraints/types/generic_spring.html

The generic spring constraint adds some spring parameters for the X/Y/Z axes to all the options
available on the Generic constraint. Using the spring alone allows the objects to bounce around as
if attached with a spring anchored at the constraint object. This is usually a little too much freedom,

so most applications will benefitfrom enabling translation or rotation constraints.

If the damping on the springs is set to 1, then the spring forces areprevented from realigning the

anchor points, leading to strange behavior. If your springs are acting weird, check the damping.
Options - Limits
e X Axis/Y Axis/Z axis

Enables/disables limit translation on X, Y or Z axisrespectively.

e [ower

Lower limit of translation for X, Y or Z axis respectively.

e Upper

Upper limit of translation for X, Y or Z axis respectively.

o X Angle/Y Angle/Z Angle
Enables/disables limit rotation around X, Y or Z axisrespectively.

e Lower

Lower limit of rotation for X, Y or Z axis respectively.
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o Upper

Upper limit of rotation for X, Y or Z axis respectively.

Options - Springs
o X/IYIZ

Enables/disables springs on X, Y or Z axis respectively.

e Stiffness

Spring Stiffness on X, Y or Z axis respectively. Specifies how*bendy” the spring is.

e Damping

Spring Damping on X, Y or Z axis respectively. Amount ofdamping the spring has.

Motor Constraint

V' Disable Collisions

Title-Img. 2. 20ptions available to a Motor constraint.
Attribution-Source-

Link-https://docs.blender.org/manual/en/dev/physics/rigid _body/constraints/types/motor.html

The motor constraint causes translation and/or rotation between two entities. It can drive two
objects apart or together. It can drive simple rotation, or rotation and translation (although it will
not be constrained like a screw since the translation can be blocked by other physics without

preventing rotation).

The rotation axis is the X axis of the object hosting the constraint. This is in contrast with the Hinge

which uses the Z axis. Since the Motor is vulnerable to confusing perturbations without a matching
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Hinge constraint, special care must be taken to align the axes. Without proper alignment, the motor
will appear to have no effect(because the Hinge is preventing the motion of the motor).

Options - Linear motor/Angular motor

e Enable
Enable linear or angular motor respectively.

e Target Velocity

Target linear or angular motor velocity respectively.

e Max Impulse

Maximum linear or angular motor impulse respectively.

Animation

The most common trick is to key frame animate the location or rotation of an Active physics object
as well as the animated checkbox. When the curve on the animated property switches to disabled,

the physics engine takes over using the object’s last known location, rotation and velocities.

Animating the strengths of various other parameters (a Motor’s Target Velocity, a Hinge’s limits,

etc.) can be used to accomplish a wide variety of interesting results.

Enabling a constraint during the physics simulation often has dramatic results as the physics
engine tries to bring into alignmenttwo objects which are often dramatically out of alignment. It is
very common for the affected objects to build up enough kinetic energy to bounce themselves out
of camera (and into orbit, although the physics engine is not yet capable of simulating aplanet’s
gravity well, so scratch that). Rigid Body dynamics can be baking to normal keyframes with
Bake to Keyframes Button in the Physics tab of the Tool Shelf.

Simulation Stability

The simplest way of improving simulation stability is to increase the steps per second. However,
care must be taken since making too many steps can cause problems and make the simulation even

less stable (if you need more than 1000 steps, you should look at other ways to improve stability).

Increasing the number of solver iterations helps making constraints stronger and also improves

object stacking stability.
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It is best to avoid small objects, as they are currently unstable. Ideally, objects should be at least
20 cm in diameter. If it is still necessary, setting the collision margin to 0, while generally not
recommended, can help making small object behave more naturally. When objects are small and/or
move very fast, they can pass through each other. Besides what is mentioned above it’s also good to avoid
using mesh shapes in this case. Mesh shapes consist of individual triangles and therefore do not really
have any thickness, so objects can pass through more easily. You can give them some thickness by

increasing the collision margin.

Combining Rigid Bodies with Other Simulations

Since the Rigid Body simulation is part of the animation system, itcan influence other

simulations just like the animation system can.

In order for this to work, the Rigid Body object needs to have a Collision Modifier. Simply
click on Collision in the Physics tab.

Scaling Rigid Bodies

Rigid Body objects can be scaled, also during the simulation. Thiswork well in most cases,

however, can sometimes cause problems.

If dynamic scaling is not needed, Rigid Body objects should havethe scale applied by using the
Apply Scale Command Ctrl-A.
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Unit summary
In this Unit, you have learnt what is Rigid Body and Soft Body and how to

e Use the Constraints to control the dynamic motion of the Activeand Passive bodies in real

time.

e Create different type of dynamic animation using the Active,Passive bodies to match the real-

world physics.

After learning this Unit, you can download the Open Source Software available on the

internet for free of cost to practice thepossibilities of creating 3D Interface.

Assignment

e Create a Simple bouncing ball using one — Soft Body and one — Rigid Body.

e Use the key words “bouncing ball” on www.google.com tocollect the reference

video to build your scene.

Assessment

1. Describe Active and Passive Rigid Bodies
2. List the Parameters of Rigid Body Collision
3. Explain the Primitive Shapes with examples
4. Explain Hinge Constraint

5. Explain Soft Body.

6. Define Motor Constraint

Fill in the Blanks

1. There are two types of Rigid Body: and

2. The option determines the collision shape of the object

3. The quickest way to constrain two objects is to select both and click the
Button

4. Constraint is dependent on the object

5. allows to make constraints stronger.
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Resources

While studying this Unit, you can browse the internet links for online video tutorials and several books and

training DVDs available in the Blender Store and on the Blender Cloud.

e wiki.blender.org

e ja600207.us.archive.org

e archive.org

e www.blender.org

e docs.blender.org
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Unit-3 Welcome to Cloth Simulations

Introduction

In this Unit, you will be introduced with Cloth Simulations and to describe which objects
will be part of the Simulation and whichare not. Once you have done this, you can define what
the objects are made of. You can also specify what Cloth is made of, and what a solid or collision
object is. This is where you define Cloth and collision objects, assign properties, and execute the
Simulation. Other controls included is creating constraints, interactively dragging the cloth, and

erasing parts of the Simulation.

Outcomes

Upon completion of this unit you will be able to:
e Demonstrate the utility of Cloth Simulation
e Use Cloth Simulation to create flags and banners
e Practice Cloth Simulation to make clothing to your 3DAssets

e Use Cloth as extra effects in your 3D Scene

Terminology

Mass . The mass of the Cloth material.

Bending . It is the Wrinkle coefficient, higher the valuecreates more large folds
on the cloth.

Damping . Damping of Cloth velocity. Higher values givea smoother result (less
jiggling)

Velocity :  Damps the velocity to help the Cloth reachthe final resting position
faster.

Cloth Simulations

Cloth Simulation is one of the hardest aspects of Computer Graphics (CG), because it is a
deceptively simple real-world item that is taken for granted, yet actually has very complex internal
and environmental interactions. After years of development, Blender has a very robust Cloth
simulator that is used to make clothing, flags, banners, and so on. Cloth interacts with and is
affected by other moving objects, the wind and other forces, as well as a general aerodynamic

model, all of which is under your control.
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Cloth Example. Cloth on carved Cloth Example.
wooden men
(made by
motorsep).

Title-Img. 3. 30ptions available to a Motor constraint.

Attribution-
Source-

Link-https://docs.blender.org/manual/en/dev/physics/cloth/introduction.html

A piece of Cloth is any Mesh, open or enclosed, that has been designated as cloth. The Cloth
panels are located in the Physics taband consist of three panels of options. Cloth is either an open
or closed Mesh and is mass-less, in that all Cloth is assumed to have the same density, or mass per

square unit.

Cloth is commonly modeled as a Mesh grid primitive, or a cube, but can also be, for example, a
teddy bear. However, Blender’s Soft body system provides better Simulation of closed meshes;

Cloth is a specialized Simulation of fabrics.

Once the object is designated as Cloth, a Cloth Modifier will be added to the object’s Modifier
Stack automatically. As a Modifier, then, it can interact with other Modifiers, such as Armature
and Smooth. In these cases, the ultimate shape of the Mesh is computed in accordance with the
order of the Modifier stack. For example, you should smooth the Cloth after the Modifiercomputes

the shape of the cloth.
So, you edit the Cloth settings in two places:
1. Use the Physics buttons to edit the properties of the Cloth

2. Use the Modifier Stack to edit the Modifier propertiesrelated to display and interaction

with other Modifiers.

You can apply the Cloth Modifier to freeze, or lock in, the shape ofthe Mesh at that frame, which
removes the Modifier. For example,you can drape a flat Cloth over a table, let the Simulation run,
andthen apply the Modifier. In this sense, you are using the simulator to save yourself a lot of

modeling time.
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Results of the Simulation are saved in a cache, so that the shape ofthe Mesh, once calculated for a
frame in an animation, does not must be recomputed again. If changes to the Simulation are made,
you have full control over clearing the cache and re-running the Simulation. Running the
Simulation for the first time is fully automatic and no baking or separate step interrupts the

workflow.

Computation of the shape of the Cloth at every frame is automaticand done in the background;
thus, you can continue working whilethe Simulation is computed. However, it is CPU-intensive
and depending on the power of your PC and the complexity of the Simulation, the amount of CPU

needed to compute the Mesh varies, as does the lag you might notice.

Cloth Workflow

A general process for working with Cloth is to:
e Model the Cloth object as a general starting shape.
o Designate the object as a “cloth” in the Physics tab of theProperties editor.

o Model other deflection objects that will interact with the cloth. Ensure the Deflection Modifier is

last on the Modifierstack, after any other Mesh Deforming Modifiers.
o Light the Cloth and assign materials and textures, UV- unwrapping if desired.
o If desired, give the object particles, such as steam coming off the surface.

« Run the Simulation and adjust Options to obtain satisfactory results. The Timeline editors” VCR

controls are great for this step.
o Optionally age the Mesh to some point in the Simulation toobtain a new default starting shape.

o Make minor edits to the Mesh on a frame-by-frame basisto correct minor tears.

Cloth Settings

Cloth

e Presets

Contains a number of preset Cloth examples.

e Quality

Set the number of Simulation steps per frame. Highervalues result in better quality, but is
slower.

e Speed
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Adjust how fast time flows in the Cloth Simulation.

Material

e Mass

The mass of the Cloth material.
e Structural

Overall stiffness of the cloth.

e Bending
Wrinkle coefficient. Higher creates more large folds.

Damping

e Spring

Damping of Cloth velocity. Higher values give a smootherresult (less jiggling).
o Air

Air normally has some thickness which slows falling thingsdown.

e Velocity
Damps the velocity to help the Cloth reach the final restingposition faster.

Pinning
The first thing you need when pinning Cloth is a Vertex Group. There are several ways of doing

this including using the Weight Paint tool to paint the areas you want to pin. The weight of each

vertex in the group controls how strongly it is pinned.

Title-Img. 3. 1Cloth Pinning.
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Once you have a vertex group set, things are pretty straightforward; all you must do is press the
Pinning of Cloth button in the Cloth panel and select which vertex group you want to use, and the

stiffness you want it at.
e Stiffness

Target position stiffness. You can leave the stiffness as it is;the default value of 1 is fine.

Cloth Pinning to an Armature
Clothing can be simulated and pinned to an armature. For example, a character could have a
baggy tunic pinned to the character’s waist with a belt.

e The typical workflow for pinning:

e Set the armature to its bind pose.

e Model clothing that encloses but does not penetrate the character’s Mesh.

e Parent the clothing objects to the armature. The armature will now have several children

meshes bound to it.
e Create a new vertex group on each Cloth object for its pinned vertices

e Add vertexes to be pinned to this vertex group and give these vertices non-zero weights
(you probably want weight = 1). For example, the belt area of the tunic would be inthe

vertex group and have weight one.

e Designate the clothing objects as “cloth” in the Physics tab of the Properties editor. Make

sure the Cloth Modifier is below the Armature Modifier in the Modifier stack.
e Press the Pinning of Cloth button in the Cloth panel and select the vertex group.

e Designate the character’s Mesh as “collision” object in the Physics tab of the Properties

editor.

e The clothing is now ready. Non-pinned vertices will be under control of the Cloth

Modifier. Pinned vertices will be under control of the Armature Modifier.

Dynamic Mesh

Normally Cloth uses the state of the object in the first frame to compute the natural rest shape of
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the cloth, and keeps that constant throughout the Simulation. This is reasonable for fully realistic
scenes, but does not quite work for clothing on cartoon style characters that use a lot of squash

and stretch.

When Dynamic Meshis enabled, the rest shape is recalculatedevery frame, allowing unpinned
Cloth to squash and stretch following the character with the help of an Armature Modifier, but

otherwise move freely under control of the physics Simulation.

Dynamic Mesh is incompatible with using a shape key to specify the rest shape.
Cloth Sewing Springs

Another method of restraining Cloth similar to pinning is Sewing Springs. Sewing Springs are
virtual springs that pull vertices in onepart of a Cloth Mesh toward vertices in another part of the
Cloth Mesh. This is different from pinning which binds vertices of the Cloth Mesh in place or to
another object. A clasp on a cloak could be created with a Sewing Spring. The spring could pull
two cornersof a cloak about a character’s neck. This could result in a more realistic Simulation
than pinning the cloak to the character’s neck since the cloak would be free to slide about the

character’s neck and shoulders.

Sewing Springs are created by adding extra edges to a Cloth Meshthat are not included in any
faces. They should connect vertices in the Mesh that should be pulled together. For example, the

cornersof a cloak.
To activate the springs, enable the Cloth Sewing Springs panel.
Options

e Sewing Force

Maximum force that can be applied by Sewing Springs.Zero means unbounded, but it is not
recommended to leave the field at zero in most cases, as it can cause instability due to extreme

forces in the initial frames wherethe ends of the Sewing Springs are far apart.

The Cloth Sewing Springs panel also contains controls forshrinking the actual Cloth faces.
Shrinking Group

Vertex group that is used to vary the intensity of the shrinkingeffect over the cloth.
e Min

Fraction of the size to shrink the Cloth by around vertices with weight O (or those not in vertex

group.) The value 0.01means shrink by 1% etc.
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Max

Fraction of the size to shrink the Cloth by around vertices with weight 1.

Collisions

In most cases, a piece of Cloth does not just hang there in 3D space, it collides with other objects

in the environment. To ensureproper Simulation, there are several items that must be set up and

working together:

The Cloth object must be told to participate in collisions.
Optionally (but recommended) tell the Cloth to collide withitself.
Other objects must be visible to the Cloth object via sharedlayers.
The other objects must be Mesh objects.

The other objects may move or be themselves deformed by other objects (like an
armature or shape key).

The other Mesh objects must be told to deflect the Cloth object.
The blend-file must be saved in a directory so that Simulation results can be saved.

You then Bake the Simulation. The simulator computes the shape of the Cloth for a frame

range.

You can then edit the Simulation results, or make adjustments to the Cloth Mesh, at
specific frames.

You can make adjustments to the environment or deforming objects, and then re-run the Cloth

Simulation from the current frame forward.

Collision Settings

Title-Img. 3. 2Cloth Collisions panel.
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Now you must tell the Cloth object that you want it to participate in collisions. For the Cloth object,

locate the Cloth Collision panel, shown to the right:

e Quality

A general setting for how fine and good a Simulation you wish. Higher numbers take more time

but ensure less tearsand penetrations through the cloth.
e Distance

As another object gets this close to it (in Blender Units),the Simulation will start to push the Cloth out of the

way.

e Repel

Repulsion force to apply when Cloth is close to colliding.

e Repel Distance

Maximum distance to apply repulsion force. Must be greater than minimum distance.

e Friction

A coefficient for how slippery the Cloth is when it collides with the Mesh object. For example,

silk has a lower coefficient of friction than cotton.

Self-Collisions

Real Cloth cannot permeate itself, so you normally want the Clothto self-collide.
e Enable Self Collisions

Click this to tell the Cloth object that it should not penetrate itself. This adds to Simulation
compute time, but provides more realistic results. A flag, viewed from a distance does not need

this enabled, but a close-up of a cape or blouse on a character should have this enabled.

e Quality

For higher self-collision quality just increase the Qualityand more self-collision layers can be
solved. Just keep in mind that you need to have at least the same Collision Quality value as the

Quality value.

e Distance

If you encounter problems, you could also change the Min Distance value for the self-collisions.
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The best value is 0.75;for fast things, you better take 1.0. The value 0.5 is quite risky (most

likely many penetrations) but also gives some speedup.

e Regression blend-file:

https://wiki.blender.org/index.php/Media:Cloth- regression-selfcollisions.blend

Shared Layers

Suppose you have two objects: a pair of Pants on layers 2 and 3, and your Character Mesh on
layers 1 and 2. You have enabled the Pants as Cloth as described above. You must now make the
Character “visible” to the Cloth object, so that as your character bends its leg, it will push the cloth.
This principle is the same for allSimulations; Simulations only interact with objects on a shared

layer. In this example, both objects share layer 2.

e To view/change an object’s layers, RMB click to select the object in Object Mode in the 3D

View.
e To bring up the “Move Layers” pop-up, which shows you allthe layers that the object is on.
e To put the object on a single layer, LMB click the layer button.
e To put the object on multiple layers, Shift-LMB the layer buttons.

e To remove an object from a selected layer, simply Shift- LMB the layer button again to

toggle it.
Mesh Objects Collide

If your colliding object is not a Mesh object, such as a NURBS surface, or text object, you must
convert it to a Mesh object. Todo so, select the object in object mode, and in the 3D View header,
select Object » Convert Object Type Alt-C, and select Mesh from the pop-up menu.

Cloth - Object collisions
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Title-Img. 3. 3Collision settings.

Attribution-Source-
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The Cloth object needs to be deflected by some other object.

e To deflect a cloth, the object must be enabled as an objectthat collides with the Cloth
object.

e To enable Cloth - Object collisions, you must enabledeflections on the collision object
(not on the Cloth object).

In the Properties editor, Object tab and Physics tab, locate the Collision panel shown to the right.
It is also important to note that this collision panel is used to tell all Simulations that this object is
to participate in colliding/deflecting other objects on a shared layer (particles, soft bodies, and
cloth).

Mesh Object Modifier Stack

Title-Img. 3. 4Collision stack.
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The object’s shape deforms the cloth, so the Cloth Simulation must know the “true” shape of
that Mesh object at that frame. This true shape is the basis shape as modified by shape keys or
armatures. Therefore, the Collision Modifier must be after any ofthose. The image to the right
shows the Modifiers panel for the Character Mesh object (not the Cloth object).

Cloth Cache

Cache settings for Cloth are the same as with other dynamicsystems.

Bake Collision

Title-Img. 3. 5After Baking.

Attribution-Source-

Linkhttps://docs.blender.org/manual/en/dev/physics/cloth/settings/collisions.html

After you have set up the deflection Mesh for the frame range youintend to run the Simulation
(including animating that Mesh via armatures), you can now tell the Cloth Simulation to compute
(and avoid) collisions.

e Select the Cloth object

¢ Inthe Object tab, Physics tab, set the Start and End settingsfor the Simulation frames you
wish to compulte,

e Click the Bake button.
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You cannot change Start or End without clearing the Bake Simulation. When the Simulation has

finished, you will notice you have the option to free the bake, edit the bake and re-bake:

Editing the Cached Simulation

The cache contains the shape of the Mesh at each frame. You canedit the Cached Simulation,
after you have baked the Simulation and pressed the Bake Editing button. Just go to the frame
you want to fix and Tab into Edit Mode. There you can move your vertices using all of Blender’s
Mesh shaping tools. When you exit, the shape of the Mesh will be recorded for that frame of the
animation. If you want Blender to resume the Simulation using thenew shape going forward, LMB
click Rebake from next Frame and play the animation. Blender will then pick up with that shape

and resume the Simulation.

Edit the Mesh to correct minor tears and places where the colliding object has punctured the cloth.

If you add, delete, extrude, or remove vertices in the Mesh, Blender will take the new Mesh as the
starting shape of the Mesh back to the first frame of the animation, replacing the original shape
you started with, up to the frame you were on when you edited the Mesh. Therefore, if you change
the content of a Mesh, when you Tab out of Edit Mode, you should unprotect and clear the cache

so that Blender will make a consistent Simulation.

Troubleshooting

If you encounter some problems with collision detection, there aretwo ways to fix them:

e The fastest solution is to increase the Min Distance setting under the Cloth Collision panel.
This will be the fastest wayto fix the clipping; however, it will be less accurate and will not
look as good. Using this method tends to make it look like the Cloth is resting on air, and

gives it a very rounded look.

e A second method is to increase the Quality (in the first Cloth panel). This results in smaller
steps for the simulator and therefore to a higher probability that fast-moving collisions get
caught. You can also increase the Collision Quality to perform more iterations to get

collisions solved.

e If none of the methods help, you can easily edit the cached/baked result in Edit Mode

afterwards.

e The Cloth is torn by the deforming Mesh — he “Hulks Out”: Increase its structural stiffness

(Structure Stiffness setting, Cloth panel), very high, like 1000.
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Examples

To start with cloth, the first thing you need, of course, is somefabric. So,

Let us delete the default cube and add a plane.

e Inorder to get some good floppy and flexible fabric,you will need to subdivide it several times; about

eight is a good number.
e So, Tab into Edit Mode, and press W > Subdivide multi,and set it to 8.
e Now, we will make this Cloth by going to the Physics tab.
e Scroll down until you see the Cloth panel, and press the Cloth button.
e Now, a lot of settings will appear, most of which we willignore for now.

e Thatis all you need to do to set your Cloth up foranimating, but if you press Alt-A, your lovely fabric

will just drop very un-spectacularly.

That is what we will cover in the next two sections about Pinningand Colliding.

Using Simulation to Shape/Sculpt a Mesh

You can apply the Cloth Modifier at any point to freeze the Mesh in position at that frame. You
can then re-enable the cloth, setting the start and end frames from which to run the Simulation

forward.
Another example of Aging is a Flag.
e Define the flag as a simple grid shape and
e Pin the edge against the flagpole.
e Simulate for 50 frames or so, and the flag will drop toits “rest” position.
e Apply the Cloth Modifier.
If you want the flag to flap or otherwise move in the scene, re- enable it for the frame range when it is in
camera view.

Smoothing of Cloth

Now, if you followed this from the previous section, your Cloth is probably looking a little blocky.
In order to make it look nice and smooth like the picture you need to apply a Smooth and/or
Subdivision Surface Modifier in the Modifiers tab. Then, in thesame editor, find the Links and

Materials panel (the same one you used for vertex groups) and press Set Smooth.
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Now, if you press Alt-A, things are starting to look pretty nice, do not you think?

Cloth on armature

e Cloth deformed by armature and also, respecting anadditional collision object:
https://wiki.blender.org/index.php/Media:Cloth- regression-armature.blend

Cloth with animated vertex groups

e Cloth with animated pinned vertices:https://wiki.blender.org/index.php/Media:Cloth_ani

m_vertex.blend

UNSUPPORTED: Starting with a goal of 0 and increasing it, but still having the vertex not pinned

will not work (e.g. from goal = 0 to goal = 0.5).

Cloth with Dynamic Paint

e Cloth with Dynamic Paint using animated vertexgroups:

https://wiki.blender.org/index.php/Media:Cloth _dyn amic paint.blend

UNSUPPORTED: Starting with a goal of 0 and increasing it, but still having the vertex not pinned
will not work (e.g. from goal = 0 to goal = 0.5) because the necessary “goal springs” cannot be

generated on the fly.

Using Cloth for Soft bodies

Title-Img. 3. 6Using Cloth for soft bodies.
Attribution-

Source-

Link- https://docs.blender.org/manual/en/dev/physics/cloth/examples.html

Cloth can also be used to simulate soft bodies. It is for sure not its main purpose but it works
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nonetheless. The example image uses standard Rubber material, no fancy settings, just Alt-A.

e Blend file for the example image:https://wiki.blender.org/index.php/Media:Cloth-
sbl.blend

Cloth with Wind

Title-Img. 3. 7Flag with wind applied.

Attribution-

Source-

Link- https://docs.blender.org/manual/en/dev/physics/cloth/examples.html

e Regression blend-file for Cloth with wind and self-collisions (also the blend for the image
above):https://wiki.blender.org/index.php/Media: Cloth- flag2.blend

Unit summary

In this Unit, you have learnt what is Cloth Simulation and how to

e Use the Simulation to create effects to 3D Characters, 3D Assets and 3D Environment.

e Bake and save Simulation on moving objects using Cache.
e Create Modifier stacks and smooth Cloth Simulation.

o Create different types of Cloth Simulation like cape, flag, curtain, banners and fabrics,

its use with the help of 3D assets to effectively work on 3D scene.

After learning this Unit, you can download the Open Source Software available on the internet

for free of cost to practice the possibilities of creating 3D Interface.

Assignment

e Create a Pole with a Flag and apply external forces likewind to simulate flag

fluttering
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e Use the key words “flag fluttering” on www.google.com tocollect the reference video to

build your scene.
Assessment

1. Describe Cloth Simulation

2. Explain Dynamic Mesh

3. Define Sewing Force

4. Define Self-Collision

5. Explain Cloth Pinning with the steps and illustration
6. Describe Smoothing of Cloth

7. List out the Properties of Clothing inSimulation.

Fill in the Blanks

1. The first thing you need when pinning Cloth is a

2. When animating or posing the character, you must begin from the
pose

3. Sewing Springs are that pull vertices in one part of a Cloth Mesh
toward vertices in another part of the Cloth Mesh.

4. If your colliding object is not a Mesh object, you must convert it toa_ .

5. The cache contains the shape of the Mesh at

Resources

While studying this Unit, you can browse the following internet links foronline video tutorials and

several books and training DVDs available in theBlender Storeand on theBlender Cloud.

Links to download 3D Files for practice

1. https://en.wikibooks.org/wiki/Blender 3D: Noob to Pro/Parti cles forming Shapes

2. https://cloud.blender.org/training

3. wiki.blender.org

4. 1a600207.us.archive.org

5. archive.org

6. www.blender.org
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Unit-4 Welcome to Fluid Simulation

Introduction

Fluid Simulation refers to Computer Graphics techniques for generating realistic
animations of fluids such as liquid, water and smoke. You would come across Fluid Simulation
that are typically focused on emulating the qualitative visual behavior of a fluid, with less
emphasis placed on rigorously correct physical results, although they often still rely on
approximate solutions that governreal fluid physics. You will also learn that Fluid Simulation can
be performed with different levels of complexity, ranging from time - consuming, and high-quality
animations for films or visual effects, to simple and fast animations for real-time animations like

computer games.
Outcomes

Upon completion of this unit you will be able to:
e Define and Use Fluid Simulation in your 3D project forcreating extra effects
o Describe to control the flow of the fluid
e Demonstrate the use of physical properties of the fluid
e Use bake simulation to save performance

e Reuse Existing simulation

Terminology

Volume . The inside of the object is initialized as fluid all. This works only if
the closed mesh.

Shell . Itis initialized as a thin fluid layer of the surface of the mesh. This can
also be used in the mesh open.

Viscosity . The “thickness” of the fluid and actually theforce needed to move an
object of a certain surface area through it at a certain speed.

Inflow Velocity . Speed of the fluid that is created inside of theobject.

How Materials Works

Fluid physics are used to simulate physical properties of liquids especially water. While creating a
scene in Blender, certain objectscan be marked to participate in the Fluid Simulation. These can
include but not limited to, being a fluid or as an obstacle. For a Fluid Simulation, you must have
a domain to define the space thatthe simulation takes up. In the domain settings, you will be able

todefine the global simulation parameters (such as viscosity andgravity).
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Title-Img. 4. 1Example of Fluid Simulation.

Attribution-Source-

Link- https://docs.blender.org/manual/en/dev/physics/fluid/introduction.html

Workflow

In general, you follow these steps:

1.

2.

5.

First you want to set the simulation domain,
Next set the fluid source(s), and specify the physical properties.
In some cases, you may want to set other objects to Control the Flow of the fluid.

You can also depend on your scene add other objects related to the fluid, like: Obstacles,
Particles floating on thefluid.

And lastly you must Bake the Simulation.

Common Options

Animated Mesh/Export

Click this button if the network is animated (Example: Deformed by an armature, shape keys, or

lattice). It can become very slow and is not necessary if the network’s position and rotation are

animated. (i.e. only object transformations).

Volume Initialization Type

A common option among the different fluid types is Volume Initialization.

e Volume

The inside of the object is initialized as fluid all. This worksonly if the closed mesh.

e Shell

It is initialized as a thin fluid layer of the surface of themesh. This can also be used in
the mesh open.

e Both
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It is a state, such as the sum of the Volume and Shell. Thisalso must be a closed mesh.

Title-Img. 4. 2 Example of different types of initiation of volume

Attribution-Source-

Link-https://docs.blender.org/manual/en/dev/physics/fluid/types/introduction.html

Fluid Domain

The Domain Object

The bounding box of the object serves as the boundary of the simulation. All fluid objects must be
in the domain. Fluid objects outside the domain will not bake. No tiny droplets can move outside
this domain; it’s as if the fluid is contained within the 3D space by invisible force fields. There can

be only a single Fluid Simulation domain object in the scene.

The shape of the object does not matter because it will always be treated like a box (The lengths
of the bounding box sides can be different). So, usually there will not be any reason to use another
shape than a box. If you need obstacles or other boundaries than abox to interfere with the fluid

flow, you need to insert additional obstacle objects inside the domain boundary.

This object will be replaced by the fluid during the simulation.
Options

Domain

Title-Img. 4. 3Fluid Domain Settings.
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Attribution-Source-

Link-https://docs.blender.org/manual/en/dev/physics/fluid/types/domain.html

Resolution

e Render resolution

The granularity at which the actual Fluid Simulation is performed. This is probably the most
important setting for the simulation as it determines the amount of details in thefluid, the

memory and disk usage as well as computational time.

10cm mug at Resolution 70. 10em mug at Resolution 200.

Title-Img. 4. 4 Render resolution

Attribution-Source-

Link-https://docs.blender.org/manual/en/dev/physics/fluid/types/domain.html

e Preview resolution

This is the resolution at which the preview surface meshes will be generated. So, it does not
influence the actual simulation. Even if “there is nothing to see” in the preview,there might

be a thin fluid surface that cannot be resolved in the preview.
Display quality

How to display a baked simulation in the 3D View (menu ViewportDisplay) and for rendering

(menu Render Display):
e Geometry
Use the original geometry (before simulation).
e Preview

Use the preview mesh.
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e Final

Use the final high definition mesh.

When no baked data is found, the original mesh will be displayed by default. After you have baked
a domain, it is displayed (usually) in the Blender window as the preview mesh. To see the size and

scope ofthe original domain box, select Geometry in the left selector.
Time
e Start

It is the simulation start time (in seconds).

This option makes the simulation computation in Blender start later in the simulation. The

domain deformations and fluid flow prior to the start time are not saved.

For example, if you wanted the fluid to appear to already have been flowing for 4 seconds

before the actual first frame of data, you would enter 4.0 here.
e End

It is the simulation ending time (in seconds).

Generate Speed Vector

If this button is clicked, no speed vectors will be exported. So, by default, speed vectors are
generated and stored on disk. They can be used to compute image based motion blur with the

compositing nodes.
Reverse fluid frames

The simulation is calculated backward

Fluid World
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Fluid Presets

Title-Img. 4. 4Fluid World options.
Attribution-Source-

Link-https://docs.blender.org/manual/en/dev/physics/fluid es/domain.html

Viscosity Presets

The “thickness” of the fluid and actually the force needed to movean object of a certain surface

area through it at a certain speed.

For manual entry, please note that the normal real-world viscosity (the so-called Dynamic
Viscosity) is measured in Pascal-seconds (Pa.s), or in Poise units (P, equal to 0.1 Pa.s,
pronounced pwaz, from the Frenchman Jean-Louis Poiseuille, who discovered the laws on “the
laminar flow of viscous fluids”), and commonly centiPoise units (cP, equal to 0.001 Pa.s,
sentipwaz). Blender, on the other hand, uses the kinematic viscosity (which is dynamic viscosity
in Pa.s, divided by the density in kg.m™, unit m2s?). The table below gives some examples of

fluids together with theirdynamic and kinematic viscosities.

Blender Viscosity Unit Conversion
Kinematic
Dynamic Viscosity(in cP) Viscosity
Fluid
(Blender, in m?.s
)
1.002x10°®
Water (20- C) 1.002x10° (1.002) (0.000001002)
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5.0x10°
Oil SAE 50 5.0x10? (500) (0.00005)
Honey (20- C) 1.0x10* (10,000) 2.0x10° (0.002)
Chocolate
Syrup 3.0x10* (30,000) 3.0x10° (0.003)
Ketchup 1.0x10° (100,000) 1.0x107 (0.1)
Melting Glass 1.0x10" 1.0x10° (1.0)

Manual entries are specified by a floating-point number and an exponent. These floating point and
exponent entry fields (scientific notation) simplify entering very small or large numbers. The
viscosity of water at room temperature is 1.002 cP, ou 0.001002 Pa.s; the density of water is about
1000 kg.m3, which gives a kinematic viscosity of 0.000001002 m?2.s — so the entry would be 1.002
times 10 to the minus six (1.002x10°% in scientific notation). Hot Glass and melting iron is a fluid,
but very thick; you should enter something like 1.0x10° (= 1.0) as its kinematicviscosity

(indicating a value of 1.0x10°cP).

Note that the simulator is not suitable for non-fluids, such as materials that do not “flow”. Simply
setting the viscosity to very large values will not result in rigid body behavior, but might cause

instabilities.

Real World Size

Size of the domain object in the real world in meters. If you want to create a mug of coffee, this
might be 10 cm (0.1 meters), while a swimming pool might be 10m. The size set here is for the

longestside of the domain bounding box.
Optimization

e Grid level
How many adaptive grid levels to be used during simulation. Setting this to -1 will perform
automatic selection.
e Compressibility
If you have problems with large standing fluid regions at high resolution, it might help to reduce
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this number (note that this will increase computation times).

Partial Slip

So

v Remove air bubbles

Title-Img. 4. 5Fluid Boundary panel.

Attribution-Source-

Link-https://docs.blender.org/manual/en/dev/physics/fluid/types/domain.html

This box has all the slip and surface options.

Boundary type

The stickiness of the surface of the obstacle, to determine the “tacky surface (Surface Adhesion).”
In the real world, and the tackiness and fluid, the granularity of the object surface, tack,determined
by the elasticity.

e No Slip

Fluid will stick to snugly (speed 0).

e FreeSlip

Fluid will move on the object (0 normal direction of speed).

e PartSlip

It is a two intermediate. It is almost No slip, 1 in the Free exactly the same in 0.

Surface

e Surface Smoothing

Amount of smoothing to be applied to the fluid surface. 1.0is standard, O is off, while larger
values increase the amount of smoothing.

e Subdivisions

Allows the creation of high-res surface meshes directly during the simulation (as opposed to doing
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it afterwards like a subdivision modifier). A value of 1 means no subdivision, and each increase
results in one further subdivision of each fluid voxel. The resulting meshes thus quickly become
large, and can require large amounts of disk space. Be careful in combination with large smoothing
values — this can lead to long computation times due to thesurface mesh generation.

Fluid Particles

Title-Img. 4. 6Fluid Particles Panel.

Attribution-Source-

Link-https://docs.blender.org/manual/en/dev/physics/fluid/types/domain.html

Here you can add particles to the fluid simulated, to enhance thevisual effect.

e Tracer Particles

Number of tracer particles to be put into the fluid at the beginning of the simulation. To
display them createanother object with the Particle fluid type, explained below, that uses

the same bake directory as the domain.

e Generate Particles

Controls the amount of fluid particles to create (0O=off, 1=normal, >1=more). To use it, you

have to have a surface subdivision value of at least 2.

Title-Img. 4. 7An example of Particles’ effects.

Attribution-Source-

Link-https://docs.blender.org/manual/en/dev/physics/fluid/types/domain.html

Left: Simulated without; Right: With particles and subdivisionenabled
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Fluid Object

Fluid

Volume

Title-Img. 4. 8Fluid object settings.
Attribution-Source-

Link-https://docs.blender.org/manual/en/dev/physics/fluid/types/fluid object.html

All regions of this object that are inside the domain bounding box will be used as actual fluid in the
simulation. If you place more than one fluid object inside the domain, they should currently not intersect.
Also make sure the surface normals are pointing outwards. In contrast to domain objects, the actual mesh

geometry is used for fluid objects.

¢ Volume Initialization Type

Refer VVolume Initialization Type

¢ Animated Mesh/Export

Refer Animated Mesh/Export

e Initial velocity

Speed of the fluid at the beginning of the simulation, inmeters per second.

Fluid Obstacle

This object will be used as an obstacle in the simulation. As with a fluid object, obstacle objects
currently should not intersect. As for fluid objects, the actual mesh geometry is used for obstacles.
For objects with a volume, make sure that the normals of the obstacle are calculated correctly, and
radiating properly (use the Flip Normal button, in Edit Mode, Mesh Tools panel, in the Tool
shelf), particularly when using a spinned container. Applying aSubdivision Surface Modifier
before baking the simulation could also be a good idea if the mesh is not animated.

e Volume Initialization Type

Refer Volume Initialization Type

e Boundary type
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Determines the stickiness of the obstacle surface, called “Surface Adhesion”. Surface
Adhesion depends in real- world on the fluid and the graininess or

friction/adhesion/absorption qualities of the surface.

v" No Slip

Causes the fluid to stick to the obstacle (zero velocity).

v Free Slip

Allows movement along the obstacle (only zero normalvelocity).

v' Part Slip

Mixes both types, with O being mostly no slip, and 1being identical to free slip.

Note that if the mesh is moving, it will be treated as no slip automatically.

Title-Img. 4. 9 Example of the different boundary types for a drop falling onto

the slanted wall. From left to right: no-slip, part-slip 0.3, part-slip 0.7 and free-slip.
Attribution-Source-

Link-https://docs.blender.org/manual/en/dev/physics/fluid/types/obstacle.html

¢ Animated Mesh/Export

Refer Animated Mesh/Export

e Part Slip Amount

Amount of mixing between no- and free-slip, describedabove.

e Impact Factor

Amount of fluid volume correction for gain/loss from impacting with moving objects. If
this object is not moving, this setting has no effect. However, it if is and the fluid collides
with it, a negative value takes volume away from the Domain, and a positive number adds
to it. Ranges from -2.0 to 10.0.

Fluid Inflow / Outflow
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To control the volume of the Fluid Simulation, you can set objectsin the scene to add or absorb
fluid within the Fluid Domain.

Inflow

Inflow

v Enabled

Volume

Title-Img. 4. 10Fluid Inflow Settings.

Attribution-Source-

Link- https://docs.blender.org/manual/en/dev/physics/fluid/types/flow.html

¢ Volume Initialization Type

Refer VVolume Initialization Type

This object will put fluid into the simulation, like a water tap.

¢ Inflow Velocity

Speed of the fluid that is created inside of the object.

e Local Coordinates/Enable

Use local coordinates for the inflow. This is useful if the inflow object is moving or rotating,
as the inflow stream will follow/copy that motion. If disabled, the inflowlocation and
direction do not change.

e Animated Mesh/Export

Refer Animated Mesh/Export

Outflow

450


https://docs.blender.org/manual/en/dev/physics/fluid/types/flow.html

v Enabled

Volume

Title-Img. 4. 11Fluid Outflow Settings.
Attribution-Source-

Link- https://docs.blender.org/manual/en/dev/physics/fluid/types/flow.html

Any fluid that enters the region of this object will be deleted (thinkof a drain or a black hole). This
can be useful in combination with an inflow to prevent the whole domain from filling up. When
enabled, this is like a tornado (waterspout) or “wet vac” vacuum cleaner, and the part where the
fluid disappears will follow the object as it moves around.

¢ Volume Initialization Type

Refer Volume Initialization Type

¢ Animated Mesh/Export

Refer Animated Mesh/Export

Fluid Particle

Particle

Title-Img. 4. 12Fluid particle settings.

Attribution-Source-

Link-https://docs.blender.org/manual/en/dev/physics/fluid/types/particle.html

This type can be used to display particles created during the simulation. For now, only tracers
swimming along with the fluidare supported.

Note that the object can have any shape, position or type. Once the particle button is pressed, a
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particle system with the Fluid Simulation particles will be created for it at the correct position.
When moving the original object, it might be necessary to delete the particle system, disable the
fluidism particles, and enable them again. The fluidism particles are currently also unaffected by
any other particle forces or settings.

e Influence

e Size Influence

The particles can have different sizes, if this value is 0 allare forced to be the same

size.

e Alpha Influence

If this value is >0, the alpha values of the particles are changed according to their size.
e Particle type
e Drops
Surface splashes of the fluid result in droplets being strewnabout, like fresh water, with low

Surface Tension.

e Floats

The surface tension of the fluid is higher and the fluidheavier, like cold seawater and soup.
Breakaways are clumpier and fall back to the surface faster than Drops, as with high Surface

Tension.

e Tracer

Droplets follow the surface of the water where it existed, like a fog suspended above

previous fluid levels. Use this tosee where the fluid level has been.

e Path (bake directory)

The simulation runs to load the particles. This should usually have the same value as the

fluid domain object (e.g. copy by Ctrl-C, Ctrl-V).

Fluid Control

Using the Lattice-boltzman method, the fluid is controlled using particles which define local force
fields and are generatedautomatically from either a physical simulation or a sequence of target

shapes. At the same time, as much as possible of the natural fluid motion is preserved.
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Options

Title-Img. 4. 13Fluid control options.
Attribution-Source-
Link- http://blender-manual- i18n.readthedocs.io/ja/latest/physics/fluid/control.html

e Enabled

Controls weather the control object contributes to the fluidsystem. This is useful when
animating the fluid control object.

e Quality

Higher quality results in more control particles for the fluid control object.

e Reverse Frames

The control particle movement gets reversed.

e Time

You specify the start and end time during which time the fluid control object is active.

e Attraction force

The attraction force specifies the force which gets emitted by the fluid control object.
Positive force results inattraction of the fluid, negative force in avoidance.

e Velocity force
If the fluid control object moves, the resulting velocity canalso introduce a force to the fluid.

Examples

In this example, we use the Fluid Control option to control part of the fluid so that it has a certain

shape (the sphere drop or the teapot drop) before it falls in the rest of the fluid:
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Title-Img. 4. 14Falling drop.

Attribution-Source-

Link-https://docs.blender.org/manual/en/dev/physics/fluid/types/control.html

Title-Img. 4. 15“Magic Fluid Control.”

Attribution-Source-

Link-https://docs.blender.org/manual/en/dev/physics/fluid/types/control.html

Baking

Domain

Final

V' Generate Speed Vectors

Title-Img. 4. 16The Fluid Simulation options with Domain selected.
Attribution-Source-
Link- https://docs.blender.org/manual/en/dev/physics/fluid/baking.html

Bake Button
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e Perform the actual Fluid Simulation.

Blender will continue to work normally, except there will be a progress bar in the header of
the Info Editor, next to the render pulldown. Pressing Esc or the “x” next to the status bar
will abort the simulation. Afterwards two.bobj.gz (one for the Final quality, one for the
Preview quality), plus one.bvel.gz (for the Final quality)will be in the selected output

directory for each frame.

Bake directory

o Directory and file prefix to store baked surfacemeshes.

This is similar to the animation output settings, only selecting a fileis a bit special: when
you select any of the previously generated surface meshes (e.g.
testl fluidsurface_final_0132.bobj.gz), the prefix will be automatically set (testl_ in this
example). This way the simulation can be done several times with different settings, and

allows quick changes between the different sets of surface data.

Notes

e Unique domain

Because of the possibility of spanning and linking between scenes, there can only be one
domain in an entire blend- file.

e Selecting a Baked Domain

After a domain, has been baked, it changes to the fluid mesh. To re-select the domain so
that you can bake it againafter you have made changes, go to any frame and select RMB
the fluid mesh. Then you can click the bake button again to recomputed the fluid flows
inside that domain.

e Baking always starts at Frame #1

The fluid simulator disregards the Start setting in the Animation panel, it will always bake
from frame 1. If you wish the simulation to start later than frame 1, you must key the fluid
objects in your domain to be inactive until the frame you desire to start the simulation.

e Baking always ends at the End Frame set in the Animation panel

If your frame-rate is 25 frames per second, and endingtime is 4.0 seconds, then you should
(if your start time is 0)set your animation to end at frame 4.0 x 25 = 100

e Freeing the previous baked solutions

Deleting the content of the “Bake” directory is a destructive way to achieve this. Be careful
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if more than onesimulation uses the same bake directory (be sure they use different

filenames, or they will overwrite one another)!

Reusing Bakes

Manually entering (or searching for) a previously saved (baked) computational directory

and filename mask willswitch the fluid flow and mesh deformation to use that which existed

during the old bake. Thus, you can re-use baked flows by simply pointing to them in this
field.

Baking processing time

Baking takes a lot of compute power (hence time).Depending on the scene, it might be preferable

to bake overnight.

If the mesh has modifiers, the rendering settings are used forexporting the mesh to the fluid solver.

Depending on the setting, calculation times and memory use might exponentially increase. For example,

when using a moving mesh with Subdivision Surface as an obstacle, it might help to decrease simulation

time by switching it off, or to a low subdivision level. When the setup/rig iscorrect, you can always

increase settings to yield a more realistic result.

Fluid Appendix

Hints

Some useful hints about Fluid Simulation in Blender:

Do not be surprised, but you will get whole bunch of mesh (. bobj.gz) files after a
simulation. One set for preview, and another for final. Each set has a .gz file foreach

frame of the animation. Each file contains thesimulation result — so you will need them.

Currently these files will not be automatically deleted, so it is a good idea to e.g. create
a dedicated directory to keep simulation results. Doing a Fluid Simulation is similar to
clicking the animation button. Currently you must take care of organizing the fluid
surface meshes insome directory by yourself. If you want to stop using the Fluid

Simulation, you can simply delete all the *fluid*.bobj.gz files.

Before running a high-resolution simulation that might take hours, check the overall

timing first by doing lowerresolution runs.

Fluid objects must be completely inside the bounding box of the domain object. If not,
baking may not work correctly or at all. Fluid and obstacle objects can be meshed with
complex geometries. Very thin objects might not appear in the simulation, if the chosen

resolution is too coarse to resolve them (increasing it might solve this problem).
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e Do not try to do a complicated scene all at once. Blender has a powerful compositor that

you can use to combine multiple animations.

For example, to produce an animation showing twoseparate fluid flows while keeping
your domain small, render one .avi using the one flow. Then move thedomain and render
another .avi with the other flow using an alpha channel (in a separate B&W .avi?). Then,
composite both .avi‘s using the compositor’s add function. A third .avi is usually the
smoke and mist and it is laid on top of everything as well. Add a rain sheet on top of the
mist and spray and you will have quite a storm brewing! And then lightning flashes,
trash blowing around, all as separate animations, compositing the total for a truly

spectacular result.

Limitations & Workarounds

If the setup seems to go wrong, make sure all the normals are correct (hence, enter Edit

Mode, select all, and recalculate normals once in a while).

Currently there is a problem with zero gravity simulation. It could be avoided by simply

selecting a very small gravity until this is fixed.

If an object is initialized as Volume, it must be closed and have an inner side (a plane will
not work). To use planes, switch to Shell, or extrude the plane.

Blender freezes after clicking bake. Pressing Esc makes it work again after a while — this
can happen if the resolution is too high and memory is swapped to hard disk, making

everything horribly slow. Reducing the resolution should help in this case.

Blender crashes after clicking bake — this can happen if the resolution is really high and
more than 2GB are allocated, causing Blender to crash. Reduce the resolution. Many
operating systems limit the total amount of memory that can be allocated by a process, such

as Blender, even if the machine has more memory installed.

The meshes should be closed, so if some parts of e.g. afluid object are not initialized
as fluid in the simulation, check that all parts of connected vertices are closed meshes.
Unfortunately, the Suzanne (monkey) mesh inBlender is not a closed mesh (the eyes are

separate).

If the Fluid Simulation exits with an error message (stating e.g. that the “init has failed”),
make sure you have valid settings for the domain object, e.g. by resetting them to the

defaults.
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e Note that first frame may well take only a few hundred MBs of RAM memory, but latter
ones go over one GB,which may be why your bake fails after a while. If so, try to bake

one frame at the middle or end at full res so you will see if it works.
e Memory used doubles when you set surface subdivision from 1 to 2.

e Using “generate particles” will also add memory requirements, as they increase surface

area and complexity. Ordinary fluid-sim generated particlesprobably eat less memory.

Unit summary

In this Unit, you have learnt about Fluid Simulation and how to
e Include the Fluid Simulation in your 3D Scene, using the global simulation parameter.
e Create simulation for water, liquid, oil, flood, ocean etc.
e Control Fluid Simulation using the physical properties of those elements

e Interact with the collusion or obstacle objects.

After learning this Unit, you can download the Open Source Software available on the internet

for free of cost to practice thepossibilities of creating 3D Interface.

Assignment

e Create a Simple Fluid Simulation of pouring liquid from a tea pot to a cup.

e Use the key words “Teapot Pouring Tea” onwww.google.com to collect the reference

video to build your scene.

Assessment

1. Describe Domain Object
2. Define Speed Vector
3. Explain Viscosity

4. Describe Fluid Object
5. Explain Fluid Particles

6. Define Baking
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State the limitations of Fluid Simulation.

Fill in the Blanks

1. _ are used to simulate physical properties of liquidsespecially water.

2. Speed Vectors can be used to compute image based withthe compositing nodes.

3. The thickness of the fluid is called

4. __ Controls the movement of the liquid.
5. __isathin fluid layer of the surface of the mesh.
Resources

While studying this Unit, you can browse the following internet links for online video tutorials

and several books and trainingDVDs available in the Blender Store and on the Blender Cloud.

wiki.blender.org

e ja600207.us.archive.org

e archive.org

e www.blender.org

e docs.blender.org

Links to download 3D Files for practice

1. https://en.wikibooks.org/wiki/Blender 3D: Noob to Pr o/Particles forming Shapes

2. https://cloud.blender.org/training
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